
 
 

USER GUIDE 
 

nanoCAD 
 

 

 

Version 3 
 

 

 

 

 

 

 

 

 

Nanosoft 

2011 

 

 



 

GENERAL INFORMATION ..................................................................................................................................... 7 

INTRODUCTION ........................................................................................................................................................... 7 
SYSTEM REQUIREMENTS ............................................................................................................................................. 7 
PROGRAM INSTALLATION ........................................................................................................................................... 8 
LAUNCH OF NANOCAD .............................................................................................................................................. 8 
HELP ........................................................................................................................................................................... 9 
EXIT FROM NANOCAD ............................................................................................................................................... 9 

NANOCAD USER INTERFACE............................................................................................................................. 10 

MAIN MENU .............................................................................................................................................................. 10 
TOOLBARS ................................................................................................................................................................ 11 
NANOCAD DOCUMENT WINDOW .............................................................................................................................. 12 
CONTEXT MENU ........................................................................................................................................................ 12 
INSPECTOR WINDOW ................................................................................................................................................. 13 
COMMAND LINE ........................................................................................................................................................ 13 

Input of commands, aliases and shortcuts ............................................................................................................ 14 
Text window ......................................................................................................................................................... 14 
Command Line prompt ......................................................................................................................................... 15 
Format of input data ............................................................................................................................................ 15 
Mathematical processor ....................................................................................................................................... 16 
Auto hide mode in the command line ................................................................................................................... 17 

WORKING WITH COMMANDS..................................................................................................................................... 18 
Transparent commands ........................................................................................................................................ 18 
Command recall ................................................................................................................................................... 18 
Cancelation of commands .................................................................................................................................... 18 
Settings of the right button ................................................................................................................................... 19 

STATUS BAR ............................................................................................................................................................. 20 
Managing elements of the Status bar ................................................................................................................... 20 

MANAGING INTERFACE ELEMENTS ........................................................................................................................... 21 
COLOR SCHEMES ...................................................................................................................................................... 21 

WORKING WITH DOCUMENTS ......................................................................................................................... 23 

CREATION OF NEW DOCUMENT ................................................................................................................................. 23 
Template usage ..................................................................................................................................................... 23 

OPENING A DOCUMENT ............................................................................................................................................. 24 
CLOSING A DOCUMENT ............................................................................................................................................. 25 
SAVING A DOCUMENT ............................................................................................................................................... 26 

Saving a document with another name ................................................................................................................. 26 
Saving a document or its part using the WBLOCK command .............................................................................. 27 
Auto saving and Backup ....................................................................................................................................... 27 

IMPORT ..................................................................................................................................................................... 28 
EXPORT .................................................................................................................................................................... 29 

Export of all data.................................................................................................................................................. 29 
Export of selected data ......................................................................................................................................... 30 

UTILITIES .................................................................................................................................................................. 31 
Document audit .................................................................................................................................................... 31 
Recovery of document .......................................................................................................................................... 31 
Purge of document ............................................................................................................................................... 32 

TUNING NANOCAD ................................................................................................................................................ 34 

TUNING PROGRAM PARAMETERS .............................................................................................................................. 34 
TUNING THE INTERFACE ........................................................................................................................................... 38 

Toolbars tab ......................................................................................................................................................... 38 
Commands tab ...................................................................................................................................................... 40 
Keyboard tab ........................................................................................................................................................ 42 
Options tab ........................................................................................................................................................... 43 
Profiles tab ........................................................................................................................................................... 44 

DESIGN SETTINGS ..................................................................................................................................................... 46 
Settings of Layers’ profiles ................................................................................................................................... 48 
Saving and transferring settings to other computer ............................................................................................. 53 

DRAWING UNITS ....................................................................................................................................................... 54 



SYMBOL SCALE AND MEASUREMENT SCALE ............................................................................................................. 56 
Specifying scale .................................................................................................................................................... 56 
Symbol scale ......................................................................................................................................................... 57 
Measurement scale ............................................................................................................................................... 59 

SOLVING PROBLEMS ................................................................................................................................................. 62 

COORDINATE SYSTEMS ...................................................................................................................................... 64 

SPECIFYING COORDINATES ....................................................................................................................................... 64 
Cartesian coordinates .......................................................................................................................................... 64 
Polar coordinates ................................................................................................................................................. 65 
Specifying points with “direction – distance” ...................................................................................................... 66 

USER COORDINATE SYSTEM ...................................................................................................................................... 66 
Changing UCS position ........................................................................................................................................ 66 
UCS icon .............................................................................................................................................................. 69 
Named UCS .......................................................................................................................................................... 69 
UCS for viewports ................................................................................................................................................ 74 

PRECISION TOOLS ................................................................................................................................................ 75 

PRECISION MODES .................................................................................................................................................... 75 
Snap and Grid mode ............................................................................................................................................. 76 
Polar Tracking mode ............................................................................................................................................ 78 
Object snap mode ................................................................................................................................................. 80 
Object Snap tracking mode .................................................................................................................................. 85 
ORTHO mode ....................................................................................................................................................... 88 

NAVIGATION IN THE DOCUMENT ................................................................................................................... 89 

DISPLAY MODES ....................................................................................................................................................... 89 
Pan ....................................................................................................................................................................... 89 
Zoom ..................................................................................................................................................................... 89 

ORDER OF OBJECTS ................................................................................................................................................... 90 
VIEWPORTS OF MODEL SPACE .................................................................................................................................. 91 
IMAGE REGENERATION ............................................................................................................................................. 94 

OBJECTS’ PROPERTIES ....................................................................................................................................... 95 

INSPECTOR ................................................................................................................................................................ 95 
Creation of custom properties windows ............................................................................................................... 96 

DISTRIBUTING OBJECT BY LAYERS ............................................................................................................................ 99 
Layers ................................................................................................................................................................. 100 

LINE TYPES ............................................................................................................................................................. 109 
Line type Editor .................................................................................................................................................. 111 
Creation a new line type ..................................................................................................................................... 114 

MANAGING THE TRANSPARENCY OF OBJECTS ......................................................................................................... 114 

GEOMETRIC OBJECTS ....................................................................................................................................... 115 

AUXILIARY LINES ................................................................................................................................................... 115 
Ray ..................................................................................................................................................................... 115 
Construction Line ............................................................................................................................................... 115 

LINEAR OBJECTS ..................................................................................................................................................... 115 
Point ................................................................................................................................................................... 115 
Two points .......................................................................................................................................................... 117 
Polyline .............................................................................................................................................................. 117 
Polygon .............................................................................................................................................................. 118 
Rectangle ............................................................................................................................................................ 119 

CURVED OBJECTS ................................................................................................................................................... 120 
Arc ...................................................................................................................................................................... 120 
Circle .................................................................................................................................................................. 125 
Spline .................................................................................................................................................................. 127 
Ellipse ................................................................................................................................................................. 128 

EDITING OBJECTS .............................................................................................................................................. 130 

SELECTION OF OBJECTS .......................................................................................................................................... 130 
Selection of objects using command line ............................................................................................................ 130 
Selection of all objects ........................................................................................................................................ 131 



Selection of superimposed objects ...................................................................................................................... 131 
Selection of objects using the Inspector ............................................................................................................. 132 
Quick selection of objects ................................................................................................................................... 134 

WAYS TO EDIT OBJECTS .......................................................................................................................................... 137 
Copy of objects properties .................................................................................................................................. 137 
Copying and insertion of objects using clipbook ................................................................................................ 138 
Editing objects using ordinary grips .................................................................................................................. 139 
Editing objects using multifunctional grips ........................................................................................................ 140 

COMMANDS TO EDIT GEOMETRIC OBJECTS ............................................................................................................. 145 
Lengthen objects ................................................................................................................................................. 145 
Trim vectors ....................................................................................................................................................... 146 
Smart trim........................................................................................................................................................... 146 
Extend vectors .................................................................................................................................................... 147 
Break vectors ...................................................................................................................................................... 148 
Break vectors at point ........................................................................................................................................ 149 
Reverse ............................................................................................................................................................... 149 
Join objects ......................................................................................................................................................... 149 
Editing a polyline ............................................................................................................................................... 150 
Editing a spline .................................................................................................................................................. 151 

COMMANDS TO EDIT OBJECTS ................................................................................................................................. 153 
Erase .................................................................................................................................................................. 153 
Copy ................................................................................................................................................................... 153 
Mirror ................................................................................................................................................................. 153 
Offset .................................................................................................................................................................. 154 
Array .................................................................................................................................................................. 155 
Move ................................................................................................................................................................... 157 
Rotate ................................................................................................................................................................. 158 
Scale ................................................................................................................................................................... 159 
Stretch ................................................................................................................................................................ 159 
Align ................................................................................................................................................................... 160 
Distributing copies ............................................................................................................................................. 161 
Chamfer .............................................................................................................................................................. 161 
Fillet ................................................................................................................................................................... 163 
Explode ............................................................................................................................................................... 165 
Explode all objects ............................................................................................................................................. 165 

CREATING AND EDITING COMPLEX OBJECTS ......................................................................................... 166 

GROUPS OF OBJECTS ............................................................................................................................................... 166 
BLOCKS .................................................................................................................................................................. 170 

Creation of block ................................................................................................................................................ 171 
Block attributes .................................................................................................................................................. 172 
Block Insertion ................................................................................................................................................... 174 
Managing blocks in a current drawing .............................................................................................................. 175 
Block editor ........................................................................................................................................................ 176 
Exploding block insertion ................................................................................................................................... 176 
Saving block in a separate file ........................................................................................................................... 176 

INSERT EXTERNAL REFERENCE .............................................................................................................................. 177 
EDIT REFERENCES ............................................................................................... ERROR! BOOKMARK NOT DEFINED. 

Add objects to the working set ................................................................................ Error! Bookmark not defined. 
Remove objects from the working set ..................................................................... Error! Bookmark not defined. 
Save external reference changes ............................................................................ Error! Bookmark not defined. 
Discard external reference changes ....................................................................... Error! Bookmark not defined. 

INSERT IMAGE ..................................................................................................... ERROR! BOOKMARK NOT DEFINED. 
Image Settings ........................................................................................................ Error! Bookmark not defined. 

EXTERNAL REFERENCES CONTROL ..................................................................... ERROR! BOOKMARK NOT DEFINED. 
Change of the external reference to raster image .................................................. Error! Bookmark not defined. 
Image settings ......................................................................................................... Error! Bookmark not defined. 

SHOW BOUNDARY ............................................................................................... ERROR! BOOKMARK NOT DEFINED. 
Setting of the show boundary for the block or external reference .......................... Error! Bookmark not defined. 
Setting of the show boundary for raster image....................................................... Error! Bookmark not defined. 

EXECUTION OF DRAWINGS COMMANDS ....................................... ERROR! BOOKMARK NOT DEFINED. 

THE FILLING AND HATCH COMMANDS ............................................................... ERROR! BOOKMARK NOT DEFINED. 



Modify Hatches Areas ............................................................................................ Error! Bookmark not defined. 
SHAPE ................................................................................................................. ERROR! BOOKMARK NOT DEFINED. 
FILLSHAPES ........................................................................................................ ERROR! BOOKMARK NOT DEFINED. 
BOUNDARY ......................................................................................................... ERROR! BOOKMARK NOT DEFINED. 
SOLID ................................................................................................................. ERROR! BOOKMARK NOT DEFINED. 
WIPEOUT ............................................................................................................ ERROR! BOOKMARK NOT DEFINED. 
REVISION CLOUD ................................................................................................ ERROR! BOOKMARK NOT DEFINED. 
WORK WITH TEXT .............................................................................................. ERROR! BOOKMARK NOT DEFINED. 

Text ......................................................................................................................... Error! Bookmark not defined. 
Multiline Text ......................................................................................................... Error! Bookmark not defined. 
Editing Text ............................................................................................................ Error! Bookmark not defined. 
Creating a text style................................................................................................ Error! Bookmark not defined. 
Find and Replace Text ............................................................................................ Error! Bookmark not defined. 

DIMENSIONING ................................................................................................... ERROR! BOOKMARK NOT DEFINED. 
Some features of nanoCAD’s dimensioning ........................................................... Error! Bookmark not defined. 
Linear dimensions .................................................................................................. Error! Bookmark not defined. 
Radial dimensions .................................................................................................. Error! Bookmark not defined. 
Angular dimensions ................................................................................................ Error! Bookmark not defined. 
Arc length ............................................................................................................... Error! Bookmark not defined. 

DIMENSIONS EDITING ......................................................................................... ERROR! BOOKMARK NOT DEFINED. 
Break and Restore dimensions ............................................................................... Error! Bookmark not defined. 
Explode dimensions ................................................................................................ Error! Bookmark not defined. 

DIMENSION STYLES ............................................................................................ ERROR! BOOKMARK NOT DEFINED. 
Modify dimension style ........................................................................................... Error! Bookmark not defined. 

NOTES ................................................................................................................ ERROR! BOOKMARK NOT DEFINED. 
Leader note ............................................................................................................. Error! Bookmark not defined. 
Position note ........................................................................................................... Error! Bookmark not defined. 
Comb leader note ................................................................................................... Error! Bookmark not defined. 
Node secant note .................................................................................................... Error! Bookmark not defined. 
Note for multilayered constructions ....................................................................... Error! Bookmark not defined. 
Node note ............................................................................................................... Error! Bookmark not defined. 
Mark of linear designs ............................................................................................ Error! Bookmark not defined. 
Chain note .............................................................................................................. Error! Bookmark not defined. 
Editing the leaders ................................................................................................. Error! Bookmark not defined. 
Advanced grips of design elements......................................................................... Error! Bookmark not defined. 

TABLES ............................................................................................................... ERROR! BOOKMARK NOT DEFINED. 
Editing Tables on the Drawing .............................................................................. Error! Bookmark not defined. 
The Interface .......................................................................................................... Error! Bookmark not defined. 
Insert material ........................................................................................................ Error! Bookmark not defined. 

MEASURE ........................................................................................................... ERROR! BOOKMARK NOT DEFINED. 
CALCULATOR ..................................................................................................... ERROR! BOOKMARK NOT DEFINED. 
NOTEPAD ............................................................................................................ ERROR! BOOKMARK NOT DEFINED. 
FEATURES OF THE DESIGN ELEMENTS ................................................................. ERROR! BOOKMARK NOT DEFINED. 

In place edit ............................................................................................................ Error! Bookmark not defined. 
Parameters redefinition .......................................................................................... Error! Bookmark not defined. 
Regenerate .............................................................................................................. Error! Bookmark not defined. 

CREATE 3D OBJECTS ............................................................................ ERROR! BOOKMARK NOT DEFINED. 

SURFACES ........................................................................................................... ERROR! BOOKMARK NOT DEFINED. 
Box ......................................................................................................................... Error! Bookmark not defined. 
Wedge ..................................................................................................................... Error! Bookmark not defined. 
Cone ....................................................................................................................... Error! Bookmark not defined. 
Sphere ..................................................................................................................... Error! Bookmark not defined. 
Torus ...................................................................................................................... Error! Bookmark not defined. 
Pyramid .................................................................................................................. Error! Bookmark not defined. 
Dish ........................................................................................................................ Error! Bookmark not defined. 
Dome ...................................................................................................................... Error! Bookmark not defined. 
Mesh ....................................................................................................................... Error! Bookmark not defined. 
3D Mesh ................................................................................................................. Error! Bookmark not defined. 

SETTING OF THE ORTHOGRAPHIC AND ISOMETRIC VIEWS .................................... ERROR! BOOKMARK NOT DEFINED. 
Orthographic views ................................................................................................ Error! Bookmark not defined. 
Isometric views ....................................................................................................... Error! Bookmark not defined. 

VISUAL STYLE .................................................................................................... ERROR! BOOKMARK NOT DEFINED. 



THE COMPONENT LAYOUT AND PLOT DRAWING ...................... ERROR! BOOKMARK NOT DEFINED. 

MODEL SPACE AND PAPER SPACE........................................................................ ERROR! BOOKMARK NOT DEFINED. 
WORK WITH LAYOUTS ........................................................................................ ERROR! BOOKMARK NOT DEFINED. 

To create a new layout ........................................................................................... Error! Bookmark not defined. 
To create a layout from template ........................................................................... Error! Bookmark not defined. 
Save layout as template .......................................................................................... Error! Bookmark not defined. 
Delete layout .......................................................................................................... Error! Bookmark not defined. 
Rename layout ........................................................................................................ Error! Bookmark not defined. 

VIEWPORTS ........................................................................................................ ERROR! BOOKMARK NOT DEFINED. 
Create Layout Viewports ........................................................................................ Error! Bookmark not defined. 
Edit Layout Viewports ............................................................................................ Error! Bookmark not defined. 

DOCUMENT PLOT ................................................................................................ ERROR! BOOKMARK NOT DEFINED. 
Page Setup Manager .............................................................................................. Error! Bookmark not defined. 
Plot Stile Editor ...................................................................................................... Error! Bookmark not defined. 
Plot Preview ........................................................................................................... Error! Bookmark not defined. 
Plot ......................................................................................................................... Error! Bookmark not defined. 
Batch Plot ............................................................................................................... Error! Bookmark not defined. 

 



General information 

Introduction 
nanoCAD – is a universal editor, graphic platform for CAD in different fields.  

A friendly and usable traditional interface and the capability to use traditional working methods makes nanoCAD a 
universal tool, almost every designer can work with it.  

nanoCAD is used for the creation and editing of vector primitives (graphic elements) and more complex objects 
(blocks, dimensions and etc.). You can insert and use a raster image as file backing,. nanoCAD contains built-in 
display tools to view different 3D geometry from *.dwg files. nanoCAD has the functionality to create 3D frame and 
Polyface Mesh models. The user can design working documentation according to the drawings and projects of 3D 
models created in different 3D CADs. 

nanoCAD can be used by an individual user and also by project teams, which use the functionality of external 
references and of integration to the engineering document workflow, including PDM/PLM systems. 

nanoCAD allows the user to:  

 Create and edit different 2D and 3D vector primitives, texts, objects of drawing preparation, settings of 

graphic display and printing of technical documentation.  

 Create and use any types of tables and specify drawing elements by block attributes and objects of drawing 

preparation. 

 Adjust the working environment to prepare working documentation to different standards.  

 Work in 3D model space and 2D paper space using viewports. 

 Display, create and edit 3D meshes. Create a User Coordinate System to edit geometric snap-to 3D objects. 

 Cooperate and collaborate with your colleagues who create drawings in other popular CADs by using the 

common file format - *.dwg. 

 Use any technical documentation created previously and stored in raster file format (scanned drawings, 

texts, tables, photos). 

 Print technical documents using any installed plot devices in the operational system. 

nanoCAD uses Teigha core, consisting of set of Teigha program libraries, developed by Open Design Alliance (ODA) 
international consortium. They allow reading and writing to *.dwg format files used by many CADs. Teigha program 
libraries support all current versions of the *.dwg format. 

nanoCAD supports the import and export of vector data of *.dxf format. Using the *.dwg file format allows integrating 
solutions on the nanoCAD base with almost any CAD. Structurally, the program consists of functionally linked parts: 

 Universal vector editor – has the same functionality as most popular CAD packages have. 

 Universal table editor – has the technology to translate the graphic, attribute data of objects into table form, 

with the ability to perform any mathematical calculations in tables; has the tools for the import/export of table 

data. 

 Plot master – creates and edits plot settings from model space and paper space. 

 Functionality of developer tools – available only for registered developers. 

System requirements 
Operating system Microsoft® Windows® 7 Enterprise, Ultimate, Professional or Home Premium 

edition. 

Microsoft Windows Vista (SP1 or later) Enterprise, Business, Ultimate or Home 
Premium edition. 

Microsoft Windows XP Professional or Home edition (SP2 or later). 

Microsoft Windows 2000 (SP4 or later). 

Processor Intel Pentium 4/AMD Athlon or higher. 

RAM From 512 Mb. 2 Gb is recommended if you have big projects. 

Hard disk free space About 300 Mb is required for full program installation. 

About 1-3Gb is required for working (according to the difficulty of projects). 

Monitor Required resolution: 1024×768. 

Recommended resolution: 1280×1024 or higher. 

Graphics Video adapter with OpenGL-compatible hardware 3D acceleration. 

Additional hardware DVD-ROM (if the program is installed from the corresponding device). 

Internet access (If the program is installed on-line). 

Mouse or other devices. 



Additional software MS Excel, MS Word. 

 

Program installation 
You must have administrator rights to install the program.  

You do not need to be an administrator to work with the program; it can be launched by a user with reduced authority. 

As nanoCAD is a universal graphic platform, during the first launch of the program you have to make a choice which 
standard (SPDS or ESKD) you want to use: 

 
This standard can be changed in the Options dialogue (Tools menu – Settings Parameters). 

 
You can change this standard for one document or make it the default for all documents. After selecting a standard, 
the window offers to set saving parameters:  

 

Launch of nanoCAD 
To launch the program: 

 Click twice on the nanoCAD icon on the Windows  desktop or  

 On the taskbar select Start > All programs > Nanosoft > nanoCAD > nanoCAD. 



Help 

 Menu: Help –  About… 

 Toolbar: Main –  

 Command line: HELP, HELPCONTENTS  

There are buttons in the dialogue boxes to open the Help file. 

The About command opens the About nanoCAD 3.0 dialogue with information about the version and build of the 

installed program and copyright:  

 

. The Help dialogue box shows the licence number, who registered the program, a link to the developer’s website – 
www.nanocad.ru and an email link for technical support – support@nanocad.ru 

The Help menu also contains links to the nanoCAD support forum, learning videos on YouTube and the official site of 
Nanosoft for additional information. 

If you have an Internet connection, you can load the links from nanoCAD. 

 

Exit from nanoCAD 

 Menu: File –  Exit 

 Hotkeys: CTRL+Q  

 Command line: EXIT, QUIT 

nanoCAD can be closed by clicking on the  icon in the top right corner of the program. 

If all changes in opened documents were saved, no additional messages are shown. 

If changes were not saved, nanoCAD shows a warning message: 

, 

where a user can save changes, refuse to save changes or select the Cancel button and continue to work in the 
program. 

http://www.nanocad.ru/
mailto:support@nanocad.ru


nanoCAD user interface 

With nanoCAD you can organise user work space according to the user’s needs and tasks. The standard set of tools 
is usually used: 

 
The nanoCAD window consists of the following interface elements : menu bar, toolbars, document windows, 
Properties window, command line and status bar. Most interface elements can be moved to other places; they can be 
fixed or floating. Some elements can be auto hidden. 

Main menu 
The Menu bar (1) is placed at the top of the nanoCAD window and consists of drop-down menus containing all the 
basic commands.  

Commands from the drop-down menus are grouped by functionality: 

 Description 

File menu Commands to work with files and documents: create, open, save, export and import files, 
print and print settings. There are also some useful utilities: audit, recover and purge. 

Edit menu Undo and redo commands, exchange buffer commands, select commands, find and 
replace command. 

View menu  Zoom commands, creation of named views and viewports, views and visual styles, 
display of  scroll bars, status bar and toolbars.  

Insert menu Insert blocks and external references, also insert rasters, commands to work with layouts 
(create, save, delete and rename).   

Format menu Commands to work with layers, line types, text and dimension styles, point styles, units 
and drawing limits.  

Tools menu  Display order commands, edit blocks and external references, drafting settings and 
program options.  

Draw menu  Commands to draw objects. 

Dimensions menu Commands to set dimensions and manage dimension styles. 

Modify menu  Commands to edit drawing objects. 



Help menu  Help and useful links. 

The graphic interface of the drop-down menus contains set of symbols to make work with the menus easier: 

- commands from each functional group are separated by lines in the drop-down menu: 

 
- a small black triangle in the left part of the menu means that selection of the item opens a cascade menu: 

 
- three dots at the end of the menu item means that the item opens a dialogue box:  

 
- there are hotkeys to the right of the most used commands:  

 

Toolbars 
Buttons on the toolbars (2) are used to start the commands. When you move the cursor over the button the tooltip is 
shown: 

 
On some toolbars the commands are grouped and you can see only one button of command from each group.  

The buttons from the command groups are marked with small arrows in the bottom right corner: .  

When clicking such a button, a toolbar opens showing the tools of the specified group. To select the required tool 
from the group, move the cursor to the button on the bar and select it.  

 



Show or hide toolbars by selecting View – Toolbars > nanoCAD toolbar; or from the context menu of any toolbar.  

Toolbars can be moved to any part of the program. 

A toolbar in the document area is called floating. You can change its shape and location. To make it fixed, move it out 
of the document area. 

nanoCAD document window 
There are documents in the nanoCAD work space (3). If several documents are opened in the program, use the tabs 
(4) to select the required document. 

User coordinate system icon (UCS) is placed in the default coordinates: X=0; Y=0; Z=0 (in the bottom left corner). 
To show/hide the icon, select the View menu – Display > UCS icon.  

 
Cursor – the main instrument for selection and specifying in the graphic area. The cursor has a crosshair shape with 

a square sight at the intersection point:  

 
The shape and size of the cursor can be adjusted in the Cursor section of the Options dialog (Tools menu – 
Options).  

Note: To change the cursor’s colour, deselect the Use default color box in the Category Name and Color dialogue 
box. 

Outside the graphic area, the cursor has an arrow shape: . 

The document’s tabs (5) in the bottom part of the window are used to switch between layouts and to switch from 

model space to paper space and back. It can be more useful to use the  button located at the end of tabs row. 

The button allows switching between layouts and named views in the document. Scroll bars in the bottom and left 
parts of the graphic area are additional tools for panning. The Scroll bars command from the View menu 
shows/hides the vertical scroll bar. The horizontal scroll bar is always shown.  

Context menu 
In nanoCAD, as in many other Windows applications, the context menu appears when you click the right button. The 
content of the context menu depends on the current context – object type, location of the cursor and what command 
is being run at the moment.   

Examples of the context menu 

 

 



 

Note: Right button clicking with SHIFT or CTRL pressed during the execution of a command for creating or editing 
objects opens the context menu of the Object snap: 

 

Inspector window 
The Inspector window (6) is used to display information about selected objects, to change objects’ properties, to set 
selection mode and to launch selection commands.  

 
 

Command line 
The command line (7) is used to enter commands from the keyboard, to show tooltips and nanoCAD messages, to 

select the options of the selected command: 



 

The default command line height is set to display 5 lines of command history. To move from one line to another, use 
the scroll bar in the right part of the command line window. The height of the command line can be changed by 
dragging the top edge and dropping it in the required place. 

In the Command line section of the Options dialog you can change  the text and background colour of the command 
line, switch on/off Use Autocomplete and Use alternate font options: 

 
If the command line was closed it can be opened by clicking in the document window.  

Input of commands, aliases and shortcuts 
To enter a command from the keyboard, type the full command name in the command line and press ENTER or 
SPACEBAR to execute it. 

Instead of the full name of the command you can use a command abbreviation, the so-called alias of command. For 
example, instead of typing CIRCLE, you can just type C. 

Several aliases can be assigned to one command. However, a particular alias can only be assigned to one 
command. Aliases are specified in nCAD.pgp file. 

Shortcuts are similar to aliases, but launch a set of commands grouped by a certain criterion.  

Note: It is does not matter what case is used when typing in the command line. 

With the Use Autocomplete mode (Command line section of the Options dialogue box) you can choose a 
command from the list displayed in the command line after you have entered several letters: 

 
To select a command from the list use TAB, ARROW DOWN and ARROW UP buttons and the ENTER button to 

confirm a selection.  

You can see  a full list of registered commands, aliases and shortcuts in the command line by entering  an 
apostrophe.  

Text window 
To display the command history, press F2 to open the text window: 



 
You can close and open the window at any time.  

The window is opened at the same location and size as set  previously.  

Command Line prompt 
 
The default command line prompt looks like: 

Command: 

but it varies depending on the current command or program state. 

The command prompt can include descriptive messages that are displayed in the status bar when the command is 
running. For example, the prompt during a creation of a circle is:  

Specify center point for circle or [3P/2P/TTR]: 

It can also include interactive keywords in square brackets separated by a slash, highlighted in a blue colour and 
underlined.  

Note: To prevent confusion with hyperlinks, interactive key words in prompts are shown in a red colour and bold 
font.  

Specify center point for circle or [3P/2P/TTR]: 

You can type any keyword manually or just click on it. A keyword specified in triangular brackets is a keyword “by 
default”. For example: 

Enter number of sides <4>: 

or 

Extend <Inscribed> or [Inscribed/Circumscribed]: 

To choose it press the ENTER key. 

As an answer to the prompt, type the keyword, or you can just type the capital letter of the word:  

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 

For example, to select the Close  keyword, type C. 

Note: The capital letter can be in the middle of the key word. 

Format of input data 
You can enter different formats of data, text, digital values, coordinates, in the command line. 

To use coordinate values to specify a point, enter an X value and a Y value separated by a comma <X,Y>: 

23.45,-6.98 

If the angle units are degrees/minutes/seconds, the following syntax is used:  

32d20m10s or 32-20-10 



Mathematical processor 
The command line allows for the input not only of commands, numbers and points, but also mathematical 
expressions. It is convenient when the coordinate or number is not known beforehand but should be calculated from 
some conditions. 

For example, instead of calculating the coordinate of a point using the SQRT(349.56-275.90)*2 formula and only 

then typing it in the command line, like here: 

Command: L,LINE – Line by points  

First point: -12.45,17.17 

You can use a mathematical expression instead of coordinates in the command line: 

Command: L,LINE – Line by points  

First point: -12.45,SQRT(349.56-275.90)*2 

To calculate a mathematical expression at any time type the ? sign before this expression. In the following example, 

a multiplication operation is performed during the line creation process. 

Command: ?25.7*5 

After pressing ENTER the result is shown in the command line: 

?25.7*5 = 128.5 

Mathematical expressions can be calculated during the execution of some commands. The following example shows 
a multiplication expression calculation during drawing a line: 

Command: L,LINE – Line by points   

First point: 25.7,41.32 

Next point: 25.7*5,93.77 

After you press ENTER, the line with first point coordinates (25.7, 41.32) and end point coordinates (128.5, 93.77) will 
be drawn. 

The complete list of registered operations, functions and constants can be viewed in the Command Line window by 

entering the ? sign. 

The Mathematical Processor supports the following arithmetical operations:  

Constants: 

E The constant e, the base of natural logarithms. 

PI The constant pi. It represents the ratio of the circumference of a circle to its diameter. 

Arithmetic operations: 

( ) Groups expressions. 

+ - Adds, subtracts. 

* / Multiplies, divides. 

% Remainder. 

** Power. 

Functions: 

COS Returns the cosine of a number. 

SIN Returns the sine of a number. 

TAN Returns the tangent of a number. 

ACOS Returns the arccosine of a number. 

ASIN Returns the arcsine of a number. 

ATAN Returns the arctangent of a number. 

ABS Returns the absolute value of a number. 

EXP Returns e (the base of natural logarithms) raised to a power. 

LN Returns the natural logarithm of a number. 

LOG Returns the base-10 logarithm of a number. 

SQRT Returns the square root of a number. The number must be non-negative. 

FLOOR Returns the largest integer less than or equal to the given numeric expression 

CEIL Returns the smallest integer greater than or equal to the given numeric expression. 

FRAC Returns a locale-specific count of the number of digits to display to the right of any decimal point. 



TRUNC Returns the integral digits of the specified number. Any fractional digits are discarded. 

ROUND 
(x,precision) 

Returns a number rounded to a specified number of decimal places (precision). Precision value 
indicating how many places to the right of the decimal are included in the rounding. 

NEG Returns the negative value of a number. 

SGN Returns an integer indicating the sign of a number: 1 - Greater than zero; 0 - Equal to zero; -1 - Less 
than zero. 

The user defined variables can be used in calculation expressions. The variable is created using the following syntax: 

?<variable>=<value> 

For example: 

?base=100 

Command: L,LINE – Line by points  

First point: base+11.56,base-5 

Auto hide mode in the command line 
Now the command line can be placed in autohide mode. In this mode the command line is  reduced to a tab. In the 
tab name you can always see the command line’s message and entered values. 
To autohide the command line select the pin icon: 

 
Or select from the context menu the Autohide command: 

 
In the Autohide mode the command line folds into a tab. 

 
 
The entry of commands and required values is performed without showing the command line. When moving the 
cursor over the tab, the command line expands to its full size, and when moving the cursor away it folds again. 

 
The command line is hidden  when working with a drawing, but you can see the current messages of the command 
line. Command and values entry is performed without expanding the command line.  
 



 
 

Working with commands 
Commands are used to create and edit objects, open dialogue windows and start any other operations. Commands 
can be launched: 

 from the main menu; 

 on the toolbars; 

 from the context menu; 

 in the command line; 

 using hotkeys; 

For example, to open the Options dialogue box: 

 from the main menu: Tools – Options; 

 on the Settings toolbar: the   Options button; 

 in the command line: PREF command; 

 using hotkeys: CTRL+9. 

Transparent commands 
Some commands can be launched while other commands are executed. Such commands are called transparent. 
Most of these commands are settings commands for display and document. 

Command recall 
The last launched command can be started by pressing the ENTER or SPACE buttons. 

The last nine launched commands are available from the context menu (Last commands): 

 
Last commands are shown in the command line.  

Use ARROW DOWN and ARROW UP buttons to select one of the last commands and press ENTER to launch it. 

Cancellation of commands  
nanoCAD creates protocols for all used commands and changes in the drawing, one or several commands can be 
undone to get to the previous step. Undone command can be launched again.  

Cancellation and recall of commands can be made using the Undo and Redo commands. 

Undo 

 Menu: Edit –  Undo 



 Hotkeys: CTRL+Z  

 Toolbar: Main –  

 Command line:  UNDO, U 

The command cancels all previous commands and operations. 

Redo 

 Menu: Edit –  Redo 

 Hotkeys: CTRL+Y  

 Toolbar: Main –  

 Command line: REDO 

The command recovers all cancelled commands and operations. It becomes available after the Undo command  is 
used. 

Settings of the right button 
The settings of the right button are specified in the Right Button Usage section of the Options dialog: 

 

Parameters: 

Always shows Popup Menu Switches on the only context menu launch. 

Override for different modes: Switches on the redefining of right button functions for different  working 
modes in the document window. 

Edit Mode: The sections redefine the right button functions when it is pressed in the 
editing mode, i.e. there are no running commands. 

Shows Popup menu Switches on the only context menu launch. 

Repeat last command Switches on the ENTER key imitation function, when clicking the right 
button again starts the last command if objects were selected.  

Repeat last command when 
nothing is selected 

Switches on the ENTER key imitation function, when clicking the right 

button again starts the last command if no objects were selected.  

Command mode: The sections redefine the right button functions when it is pressed in the 
mode of any running command. 

Shows Popup menu Switches on the only context menu launch. 

Sends “ENTER” Switches on the ENTER key imitation function.  

Shows Popup menu after delay: Switches on the mode which considers the duration of right button holding: 

- short clicking – repetition of command or ENTER according to the 

mode, 

- long holding – opens the context menu. 

Delay <250> ms Specifies, in milliseconds, the duration of right button holding to open the 



context menu. By default the value is 250 ms. 

To change the duration of button holding: 

- click twice on the delay value, 

- enter a new delay value. 

Always show Popup menu when 
objects selected 

Switches on/off the mode, where the context menu launches every time 
the right button is clicked during selection of objects.  

Status bar 
There are interface elements in the status bar (8):  

 
Current coordinates of the cursor. 

Display modes: 

- dynamic display of cursor absolute coordinates when the cursor is moving,  

- display of relative distance (distance<angle) when the cursor is moving: 

 
Switching to the relative distance mode is made automatically when specifying two or more 
points is required.  

 Button to switch to viewport. It is not used in Model space. 

 Button to switch to Layout from Model space or viewport.  

 
Button to set scale of objects.  

 Button to start regeneration mode. 

 Button to switch on/off full screen mode. 

Buttons to switch on/off modes: 

 Snap (F9). 

 Grid (F7). 

 Object snap (F3). 

 Object tracking (F11). 

 Polar tracking (F10). 

 Ortho mode (F8). 

 Show line width. 

 Hatch 

Buttons to manage the graphic area: 

 Pan. 

 Zoom. 

 Zoom all 

 Zoom window. 

To switch the status bar on/off, use the Status bar command from the View menu..  

Managing elements of the Status bar 
Use the Status Bar Configuration menu to set elements of the Status bar:  



 

To open the context menu: 

 right button click on the Status bar, 

 select/deselect the required elements in the context menu. 

Managing interface elements 
To change the location of interface elements, drag their titles. 

To change location: 

 click on an element’s title and drag it to an area of the window where you want to attach the element. The icon 
appears in the  centre of the window, showing the place of attachment in the window. 

 

 holding the left button, place the cursor over one of the pictograms. The central pictogram 
is used to attach the object as a tab, others attach to the sides of the window.  

 The new location of the element is highlighted blue.  

If you are satisfied with the new location, release the button. 

The attached element can be made into a pop-up tab. Select the pin in the element’s title: 

 
For some elements, the context menu is available with various ways of attachment: 

 

Colour schemes 
Besides full reorganisation of the working area for user needs, nanoCAD has a set of colour schemes for the 
interface. You can change the colour scheme in the Options tab of the Interface dialogue box (Tools – Customize – 
Interface): 



 



Working with documents 

nanoCAD allows documents to be saved with *.dwg (drawing format), *.dwt (template format) и *.dxf (graphic data 
exchange format) extensions. There is support of file formats created in the following AutoCAD versions: 

- AutoCAD 2010-2012/LT2010-2012 

- AutoCAD 2007-2009/LT2007-2009 

- AutoCAD 2004-2006/LT2004-2006 

- AutoCAD 2000-2002/LT2000-2002 

- AutoCAD R14/LT98/ LT97 

- AutoCAD R13/LT95 

- AutoCAD R11 

Commands to work with documents are in the File menu: 

 
and on the Main toolbar: 

 

Creation of new document 

 Menu: File –  New Document 

 Toolbar: Main –  

 Hotkeys: CTRL+N  

 Command line: NEW 

A new document, created at first launch, has  the name Untitled0; all subsequent documents have the names 
Untitled1, Untitled2 etc. Documents which have been created and not saved have a star symbol (*): 

 

Template usage 
To create a new document you can use a template (files with *.dwt extension). The template is a drawing used for 

the creation of new drawings and contains some base settings (type and accuracy of units, drawing limits, settings of 



SNAP and GRID modes; managing of layers; dimension and text styles; types and weights of lines etc.) and graphic 

objects (main titles, borders and logos).   

Changes in a drawing created using a template are not applied to the template. 

Note: You can create a template not only for new documents but also for imported documents. 

Templates are managed in the Template Usage section of the Options dialog: 

 

In the For new documents subsection you can select: 

None  Prevents the use of a template for new documents. 

Use default Uses the file specified in Default Template File Name. 

Ask for file Opens the dialogue box File →  Open. 

Choose from 
list 

Opens the Choose Template dialogue box. 

Default 
Template File 
Name 

Sets the Default Template File Name. 

Templates 
Names List 

Specify the template files if the Choose from list is selected: 

- Click twice on the Templates Names List, 

- Press the  button, 

- In the Open dialogue box select template files, select Open. 

 

Opening a document 

 Menu: File –  Open… 

 Toolbar: Main–  

 Hotkeys: CTRL+O  

 Command line: OPEN 

To open a document you can drag it into the working area of nanoCAD. 

Note: If a document contains a font, which is not included in the program, when you open the document it is 
automatically replaced with an alternative font. There is a message in the command line like: 

 
 
nanoCAD uses a default txt.shx  for replacement. You can change it in the Options dialog. 

 
When many documents are opened, every document is opened in a separate window with a tab in the top part of the 

working area. To switch between them, select the tab or click the  Active files button: 

 

This illustration is still in Russian 
and needs replacing with one in 
English 



 
 
The context menu allows the selection of display options for the documents: 

 

Commands of the context menu: 

Save Saves a document. 

Save As… Saves a document with a new name. 

Close Closes a document. 

Plot Prints a document. 

Single Viewport Shows a document in one Viewport 

Split Vertical Splits document to 2 Viewports. 

Splits to 3 Viewports Splits document to 3 Viewports. 

Splits to 4 Viewports Splits document to 4 Viewports. 

New Horizontal Tab Group Horizontal display of a tab in the working area. 

New Vertical Tab Group Vertical display of a tab in the working area. 

You can change the location of tabs by dragging them into other windows.  

If you release the left button when dragging a tab, the context menu with tab display options will be shown: 

 

Closing a document 

 Menu: File –  Close 

   button on the document’s window 

 Hotkeys: CTRL+F4  

 Command line: CLOSE 

Should this say Print? 



When closing an existing document you should save the changes to it;  a document is saved with its name. 

When closing a new document, the program offers to save changes and opens the Save Document File dialogue 

box. 

Saving a document 
Documents can be saved in the *.dwg drawing format, in the *.dxf graphic data exchange format and in the *.dwt 
template format. Save, Save As and WBLOCK commands are used. 

Saving of an existing document. 

 Menu: File –  Save 

 Toolbar: Main –  

 Hotkeys: CTRL+S  

 Command line: SAVE, BS 

The command saves a document with its name. 

Saving a new document 

The Save command opens the Save Document File dialogue box, where you can specify a path for a document and 

change the default file name:  

 

To save a document: 

 specify the path to the file in the Folder drop-down list, 

 type the name in the File name field,  

 select the format in the File type field,  

 select the Save button.  

Saving the file will be done without specifying the path and file name in the future.  

Note: Format, specified in the File type field, is also used to save all documents with Save, Save As and WBLOCK 

commands. 

Saving a document with another name 

 Menu: File –  Save As 

 Hotkeys: CTRL+SHIFT+S  



 Command line: SAVEAS 

Every time you select the Save As command, nanoCAD will offer to specify a path to a file and/or change a file name 
in the Save Document File dialog. The selected path and entered file name are set by default, and when the Save 
command  is used, a file will be saved with the path and name specified earlier. 

The Save As command can be used to change the format of a file, specified to save all documents using Save, Save 
As and WBLOCK. 

Saving a document or its part using the WBLOCK command 

 Command line: WBLOCK, W, ACADWBLOCKDIALOG 

The WBLOCK command is started from the command line and allows saving of an entire document and also part of 
a drawing using the Write Block dialog: 

 
The Write Block dialogue box complements and extends the capabilities of the Save and Save As commands, 
allowing the saving of an entire document (Entire drawing parameter) and also part of a drawing (Block and 
Objects parameters).   

Auto saving and Backup 
To minimise losses caused by software or hardware failures and any other consequences, nanoCAD has auto saving 
and backup functions. 

Auto saving 
If Auto saving mode is switched on, the data is saved at the specified intervals. 

The time and date of the auto saving is added in round brackets to a file name with *.autosave extension, for 
example: <file name>.dwg(20-29-44_15.08.2010).autosave. 

Note 1: the time of auto saving is the time of the first auto saving and it is not updated further. 

Note 2: If the program is closed normally, auto saved documents are removed. If there is a software or hardware 
failure and any other consequences, auto saved files are not removed.  

Note 3: You can restore the previous session of a document from the auto saved file. Do not close the program and 
file, copy it to another folder and rename as described below. 

A default folder for auto saved files 

C:\Documents and Settings\Account Name\Local Settings\Temp. 

To open and work with an auto saved file, change its extension to *.dwg (delete the additional information in round 
brackets and the *.autosave extension). 



The auto saving parameters are specified in the AutoSave and Backup section of the Options dialogue box (Tools 
menu > Options): 

 

Parameters: 

Autosaving every <XX> min Time interval between savings. To switch off auto saving, set 0 for this 
parameter.  

Auto saving folder Folder to save files. 

The first launch of nanoCAD after a failure is started from the Recover documents dialogue box, containing 

information about the original file (name, path and creation time) and last auto saving time. 

 
To recover document data, click on the file name and select one of the following in the context menu: 

Recover from autosaved 
document 

Opens the autosaved file. 

Open original file Ignores the automatically saved version and opens the original document (if it exists). 

Delete autosaved file Deletes the automatically saved versions 

Open both files Opens both documents.  

Backup 
nanoCAD creates 2 backup copies of the file with the same name, but with different extensions.  

Original backup copy (file with *.original extension) saves document data as it was when the file was opened for 
editing (original backup is created at the beginning of the session of file editing); 

Backup copy (file with *.bak extension) is often updated during the document editing process (at every saving by the 

user).  Different contingencies can occur with a document during the working process, for example, malfunctions of 
hardware, failure of the software or improper actions of a user. Backup copy allows the user to recover information 
and minimise losses of information by means of periodic savings of the file by the user.   

Backup copies are saved in the folder where the document file is saved.  

Backup parameters are specified in the AutoSave and Backup section of the Options dialogue box (Tools menu > 
Options): 

Parameters: 

Create backup copy Switches backup mode on/off. 

Backup original Switches original backup mode on/off. 

Backup folder Location to save backup copies. 

To recover data from a backup copy, change the file extension to *.dwg. 

Import 

 Menu: File–  Import… 



 Command line: IMPORT 

You can import data in AutoCAD format(*.dwg) and data exchange format  (*.dxf) into nanoCAD documents. 

To import data: 

 Start the File – Import command; 

 In the Open Vector File dialogue box select a format and specify a file name: 

 

 Select Open. 

The ways to use templates for imported documents are set in the Options: Template Usage > For imported 
documents.  

Export 

 Menu: File –  Export… 

 Command line: EXPORT 

A nanoCAD document’s data can be exported to AutoCAD format(*.dwg) and data exchange format  (*.dxf). Either 
the entire document or a part of it can be exported. 

Export of all data 
In the Save Document File dialogue box: 



 

 specify the path for the saved file in the Folder drop-down list, 

 type a name in the File name field, 

 select a format in the File type field, 

 select the Save button.  

Export of selected data 
The export procedure for selected data is the same as the export procedure for all the data, except that the Selection 
Only checkbox is checked in the Save Document File dialogue box: 

 



Note: If the objects were not selected before saving, the Selection Only checkbox is unavailable. 

Utilities 
Errors and damage can occur in document files due to disruptions in power supply, malfunctions of computer 
hardware, programs crashes, transfer of documents on electronic media and transferring over the network etc.  

Utilities find and correct errors and damage in problem files as far as possible. Full recovery of data is not 
guaranteed.  

Purging of a document allows deletion of unused elements from the finished document to reduce document size.  

Document audit 

 Menu: File – Drawing utilities > Audit 

 Command line: AUDIT  

The command allows auditing of an opened document in nanoCAD for errors and correcting some of them. If a 
document cannot be opened due to damage, use the Recover command. 

Correction of all errors is not guaranteed.  

After starting the command, in the inquiry Do you want to fix errors ? or [Yes/No]: select  Yes. 

Audit protocol is like:  

 

AcDbLine(117689). Error:: Inactive XData handle (1157FE) was found. 

Audit: Invalid . 

Fixed:: Replaced: Set to Null . 

 

AcDbArc(11768A). Error:: Inactive XData handle (1157FE) was found. 

Audit: Invalid . 

Fixed:: Replaced: Set to Null . 

 

AcDbCircle(119E1F). Error:: Inactive Z coordinate - 1e+100 was found. 

Audit: Invalid . 

Fixed:: Replaced: Set to 0 . 

 

To see the protocol press F2. 

Recovery of document 

 Menu: File – Drawing utilities > Recover 

 Command line: RECOVER 

The command allows auditing an opened document in nanoCAD for errors and correcting some of them. I 

Full recovery and correction of all errors are not guaranteed.  

After command launch, a standard dialogue box to open a file  appears, you have to select the folder and the name 
of the damaged file and after that select the Open button. 

The protocol is shown in the command line and is similar to the protocol of the Audit command:  

 

AcDbLine(117689). Error:: Inactive XData handle (1157FE) was found. 

Audit: Invalid . 

Fixed:: Replaced: Set to Null . 

 

AcDbArc(11768A). Error:: Inactive XData handle (1157FE) was found. 

Audit: Invalid . 

Fixed:: Replaced: Set to Null . 

 

AcDbCircle(119E1F). Error:: Inactive Z coordinate - 1e+100 was found. 

Audit: Invalid . 

Fixed:: Replaced: Set to 0 . 

 

To see the protocol press F2. 



Purging of document 

 Menu: File – Drawing utilities > Purge … 

 Command line: PURGE, PU 

This command is used to purge unused named elements from a document: blocks’ descriptions, layers, text styles 
and line types.  

Using this procedure you can reduce file size after finishing your project. 

Note: Deleted elements cannot be recovered. 

The Purge dialogue box appears after the command is launched. There is a list of elements available for deletion 

and a list of elements not available for deletion. The list is organised as a tree: to open a list of elements of one type 

select the   sign to the left of the name. If there is no  sign, it means that there are no elements of this type to 
delete (or which cannot be deleted).  

 

Parameters: 

View elements you 
can purge 

Switches on the mode for viewing elements which can be deleted from a document. 

View elements you 
cannot purge 

Switches on the mode for viewing elements which cannot be deleted from a document. 
Elements, used in a document or standard items, which cannot be deleted.   

 Purges the selected elements. 

 Purges all elements from the list. 

To delete elements with confirmation: 

 Switch on the Confirm each item to be purged mode. 

 Select the  button or  . 

 In the opened dialogue box confirm purging of the elements: 



 

Parameters: 

 Confirmation for every selected element. 

 Confirmation for all elements. 

 Refuse to delete a selected element. 

 Cancels the purging mode. 



Tuning nanoCAD 

User can change different parameters of nanoCAD. 

Tuning program parameters 

 Menu: Tools –  Options… 

 Hotkeys: CTRL+9  

 Command line: OPTIONS, PREF 

Tuning program parameters is performed in the Options dialogue box: 

 
There is a tree of Options, grouped by sections, in the left part of the dialogue box. 

To see the parameters of the group, click twice on the  icon to the left of the section name. If you click the  icon, 
the section (subsection) will be closed.   

The Add, Modify and Delete buttons of the Action section become available; this means that the selected parameter 
from the tree can be edited.  

To change a selected item, click twice on it or select the  button and specify a new value.  

There is brief information about the selected section, subsection or parameter in the bottom right field. 

The tree of parameters contain the following elements: (adjustable parameters are bold): 

 Application Options 

 
Cursor Changes the appearance and size of the graphic cursor. 

 
Crosshair size<5%> Sets the size of the Crosshair as a percentage of the 

display size. 

 
Pickbox The Pickbox size. 



 
PickBox size <4> Pickbox size in pixels. 

 
3D style colors 3D colour style for the crosshair and pickbox. 

 
Cursor color Cursor colour 

 
Show Object and Snap Tooltips Switches object tooltips on/off. 

 Select Parameters of frames to select objects. 

 
Color frame Colour frame 

 Color fence Colour fence. 

 Transparency <70> Transparency of frame. 

 
Grips Parameters of the grips of the selected objects. 

 
Grip size <10> Grip size in pixels. 

 
Grip max objects count <100> Limits of grips shown for selected objects. 

 
Grips color Grips colour. 

 
Hovered grips color Grips colour under cursor. 

 Selected grips color Selected grips colour.  

 
Color Colours of the program components.  

 
Preview frame The frame colour that indicates an image preview area 

inside the preview window. 

 Background The colour of the program window background. 

 
Print Area The frame colour that indicates a print area 

 Grid Color The colour of Grid points. 

 Layout Paper The colour of the Layout paper. 

 
Scroll settings Defines the scroll parameters of a document in the 

program window. 

 
Mouse Wheel scale factor <1.5> Scale factor used to scale with the Mouse Wheel 

 
Snap settings Defines the Snap settings. 

 
Hold Aperture Size <10> The size of a cursor frame in snap mode.  

 Show Aperture Box Switches the aperture box on/off in the snap mode. 

 
Snap Marker size <5> Snap marker size. 

 
Show Tooltips Turns on the display of a snap name. 

 Vector Marker Color The colour of the snap marker when snapping to a vector 
object. 

 
Papers Contains standard paper formats. Allows the modification 

of an existing format or addition of a new one. 

Formats from this section are used for printing.  

 
Raster File Formats Raster file formats which can be inserted with Image from 

File command. 

 
TIFF  

 
Windows Bitmap  

 
JPG  

 
JPEG  

 
Portable Network Graphics  

 
Template Usage Section to specify templates for new documents and for 

import and export of documents.  

 
For new documents Actions on the File > New command. 



 
None No action taken. 

 
Use default Opens the file specified in the Default Template File 

Name. 

 
Ask for file Opens the File > Open dialogue box. 

 
Choose from list Opens the Choose Template dialogue box. 

 
Default Template File Name 
<Default.dwt> 

Shows and allows changing of the Default Template File 
Name. 

 
Templates Names List List for Choose Templates. 

 
For imported documents Actions for imported documents. 

 
None No action taken. 

 
Use default Opens the file specified in the Default Template File 

Name. 

 
Ask for file Opens the File > Open dialogue box. 

 
Choose from list Opens the Choose Template dialogue box. 

 
Default Template File Name 
<Default.dwt> 

Shows and allows changing of the Default Template File 
Name. 

 
Templates Names List List for Choose Templates. 

 
For Export to File Actions for exported documents. 

 
None No action taken. 

 
Use default Opens the file specified in the Default Template File 

Name. 

 
Ask for file Opens the File > Open dialogue box. 

 
Choose from list Opens the Choose Template dialogue box. 

 
Default Template File Name 
<Default.dwt> 

Shows and allows changing of the Default Template File 
Name. 

 
Templates Names List List for the Choose Templates. 

 Text Text parameters. 

 Alternative font name <txt.shx> Name of font file to replace an missing font in an opened 
document.  

 
Standard directories Sets the folder in which the miscellaneous system files 

are stored. 

 
Shx file location: < C:\Documents and Settings\All Users\Application Data\Nanosoft\nanoCAD 2.5\shx > 

 
Templates file location: < C:\Documents and Settings\User_name\Application Data\Nanosoft\nanoCAD 
2.5\Templates > 

 
Samples file location: < C:\Program Files\Nanosoft\nanoCAD 2.5\Samples > 

 
PlotStyles files location: < C:\Documents and Settings\User_name\Application Data\Nanosoft\nanoCAD 
2.5\PlotStyles > 

 
PlotConfigs files location: < C:\Documents and Settings\User_name\Application Data\Nanosoft\nanoCAD 
2.5\PlotConfigs > 

 
Pat files location: < C:\Documents and Settings\All Users\Application Data\Nanosoft\nanoCAD 2.5\shx > 

 AutoSave and Backup Autosaving and Backup parameters.  

 Autosaving every < 5 > min Saving interval for the current document. Zero value 
switches off autosaving.   

 Autosave folder < > Folder for autosaved files.  

Default folder is ТEMP. 

 Create backup copy Switches backup copy mode on/off. 

 Backup original Switches original backup copy mode on/off. 

 Backup folder < > Folder to save backup files. By default, backup files are 



saved in the same folder as the original file. 

 Right button usage Functions of the right button. 

 Always shows Popup Menu Switches on the context-only menu launch. 

 Override for different modes: Switches on the redefining of right button functions for 
different working modes in the document window. 

 Edit Mode: This section redefines the right button functions when it is 
pressed in the editing mode, i.e. there are no running 
commands. 

 Shows Popup menu Switches on the context-only menu launch. 

 Repeat last command Switches on the ENTER key imitation function, where 

clicking the right button again starts the last command if 
objects were selected.  

 Repeat last command when nothing is 
selected 

Switches on the ENTER key imitation function, where 

clicking the right button again starts the last command if 
no objects were selected.  

 Command mode: This section redefines the right button functions when it is 
pressed  during a running command. 

 Shows Popup menu Switches on the context-only menu launch. 

 Sends “ENTER” Switches on the ENTER key imitation function.  

 Shows Popup menu after delay: Switches on the mode which considers the duration of 
right button holding: 

- short clicking – repetition of command or ENTER 
according to the mode, 

- long holding – opens the context menu. 

 Delay <250> ms Specifies in milliseconds, the duration of right button 
holding to open the context menu. By default the value is 
250 ms. 

To change the duration of button holding: 

- click twice on the delay value, 

- enter a new delay value. 

 Always show Popup menu when objects 
selected 

Switches on/off the mode where the context menu 
launches every time the right button is clicked during 
selection of objects.  

 Command line  

 Use Autocomplete  

 Command line background color  

 Command line text color  

 Use alternate font  

 System settings System setting section. 

 Graphics hardware acceleration settings Settings of the platform component serving video card 
and OpenGL subsystem. 

 Setting 1 (OpenGL)  

 Setting 2 (OpenGL)  

 Setting 3 (OpenGL)  

 Print preview mode settings Section is used to control platform components, used for 
creation of preview if printing is in metafile format (WMF) 
or raster image (BMP). 

 Metafile (WMF)  

 Bitmap (BMP)  

 Separate display cache for Model Space 
views 

Creates display cache for every viewport of Model Space. 

 Separate display cache for Paper Space 
views 

Creates display cache for every viewport of  Paper Space 

 System variables Changes values of system variables. 



 CMDDIA  

 FILEDIA  

Tuning the interface 

 Menu: Tools – Customize >  Interface… 

 Command line: CUSTOMIZE 

In the Customize dialogue box you can change the settings of the working environment, create new menus and 
toolbars, add or delete commands to menus or toolbars, save all settings in one profile and manage profiles.  

The Customize dialog contains 5 tabs: Toolbars, Commands, Keyboard, Options and Profiles. 

Toolbars tab 
The toolbar contains a list of instruments, used in nanoCAD. 

 

The  checkbox to the left of the toolbars manages toolbar display. 

The Show text labels checkbox switches on/off the display of text labels on the buttons of the selected toolbar. The 
Layout toolbar view: 

Show text labels is switched off Show text labels is switched on 

 

 

The Toolbar tab allows the creation of custom toolbars and placing any button there, and adding buttons to standard 

toolbars. 

The   button resets the menu bar. 

The   resets all menus and toolbars. 

To create a new toolbar: 

 Select the   button. 



 In the Toolbar Name dialog specify a name and select OK: 

 

The  checkbox for the created toolbar is selected automatically.  

 Select the Close to close the Customize dialogue box. 

To place a button onto a new toolbar: 

 Open the Customize dialogue box. 

 Switch to the Commands tab. 

 In the Categories section select All Commands. 

 In the Commands section select the required command and drag it to the new toolbar. 

 Select the Close button. 

You can move and copy buttons from the existing toolbars to a new toolbar.  

The toolbar from which you want to take a button must be displayed. 

To copy a button drag it with CTRL pressed.  

To create a new group of commands on a toolbar: 

 Open the Customize dialogue box.  

 Place the cursor over the button which will start a group. 

 Press the right button and from the context menu select the Begin Group command: 

 

 There is a separation line to the left of the button: 

 

To delete a button from a toolbar: 

 Open the Customize dialogue box.  

 Place the cursor over the button, which you want to delete. 

 Drag the button off the toolbar or from the context menu select the Delete command: 

 

 Select the Close button. 

To rename a toolbar: 

 Open the Customize dialogue box.  

 Select the toolbar from the list. 



 Select the  button. 

 In the Toolbar Name dialogue box specify the new name and select OK: 

 

 Select the Close button. 

Note: You can only rename custom toolbars. 

To delete a toolbar: 

 Open the Customize dialogue box.  

 Select the toolbar from the list. 

 Select the  button. 

 Select the Close button. 

Note: You can only delete custom toolbars. 

Commands tab 
This tab allows nanoCAD commands to be added to menus and toolbars.  

 
There are two sections (Categories and Commands) in the Commands tab. 

The titles of the main menus are in the Categories section.  

All the nanoCAD commands are in the All commands category of the Commands section. 

There is short description of the selected command in the Description field. 

nanoCAD commands can be dragged into the opened menus and toolbars from the dialogue box. 

To add new commands to a menu: 

 Open the Customize dialogue box.  

 Select the New Menu in the Categories section. 

 Open the menu to which you want to add new commands. 

 From the Commands section drag the New Menu element to the menu bar. 



 To rename the inserted menu bar, place the cursor over the New menu and press the right button. From the 
context menu select the Button Appearance: 

  

  In the opened Button Appearance dialogue box type the new name in the Text field and select ОК. 

To add a command to a new submenu, click on the inserted menu. 

 Select the All commands category of the Categories section.  

 From the Commands drag the required commands to the new menu item:  

 

 Close the Customize dialogue box. 

 A new menu will be created with the commands added  

 
Note: Elements of the Commands section (All commands category) with special icons are used to create menus: 

 
Using these elements you can create a cascading menu: 

 

To delete a custom menu item: 

 Open the Customize dialogue box.  

 Open the menu where you want to delete the item. 

 Drag the item outside the menu. 

Note: You can delete a menu item and all its submenus.  



Keyboard tab 
The Keyboard tab is allows hotkeys to be defines for nanoCAD commands. 

Hotkeys are a combination of symbol and command keys: CTRL, SHIFT and/or ALT. For example, CTRL+O is the 
same as File> Open, and opens the Open File dialogue box; CTRL+S – saves a document etc. Hotkey 
combinations used are shown in the right part of context menus and in the tooltips of toolbar buttons.  

 

To assign hotkeys: 

 Select a menu title to display the required list of commands in the Command section. The All commands 
category opens a list of all commands in the Commands section.  

 Choose a command from the Commands list. The Description field shows the description of the chosen 
command.   

 Place the cursor in the Press new acceleration key field and press the hotkeys for this command on the 
keyboard. The pressed combination is shown in the field.  

 Select the  button. 

If a combination is set for the first time, in the Assigned to section Unassigned is shown. 

If hotkeys are already set for the selected command, they will be shown in the Current keys section.  

You can assign several combinations for one command and remove unnecessary combinations by selecting them in 

the Current keys section and selecting the  button.  

If chosen combination of keys for the selected command is already used for another command, the command having 
this hotkey combination is shown in the Assigned to section and the Assign button is blocked: 



 

The  button removes all custom hotkeys and restores their original state. 

Options tab 
The tab is used to change the view of the application and toolbars. 

 

Parameters: 

Application look 

Visual Style: Selection of program style. 

Available styles: 

Windows default  



Smart 1 

Smart 2 

Smart 3 

Luna Blue 

Obsidian Black 

Aqua 

Silver 

 The button to apply a selected visual style.  

Toolbars 

Show tooltips Switches tooltips on/off when moving the cursor over a button on a toolbar. 

Show shortcut in 
tooltips 

Switches on/off shortcuts in tooltips. 

Toolbar button size Use the slider specify the button size on toolbars. 

Profiles tab 
The tab is used to create profiles. 

 

A Profile is a set of custom settings with a unique name for working environment parameters. By default, nanoCAD 
saves all current settings in <<Unnamed>> profile.  

If several users, using one account to enter the system, work with the program, each of them can create a profile and 
load it for working. Another example of profile usage is for quickly switching between settings when working with 
different documents in the current session.  

Only one profile can be current. When changing interface settings the current profile is changed automatically.  

To use the custom settings of the working environment on other computers, a profile can be saved in a file with a 
*.wip extension. A WIP-file loaded on the other computer changes only the setting of the current profile, which were 
saved in this file. Other settings remain unchanged.   

 
The list of all profiles is shown in the Profiles section. 

The name of the current profile is shown in the Current profile field. 

A new profile inherits the properties of the current profile. 

To set a selected profile as the current one, select the  button. 

To delete a selected profile from the list select the  button. 



The  button deletes all profiles and recovers the standard nanoCAD profile.  

Note: Before applying the  button, save user profiles or they will be deleted. 

To create a new profile: 

 In the Customize dialogue box, specify the required settings.  

 In the Profile tab select the  button. 

 In the Profile dialogue box specify a name for the new profile and select the required checkboxes: 

 

 Select OK. The name of the created profile will be shown in the list of profiles. 

 Select the Close button to close the dialogue box. 

To save a profile: 

 Select the profile to save. 

 Select the  button. 

 In the Profile dialogue box specify a name for the new profile and select the required checkboxes. 

 Select OK.  

 In the Save As dialogue box specify the name and the folder location to save the profile, after that select the 
Save button. 

 Select the Close button to close the dialogue box. 

To load a profile from other computer: 

 Select the  button. 

 In the Open dialogue box select the nanoCAD profile. 

 Select the Open button. The file will be added to the profiles list and set as the current one.  

 Select the Close button to close the dialogue box. 

Note: You can open the profile editor from the Tools menu: Customize>Profile Manager. 



 
The Profiles dialogue box is identical to Profiles tab of the Customize dialogue box. 

Design settings 

 Menu: Tools –  Settings Parameters… 

 Command line: PARAMS 

Interface and parameters of annotations are set in the Settings dialogue box in nanoCAD: 



 
The path to the settings file is shown in the top part of the dialogue box.  

The Open button opens a standard dialogue box for the selection and loading of a new settings file. 

The main window contains a tab with the settings: 

 Main options, 

 Standard elements, 

 Symbols, 

 Forms. 

The parameters of the settings are shown in a tree form. 

There is a graphic illustration of the adjusted parameters in the right part of the dialogue box: 

  
Select a parameter from the drop-down list: 



 

or in the dialogue box by pressing the  button: 

 
The values of some parameters are entered from the keyboard: 

 
The drop-down list in the Standard section is used to change the standard: 

 
It is strongly recommended to match a  *.dwt working template with nanoCAD settings.   

What can be unified: 

 Dimension and text styles. It is recommended to adjust nanoCAD according to *.dwt template settings.  

 The global scale of linetypes. 

 Layers’ names and properties. By default many nanoCAD objects use a “current” layer for insertion. It is 
recommended to set layers’ names from a *.dwt template.   

 Layouts’ names and their settings. 

 Plot styles of objects, if a *.dwt template with named plot styles is used. 

Settings of Layers’ profiles 
Layers’ profiles are used to organise different divisions of the design work within one drawing file. Every user works 
with their own group of layers. 

For example, you have to annotate a drawing with leaders set separately by the compliance supervisor and the 
technologist.  

Do:  

 Switch to the Symbols tab in the Settings dialog, select the Leader note in the Notes section, in the Layer field 
select the <Table of layers>: 



 

Note: The  button opens the Table of layers dialog too. 

 Select the  New layer button to create a new layer. By default a new layer will have a LayerN name, where 

N – layer’s number.  

 Click on the created layer’s name to rename it. Type a new name – Notes: 

 



 Select ОК. 

 Select ОК to close the Settings dialogue box. 

 In the Save changes? Dialogue box select the Save to config file and current document parameter and 
select OK: 

 
Notes: When saving settings in a configuration file (not in a current document) all notes will be created on the Notes 
layer by default. It does not matter whether this layer is in the document. If a layer does not exist, it will be created 
with the parameters specified in the Table of layers dialogue box.   

To separate the work of the compliance supervisor and the technologist, create layers’ profiles.  

Do: 

 In the Settings dialog switch to the Main options tab and in the Common settings section in the Current profile 

select the  to open the Table of profiles dialog: 

 

 Select the  New profile button to create the new profile’s prefix. By default a new profile’s prefix will have a 

Profile1 name.  

 Click on the created profile’s prefix name to rename it. Type a new name – T_. 

 In the Full profile name column rename Profile1 to Technologist: 

 



 Using the same method to create the CS_ profile’s prefix : 

 

 Select ОК to close the Table of profiles dialogue box. 

 Select ОК in the Settings dialogue box.  

 In the Save changes? Dialogue box select the Save to config file and current document parameter and 
select OK: 

As a result of the settings, according to which profile is set as current, you can create: 

 Technologist’s annotation on the T_Notes;  

 Compliance supervisor’s annotation on the CS_Notes;  

 Leader note on the Notes layer. 

To create technologist’s annotation:  

 Select CTRL+SHIFT+Q hotkeys to open the Quick Options dialogue box: 

 

 Select the T_ profile from the drop-down list: 

 

 Select ОК. 

 Create an annotation using the Notes>Universal notes command from the Draw menu. When the first 
annotation is being created, a new T_Notes layer is created on the Notes layer base: 



 

To create the compliance supervisor’s annotation: 

 Select CTRL+SHIFT+Q hotkeys to open the Quick Options dialogue box. 

 Select the CS_ profile from the drop-down list. 

 Select ОК. 

 Create an annotation using the Notes>Universal notes command from the Draw menu. When the first 
annotation is being created, a new CS_Notes layer is created on the Notes layer base: 

 

To create a universal note: 

 Open the Settings dialogue box. 

 Open the Table of profiles dialogue box.  

 Select NO PROFILE. 

 Twice select OK to close the dialogue boxes. 

 Create a universal note. When the first annotation is being created, a new Notes layer is created: 



 
To enhance visualisation, you can set different colours for the Notes,  CS_Notes and T_Notes layers.  

Do:  

 Switch to the Symbols tab in the Settings dialogue box and in the Notes – Universal note section select By layer 
in the Color and Text color fields. 

 Select OK in the Settings dialogue box.  

 In the Save changes? Dialogue box select the Save to config file and current document parameter and 
select OK. 

 In the Layers dialog specify the colours for the layers. 

 
 

Note: Hotkeys for the Quick options dialogue box are specified in the Hot keys section in the Main options tab of the 
Settings dialogue box: 

 

Saving and transferring settings to another computer 
There are two types of settings in nanoCAD – interface settings (highlighted yellow) and design elements settings:  



 
Interface settings are set by the user and influence the application’s work.   

Design elements settings are written in a separate file. These settings are read when a new document is created and 
they define how the drawing created with nanoCAD tools will look.  

If the design elements settings are changed, the following dialogue box is shown after selecting the OK button: 

 

Parameters:  

Save to current 
document 

Saves the design elements settings in the current document. 

When a new document is created, the settings will be the same as the settings set in a 
configuration file; the setting will only be applied  to the current document. 

Save to config file 
and current 
document 

The new design elements settings will be applied to all new documents by default and to the 
newly created design elements in the current document.  

To save settings in this file you must have the rights to write to the settings folder. 

Don’t save Refuse to save the changes to the design element settings. 

This separate saving of design elements settings helps to standardise the drawing preparations procedures in an 

organization: you just have to set a common settings file on a network.  Defining who has rights to write to the 
common file can be done using the operating system tools. 

Settings files for users 

spot.icf - nanoCAD interface settings file 

ObjSettings_spot.cfg – settings file for nanoCAD design elements 

 are stored in the folder C:\Documents and Settings\User_name\Application Data\Nanosoft\nanoCAD. 

To transfer settings to another computer, you should copy them into the corresponding folders and specify the path to 
them in the Settings dialog. 

Drawing units 

 Menu: Format – Units… 

 Command line: UNITS, UN 

The command opens the Drawing Units dialogue box, where you can define the format and accuracy of the linear 
and angle units. 

By default, the base direction to measure angles is to the right of the initial point (East). Angles should be measured 
in a counterclockwise direction to give positive numbers. 



 

Parameters: 

Linear 

Type: Current format of linear units. 

Available formats in the drop-down list: 

Architectural 

Decimal 

Fractional 

Engineering 

Scientific 

Precision: Accuracy of current linear units.  

Angle 

Type: Current format of angle units. 

Available formats in the drop-down list: 

Deg/Min/SEC 

Grads 

Decimal degrees 

Radians 

Surveyor’s units 

Precision: Accuracy of current angle units. 

Base Angle: Direction of base angle. 

Available formats in the drop-down list: 

East 

North 

West 

South 

Pick angle – by specifying two points in the graphic area. 



Clockwise To change positive direction to measure angles to clockwise. 

Insertion scale 

Units to scale 
inserted 
content: 

Units to measure blocks and external references, inserted in a document. If a block or inserted 
document was created with units which do not coincide with the nits set in this section, the block or 
inserted document will be scaled to the specified units.  Scale is defined by the ratio of units in an 
inserted document and a current document.  

If the Undefined option is selected, the insertion is performed without scaling.  

Sample output Preview of current linear and angle units set in the dialogue box. 

Symbol scale and measurement scale 
There are two types of scale: symbol scale and measurement scale. The values for any of these scales can be set for 
any object, group of objects or document. New objects inherit the scale values from the document. 

Note: The list of scale values corresponds to the Unified system for design documentation GOST 2.302-68 "Scales". 

 

Specifying scale 
To set scale, use the scale button on the status bar. 

 
This button displays the scale of the selected objects. If objects are selected, an 
asterisk symbol is displayed before the scale value (scale 1:1 means that 1mm of 
object equals to 1 unit of drawing). 

 
If there are no objects selected, the button displays the document scale but the 
asterisk is absent. 

   

 

If the symbol scale value is displayed, the M character is in lower case. If the 
measurement scale value is displayed, the M character is in upper case 

 
If the selected object does not support the selected scale, or selected objects have 
different scales, the scale value is not displayed. 

To specify scale: 

 Select objects. To change the scale of all objects in the drawing, select all objects. If no objects are selected, a 
new scale will be set only for new objects that are created. 

 Select the scale button in the status bar. 

 Select the scale type in the menu (Symbol scale or Measurement scale) and specify the scale value from the 
list. 

    
You can set the scale for the selected objects or take the scale value from the selected object. 

To apply the scale to the selected objects or to take the scale from the selected object: 

To set the current scale of the document to selected objects: 

 Select the scale button. 

 In the menu that opens, select the scale type (Symbol scale or Measurement scale). 

 Select Set to selection. 

  

 Select the objects on the drawing whose scale you want to change. 



To copy the scale from a selected object: 

 Select scale button. 

 In the menu that opens, select the scale type (Symbol scale or Measurement scale). 

 Select Take from selection. 

 Select the object in the drawing whose scale you want to copy. 

Symbol scale 
Symbol scale is a settings parameter which decreases or increases the annotation objects in the drawing. This scale 
type is used for adjusting the display of annotation if it is too small or too big; for example, to change the size of an 
object’s arrows and text. This scale has no influence on the size of other objects. 

Changing symbol scale affects: 

- Annotation objects. 

- Linetypes with gaps and text. 

- Dimensions and special text. 

Symbol scale for objects is 1:1 Symbol scale for objects is 1:2 

  

To set symbol scale: 

To set and change scales, use the scale button in the status bar. If the value is set to symbol scale, the m character 

is in lower case:   

 



Example of changing the symbol scale of a dimension object: 

 



 

Measurement scale 
This scale influences objects, but the size of the annotation of the objects stays unchanged. Linear dimensions are 
also scaled. 

Measurement scale can be set for the following objects: 

- dimension objects; measurement scale influences the dimension text. 

- special object from vertical applications can have influences on the measurement scale of an object size in the 
drawing. 

Measurement scale for all objects is 
1:1 

Measurement scale for all objects is 
1: 2 

Measurement scale for dimension 
objects is 1:2 and for object is 1:1 



   

Use this scale if the drawing has a scale that differs from 1:1 scale. 

To set measurement scale: 

To set and change scales, use the scale button in the status bar. If the measurement scale value is set, the M 

character is in upper case:   



Example of changing the measurement scale: 

 



 

Solving problems 
1. The program graphic subsystem might work slowly or become unstable with some video adapters and driver 

versions. For example, the cursor in the empty drawing moves unevenly or isn’t shown. 

In this case, try the following: 

 Save all changes, close all drawings that you are editing. 

 Open the Options dialogue box (Tools> Options). 

 In the dialogue box that opens, select System settings> Graphics hardware acceleration settings: 



 

 Try switching between settings 1, 2 and 3. After every attempt, press OK in the dialogue box, open a new 

document and check the cursor speed. The program saves the selected setting until complete reinstallation.  

2. If an image  is a large size (the values of the cursor’s coordinates are 3000000 or higher), you sometimes need 
to switch on the following parameters to correct the graphics display: 

 



Coordinate systems 

The position of every drawing point is defined by its coordinates. In the command prompt for a point position you can 
specify it on the screen or type the coordinates in the command line.  

Specifying coordinates 
Coordinates can be specified in the Cartesian coordinate system and polar coordinate system.  

Cartesian and polar coordinates can be relative and absolute. 

Cartesian coordinates 
Cartesian coordinate system is defined by three perpendicular axes: X, Y and Z.  

The origin of the coordinate system is the point of intersection of the three axes and has the coordinates: (0,0,0). 

If you work in the plane, the Z coordinate is always 0, you have to specify X and Y. The X value is specified 
horizontally and Y value vertically. Positive coordinates are set to the right and above the origin, and negative to the 
left and below.  

When working in three dimensions, you have to set the Z coordinates. By default, the Z axis is set perpendicular to 
the XY plane from the viewpoint of the observer. The positive coordinates are set above the plane and negative 
below. 

For example, the coordinates (30,20) specify the point set 30 units in on the X axis and 20 units in on the Y axis.  

 
Absolute coordinates are specified from the origin of the coordinate system. Absolute are used if the precise X and Y 
coordinates are known values.  

Example: The point with coordinates X=10 and Y=20 is the start and the point with coordinates X=30, Y=40 is the 
end of the line. To create the line, enter in the command line: 

Command:  LINE 

Specify first 

point:  

10,20 

Specify next 

point:  

30,40 

 
Relative coordinates are used when the distance from the previous point is a known value.  

To specify relative coordinates, enter the @ symbol before their values. Values specified after the @ symbol are 
distances along the X and Y axes from the previous point. 



To create a line from the previous example using the relative coordinates enter in the command line: 

Command:  LINE 

Specify first 

point:  

10,20 

Specify next 

point:  

@20,20 

Polar coordinates 
In the Polar coordinate system, the absolute coordinates of a point are set by the distance from the origin and an 

angle between the polar axis and a line lying through the point and origin. The angle is set in degrees 
counterclockwise.   

For example, the coordinates 40<30 specify a point on the plane,  setting the distance as 40 units from the origin and 
with a 30

0
 angle from the X axis. 

 
Example: The start point of the line is set  as 20 units from the origin and at a 45

0 
angle from the X axis; the end point  

is set as 50 units from the origin and 30
0  

from the X axis. Enter in the command line: 

Command:  LINE 

Specify first 

point:  

20<45 

Specify next 

point:  

50<30 

 
In the relative polar coordinates the distance to the point is set not from the origin, but from the previous point. The 
angle is specified from the polar axis to the line connecting the previous point and the defining point. 

The @ symbol is used to specify relative coordinates.  

Example: The start point of line is set as 20 units from the origin and at a 45
0
 angle from the X axis; the end point is 

set as 40 units from the previous point and 30
0 
from the polar axis. Enter in the command line: 

Command:  LINE 

Specify first 

point:  

20<45 

Specify next 

point:  

@40<30 



   

Specifying points with “direction – distance” 
The direct distance is set instead of entering coordinates; it is very useful for  quickly entering the lengths of lines. 

Using direct distance specifying, move the cursor in the desired direction and enter the length value in the command 
line at the command prompt: Specify next point:. If ortho mode is switched on, it is very useful for drawing 

perpendicular lines.  

This method can be used in all commands, except commands where just a value needed, for example Array, Divide 
etc.  

User coordinate system 
nanoCAD uses two coordinate systems: world coordinate system and user coordinate system.  

Only one coordinate system is active at any time;  this is called current. 

World coordinate system is a base coordinate system and cannot be redefined (X axis is set horizontally, Y axis 
vertically and Z is perpendicular to XY plane).  The main difference of the world coordinate system from the user 
coordinate system is its rigidity and that it can be the only one (for every model space and layout).  

The usage of the user coordinate system has almost no restrictions; it can be placed at any point of the space and 
with any angle to the world coordinate system. UCS can be moved and rotated to specify points on the three 
dimensional and rotated views. Node points and base directions, defined by the SNAP, GRID and ORTHO modes 
are rotated with UCS.  

Changing UCS position 
Commands for changing the UCS position set a new coordinate system, the so-called current coordinate system.  

The current coordinate system inherits the parameters of the previous coordinate system, only the required values 
are changed.  

World coordinate system 

 Menu: Tools – Coordinate system > World UCS  

The command sets the parameters of the world coordinate system for the current user coordinate system. 

To set a coordinate system quickly: 

 Click in the UCS name field in the Inspector window: 

 

 Click the  button, specify World: 



 

Aligning UCS to an object 

 Menu: Tools – Coordinate system >  Object 

 Command line: SETUCSBYOBJECT 

The command specifies the new position of the coordinate system origin for the current UCS; the direction of the 
axes is specified according to the geometry of the current object. The extrusion direction of the selected object 
specifies the positive direction of the Z axis for the new UCS. 

Rules to create UCS, aligned to an object: 

Line 

 

The origin of the new UCS is set at the line end which is 
closest to the selection point. The X axis is used to place 
the line in the XZ plane. The Y coordinate of the second 
end of the line is zero in the new UCS.  

Arc 

 

The origin of the new UCS is the centre of the arc . The 
X axis is set at the end of the arc which is closest to the 
selection point. 

Circle 

 

The origin of the new UCS is the centre of the circle . 
The X axis is set at the selection point. 

Point 

 

The origin of the new UCS is the selection point. 

Polyline 

 

 

The origin of the new UCS is the start point of the 
polyline. The X axis is set at the start point and the 
nearest polyline vertex. 



Dimension 

 

The origin of the new UCS is in the middle of the 
dimension text. The new X axis is set parallel to the X 
axis of the UCS used to specify the dimension. 

Text block 
insertion, 
attribute 
definition  

 

 

The origin of the new UCS is the insertion point of the 
object and the direction of the X axis is set by the angle 
of object rotation around the direction of extrusion. The 
object used to set the new UCS has a zero rotation angle 
in this UCS.  

Command prompt:  

Select object to align UCS: Select an object. 

New origin for coordinates 

 Menu: Tools – Coordinate system >  Point  

 Command line: SETUCSBYPOINT 

The command specifies the new origin for the current UCS at the specified point. 

Command prompt:  

Specify origin of UCS [] 

<World>: 

Enter the coordinates for the UCS origin or specify them on the screen. 

New origin for coordinates and rotation angle 

 Menu: Tools – Coordinate system >  Point and angle 

 Command line: SETUCSBYPOINTANGLE 

The command specifies a new origin for the current UCS and the rotation angle of its axes. 

Command prompt:  

Specify origin of UCS [] 

<World>: 

Enter the coordinates for the UCS origin or specify them on the screen. 

Specify point on X axis or 

<Accept>: 

 

Specify the rotation angle on the screen or enter in the command line. 

Changing the UCS position from the command line 

 Command line: UCS 

Command options: 

Named Saves and restores frequently used UCS orientations by name. 

Restore Replaces the current UCS with one from the list of named UCSs. 

Save Saves the current UCS with a specified name. 

Delete Deletes the UCS from the list of named UCSs. 

? Shows the list of named UCSs. 

Object Sets the origin and the direction of the UCS axes according to the geometry of the existing 



object. 

View Specifies a new coordinate system within the XY plane, set perpendicular to the direction of 
sight and parallel to the viewport’s plane. The position of the origin is not changed. The X axis 
is set horizontally and the Y axis is set vertically.  

World Matches the current UCS to the World coordinate system (restores the World coordinate 
system).  

X/Y/Z Rotates the current UCS around the selected axis. 

ZAxis Specifies the UCS using the positive direction of the Z axis: the origin is placed at the first 
specified point; the positive direction of the Z axis is set through the second specified point.  

Command prompts:  

Specify origin of UCS or 

[Named/Object/View/World/X/Y/Z/ZAxis] 

<World>: Select UCS or option. 

Specify point on X-axis or <Accept>: Specify a point on the positive ray of the X axis. 

Specify point on XY plane or <Accept>: Specify a point on the positive ray of the Y axis in the XY 
plane. 

UCS icon 

 Menu: View – Display > UCS icon  

  Command line: UCSICON 

Manages the visibility and position of the UCS icon. 

There are On, Off and Origin commands available in the View – Display > UCS icon. 

To manage the visibility of the UCS icon use the Inspector dialogue box: 

 
The full list of options available to manage the UCS icon is available in the command line. 

Command options: 

ON Shows the UCS icon. 

OFF Hides the UCS icon. 

All Parameters of visibility for all viewports. If this option is not used, the parameters of the UCS icon 
are specified only for the current viewport.  

On Shows the UCS icon for all active viewports. 

Off Hides the UCS icon for all active viewports. 

Noorigin Shows the UCS icon in the left corner of the screen regardless of the origin for all active viewports.  

Origin Shows the UCS icon at the origin (0,0,0) of the current UCS for all active viewports. If the origin of 
the UCS is outside the visible part of a drawing, the icon is shown in the left corner of the screen. 

Noorigin Shows the UCS icon in the left corner of the screen regardless to origin of UCS. 

Origin Shows the UCS icon at the origin (0,0,0) of the current UCS. If the origin of the UCS is outside the 
visible part of a drawing, the icon is shown in the left corner of the screen. 

Command prompt:  

Entry an option or [On/Off/All/Noorigin/Origin] <"On">: Select the required option. 

Named UCS 

 Menu: Tools –  Named UCS… 



 Command line: UCSMAN, UC 

The command opens the UCS dialogue box, where you can select from the specified UCS, the parameters and UCS 
icon modes for viewports.  

The UCS dialogue box can be opened from the Inspector dialog: 

 

Named UCSs tab 
This tab contains the list of coordinate systems specified in the current drawing.  

If the UCS is not saved or named, it is shown as Unnamed in the list. 

The current UCS is marked with sign. 

 

To set a UCS as current: 

 Select the UCS from the list, 

 Select the Set Current button. 

You can set the UCS as current by double clicking on the UCS name or select Set Current from the context menu: 



 
The Details button (or command from the context menu) opens the UCS Details dialogue box with information about 
the coordinates of the selected UCS: 

 

To delete a UCS:  

 Select the UCS from the list,  

 Open the context menu,  

 Select Delete. 

To rename a UCS: 

 Select the UCS from the list,  

 Open the context menu,  

 Select Rename, 

 Enter the new name. 

Orthographic UCSs tab 
This tab contains six orthogonal coordinate systems which can be set for a UCS selected in the Relative to drop-
down list.  All named UCS existing in the current drawing are shown in the Relative to drop-down list.  



 

To set an orthogonal UCS: 

 Select the UCS from the list,  

 Select the Set Current button. 

You can set an orthogonal UCS by double clicking on the UCS name or select Set Current from the context menu: 

 

Options of the context menu: 

Set Current Sets the orthogonal UCS as current one. 

Reset Restores the origin of the selected orthogonal coordinate system (the origin has (0,0,0) coordinates 
of the base coordinate system). 

Depth Sets the direction between the XY plane of the orthogonal UCS and the parallel plane, set through 
the origin of the base coordinate system. 

The parallel plane can coincide with XY, YZ or XZ planes of the base coordinate system. 

Details Opens the UCS Details dialogue box with information about the coordinates of the selected 

orthogonal UCS.  



To set an orthogonal UCS: 

 Click in the UCS name field in the Inspector window: 

 

 Click the  button, select UCS from the list: 

 

Settings tab  
The tab is used to show and change the UCS icon modes and the UCS modes saved with the viewport: 

 

Parameters: 

UCS icon setting 

On Displays the UCS icon in the current viewport. 

Display at UCS 
origin point 

Displays the UCS icon in the current viewport at the origin. If the UCS origin is outside the 
viewport and the parameter is switched off, the UCS icon is specified in the left corner of the 
viewport. 

Apply for all 
active 
viewports 

Applies the UCS icon modes to all the active viewports of the current drawing. 

UCS settings 



Save UCS with 
viewport 

Saves the UCS mode with the viewport. If the parameter is switched off, the UCS of the current 
viewport is used for the specified viewport. 

Update view to 
Plan when UCS 
is changed 

Restores the view in plan when the coordinate system is changed in the current viewport. 

UCS for viewports 
Different model views can be shown for different viewports.  For example, a configuration of three viewports can have 
the top view in one viewport, the front view in other and the right side view in the third viewport. You can set and save 
the UCS for every viewport. 

If the Yes parameter is set in the UCS per viewport field in the Inspector dialogue box, the UCS of the viewport is 
saved before switching to another viewport. When you switch back to the viewport, the saved UCS restores. 

If the No parameter is set, the UCS of the viewport always coincides with the UCS of the current active viewport. 

Manage saving of the UCS for every viewport in the Inspector dialogue box: 

 



Precision tools 

nanoCAD, as other CAD systems, allows precise geometric creations (up to 14 decimals).  

Using precision tools allows: 

 speeding up of implementations during the project, 

 eliminating errors and inaccuracies in the dimensioning, 

 eliminating errors in the measurements of angles, length and distances, which were not dimensioned in the 
drawing, 

 avoiding problems occurring with hatch, due to open contour, 

 reducing time spent on the control programs for NC machines (because it is not necessary to edit inaccurate 
geometry of the parts) etc. 

nanoCAD provides precise geometric creations in two ways : 

 precise coordinates of object points and  

 using precision modes. 

Precision modes allow: 

 placing points on the rectangular grid (SNAP, GRID); 

 using object snaps to snap to characteristic points on the objects, for example to the endpoints of a line or to 
circle centre (OSNAP); 

 the use of tracking lines to place a created object in relation to other objects (OTRACK); 

 snap to specified angles and define distances using polar tracking (POLAR); 

 create and replace objects parallel or perpendicular to coordinate axes (ORTHO). 

Precision modes 
Precise tools are controlled in the context menu by the buttons and in the Drafting Settings dialogue box (Tools> 
Drafting settings). 

Buttons to switch between precise modes are in the status bar. 

 
The orange colour of a button shows that the mode is switched on.  

All or several modes can be switched on at once. 

Three ways to switch on/off the modes: 

 Click on the button. 

 From the context menu of the button select On or Off. 

 In the Drafting Settings dialogue box (Tools> Drafting settings) select or deselect the checkboxes: Snap on 
(F9), Grid on (F7), Polar Tracking on (F10), Object Snap on (F3), Object Snap Tracking on (F11). 

To open the context menu with the commands to control modes: 

 Place the cursor in the status bar, 

 Press the right button, 

 Select/deselect the required mode. 

Note: To cancel the context menu of the OSNAP select the Exit Menu command (other context menus are closed 

after the parameter is selected). 

The Drafting Settings dialogue box consists of three tabs: Snap and Grid, Polar Tracking and Object Snap: 



 

Snap and Grid mode 

 Menu: Tools – Drafting settings… > Snap and Grid tab 

 Status bar:  and       

 Hotkeys: F9 and F7 

 Command line: DDRMODES, DSETTINGS, SE 

Grid is an ordered sequence of points, which with SNAP mode allows specifying restrictions of the cursor movement 

to define accurate coordinates. You can switch the grid on/off at any time when you are working with a drawing. 
Changing Grid spacing does not affect any drawing objects.  

If SNAP mode is switched on, the cursor jumps from node to node with the specified snap spacing. Snap spacing 

and grid spacing can be different but very often their values are the same. Grid can have high spacing and snap 
spacing can be small to give a user the capability to specify points of high precision. For example, you can set grid 
spacing to 10 units, and snap spacing  to 1 unit.  Grid and snap spacing can be different along the X and Y axes.  

Major line – additional lines are also highlighted: 

 
Adaptive grid – grid display depends on the drawing scale. When zooming in, additional grid lines appear; when 
zooming out, they disappear. The frequency of these lines is determined by the frequency of the main grid lines. 

A grid  showing drawing limits, allows visualization of the drawing dimensions to place base elements on the initial 
stages. 

The parameters of the SNAP and GRID modes are specified in the Snap and Grid tab of the Drafting settings 
dialogue box or in the context menus. 



 

Tab parameters: 

Snap On (F9) Switches snap mode on/off. 

Snap spacing 

Snap Х spacing: Specifies the X spacing. 

Snap Y spacing: Specifies the Y spacing. 

Equal X and Y 
spacing 

Sets equal spacing between X and Y. 

Grid spacing 

Grid On (F7) Switches display of the grid on/off. 

Grid Х spacing: Specifies the X grid spacing. 

Grid Y spacing: Specifies the Y grid spacing. 

Major line every: Specifies the number of cells between major lines. 

Grid behavior 

Adaptive grid Switches adaptive grid mode on/off. 

Allow subdivision 
below grid spacing 

Switches division of the grid spacing on/off. 

Display grid beyond 
limits 

Switches display of the grid beyond specified limits on/off. 

The context menu of the SNAP button: 

 



Parameters: 

Set snap steps Specifies the X and Y spacings in the command line. 

Drafting settings… Opens the Drafting settings dialogue box. 

On/Off Switches snap mode on/off. 

The context menu of the GRID button: 

 

Parameters: 

Set grid steps Specifies the X and Y spacing in the command line. 

Set grid limits Specifies the limits of the grid display. 

Infinite grid Switches off restrictions for the grid display. 

Adaptive grid Switches adaptive grid mode on/off. 

Drafting Settings… Opens the Drafting settings dialogue box. 

On/Off Switches display of the grid on/off. 

Drawing limits 

 Menu: Format – Drawing limits 

 Status bar: Context menu of  – Set grid limits 

   Command line: LIMITS 

The command sets the limits for the current drawing in Model Space and in Paper Space.  

Drawing limits are specified by the coordinates of two opposite corners of the rectangular area – bottom left corner 
and top right corner. 

Command prompts:  

Specify lower left corner <0.0000,0.0000>: Specify coordinates or pick a point on the screen. 

Specify upper right corner 

<59400.0000,42000.0000>: 

Specify coordinates or pick a point on the screen. 

Polar Tracking mode 

 Menu: Tools – Drafting settings… > Polar tracking tab 

 Status bar: the  button 

 Hotkeys: F10 

 Command line: DDRMODES, DSETTINGS, SE  

Polar tracking mode helps to specify a point, set at a specified distance and angle from the last selected point. The 
dotted tracking line with a tooltip shows the distance from the last specified point and current angle value. 

 



Using polar tracking mode you can create geometric creations with any specified  interval. For example, if an angle of 
30

0
 was selected, tracking lines will be displayed when the direction from this point to the cursor’s pickbox is a 

multiple 30
0
 (e.g. 60

0
, 90

0
, 120

0
 and so on). 

Specify the increment of the polar angle in the Polar tracking tab of the Drafting Setting dialogue box or from the 
context menu of the POLAR button. 

 

Parameters: 

Polar tracking on (F10) Switches polar tracking mode on/off. 

Polar Angle Settings 

Increment angle: Specifies the increment angles used for polar tracking lines. 

Additional angles Switches on/off the mode for specifying any additional angles (which do not depend on 
the increment angle) 

Object Snap Tracking Settings 

Track orthogonal only In OSNAP mode tracking lines are only drawn horizontally and vertically. 

Track using all polar 
angle settings 

Switches on the mode for applying the parameters of polar tracking to object tracking. 
In this mode the cursor is moved from the point of object snap using aligning angles. 

Do not track Polar Switches off the polar angles tracking mode . 

To specify additional angles: 

 Enter an angle value, 

 Select the Add button. 

To delete an additional angle: 

 Select the angle in the section,  

 Select the Delete button. 

The context menu of the POLAR button contains the available increment angles: 



 

Parameter: 

Set custom angle  Specifies a new angle of polar snap direction in the command line. 

On/Off Switches the polar angles tracking mode on/off. 

Object snap mode 

 Menu: Tools – Drafting settings… Object snap tab 

 Status bar: the  button 

 Hotkeys: F3 

 Command line: DDRMODES, DSETTINGS, SE 

Object snap is the main and the quickest way to specify an object’s characteristic points without knowing their 
coordinates.  

Characteristic points are: 

 End points and the middle of a line, 

 Centre of a circle and its intersection points with centre lines (quadrant), 

 Endpoints, centre and middle of an arc, 

 Insertion point of block or text  

 Etc. 

The mechanism of object snap allows one of the characteristic points of the existing object to be specified as the 
coordinates for the point of a new object.   

Object snap can be used when you need to set a point in the command line. 

To use object snap: 

1. Switch on one-time object 
snap during one of the 

creation or modifying 
commands, open the 
context menu of one-time 
object snap with CTRL (or 
SHIFT) button pressed and 
select the required mode: 

2. Switch on temporarily object 
snap, open the context menu of the 
OSNAP button in the status bar and 
select the required mode: 

3. Switch on temporarily object snap, in 
the Drafting Settings dialogue box 
select the Object Snap On checkbox 
and select the required mode: 



 

 

 

You can switch on one or several modes of object snap (except the context menu of one-time object snap, only one 
mode can be selected there). 

The Select All and Deselect All are applied to all parameters of the snap. 

One-time object snap is used to replace temporarily object snap and stays active  until the current snapping is 
finished.  When a snap point is selected, one-time object snap switches off. For example, when creating geometric 
objects consisting of lines, as a temporarily snap you can specify Endpoint, Midpoint, Perpendicular, and 
Intersection. If you want to snap one of the lines to a circle, specify one-time object snap Center, Quadrant or 
Tangent.  

The context menu of one-time object snap has an additional option – None, which switches off all modes of object 
snap before finishing the point selection operation . None is used for one time application (during one operation), that 
is why it is absent in the Object Snap tab in the Drafting Setting and in the context menu of OSNAP button.  

None is used when you cannot select a point in the drawing due to temporarily snap modes being used. After the 
point is specified, the temporarily snap mode starts again.   

You can switch the object snap mode on/off in the Snap toolbar: 

 
To display the Snap toolbar, select the Snap checkbox in the Customize dialogue box (Tools menu – Customize > 
Interface): 



 
To open the Snap toolbar select the Show Snap Toolbar option in the context menu of the OSNAP button: 

 
If an object snap mode is switched on, the marker and a tooltip about the available object snap types for the object 
are shown when moving the cursor over the object. 

If several or all types of object snap are switched on as a temporarily snap, and if a snap to some characteristic point 

is available in the cursor’s current position (for example, if some objects are placed close to each other), the highest 
priority snap is used. 

The priority of snaps is specified in the Object Snap tab in the Drafting Setting, the highest priority has Endpoint, 
the lowest – Parallel. Any one-time snap has a higher priority than any temporarily has.  

Object Snap types: 

 
Endpoint  

Snap to the object’s endpoints (lines, arcs etc.).   

 

 
Midpoint  

Snap to the middle of objects (lines, arcs etc.). 



 

 

Center  

Snap to the centre of an arc, circle or ellipse.  

 

 
Node  

Snap to a Point of the object, and for specifying point of dimension or start point of dimension text. 

 

 
Quadrant  

Snap to the nearest quadrant (the point located at an angle of 0, 90, 180 or 270 degrees from centre) of arc, 
circle or ellipse.  

 

 
Intersection  

Snap to the intersections of objects (lines, circles, arcs etc.).  



 

 
Insertion 

Snap to an insertion point of text, block, shape or attribute.  

  

 
Perpendicular  

Snap to the point of the object lying perpendicular to another object or to its imaginary extension.  

 

 
Tangent  

Snap to the point on an arc or circle belonging to the tangent of another object. 

 

 
Nearest  

Snap to the point of the object located closest to the cursor position. 

 



 
Parallel  

Snap to an existing linear segment for the creation of a parallel linear segment of other object.  

After specifying the first point of a linear segment, you need to place cursor’s pickbox over a linear segment of 
the existing object and slowly move the cursor to the expected position of a parallel segment of a new object. 
The symbol of a parallel snap on the existing object and parallel rubber line to this object means that you can 
specify the second point of the linear segment at any required place in the rubber line.   

 

 Extension  

Creates a temporarily auxiliary line which is an extension of an object and the cursor goes over its end point. 

 

Object Snap tracking mode 

 Menu: Tools – Drafting settings… Object snap tab 

 Status bar: the  button 

 Hotkeys: F11 

 Command line: DDRMODES, DSETTINGS, SE 

 

The object snap tracking mode allows the placing of created objects in specific relation to other created objects. 
When object snap tracking mode is switched on, nanoCAD temporarily displays dotted trajectories of different types 
(tracking lines) for accurate positioning of objects.  

Object tracking modes are used together with object snap and works when the cursor’s pickbox is near a probable 
point of object snap (the pickbox’s size determines the zone of tracking lines  activation). Object tracking expands 
and adds to the capabilities of object snap.  

The parameters of object tracking are specified in the Object Snap tab in the Drafting Setting dialogue box (Tools 
menu – Drafting Settings) or in the context menu of the OTRACK button. 



 

Parameters: 

Object Snap Tracking On 
(F11) 

Switches object snap tracking mode on/off. 

Object Snap Tracking models 

Track to alignment point Switches on/off  the display of tracking lines to an object’s characteristic points.  

Clear track points on 
“shift + mouse wheel” 

Switches on/off the erasing mode of the snap point marker on a tracking line using 
SHIFT and the mouse wheel. 

The context menu of the OTRACK button: 

 

Parameters: 

Track using polar angles Switches using object tracking together with polar tracking mode on/off. In this case, 
the tracking lines for all angles specified in the Polar Tracking tab in the Drafting 
Settings dialogue box are displayed.   

Track ortho only Switches the display of tracking lines only in ortho directions on/off. 

Don’t track polar Switches off polar tracking mode. 

Track to any alignment 
point 

Switches on/off  the display of tracking lines to specific points. 

Clear track points on           
SHIFT + mouse wheel 

Switches on/off the erasing mode for the snap point marker on a tracking line. 



On/Off Switches object tracking mode on/off. 

To use object tracking mode: 

 Switch on the OTRACK and OSNAP modes in the status bar.  

  Use the cursor to capture the required characteristic objects’ points to set tracking lines. Place the cursor near a 
point to capture it. A captured point is marked with + symbol. To deactivate a point already captured, move the 
cursor over it again.   

 Dotted tracking lines, going through one or several captured points and the cursor’s pickbox, will appear when 
you move the cursor within the drawing. You can snap to points on those lines or to the intersection points. The 
more types of object snap that are switched on, the more points that will be available for capture.   

To zoom and pan, the + marker is removed from captured points. 

Example: Circle in the  centre of a rectangle. 

1. Defining the  centre of rectangle: 

 
2. Specifying the circle  centre: 

 
3. Specifying the circle radius: 

 

Display of snap elements 

 Menu: Tools –  Options… 

The cursor’s pickbox is enlarged automatically in nanoCAD snap modes (creation and edition of primitives, 
dimensioning etc.) for your convenience: 

Common cursor’s pickbox size Enlarged cursor’s pickbox size  

  

The common cursor’s pickbox size is specified in the Cursor – Pickbox – Pickbox size section of the Options 
dialogue box (Tools menu – Options): 

 

Parameters: 

Crosshair size Sets the size of the Crosshair as a percentage of the display size. 



Pickbox size Pickbox size in pixels. 

The enlarged cursor’s pickbox is specified in the Options dialog in the Snap settings – Hold Aperture Size: 

 

 

Parameters: 

Hold Aperture Size 
<10> 

The size of the cursor frame in snap mode.  

Show Aperture Box Switches the aperture box on/off in the snap mode. 

Snap Marker size <5> Snap marker size. 

Show Tooltips Turns on the display of the snap name. 

Vector Marker Color The colour of the snap marker when snapping to a vector object. 

ORTHO mode 

 Status bar: the  button   

 Hotkey: F8 

With orthogonalisation mode set on, vector lines and rubber lines for editing can only be drawn in directions parallel 
to the coordinate axis.  

If an angle of a coordinate system is changed, the corresponding ortho mode angle is also changed. 

The ORTHO mode has higher priority than the polar tracking mode. 



Navigation in the document 

View is a combination of the size, position and orientation of a drawing fragment on the screen. 

There are different tools and methods allowing you to orient in the document when you edit it. You can zoom or pan 
the working area for visual control of changes in the document; you can save a selected view for further display or 
printing; you can separate the working area of a document into several non-overlapping viewports to display different 
drawing fragments at the same time.  

Display modes 
The main methods to change the document display on the screen are zooming and panning. 

Zoom command enlarges the view of a drawing segment for better detailing or decreases it to display more of the 
drawing. Absolute sizes are not changed during zooming.  

Pan command allows you to pan the drawing without decreasing or enlarging it. 

Zoom and Pan commands are available in the View – Zoom menu or on the Zoom toolbar. For your convenience, 
most frequently used commands are on the Main toolbar and in the status bar.  

Note: You can zoom using the mouse wheel. Moving the mouse with the wheel pressed and held allows panning. 

Pan 

 Menu: View – Zoom >   Pan 

 Toolbar: Main –  

 Status bar –  

 Command line: PAN, VIEWPAN 

Allows you to move a document in the window with the mouse. 

After starting the command, the cursor has the shape.  

With  theleft button pressed, the cursor has the  shape. 
To exit from pan mode, press the ESC or ENTER buttons. 

Zoom 

 Menu: View – Zoom >  Zoom Dynamic 

 Toolbar: Main –  

 Status bar –   

 Command line: ZOOMD 

Turns on the mode in which you can increase an object’s size on the screen by moving the mouse up and decrease it 
by moving it down. 

After starting the command from the View menu or Main toolbar, the cursor has the .shape.   
When you release the button the zoom stops; you can move the cursor to another position and press the button 
again to continue zooming in a new position. 

To exit from the zoom mode, press the ESC or ENTER buttons. 

If you start the command in the command line, the following options are available: 

Specify corner of window or 

[All/Center/Dynamic/Extents/Previous/Scale/Rscale/Window/Object/] <real time>: 

Zoom 1:1 

 Menu: View – Zoom >  Zoom 1:1 

 Command line: ZOOM1 

An image is scaled so that one pixel on the screen corresponds to one image point. 

Zoom All  

 Menu: View – Zoom >  Zoom All 



 Toolbar: Main –  

 Status bar –  

 Hotkeys: ALT+0  

 Command line: ZOOMALL 

Displays the whole document.  

Zoom Selected  

 Menu: View – Zoom >  Zoom Selected 

 Toolbar: Main –  

 Command line: FITSEL 

Displays the selected objects. 

Zoom Window  

 Menu: View – Zoom >  Zoom Window  

 Toolbar: Main –  

 Status bar –  

 Command line: ZOOMW 

Selects an area on the screen.  

Zoom In  

 Menu View – Zoom >  Zoom In 

 Command line: ZOOMIN 

Doubles the scale. 

Zoom Out  

 Menu: View – Zoom >  Zoom Out  

 Command line: ZOOMOUT 

Decreases the scale by half. 

Order of objects  
When editing a document, the objects are shown in the order that they were created. Some objects can be 
overlapped or obscure each other. To correct the situation, the order of the objects (their display on the screen) can 
be changed, one object can be placed in front of another.   Commands to change the order of objects are shown in 
the Tools – Display Order and on the Display Order toolbar.  

Bring to Front 

 Menu: Tools – Display Order >  Bring to Front  

 Toolbar Display Order –  

 Command line: DRAWORDER1 

Forces the selected object to be displayed in front of all other objects. 

Send to Back 

 Menu: Tools – Display Order >  Send to Back 

 Toolbar: Display Order –  

 Command line: DRAWORDER2 

Forces the selected object to be displayed behind all other objects. 

Bring Forward 

 Menu: Tools – Display Order >  Bring Forward 



 Toolbar: Display Order –  

 Command line: DRAWORDER3 

Forces the selected object to be displayed in front of the object located in front of it. 

Send Backward 

 Menu: Tools – Display Order >  Send Backward 

 Toolbar: Display Order –  

 Command line: DRAWORDER4 

Forces the selected object to be displayed behind the object located beneath. 

Viewports of Model Space 
Model space can be separated into several rectangular non-overlapping areas called viewports.  

Non-overlapping areas fill in model space and cannot be placed over each other. When starting a project, usually one 
viewport, filling in all the model space, is used. This viewport can be separated into several viewports and different 
fragments of the drawing or model views can be can be displayed on every viewport at the same time.  The changes 
made in one viewport are also shown in the whole drawing (in other viewports). You can switch between viewports at 
any time, even whilst a command is being performed. To switch to another viewport, click at any point on the screen. 
The cursor is displayed in the current viewport, –the common arrowhead is displayed in all the others. 

For every viewport you can specify the display scale, pan the viewport image independently of the other viewports, 
specify UCS and display the modes of grid and snap usage. You can save the setting parameters of any viewports to 
use them again and restore an image of any viewport.   

Only one non-overlapping viewport can be printed.  

Configuration of non-overlapping viewports can be different:  

1 Viewport 

 Menu: View – ViewPort >  1 Viewport 

 Command line: VIEWPORT_SINGLE 

In Model Space: restores the configuration to one viewport (the view is taken from the last active window).  

In Paper Space: creates one viewport. 

2 Viewports 

 Menu: View – ViewPort >  2 Viewports 

 Command line: SPLITVIEWPORT_VERTICAL 

Creates two identical viewports. 

3 Viewports 

 Menu: View – ViewPort >  3 Viewports 

 Command line: SPLITVIEWPORT_3 

Creates three viewports. 

After starting the command, there is a prompt in the command line:  

Enter an option [Horizontal/Vertical/Left/Right/Top/Bottom]<Right> 

Select the option for the required viewport configuration. 

4 Viewports 

 Menu: View – ViewPort >  4 Viewports 

 Command line: SPLITVIEWPORT_4 

Creates four viewports. 

Named viewports 

 Menu: View – ViewPort >  Named views 

 Command line: VPORTS 

The command opens the Viewports dialogue box.  

On the New Viewports tab you can create the required configuration of viewports on the standard base and save it 
for further usage: 



 

Parameters: 

New name: Name of the saved configuration of viewports. 

Standard viewports: List of standard configurations of viewports. 

Apply to: 

Display Applies the selected configuration of viewports to the whole Model Space. 

Current viewport Applies the selected configuration of viewports to the current viewport. 

Setup: 

2D Sets the selected configuration as the current viewport for all viewports. 

3D Sets the selected configuration of standard model views for all viewports. 

Preview Preview of the selected configuration of viewports. 

The current viewport is shown with a double frame. 

Change view to: Changes the view of the common viewport.  

There are existing named views of the drawing in the drop-down list (there are additional 
standard model views for 3D mode).  

Visual style: Changes the visual style of the selected viewport. 

There available styles in the drop-down list are: 

*Current* 

2D Wireframe 

3D Hidden 

3D Hidden 

Conceptual 

Realistic 



To change a view or a visual style for a viewport: 

 Double click to select the viewport in the Preview window (selected object is shown with double frame). 

  Select the required view or visual style from the drop-down list. 

If a name was specified in during the creation of the configuration of the viewports, the configuration will be saved as 
a named configuration. A named configuration of viewports can be used without preset. 

The list of created and saved configurations is shown on the Named Viewports tab:  

 

To create named configurations of viewports: 

 Select a standard configuration in the New Viewports tab. 

 In the New name enter a configuration name. 

 Select ОК.  

The name of the created configuration is shown in the Named viewports section of the Named Viewports tab when 
the Viewports dialog is opened next time. 

The Save Configuration command from the View>Viewports menu allows a name to be specified in the command 

line for the current configuration of viewports.  

To restore a named configuration of viewports: 

 Select the required configuration in the Named viewports list (after selection, a scheme of viewports will be 
selected in the Preview window). 

 Select ОК. 

Or: 

 Start the Restore Configuration command (the View>Viewports).  

 In the command line, type the configuration name as an answer to the prompt Enter viewport 

configuration name: (the list of available configurations is shown in the command line’s protocol). 

 Press ENTER to finish the command. 

To delete a named configuration of viewports: 

 Start the Delete Configuration command (the View>Viewports).  

 In the command line, type the configuration name as an answer to the prompt Enter viewport 

configuration name: (the list of available configurations is shown in the command line’s protocol). 

 Press ENTER to finish the command. 



Image regeneration 
Sometimes, when you are working with a document after the command is finished, some visual elements stay on the 
drawing; for example, markers of characteristic points. To delete such visual elements, use forced regeneration 
(specified manually) or redrawing of a drawing. 

Two commands in nanoCAD are used for it: Regen and Redraw (View menu). 

 Redrawing of a drawing is faster than regeneration because all the drawing objects’ coordinates are recalculated 
(converting values with floating points from the drawing database to integer display coordinates) during regeneration. 

 

Regeneration 

 Menu: View –  Regen 

 Status bar:  

 Command line: RE, REGEN 

The Regen command is used for a forced update of a current drawing.  

Redrawing 

 Menu: View – Redraw 

 Command line: REDRAW 

The Redraw command is used for a forced update of a display.  

 



Objects’ properties 

In nanoCAD, graphic drawing objects have properties, such as colour, type and weight (width) of lines, transparency 
and plot style, which can be changed. 

When placing the cursor over any object on the screen, a tooltip with the object’s name, name or number of its colour 
and layer where the object is placed, appears: 

 
The display of a tooltip can be switched off in the Cursor section of the Options dialogue box (Tools – Options): 

 

Set different properties for objects for the document’s clarity. When creating new objects, their properties are 
inherited from the description of the layer where they were created.  

Inspector 

 Menu: Modify –  Properties 

 Toolbar: Main –  

 Hotkeys: CTRL+1  

 Command line: INSP, INSPECTOR, PROPERTIES 

The Inspector window is used to display information about selected objects, to change objects’ properties, to specify 
a selection mode and call up selection commands.  

The list of properties is separated into groups. Manage the visibility of properties of any group by using the  and  

buttons in the group name. The  button shows the properties for the hidden group. When this button is selected the 

properties list of the group is shown and the button switches to the button. 

 

The different properties of objects are displayed in the left 
column of the Inspector window, their values in the right 

column. 

Information in the Inspector depends on the current command 
and different parameters of the selected objects are shown. 

If no object is selected, No selection is shown in the Object 
type field: 

 
Current settings parameters for the properties of created objects 
of the document are shown in the General group. For example, 
the Line Weight has a «1.00» value, so new lines, arcs and 
circles will be created with this weight. 

 

 



 

If several objects of one type are selected, their type and number (in 
brackets) are displayed in the left column: 

 

If several objects of different types are selected, All (2) is displayed in the 
Objects type field: 

 
The General group contains information about an object’s properties: 
colour, layer, line type and etc. 

The Geometry group displays information about the geometric 
parameters of an object and its position in the document. 

Propertiesthat can be changed are shown in black in the left column. 

You can specify new values for these properties in the corresponding 
fields. Values outside of the limits are not used automatically. 

The grey colour is used to display information about properties which 
cannot be changed and for properties depending on other properties. 

If several objects are selected, only properties common to all the objects 
are displayed. 

If any property does not have a value (the field in the column is empty); 
two or more objects having the property among selected objects, but the 
values of the property are different, for example  centre coordinates for 
two non-concentric circles: 

 
The value, entered in such a field, is one for this property for all objects  
selected, if it can be applied.  

Some properties of objects, such as, colour, line type, and line weight can be selected from the drop-down list: 

 

To change the properties of objects in the Inspector window: 

 Select one or several objects. 

 Click in the left column of the property that you want to change.  

 Select the required value in the drop-down list to the right of the column or type a new value. 

 To apply a typed property value to the objects, press ENTER. Values, selected from a list, are applied to the 
selected objects immediately without pressing the ENTER button. 

 To deselect objects, click in the drawing area or press ESC. 

There are mode and selection commands buttons in the top part of the Inspector dialog: 

 

Creation of custom properties windows 
The fields of the Inspector window display information about selected objects which can be dragged onto an 
existing or created toolbar, creating a user properties window: 



 
After dragging, only the right column with the values from the Inspector window is shown in the toolbar. 

The value of a property is shown in the user properties window after selection of object, the property of which is 
shown in the window. The window remains empty if an object is not selected or if the selected object does not have 
properties contained in the window. If several objects are selected, the window is empty  unless similar objects are 
selected, for example circles of one diameter.  

One user properties window can contain several fields from the Inspector window. 

If the user window contains several properties of one properties group or several properties of one object type, only 
one property (the top property in the Properties Setup) is shown when the object is selected: 

 
In this case, when a circle is selected the radius value will be shown; if a line is selected, its length value will be 
shown; if a single line of text is selected, its height will be shown.  

The  and  buttons are used to move the selected property in the list.  

To display the Geometry.Diameter property when a circle is selected, use the  to move this property above the 

Geometry.Radius property: 

 

The  button deletes the selected property from the list. 

To display two or more properties from one group or one object type, create several windows on the toolbar. 

As an example, we will show how to create a toolbar with 3 user properties windows, the first displays the circle 
diameter and text height, the second – circumference and text rotation and the third – circle area and text oblique. 

To create user properties windows: 

 Create a new toolbar: 

 

 Select a created circle. 

 Place the cursor over the Diameter field in the Inspector window. 

 Drag the Diameter field, using the left mouse button and Alt button, onto the created toolbar: 

 

 Drag the Circumference field to the right of the first field on the toolbar in the same way: 

 



Drag the Area field to the right of the second field on the toolbar: 

 

 Press ESC to deselect the circle. 

 From the context menu of the first field select Setup: 

 

 In the drop down list of the dialogue box that appears, select the Text.Height property: 

 

 Select OK to close the dialog. 

 From the context menu of the second field select Text.Rotation. 

 Select OK to close the dialog. 

 For the third field select the Text.Obliquing. 

 Select OK to close the dialog. 

 After selecting any circle on the drawing, the values for its diameter, circumference and area are shown:  

 

 After selecting any single line of text  on the drawing, the values of its diameter, circumference and area are 
shown: 

 

To delete a field from a new toolbar: 

 Place the cursor over the field: 



 

 When the field is  selected, press Alt and drag the field into the drawing area: 

 
Note: The Disable All switches off the display of properties’ values not only in the user windows, but in the 
Properties and Styles standard toolbars. 

Distributing object by layers 
The main advantage of CAD is organising a document by layers. Layers are used to separate, sort and edit drawing 
objects.  

To explain the function of layers we will use an example with tracing paper. Layers in the drawing are like transparent 
tracing papers. One tracing paper (or layer) contains the floor plan, the second – water supply system, the third – 
heating, the fourth – electric power supply etc.   By combining different layers (tracing papers), you can create the 
required sets of design documentation.  

Placing different groups of objects on separate layers helps to order and simplify many of the operations of drawing 
management. For better organisation and operation of data, drawing elements of one type are placed on the same 
layer. For example, auxiliary lines are placed on a separate layer to facilitate and accelerate their  removal. 
Dimensions, text objects, hatches etc. can be placed on separate layers.  

Every newly created object contains by default the 0 layer, which cannot be deleted or renamed. The drawing must 

contain at least one layer because any graphic object must be placed on a layer (it is often said that an object 
belongs to a layer).  

It is not recommended to create all drawing objects on the 0 layer. It is recommended to create a new layer for the 
correct organisation of graphic objects. 

When the first dimension is set, the Defpoints utility layer is created; this is where the control points of dimensions 
are set.  The display view of these points is not changed with the DDPTYPE command. The Defpoints layer is never 
printable.  

When an object is created, its properties are taken from the layer where it is placed (if By layer is selected).  

If you specify a particular colour, type and line weight instead of the By layer parameter in the Color, Line type and 
Line Weight drop down lists in the Inspector window, these values will be applied to all newly created objects on the 
layer.  

To create a new object you do not need to specify its properties every time. You switch to the required layer and 
create the object.  

Distributing objects by layers helps to edit objects’ properties separately. By blocking separate layers you can prevent 
editing of objects placed on these layers if you do not want accidental changes. Layers can be switched on/off, 
visible/invisible.  Every layer can be made printable or unprintable.  

An active layer, selected for working with, is called current. By default, newly created objects are placed on the 
current layer.  

Some frequently used parameters  for managing layers and their properties are placed on the Properties toolbar: 

 
And in the General section of the Inspector window: 



 
The Layer drop down list allows reassigning of the current layer, and also switch on/off, freeze/unfreeze and 
block/unblock a layer: 

 
Color, Line type and Line weight drop down lists are used to change the properties of a selected layer quickly: 

 

 
 

The Layers  button on the Properties toolbar opens the Layers dialogue box where you can create, delete, 

rename and do other operations with layers. 

Layers 

 Menu: Format –  Layers… 

 Toolbar: Properties –  

 Command line: LAYER, LAYERS, LO 

The Layers dialogue box is used to manage layers and their properties: 



 
There is a window in the left part of the dialogue box with a category tree.  In general, a category tree consists of the 
following elements: 

- All,  

- All Used Layers,  

- External reference,  

- Filters,  

- Groups, 

- Configurations.  

In the right part of the dialogue box is the list of layers for the selected element of the category tree. 

Below the dialogue box title: 

 – the selected element from the category tree is shown, 

 – the current layer is shown. 

Parameters: 

Tree categories window 

 Add group The button adds groups of layers. 

 Add filter The button adds a filter. 

 Add configuration  The button adds configurations of layers. 

 Delete The button deletes the tree’s elements. 

 Close/Open tree The button folds/unfolds windows of the categories tree. 

Remark: Short description of the layers’ configuration. The parameter is 
displayed above the Invert filter when you select the layers’ 
configuration in the tree. 

Invert filter The Inversion mode for the display of layers in the layers’ list.  

List of edited layers 

Buttons 



 Add  

 Delete  

 

Show all layers 
(for group)  

 Edit property  

 Refresh  

 

Single layer view 
mode  

Buttons 

 Icon of the current layer. 

 Column displays the layer’s name. 

 Column displays the icon for visibility of layers. 

 Column displays the icon for freezing of layers . 

 Column displays the icon for blocking a layer. 

 Column displays an icon for the layer’s colour. 

 Column displays the layer’s line type.  

 Column displays the layer’s line weight. 

 Column displays the layer’s plot style.  

 Column displays the icon permitting printing.  

 Short information about the layer. 

Editing of a layer’s parameters 

To select layers in the dialogue box 

Click on a layer to select it. 

You can edit the parameters of several selected layers at once. 

With SHIFT pressed, select the first and the last layer in the list. These layers and any layers between them will be 
selected.  

With CTRL pressed, you can select individual layers from the list.  

To sort layers by property  

A list of layers can be sorted by any parameter. To sort a list of layers, click on the parameter column title.  

For example, click on the Color title and all layers in the list are sorted by colour.  Clicking on the title again reverses 
the order of the sorted layers: 



  

Specifying the colour, type and width of lines in the layer  

In Layers it is possible to specify all the properties that can be inherited by the objects created on it. Ensure the By 
layer value is set in the corresponding boxes of the object properties.  

Colour, type and weight of lines can be specified for several layers at once: 

 Select a layer to change its properties. 

 Click on the required parameter in the column: Colour, Lineweight or Linetype. 

 Select the value from the list. 

Creation of a new layer 

A newly created layer has default properties. After a new layer is created, you can change its properties. 

To create a layer: 

 Select button  Add. 

A new layer with the name New Layer (N) appears in the list. The default name for the  new layer can be changed. 

To rename a layer: 

 Select layer in the dialogue box. 

 Select Name in the Layers dialogue box 

 Enter the new name. 

 Select ENTER. 

Removing a layer 

Only layers not used in the document can be deleted. The current layer, even if it is not used cannot be deleted. 

To delete a layer: 

 Select layer in the dialogue box. 

 Select the Delete  button. 

You can delete several unused layers at once. 

To delete several layers: 

 Select All Used Layers in the categories tree.  

 Switch on the Invert filter   parameter.  

Select all sorted unused layers and select the Delete  button or Delete command from the context menu. 

To make a layer active: 

 Select a layer in the Layers dialogue box. 

 Click in the column icon of the selected layer. The  icon means that a layer is current. 

To control layer visibility  

Objects with visibility switched off are not displayed on layers and are unprintable, but are used in regeneration of a 
drawing. When layers are switched on/off, regeneration is not performed. It is recommended to switch on/off layers 
when you need to do it frequently and not for a long time. In other cases it is better to freeze them. 

Visible layers are marked with icon. Absence of the icon means that visibility of the layer is switched off. 

To switch on/off visibility of a layer: 

 Select one or several layers in the list. 



 Click in the column icon of the selected layer. 

Freezing a layer 

Objects placed on frozen layers are not displayed on the screen and are unprintable and not used in regeneration of 
the drawing. You can freeze unused layers to make display and regeneration operations faster. But freezing a layer 
causes regeneration of the drawing, which takes time. Freeze layers if you only do it occasionally or you want to 
freeze the layers for a long time. In other cases it is better to switch them off. 

Frozen layers are marked with icon. 

You can freeze and unfreeze several layers at once. The current layer cannot be frozen.  

Locking or unlocking a layer to edit it: 

 Select one or several layers in the list. 

 Click on the column with the lock icon for the selected layer. 

Freezing layers in the viewports of a layout 

Layers can be frozen in separate viewports of a layout. You can get different displays of the same objects in different 
viewports without creating additional geometry; for example, you create two viewports for the same object and freeze 
the layer with design elements in the second viewport: 

Viewport with unfrozen layers Viewport with frozen layer of design elements 

  

To freeze a layer in a viewport: 

 Make the selected viewport active by double clicking on its frame. 

 Open the Layers dialogue box. 

 Freeze the selected layer. 

 Close the Layers dialogue box. 

The layer will be frozen only in this viewport and is visible in other viewports. It will not be printed only in this viewport. 

Blocking a layer from changes  

If a layer is unblocked, you can create a new object on it.  Objects created before blocking are visible and they can be 
selected to view their properties, but they cannot be edited. You can snap to the object on a blocked layer  with an 
object snap. You can change the colour, line type, weight type, make printable or unprintable on a blocked layer. 

Blocked layers are marked with icon. 

You can block or unblock several layers at once. 

To block/unblock layer: 

 Select one or several layers in the list. 

 Click on the block column of the selected layer. 



Controlling layer printability  

The icon means that objects on the layer can be printed. Object on the layers without this icon will not be printed. 

You can make several layers printable or unprintable at once.  

To make layers printable or unprintable: 

 Select one or several layers in the list. 

 Click on the printability column of the selected layer. 

Single layer view mode 
There is a mode to view only the selected layer in nanoCAD. Visibility of all layers in this mode, except the one 
selected, is switched off automatically; visibility is restored when you close this mode. This mode is a quick alternative 
to switching off the visibility of all layers to display content of one layer; it is very convenient if there are a lot of layers 
in the drawing. 

All layer view mode Single layer view mode 

  

To switch on single layer view mode: 

 Select the  Single layer view mode button, the  icons disappear for all layers. 

 Select a layer by clicking (in the column). Visibility of all layers, except the one selected, is temporarily 

switched off.  

With the Layers dialogue box opened you can zoom and pan the drawing using the corresponding commands. 

To restore visibility of all the layers, switch off the  Single layer view mode button or close the Layers dialogue 

box.  
This mode is a quick alternative to switching off the visibility of all layers to edit the content of one layer. After 
selecting the mode, select any command and the Layers dialogue box closes and the selected layer will be 
displayed. To restore the visibility of all layers after editing, open the Layers dialogue box and the visibility of all 

layers is restored automatically. 

Creating and editing group of layers 
The Layers dialogue box allows merging of layers into groups. Grouping of layers is recommended when a 

document contains a lot of layers and you often need to change the settings of several layers; for example, to quickly 
block/unblock them or to control their printability. 

One layer can belong to different groups.  

Creation of a new group of layers 

To create a group of layers for all the document: 

 Select All in the categories tree. 



 Select the button  Add groupand the button  Show all layers (for group). To the left of the current 

layer icon column, the column  for selecting layers for the groups is shown.  

 Enter a group name (the default name is Group…N, where N – is the number of the created group). 

 Select layers to make a group. 

 Select the button  Show all layers (for group) to create the group. 

If a group is selected in the categories tree instead of All, a subgroup of layers will be created:  

 
When adding new layers to a subgroup they are automatically added to all parent groups. 

You cannot create a subgroup of layers for a filter. 

Editing a group of layers 

To add or exclude layers from a group: 

 Select the group in the categories tree. 

 Select the Show all layers (for group)  button. 

 In the  column for selecting layers for groups, select the layers to form the group. Layers of the parent group 

are always selected.  

Creating and editing filters 

A filter forms a list of layers that satify certain selection criteria. Selection in the filter is performed by one or several 
parameters of the layers; for example, selection of  layers having line weight 0.50 which can be printed.  



 

Creation of a new filter 

To create a layers’ filter for the whole document: 

 Select All in the categories tree. 

 Select the  Add filter button. The   Edit property button is automatically selected. 

 Enter a filter name (a filter has a default name FilterN, where N is the number of the created filter).  

 In the Editing of properties of the filter window, specify the selection criteria for the layers in the filter.  

 Criteria, specified in one row are linked with the logical “AND”.  

 Criteria, specified in different rows are linked with the logical “OR”. 

 The  Add and  Delete buttons are used to add or delete rows of selection criteria.  

 Select the  Edit property button to finish filter creation. 

A layer’s name is often used as a selection criterion. Names can be specified as templates.  

It is possible to use the following symbols in the template of a layer’s name: 

Symbol in a template Corresponding symbols in a layer’s name 

*  Asterisk Any sequence of symbols. 

?  Question mark Any symbol. 

# Hash Any figure. 

@ At sign Any letter. 

. Point Any symbol except a letter or figure. 

~ Tilde Any sequence of symbols except the sequence after the tilde.  

[   ] Square brackets Any symbol except the symbols in brackets. 

[ ~ ] Tilde in square 
brackets                    

Any symbol except the symbols in brackets. 

[ - ] Dash in square 
brackets 

Any symbol from the range starting with the symbol to the left of the dash and 
ending with the symbol to the right of the dash. 

` Backtick character Backtick character shows that the following symbol is an ordinary symbol and not 



special. 

If you select a group instead of the All element, a filter is created for the group. 

Editing layers’ filter 

To add to or exclude layers from a filter: 

 Select the All in the categories tree (to create a filter for all layers in the document) or a group (to create a filter 

only for the group). 

 Select the  Edit property button. 

 In the Editing of properties of the filter window specify the selection criteria for layers in the filter.  

 Criteria, specified in one row are linked with the logical “AND”.  

 Criteria, specified in different rows are linked with the logical “OR”.  

 The  Add and  Delete buttons are used to add or delete rows of selection criteria.  

 Select the  Edit property button to finish filter creation. 

Criteria symbols to select layers for a filter: 

 Visible layer. 

 Invisible layer. 

 Frozen layer. 

 Unfrozen layer. 

 Blocked layer. 

 Unblocked layer. 

 Layer available for printing. 

 Layer unavailable for printing. 

 Used layer. 

 Unused layer. 

“All used layers” filter 

By default, all nanoCAD documents contain a layer’s filter All used layers: 

 

The filter shows all layers used in the current document. A filter does not show unused layers in a document. You 
cannot delete this filter. 

“Invert layers” checkbox 

The Invert filter parameter below the categories tree can be used to display all the layers, which are not in the group, 

filter or configuration.  

For example, to display all unused layers in a document, select the All used layers and select the Invert filter. 

. 

When you deselect the Invert filter the list of layers recovers. 

It is often needed to display layers of a particular category.  

You can use the Invert filter for  this: 

 Select a group or a filter in the categories tree. 

 Select the Invert filter. 

 Select all layers in the list and make them invisible. 

Configurations of layers 
Configurations of layers are backup copies of layers’ parameters.  

Configurations are placed in the separate Configurations folder in the categories tree. 

A configuration is created for all layers in the document. 



To create a configuration, select the  Add configuration button. A new configuration has a default name – 

Configuration N, where N is the number of created configurations.  

A created configuration can be edited, e.g. to change the parameters of its layers. 

Configurations can be restored, renamed and deleted.  

A recovery of a configuration places a copy of the parameters of the layer with the same name into the document; it 
means recovering the parameters of the layers and returning them to the moment the configuration was created. To 
recover a configuration, select Restore from the context menu of the configuration: 

 
A configuration can be exported to a LAS-file and imported from a LAS-file or *.dwg file (Import and Export 

commands of the context menu).  

Line types 

 Menu: Format –  Styles… 

 Command line: LINETYPE 

Different line types have different purposes; for example, to create axes you use one type of line, another to create 
invisible lines –etc. Using different line types to create different objects improves visual perception of graphic data 
and makes working with drawings more efficient.    
Line type is a repeated sequence of lines, dots and spaces along a line or curve. Complex types of lines can contain 
built-in shapes which are stored in the (*.SHP) shape file. Line types are stored in files with a *.LIN extension. Every 
type has its own name; sequence of dashes, points, relative lengths of dashes and spaces and other characteristics 
are specified in a line’s description. One LIN-file can contain many line types. 
There is a GOST 2.303-68.lin file, containing descriptions of GOST line types, in nanoCAD. After installation of the 
program, you can find this file in c:\Documents and Settings\All Users\Application Data\Nanosoft\nanoCAD 2.5\SHX. 
There is a GOST 2.303-68.shx file, containing shapes, used to describe line types in the GOST 2.303-68.lin file, in 
this folder. 
nanoCAD supports line types created for AutoCAD. 
Users can create their own line types by adding their descriptions to an existing LIN-file or creating their own new 
files. Edit an existing file or create a new file in any text editor or text processor.   
There is a built in Line type editor to create user line types and edit existing ones.  

Before using a line type, you have to load it into the drawing. Loaded line types can be renamed when you are 
working with the drawing. Renaming a line type only changes its description in the current drawing;  the name of the 
line type stays the same in the LIN-file. 

Unused line types can be deleted in the Linetype Manger with the Purge command (File menu – Drawing Utilities).  

Note: By layer, By block and Solid line types cannot be renamed or deleted. 

All newly created objects inherit the line type currently set in the Linetype row of the Inspector window.  

Note: The Linetype drop-down list only contains loaded line types, shown in the Linetype Manager.  

If a current line type is specified By layer, new objects will have the line types defined for this layer. 



Line types can be assigned not only to layers, but also to objects. To change an object’s line type, replace it on the 
layer with another line type, change the line type of the layer where it is placed or specify another line type especially 
for the object.  

Line types are saved with the document in the *.dwg file. They can be saved in a (*.dwt) file template to transfer to 
another computer.  

Information about all line types in the document is shown in the Linetype Manger. Linetype Manager allows loading, 
deleting and renaming of line types. There is a button to open the built-in Edit Linetype dialogue box which allows 

you to create your own line types or editing existing line types. 

 
 Parameters: 

Line types Shows the list of line types loaded in the current document. 

Buttons 

  Add linetype Creation of a new style of line type using a selected type from the list as a base. 

  Delete linetype Removal of the selected line type from the current document. 

  Edit linetype Opens the Linetype Editor. 

  Open linetype Imports line types into the current document. 

  Save linetype Saves the selected line types into a file with *.LIN extension. 

Details  

Use paper space units 
for scaling 

Sets the same scale of line types for paper space and model space.  

This option is useful if you use several viewports at once. 

Global scale factor: Sets a global scale factor for all line types. 

Current object scale: Sets the scale factor for line types for newly created objects. The scale is a multiplication 
of the global scale and the current scale. 

Note: There is a context menu in the Linetype Manger: 



 

To set a line type as current:  

 Select the required line type in the dialogue box. 

 Click in the left field of the selected line type. The  tag appears, the line type is set as current. 

To import line types:  

 Select the  Load line type. 

 In the Open Line Type Import dialogue box, specify the path to load the line type file (*.LIN), containing the 

descriptions of the line types.  

 In the Load/Reset Line Types dialogue box, select the line types for import. To select several line types, use the 
SHIFT or CTRL buttons. 

 Select ОК to start loading the selected line types. 

 Select ОК to close the Linetype Manger dialogue box. 

To export line types:  

 In the dialogue box, select one or several line types to export (you can use SHIFT and CTRL buttons). 

 Select the Save linetype button. 

 In the Save Line Type Import select the folder and specify a name. 

 Select the Save button. 

 Select ОК to close the Linetype Manger dialogue box. 

To delete a line type: 

 In the dialogue box, select one or several line types to delete (you can use SHIFT and CTRL buttons). 

 Select the   Delete button. 

 Select ОК to close the Linetype Manger dialogue box. 

Line type Editor 
In the Linetype Manager you can edit the selected line type or created a new one using the built-in Linetype Editor: 



  

Parameters: 

Description of line 
types 

Description of line types is shown. 

Buttons 

  Add dash Adds a new element to a line. 

  Delete dash Deletes an element from a line. 

  Move dash up Moves one element up. 

  
Move dash 
down Moves one element down. 

 

Elements are selected in the Common section. 

There are the following options in the drop-down list: 

Dash 

Text 

Shape 

 

An element’s value is shown in the Geometry section. 

 

To edit a line type: 

 Select a line type in the Linetype Manager. 

 Select the  Edit linetype button to start the built-in Linetype Editor. There is a description of the selected 

line type in the Dashes field: 

 

 Select an element and enter its new value in the Length field of the Geometry section. 



Note 1: When you specify a positive value, a dash is drawn, when you specify a negative value, a space is drawn, 
when a value is zero a point is drawn.  

Note 2: The length of the first element must be greater than or equal to zero, i.e. the dash or point must be drawn first. 

 To display a new value, press ENTER or just click. 

 To add a new element, select the  Add dash button. A new element is added to the end of the list and a zero 

value is assigned to it by default. 

 Specify a new value for an added element in the Length field of the Geometry section. To display a new value 
press ENTER. 

 Select ОК to close the Edit Linetype dialogue box. 

 Select ОК to close the Linetype Manger dialogue box. 

To add text to a description of a line type: 

 In the Type field select the Text option: 

 

 In the Style field of the Text section, select a text style from the drop-down list. In the Text field enter symbols, 
specify parameters in the Geometry section: 

 

 Select ОК to close the Edit Linetype dialogue box. 

 Select ОК to close the Linetype Manger dialogue box. 

To add a shape to a description of a line type: 

 In the Type field select the Shape option: 

 

 В разделе Форма в поле Файл выбрать из раскрывающегося списка файл с формами, в поле Имя 
выбрать из раскрывающегося списка имя формы, в разделе Геометрия задать необходимые параметры: 

This needs changing to English 



 

 Select ОК to close the Edit Linetype dialogue box. 

 Select ОК to close the Linetype Manger dialogue box. 

Creation of a new line type 
 A new line type is created on the base of an existing one: 

 In the Linetype Manager select a line type. 

 Select the   New linetype button. The new row has a default name – Linetype1 appears.  

 Click Linetype1 and enter a new name. 

 In the Description field enter information about the line type. 

 Select the  Edit linetype button.  

 Change the parameters in the Edit Linetype dialogue box. 

 Select ОК to close the Edit Linetype dialogue box. 

 Select ОК to close the Linetype Manger dialogue box. 

Managing the transparency of objects 
Objects in nanoCAD have transparency properties. The transparency is used to reduce the visibility of objects or 
drawing fragments on the screen to increase the readability of the drawing.  
The Transparency parameter is displayed in the Inspector dialogue box (General section) when one or several 

objects are selected and can have values from 0 to 100: 

 
If a value is 100, the selected object becomes invisible. Totally opaque objects have values of 0. 
The transparency of objects is not shown when printing or previewing the document.  

To set the transparency for an object: 

 Select an object. 

 In the Transparency field of the General section in the Inspector dialogue box, specify the required value. 

This needs changing to English 



Geometric objects 

Base elements to create a drawing are graphic primitives – nanoCAD objects, which are whole objects and cannot be 
separated with the Explode command.  

Auxiliary lines 
Lines, infinite in one or both directions, are called rays and lines. Their lines can be used as auxiliary lines to create 
objects. It is recommended that auxiliary lines are created on a separate layer, which can be frozen or made 
unprintable. Auxiliary lines can be edited: copy, replace, rotate etc.  

Ray 

 Menu: Draw –  Ray 

 Toolbar: Draw –  

 Command line:  RAY 

This command creates a ray – a semi-infinite construction line. 

Command prompts:  

Specify start 

point: 

Specify start point. 

Specify 

through 

point: 

Specify second point. 

Specify 

through 

point: 

Specify next point or press ESC to finish the command. 

Construction Line 

 Menu: Draw –  Construction Line  

 Toolbar: Draw –  

 Command line: XL, XLINE 

This command creates an infinite construction line. 

Command options: 

Hor Creation of infinite line through the specified point and parallel X axis. 

Vert Creation of infinite line through the specified point and parallel Y axis. 

Command prompts:  

Specify start point or 

[Hor/Vert]: 
Specify start point. 

Specify through point: Specify second point. 

Linear objects 

Point 

 Menu: Draw – Point >  Single Point 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+Т  

 Command line: PO, POINT 



The command allows the creation of point objects which can be shown as a common point or a special symbol. 
Points are used to mark or as reference points for object snap. A point is shown as a special symbol because a point 
object of the default style is hard to see on the screen. 

The Point Styles dialogue box (Format menu) allows changing of the size of a point object and its style. 

Note: Changing the size and/or style of point objects affect not only new objects, but also created objects. 

Command prompts:  

Specify 

point: 

Specify the point coordinates or click on the drawing. 

Specify 

point: 

Specify the next point or press ESC to finish the command. 

Size and style of points 

 Menu: Format –  Points Styles… 

 Command line: DDPTYPE 

The Point Style dialogue box is used to display and change the current style and size of a point. The current display 

style of the point is highlighted.  

 

Parameters:  

Point Size: Specify point size. 

Set Size 
Relative to 
Screen 

Shows point size as a percentage of the screen size (the point size is not changed if the screen is 
zoomed). 

Set Size in 
Absolute units 

The point size is changed if the screen is zoomed. 

To change the current size and style of a point: 

 Select the style; 

 Specify the point size in the Point Size dialog. 



Two points 

 Menu: Draw –  Two points 

 Toolbar: Draw –   

 Hotkeys: CTRL+ALT+L  

 Command line: L, LINE 

The two point segment is one of the base primitives and is often used for drawing. Segments can be drawn 
separately and merged into zigzag lines. 

Command options: 

Undo Deletes the last created segment. 

Close Creates the segment, connecting the last point of the last segment with the start point of the first 
segment. This option is available after the creation of the second segment. 

 

 

Command prompts:  

Specify first point: Specify point 1. 

Specify next point: Specify point 2. 

Specify next point [Undo]: Specify next point or select Undo to cancel previous action. 

Specify next point [Undo/Close]: Specify next point or select Close to create closed contour. 

Specify next point [Undo/Close]: Specify next point or press ESC to finish the command. 

Polyline 

 Menu: Draw –  Polyline  

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+P  

 Command line: PL, PLINE 

A polyline can contain linear and arc segments and their combinations and is a graphic primitive. Arc segments of a 
polyline are created by two points, or by angle,  centre and tangent or arc radius. 

Command options of linear segments: 

Arc Arc segment mode. 

Close Closes a polyline by linear segment. 

Halfwidth Halfwidth of polyline segment. 

Length Length of segment, created as continuation of the previous segment and in the same direction. 

Undo Deletes the last created segment. 

Width Width of following segments. 

Command options of arc segments:  

Angle  Centre angle (positive value – arc is created counterclockwise; negative value – arc is created 
clockwise). 

Center  Centre of arc. 



Close Closes a polyline with an arc segment. 

Direction Direction of tangent. 

Halfwidth Halfwidth of polyline segment. 

Line Linear segment mode. 

Radius Arc radius. 

Second pt Second point of arc in three point creation. 

Undo Deletes the last point. 

Width Width of following segments. 

 

Command prompts:  

Specify start point: Specify point 1. 

Specify next point or 

[Arc/Halfwidth/Length/Undo/Width]: Specify point 2. 

Specify next point or 

[Arc/Close/Halfwidth/Length/Undo/Width]: 
                                                                             
Select Arc to create an arc segment. 

Specify endpoint of arc or 

[Angle/Center/Close/Direction/Halfwidth/Line/Radius/Sec

ond pt/Undo/Width]: 

 

                                                                         
Specify endpoint 3 of arc. Press ENTER to 
finish command. 

Polygon 

 Menu: Draw –  Closed Polygon  

 Toolbar: Draw –  

 Command line: POL, POLYGON 

The command creates polygons with similar sides from closed polylines. The rotation angle of the polygon is 
specified from the horizontal axis before point 2. 

Command options: 

Edge Creation of a polygon by edge. 

Inscribed Creation of an inscribed polygon. 

Circumscribed Creation of a circumscribed polygon. 

Command prompts when creating a polygon by side:  

Enter number of sides <6>: Enter number of sides for polygon. 

Specify center of polygon or [Edge]: Select Edge. 

Side Inscribed Circumscribed 

 
 

 



Specify first endpoint of edge: Specify point 1. 

Specify second endpoint of edge: Specify point 2. 

Command prompts when creating a polygon by radius:  

Enter number of sides <6>: Enter number of polygon’s sides. 

Specify center of polygon or [Edge]: Specify  centre point 1. 

Extend <"Inscribed"> or 

[Inscribed/Circumscribed]: Select option. 

Specify radius of circle: Specify radius (point 2). 

Rectangle 

Rectangle by two points 

 Menu: Draw – Rectangle by >  Two points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+R  

 Command line: REC,RECT,RECTANG,RECTANGLE 

The command creates a rectangle from two opposite points. 

Command options: 

Chamfer Fillet sizes for rectangle’s corner. 

Elevation Current elevation. 

Fillet Fillet of rectangle’s corners. 

Thickness Current three-dimensional height. 

Width Width of polyline to create a rectangle. 

Area Area of rectangle. 

Length Length of rectangle. 

Width Width of rectangle. 

Dimension Height and length of rectangle. 

Rotation Rotation angle of rectangle. 

 

Command prompts:  

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: 
Specify first corner (point 1). 

Specify other corner point or 

[Area/Dimensions/Rotation]: 
Specify second corner (point 2). 

Rectangle by three points 

 Menu: Draw – Rectangle by >  Three points 

 Toolbar: Draw –  

 Command line: FRAME 



The command creates a rectangle by angle and two sides. 

 

Command prompts:  

Specify first point of 

rectangle: 

Specify rectangle’s angle (point 1). 

Specify second point of 

rectangle: 

Specify length of first side (point 2). 

Specify third point of 

rectangle: 

Specify length of second side (point 3). 

Curved objects 

Arc 
An arc can be created with different methods. There are 11 ways to create an arc in nanoCAD. 

Arc by three points 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 

Command options: 

Center Arc  centre. 

Angle Arc angle. 

chordLength Chord length. 

End End point of arc. 

Angle Arc angle. 

Direction Direction of tangent from the start point of the arc. 

Radius Radius. 

 

Command prompts:  

Specify start point of arc or 

[Center]: 
Specify start point 1. 

Specify second point of arc or 

[Center/End]: 
Specify second point 2. 

Specify end point of arc: Specify end point 3. 

Arc by  centre, start and angle 

 Menu: Draw – Arc >  Center, start, angle 



 Toolbar: Draw –  

 Command line: ARC2 

 

Command prompts: 

Specify center 

point of arc: 

Specify arc  centre (point 1). 

Specify start point 

of arc: 

Specify start point 2. 

Specify included 

angle: 

Specify angle (point 3). 

Arc by  centre, angles and radius 

 Menu: Draw – Arc >  Center, angles, radius 

 Toolbar: Draw –  

 Command line: ARC3 

 

Command prompts:  

Specify center 

point of arc: 

Specify  centre of arc (point 1). 

Specify start angle 

of arc: 

Specify start angle (point 2). 

Specify end angle 

of arc: 

Specify end angle (point 3). 

Specify radius of 

arc: 

Specify radius (point 4). 

Arc by  centre, start and end 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 

 

Command prompts:  

Specify start point of arc or [Center]: Select  Center. 



Specify center point of arc: Specify arc  centre (point 1). 

Specify start point of arc: Specify start point 2. 

Specify end point of arc or 

[Angle/chordLength]: 
Specify end point 3. 

Arc by  centre, start and chord length 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 

 

Command prompts:  

Specify start point of arc or [Center]: Select  Center. 

Specify center point of arc: Specify arc  centre (point 1). 

Specify start point of arc: Specify start point 2. 

Specify end point of arc or 

[Angle/chordLength]: 
Select chordLength. 

Specify length of chord: Specify chord length (point 3). 

Arc by start,  centre and end 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 

 

Command prompts:  

Specify start point of arc or [Center]: Specify start point 1. 

Specify second point of arc or 

[Center/End]: 
Select  Center. 

Specify center point of arc: Specify arc  centre (point 2). 

Specify end point of arc or 

[Angle/chordLength]: 
Specify end point 3. 

Arc by start,  centre and angle 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  



 Command line: A, ARC 

 

Command prompts:  

Specify start point of arc or [Center]: Specify start point 1. 

Specify second point of arc or 

[Center/End]: 
Select  Center. 

Specify center point of arc: Specify arc  centre (point 2). 

Specify end point of arc or 

[Angle/chordLength]: 
Select Angle. 

Specify included angle: Specify  centre angle (point 3). 

Arc by start,  centre and chord length 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 

 

Command prompts:  

Specify start point of arc or 

[Center]:: 
Specify start point 1. 

Specify second point of arc or 

[Center/End]: 
Select  Center. 

Specify center point of arc: Specify arc  centre (point 2). 

Specify end point of arc or 

[Angle/chordLength]: 
Select chordLength. 

Specify length of chord: Specify chord length (point 3). 

Arc by start, end and angle 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 



 

Command prompts:  

Specify start point of arc or [Center]: Specify start point 1. 

Specify second point of arc or 

[Center/End]: 
Select End.  

Specify end point of arc: Specify end point 2. 

Specify center of arc or 

[Angle/Direction/Radius]: 
Select Angle. 

Specify included angle: Specify  centre angle (point 3). 

Arc by start, end and direction 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 

 

Command prompts:  

Specify start point of arc or [Center]: Specify start point 1. 

Specify second point of arc or [Center/End]: Select End. 

Specify end point of arc: Specify end point 2. 

Specify center of arc or 

[Angle/Direction/Radius]: 
Select Direction. 

Specify tangent direction for the start point 

of arc: 

Specify tangent direction (point 3). 

Arc by start, end and radius 

 Menu: Draw – Arc >  3 points 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+A  

 Command line: A, ARC 

 

Command prompts:  



Specify start point of arc or [Center]: Specify start point 1. 

Specify second point of arc or 

[Center/End]: 
Select End. 

Specify end point of arc: Specify end point 2. 

Specify center of arc or 

[Angle/Direction/Radius]: 
Select Radius. 

Specify radius of arc: Specify arc radius (point 3). 

Circle 

Circle by centre and radius  

 Menu: Draw – Circle >  Center, radius 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+C  

 Command line: C, CIRCLE 

Command options: 

3P Circle by three points. 

2P Circle by diameter. 

TTR Circle by two tangents and radius. 

Diameter Circle by  centre and diameter. 

 

Command prompts:  

Specify center point of circle 

or [3P/2P/TTR]: 
Specify centre (point 1). 

Specify radius: Specify radius of circle (point 2). 

Circle by centre and diameter 

 Menu: Draw – Circle >   Center, radius 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+C  

 Command line: C, CIRCLE 

Command options: 

3P Circle by three points. 

2P Circle by diameter. 

TTR Circle by two tangents and radius. 

Diameter Circle by  centre and diameter. 



 

Command prompts:  

Specify center point of circle 

or [3P/2P/TTR]: 
Specify centre (point 1). 

Specify radius or [Diameter]: Select Diameter. 

Specify diameter: Specify diameter (point 2). 

Circle by diameter  

 Menu: Draw – Circle >  Diameter 

 Toolbar: Draw –  

 Command line: CIRCLE2 

 

Command prompts:  

Specify first end point for circle’s 

diameter: 

Specify first point 1 for circle diameter 

Specify second end point for circle’s 

diameter: 

Specify end point 2 for circle diameter 

Circle by three points  

 Menu: Draw – Circle >  3 points 

 Toolbar: Draw –  

 Command line: CIRCLE3 

 

Command prompts:  

Specify first point on 

circle: 

Specify first point. 

Specify second point on 

circle: 

Specify second point. 

Specify third point on Specify third point. 



circle: 

Circle by two tangents and radius 

 Menu: Draw – Circle >   Center, radius 

 Toolbar: Draw –  

 Hotkeys: CTRL+ALT+C  

 Command line: C, CIRCLE 

 

Command prompts:  

Specify center point of circle or 

[3P/2P/TTR]: 
Select the TTR. 

Specify a point on first tangent 

object: Select a first tangent object (point 1). 

Specify a point on second tangent 

object: Select a second tangent object (point 2). 

Specify radius: Specify radius of circle. 

Spline 

 Menu: Draw –  Spline  

 Toolbar: Draw –  

 Command line: SPL, SPLINE 

A spline is a smooth curve passing through a given set of points. Example of spline usage: line breaks of objects, 
horizontals in GIS. 

Command options: 

Object Converts a polyline, smoothed by the Spline command, to an equivalent spline. 

Close Closes a spline. 

Fit 

tolerance 
The maximum distance from a spline curve to any points defining it. 

 

Command prompts:  

Specify first point or [Object]: Specify a start point 1. 

Specify second point: Specify second point 2. 

Specify next point or[Close/Fit tolerance] 

<start tangent> 

Specify 3, 4, 5 etc. points. 

Specify next point or[Close/Fit tolerance] 

<start tangent> 

Press ENTER to finish specifying points. 



Specify start tangent: Specify a tangent 6 for the start spline point. 

Specify end tangent: Specify a tangent 7 for the end spline point. 

Ellipse 

Ellipse by  centre and radiuses 

 Menu: Draw – Ellipse By >  Center and Radiuses 

 Toolbar: Draw –  

 Command line: ELLIPSE1 

The command creates an ellipse by  centre and radiuses.  

Command options: 

Arc Elliptic arc mode 

Center Central point of ellipse. 

Rotation Relation between ellipse axes by rotation around first axis. 

 

Command prompts:  

Specify center point of ellipse: Specify centre point for ellipse (point 1). 

Specify endpoint of axis: Specify first radius (point 2).  

Specify distance to other axis or 

[Rotation]: 
Specify second radius (point 3).   

Ellipse by diameter and radius 

 Menu: Draw – Ellipse By >  Diameter and Radius 

 Toolbar: Draw –  

 Command line: ELLIPSE2  

The command creates an ellipse by diameter and radius. 

 

Command prompts:  

Specify axis endpoint of ellipse: Specify point 1. 

Specify other axis endpoint of 

ellipse: 

Specify diameter of ellipse (point 2). 

Specify distance to other axis or 

[Rotation]: 
Specify radius of ellipse (point 3).  

Elliptic Arc 

 Menu: Draw – Ellipse By >  Elliptic Arc 

 Toolbar: Draw –  

 Command line: ELLIPTICARC 



Command options: 

Center  Centre of elliptic arc. 

Rotation Relation between ellipse axes by rotation around the first axis 

Parameter Select Parameter when specifying the start and end points of the elliptic arc to create an elliptic arc 
according to the parameter vector: p(u) = c + a* cos(u) + b* sin(u), where с – ellipse centre; а – major 
axis; b -  minor axis. 

Inner 

angle 
Inner angle of the elliptic arc; specified relative to the origin angle. 

Angle Switch between Parameter and Angle modes. 

 

Command prompts:  

Specify axis endpoint of elliptical arc or 

[Center]: 
Specify point 1. 

Specify other axis endpoint of elliptical arc: Specify length of ellipse axis (point 2). 

Specify distance to other axis or [Rotation]: Specify length of another axis (point 3).  

Specify start angle or [Parameter]: Specify start angle (point 4). 

Specify end angle or [Parameter/Inner angle]: Specify end angle (point 5). 



Editing objects 

To edit objects and their parameters you have to select them on the drawing. It is possible to edit them using grips 
and their properties in the Inspector window. 

By double clicking on objects, the editing command starts or the Inspector dialogue box appears. According to the 

object’s type, the editing command opens an editing dialogue box (dimensions, notes) or offers to edit parameters in 
the command line (polylines, spline). 

Selection of objects 
To edit objects you have to select them.  

There are different ways to select objects in nanoCAD.  

One of the main ways to select objects is  by using the cursor. Objects can be selected separately or in groups: 

 Selection of separate objects is performed with the pickbox. 

 Selection of a group of objects is performed using a rectangular selection area. 

The order in which the corners of the area are specified is important when you select a group: 

 If the corners of the area are specified from left to right (selection with window), only objects that are entirely 
inside the window are selected. 

 If the corners of the area are specified from right to left (selection with crossing window), objects are selected 
that are entirely inside the window and also those that are crossed by the window. 

For better visual perception a window is displayed with a solid line and the area inside it is highlighted in blue; a 
crossing window is displayed with a dotted line and the area inside it is highlighted in green.  

Selection with window Result 
Selection with crossing 

window Result 

    

It is important which selection mode is selected in the Inspector window when you select objects: 

 If the multiple selection mode is switched on (the button  ), all newly selected objects are added to the set. 

Objects selected in this mode are excluded from the set if you press Shift. 

 If single selection mode is switched on (the button  ), only newly selected objects are added to the set. 

Objects selected in this mode are added to the set if you press Shift. 

Selection of objects using the command line 
For many editing commands, you can launch additional options for object selection in the command line.  

 Start an editing command. 

 To the command prompt about object selection enter? (question mark): 

Select objects: ? 

 Press ENTER: 

Select an option or 

[Window/Last/Crossing/Box/All/Fence/Wpolygon/Cpolygon/Group/Add/Remove/AUto]: 

 Select the required option.  

Command options: 

Window Selection of objects that are entirely inside the rectangular area, specified by two points from left to 
right. 

Last Selection of the last created object.  

Objects cannot be on a frozen layer. 

Crossing Selection of objects, crossed by the rectangular area or inside the rectangular area, specified by two 
points from right to left. 

Box Selection option, with choice of Window  orCrossing options.  

If points in the rectangular area are specified from right to left, the selection of objects is equal to the 



Crossing option. 

If points in the rectangular area are specified from left to right, the selection of objects is equal to the 
Window option. 

All All objects are selected, excluding objects belonging to blocked or frozen layers. 

Fence Selection of objects crossed by the selection line. 

WPolygon Selection of objects which are entirely inside the polygonal area. 

A polygon can have any shape, but there must not be any self-intersections. 

The segment of a polygon created last is the closing segment. 

CPolygon Selection of objects which are entirely inside the polygonal area or are crossed by this area. 

A polygon can have any shape, but there must not be any self-intersections. 

The segment of a polygon created last is the closing segment. 

Group Selection of objects in the specified group. 

Add Adds objects to the current set using any selection method . Automatic mode and adding mode are 
used by default (Auto and Add modes).  

Remove Deletes objects in the current set using any selection method .  

You can exclude objects by pressing the SHIFT button in the adding mode (Add mode) or automatic 

mode (Auto mode). 

AUto Selection of objects with pickbox. 

When an empty area is selected by the pickbox, the Box option is switched on and the first point of 

the window or crossing window is specified. 

Automatic mode and adding mode are used by default (Auto and Add modes). 

Question mark (?) can be entered not only to the prompt select objects:, but as an answer to any prompt to 

select objects containing ahint . For example: 

Select objects to trim or [Fence/Crossing/Project/Edge/ERase/Back]:, 

Etc. 

While the command is being performed, you can launch a prompt with selection options many times. 

Selection of all objects 

 Menu: Edit –  Select all 

 Hotkeys: CTRL+A  

 Command line: SELECTALL  

The command allows the selection of all objects in the current drawing, except objects on frozen layers. 

The command is available from the context menu. 

To cancel the selection, press ESC. 

Selection of superimposed objects 
Selection of objects which are very close to each other is not difficult in nanoCAD. 

If several objects are in cursor’s pickbox: 

  
the dialogue box automatically opens showing the list: 



 

Parameters: 

All Selection of all the objects in the dialogue box list. 

Nothing  No objects in the dialogue box list are selected.  

Pressing ESC is also cancels the selection and closes the dialogue box. 

Placing the cursor over any object in the list highlights it on the screen. Clicking on any object in the dialogue box 
selects it. The dialogue box closes after an object is selected.  

Examples of different object selection: 

Selection of circle Selection of arc  Selection of diameter size  

   

The Show selection dialog command from the View menu switches on/off display of the Selection dialogue box.  

Selection of objects using the Inspector 

 Menu: Modify –  Properties... 

 Toolbar: Main –  

 Hotkeys: CTRL+1  

 Command line: INSP, INSPECTOR, PROPERTIES 

There are buttons for modes and commands to select objects in the top part of the Inspector dialog: 

 

Mode and commands to select objects 

Modes of object selection 

 
Multiple 
selection 

Mode of multiple object selection; all the selected objects are added to the previous selection 
set.  

ESC cancels the selection .  

Objects selected in this mode are excluded from the set if you press Shift. 

 
Single 
selection 

Mode of single object selection; all newly selected objects are added to the selection set.  

Previously selected objects are removed from the set.  



Objects selected in this mode are added to the set if you press Shift. 

Commands of object selection 

 Select 
Selection of objects using the cursor. 

 
Select 
similar 
objects 

Only objects, whose properties correspond to the specified template object are selected. In the 
Property Settings dialogue box you can specify the properties for object selection. The 
dialogue box opens if you select  Settings in the command prompt: Select patterns or 
[Settings]: 

 

Note 1: If no property is selected, objects of the same type as the template object will be 
selected. 

Note 2: If one property is selected (for example Color), objects of the same type and colour as 
template object will be selected. 

Note 3: If several properties are selected (for example, Color, Layer and Lineweight) objects 

are selected: 

- Objects of the same type and colour as the template object, 

- Objects of the same type and layer as the template object, 

- Objects of the same type and lineweight as the template object, 

  
Remove 
from 
selection Excludes the specified objects from the selection set. 

  
Leave in 
selection Leaves only the specified objects in the selection set. 

To exclude objects from a selection set 

To exclude objects from a selection set:  

 Select the Select all in the context menu or from the Edit menu: 

 
All objects in the drawing will be selected. 

 Select the object type that you want to exclude from the set in the drop down list in the Object type of the 
Inspector window:  



 

 Select the   Remove from selection. All objects of the specified type will be deleted from the selection set. 

 Select another type of object in the drop-down list. 

 Select the   Remove from selection.  

 Selection and removal of objects can be repeated until only the required objects remain. 

To leave objects in a selection set  

To leave only specified objects in a selection set:  

 Select Select all in the context menu or from the Edit menu. All the objects in the drawing will be selected. 

 Select the object type which you want to exclude from the set in the drop down list in the Object type of the 
Inspector window. 

 Select the  Leave in selection. All objects, except the specified type, will be deleted from the selection set.. 

Quick selection of objects 

 Menu: Edit –  Quick Select…  

 Command line: QS 

Using the Quick select command you can select inserted objects  using specified conditions. 

The Quick Select command can be launched from the context menu: 

 
In the Quick Selection dialogue box you can adjust the search conditions: 



 

Parameters: 

Search There are selection areas in the drop-down list: 

 
Available options: 

In whole document – search in the whole document. 

In current space – search in the current space. 

In bounding box – search in the selected rectangular area in the drawing. 

In current selection – search among selected objects in the drawing. 

If In bounding box or In current selection is selected, the Quick Selection dialogue box temporarily 

closes  to allow the rectangular area to be specified on the screen or for objects to be selected .  

The  Set selection button becomes available after the area is specified or the objects are selected; 

using this button you can select a new rectangular area or change the current set of objects. 

 
This button  allows found objects to be added to selected objects on the drawing. According to which 
method is selected,  the view of a button can be changed. 

The following methods are available: 

 Result set to new selection – Objects corresponding to the specified search conditions are 

selected in the drawing, other objects are deselected. 

 Result add to selection – Found objects will be added to the selected objects on the drawing. 

 Result subtract from selection – If objects were selected, they become deselected. 

Filter templates:  Using a set of tools you can select objects using set and saved conditions. 

 
Load preset 

 
 

Save preset  

 
Remove preset 



To add a condition for object search:  

 Click in the <Select object type> field and select the required object type from the list:  

 
To reject the selection, click on None. 

 There is a list of parameters of all objects belonging to this type and to the specified selection area: 

 

 Select the value of the required search parameter in the Value column: 

 

 Select a logic search condition in the ExprType column: 

 
Available logic conditions for search: 

= equals 

!= does not equal 

< less 

> more 

>= not less 



<= not more 

Like Search of substring. 

Searches for objects whose parameter value contains the substring specified in the ExprType 
column. 

Unlike Search of substring. 

Searches for objects whose parameter value does not contain the substring specified in the 
ExprType column. 

Note: for every object type you can set numerous search conditions using one or several parameters. 

 To add another type of object, click on the <Select object type>bottom  field: 

 
The number of objects satisfying the search conditions is displayed in the bottom part of the dialogue box: Object 
found: 3. 

Ways to edit objects 
You can edit objects (change their properties) in different ways: 

 Editing with the Styles toolbar; when a text or dimension style for the selected objects is changed. 

 Using the Main toolbar; when a layer, colour, type or lineweight for previously selected objects is changed. 

 Using the Inspector window. 

 Editing of text objects (search and replace) using the Search and Replace. 

 Using the Copy object properties command. 

 Using the Windows  clipboard. 

 Editing with grips; the selected objects are highlighted (object lines become dotted) and marked with special 
markers, small blue rectangles, placed at the characteristic points of the objects. The markers of grips can be 
triangles, circles, rhombs etc. The colour of markers can be light blue or green. 

 Editing using editing commands; the editing command starts (for example, Copy from the Edit menu) and 
objects are selected. For many commands you can first select objects and  then start the editing command. 

 Editing by double clicking on an object and an editing command relevant to the object’s type starts. It can be the 
Inspector dialogue box, if it was closed. The editing command can open a dialogue box to edit the object’s 

properties (dimensions, notes, tables etc.) or offer to edit in the command line (for example, polylines and 
splines).  

Copy of objects properties 

 Menu: Modify –  Copy object properties 

 Toolbar: Main –  

 Command line: MATCHPROP 

This command is used to copy a part of the selected object properties or all of them and assign them to one or 
several objects. 

You can copy colour, layer, linetype, lineweight and other properties. 

Command options: 

Settings Opens the Property Settings dialog. 

Command prompts:  

Select source objects: Select a source object. 

Select destination object(s) or 

[Settings]: 
Select object(s) to assign the copied properties to or select 
the Settings.  

Select destination object(s) or 

[Settings]: 
Select object(s) or pres  ENTER to finish the command. 



The Settings option opens the Property Settings dialogue box where you can specify the copied properties from the 

source object:  

 

Parameters: 

Basic properties 

Color Switches on/off the colour copying mode . 

Layer Switches on/off the layer copying mode . 

Linetype Switches on/off the linetype copying mode . 

Linetype Scale Switches on/off the linetype scale copying mode . 

Lineweight Switches on/off the lineweight copying mode . 

Thickness Switches on/off the height copying mode . 

Special properties 

Dimension Switches on/off the dimension style copying mode . 

Polyline Switches on/off the width and type of polyline mode . 

Material Switches on/off the material copying mode . 

Text Switches on/off the text style copying mode. 

Viewport Switches on/off the viewport properties copying mode . 

Shadow display Switches on/off the shadow display copying mode . 

Hatch Switches on/off the hatch copying mode . 

Table Switches on/off the table style copying mode . 

Multileader Switches on/off the leader note style copying mode . 

Copying and insertion of objects using  clipboard 
The clipboard can be used to copy a drawing or part of it from one document to another. Data copied to the clipboard 
can be inserted into other applications, for example into open documents in MS Office.  

nanoCAD commands using the clipboard are in the Edit menu. 



Cut 

 Menu: Edit –  Cut 

 Toolbar: Main –  

 Hotkeys: CTRL+X  

 Command line: CUT, CUTCLIP 

This command deletes the selected objects from the document and places them on  the clipboard . 

Copy 

 Menu: Edit –  Copy 

 Toolbar Main –  

 Hotkeys: CTRL+C  

 Command line: COPYCLIP 

This command copies the selected objects and places a copy of them on the clipboard . 

Copy With Base Point 

 Menu: Edit –  Copy With Base Point 

 Hotkeys: CTRL+SHIFT+C  

 Command line: COPYBASE 

This command copies the selected objects and places a copy of them on the clipboard . When copying, a base point 
is specified and it is used to insert a copy of the objects into the document. 

Paste 

 Menu: Edit –  Paste 

 Toolbar: Main –  

 Hotkeys: CTRL+V  

 Command line: PASTE, PASTECLIP 

This command inserts the contents of the clipboard into the document. 

Paste as block 

 Menu: Edit –  Paste as Block 

 Hotkeys: CTRL+SHIFT+V  

 Command line: PASTEBLOCK 

This command inserts the contents of the clipboard as a block into the document. 

Paste to Original Coordinates 

 Menu: Edit –  Paste to original coordinates 

 Command line: PASTEORIGIN 

This command inserts objects from the clipboard into the document with the same coordinates that they had in the 
initial document.  

Editing objects using ordinary grips  
Editing commands can be applied to objects previously selected and marked with grips. Available parameters can be 
changed in the Inspector dialogue box. Sometimes, editing with grips is the quickest and most effective method to 

change the shape and location of objects because actions with grips are performed with the cursor, so you do not 
need to use menus and toolbars.  

You can use grips to move, copy, stretch or scale objects. 



The number and location of grips depends on the selected object’s type; for example, a line segment has 3 grips. 
Two of them located at the endpoints and one in the middle, 5 grips are displayed for circle, four of them are located 
in the quadrants and one in the  centre etc.: 

Line Polyline Polygon Rectangle Arc Circle 

      

Spline Ellipse Block Note Text Dimension 

      

All newly selected objects are added to the current selection set of objects. To delete objects from a set, press and 
hold the SHIFT button during selection of objects. 

To switch to the editing mode with grips, click on any grip after the objects are selected. The selected grip becomes 
active and changes its colour to red. This grip is used to perform editing operations and is called the base. According 
to which grip is selected as the base, the object can be copied, moved, stretched and scaled by moving the cursor. 

The selected base grip is snapped to the cursor’s crosshair and moved with it until you click to specify a new grip 
position.  

Any grip in the drawing can be specified as the base if you select the Base option in the command line after the base 
point is selected: 

Specify stretch point or [Base/Copy/Undo/Exit]: 

Options available in the command line  for editing with grips: 

Base Specify a point as the base. 

Copy Switch to copying mode. 

Undo Cancels the last operation. 

Exit Exits from the editing with grips mode. The display mode of the selected objects is not cancelled. 

You can make several grips active  if the SHIFT button is pressed during grips selection. Editing with grips mode is 
switched on after one of these grips is selected as the base (select it without SHIFT button). 

You can change grips in the Grips section of the Options dialog: 

 

Editing objects using multifunctional grips  
Grips that can change editing mode in rotation are called multifunctional.  Rotation of editing modes is carried out for 
the active (selected) grip using the CTRL button. 

Objects which have multifunctional grips: 

 line segment, 

 arc, 

 spline, 

 polyline, 

 hatch, 

 viewport. 

To edit objects with multifunctional grips: 

 Select an object. 

 Activate the multifunctional grip. 

 Press CTRL to select the editing variant.  



 Move the cursor for dynamic display of an object’s properties. 

 Click to  confirm the change. 

Segment editing 
A line segment has multifunctional grips at the endpoint. Two editing modes are available 

 Normal mode: the length of the segment changes when you move the grip. In general, not only the segment 
length is changed, but also its orientation. 

 Change of length: only the length of the segment changes when you move the grip. A new position for the 
endpoint is provided by the projection of the specified point along the segment’s imaginary extension. Segment 
orientation is not changed.  

Normal mode Change of length 

  

Arc editing 
Multifunctional grips are at the endpoints and in the middle of the arc. Three editing modes are available: 

 Normal mode: when you hold and move a grip on the end or middle point, the length and radius are changed: 

  

 Change of  arc length: when you hold and move a grip on the end point, only the length is changed: 

 

 Change of arc radius and length, when you hold and move the grip on the middle point, an arc is created similar 
to the source arc: 

 

Spline editing 
Spline has two editing modes with grips: 

Editing of characteristic points (rectangular grips): allows the shape of a small part of the spline to be changed. . 
Editing of control vertexes (round grips ape): allows the general shape of a spine to be changed. . 

To switch between modes, click on a round grip located near the spline and having a bigger diameter than the grips 
of the control vertexes. 

Grips of characteristic points Grips of control vertexes 



  

Polyline editing 

Polyline has multifunctional grips at the end of the segments and in the middles of the segments. Rotational editing 
modes,  accessed with the CTRL button, depend on the location of the grips (end point or middle point) and segment 
type (linear or arc). 

 For improved functionality, additional symbols are displayed beside the polyline shape and near the cursor. Which 
symbols are shown depends on the editing mode selected: 

 
Adds a vertex 

 
Deletes a vertex. 

 
Transforms a linear segment to an arc. 

 
Transforms an arc segment to linear. 

Absence of a symbol means that the normal editing mode is current  - stretching by moving a segment or stretching a 
vertex (depends on selected grip). 

Variants of polyline editing with grips in vertexes 

Adding vertex Deleting vertex Stretching with vertex 

   

Variants of polyline editing with grips in the middle of a linear segment: 

Adding vertex Transforming to arc segment Stretching 

   

Variants of polyline editing with grips in the middle of an arc segment: 

Adding vertex Transforming to linear segment Stretching 

   

A multifunctional mode for editing polylines can be applied to several grips located in vertexes. Two editing variants 
are available: normal stretching of the polyline and deleting of selected vertexes. Instead of deleted vertexes, a linear 
segment is drawn, even if arc segments are between the deleted vertexes. 

Stretching vertexes Deleting vertexes 



  

To edit several vertexes of a polyline using multifunctional grips: 

 Press SHIFT. 

 Select the required grips with SHIFT pressed. 

 When you finish selecting grips, release SHIFT. 

 Select a base grip. 

 Select an editing mode with CTRL. 

 Move the cursor for dynamic display of the polyline shape. 

 Click to fix changes. 

Editing viewports of paper space 
You can edit any viewports of paper space using multifunctional grips where closed polylines and splines are used as 
boundaries. The process of editing the boundaries of the viewport is the same as editing of a spline or polyline with 
multifunctional grips. 

As viewports consist of two objects (viewport and display border), to edit them in the Selection dialogue box select a 
polyline or spline, not a viewport: 

 
If display of the Selection dialogue box is switched off, select a polyline or spline in the Inspector window in the 
Object type  field: 

  
Select a viewport with a window or crossing window, if you select with the pickbox in the Object type field in the 
Inspector window, Viewport is displayed by default. 

Editing hatch and fill 
In nanoCAD, using multifunctional grips you can edit the shape of: 

 associative hatches, which use closed polylines and splines as linked contours; 

  non-associative hatches. 

Changing the shape of an associative hatch using multifunctional grips and a linked contour does not differ from the 
editing of a polyline or spline using multifunctional grips. 

If you select non-associative hatch, the same multifunctional grips are displayed as in a polyline, except the round 
grips  are used to move the hatch: 



 
The process of editing a non-associative hatch shape is the same as editing of a polyline with multifunctional grips. 

Variants of non-associative hatch shape editing with grips in a boundary vertex: 

Adding of boundary vertex Deleting of boundary vertex Stretching boundary by top 

   

Variants of non-associative hatch shape editing with a grip in the middle of a boundary linear segment: 

Adding of boundary vertex Transforming of linear segment of 
boundary into arc segment  

Stretching 

   

Variants of non-associative hatch shape editing with a grip in the middle of a boundary arc segment: 

Adding of boundary vertex Transforming of arc segment of 
boundary into linear segment 

Stretching 

   

For non-associative hatch, a multifunctional editing mode can be applied to several grips located in the boundary 
vertexes. Two variants of editing are available: normal stretching of boundary and deleting of selected vertexes. 
Instead of deleted vertexes a linear segment is drawn, even if arc segments were between deleted vertexes. 

Stretching of  boundary vertexes Deleting boundary vertexes 



  

To edit several vertexes of non-associative hatch area using multifunctional grips: 

 Press SHIFT. 

 Select the required grips with SHIFT pressed. 

 When you have selected the grips, release SHIFT. 

 Select a base grip. 

 Select an editing mode with CTRL. 

 Move the cursor for dynamic display of the hatch shape. 

 Click to fix changes. 

Commands to edit geometric objects 

Lengthen objects 

 Menu: Modify –  Lengthen objects 

 Command line: LEN, LENGTHEN 

Using the Lengthen command you can change the central angle of arcs and the length of lines, arcs and open 

polylines. The length or angle of objects is changed on the side closest to the specified point. The length or angle of 
an object can be changed several times whilst one command is being performed. If a value is positive, the arc is  
lengthened, if a value is negative – the arc is shortened. 

Command options:  

DElta The value of the object’s length is changed. 

Angle The value of the object’s  centre angle is changed. 

Percent The object’s length as a percentage of the source length. 

Total The total length or  centre angle. 

DYnamic Dynamic change of the selected object’s length by replacing the endpoint closest to the selection point 
with the fixed position of another endpoint. 

 

Selection of object Specifying a new length Result 

   

Command prompts:  

Select objects or[DElta/Percent/Total/DYnamic]: Select the DYnamic. 

Select an object to change: Specify an object. 

Select an object to change: Specify an object or press ESC to finish the 
command. 



Trim vectors  

 Menu: Modify –  Trim vectors 

 Toolbar: Modify –  

 Command line: TR, TRIM 

The Trim vectors command allows the trimming of vector objects by their boundaries (or cutting edges), specified for 

one or several objects. Objects not intersecting with cutting edges can be cut at the point of their imaginary 
intersection. One object can be a cutting edge and a cut object.  

Command options:  

Fence Selection of objects by a crossing line which can consist of several segments. 

Crossing Selection of objects with a crossing frame. 

Project Mode for cutting objects by intersection of their projections with the boundary in 3D space. 

None Only objects that are crossed by the specified boundary in 3D space are selected . 

Ucs Defines the projections of objects in the XY plane of the current UCS and cuts objects which 
are not intersected by the boundary in 3D space. 

View Defines the projections of objects in the direction of the specified view and cuts objects which 
are not intersected by the edge.  

Edge Specifies the cutting mode of objects by imaginary extension of the edge. 

No extend Switches off the cutting of objects by imaginary extension of the edge. 

Extend Switches on the cutting of objects by imaginary extension of the edge. 

eRase Deletes the selected objects. 

Back Cancels the last change executed during performance of the command. 

 

Selection of edge Selection of object with 
pickbox 

Selection of objects with 
crossing frame 

Result 

    

Command prompts:  

Select objects: Select an object which will be used as the cutting 
object. 

Select object: Select the next object or press ENTER to select 
the objects to be cut. 

Select object to trim or 

[Fence/Crossing/Project/Edge/eRase/Back]: Select an object. 

Select object to trim or 

[Fence/Crossing/Project/Edge/eRase/Back]: 

 

Select the next object or press ENTER to finish 
the command. 

Smart trim  

 Menu: Modify –  Smart trim  

 Toolbar: Modify –  

 Command line: SMARTTRIM 



The Smart trim command differs from the Trim vectors in automatically selecting all vector objects in the document 

as potential cutting edges. Selected objects are cut to the nearest cutting edges. 

Command options:  

Fence Selection of objects by a crossing line which can consist of several segments. 

Crossing Selection of objects with a crossing frame. 

Project Mode of cutting objects by intersection of their projections with the boundary in 3D space. 

None Only objects that are crossed by the specified boundary in 3D space are selected . 

Ucs Defines the projections of objects in the XY plane of the current UCS and cuts objects 
which are not intersected by the boundary in 3D space. 

View Defines the projections of objects in the direction of the specified view and cuts objects 
which are not intersected by the edge.  

Edge Specifies the cutting mode of objects by imaginary extension of the edge. 

No extend Switches off the cutting of objects by imaginary extension of the edge. 

Extend Switches on the cutting of objects by imaginary extension of the edge. 

eRase Deletes the selected objects. 

Back Cancels the last change executed during performance of the command. 

Command prompts:  

Select object to trim or 

[Fence/Crossing/Project/Edge/eRase/Back]: Select objects to be cut. 

Select object to trim or 

[Fence/Crossing/Project/Edge/eRase/Back]: 

 

Select eRase. 

Select objects to erase: Select objects and press ENTER to delete them.. 

Select object to trim or  

[Fence/Crossing/Project/Edge/eRase/Back]: 

 

Select Back to cancel deleting. 

Select object to trim or  

[Fence/Crossing/Project/Edge/eRase/Back]: 

 

Press ESC to finish the command. 

Extend vectors 

 Menu: Modify –  Extend vectors  

 Toolbar: Modify –  

 Command line: EX, EXTEND   

The Extend command extends open vector objects to their real or imaginary crossing with other objects, called 
boundaries or boundary edges. Extended objects are selected by specifying an extended part.  

When several boundaries are specified, the object is extended to the nearest one. The object can be selected again 
to extend it to the next boundary edge. 

Command options:  

Fence Selection of objects by a crossing line which can consist of several segments. 

Crossing Selection of objects with a crossing frame. 

Project Mode of extending objects by intersection of their projections with the boundary in 3D space. 

None Only objects, crossed with the specified boundary in 3D space. 

Ucs Defines the projections of objects in the XY plane of the current UCS and extends objects 
which are not intersected by the boundary in 3D space. 

View Defines the projections of objects in the direction of the specified view and extends objects 
which are not intersected by the edge.  

Edge Specifies the extending mode of objects by imaginary extension of the edge. 



No extend Switches off the extending of objects by imaginary extension of the edge. 

Extend Switches on the extending of objects by imaginary extension of the edge. 

Back Cancels the last change executed during performance of the command. 

 

Selection of edge Selection of object with 
pickbox 

Selection of objects with 
crossing frame 

Result 

    

Command prompts:  

Select objects: Select the object  that is to be used as the edge. 

Select objects: Select next object or press ENTER to start 
selecting objects to extend. 

Select object to extend or  

[Fence/Crossing/Project/Edge/Back]:  Select an object. 

Select object to extend or  

[Fence/Crossing/Project/Edge/Back]: 

 

Select Crossing and select other objects. Press 

ESC to finish the command. 

Break vectors 

 Menu: Modify –  Break vectors  

 Toolbar: Modify –  

 Command line: BREAK 

The Break vectors command breaks lines, arcs, circles, polylines, ellipses, splines and other vector objects into two 

parts. A break can be performed by deletion of a part of it (breaking of the object at two points) or without deletion 
(breaking of the object at one point).  

To break an object at one point, at the command prompt to enter the second point, enter @0,0: 

Specify second break point or [First point]: @0,0 

Command options:  

First point Switches to the mode of first point selection. 

Break of object in two points  

The part of the object between the specified points will be deleted. By default, the selection point of the object is the 
first point of the break. To specify another point as the first point, select the First point option.  

    

Command prompts:  

Select objects: Select an object. 

Specify second break point or [First point]: Select First point. 

Specify first break point: Specify point 1. 

Specify second break point: Specify point 2. 

Break of object in one point 



Specify the same point as the first and the second points of the break. 

    

Command prompts:  

Select objects: Select an object. 

Specify second break point or [First point]: Select First point. 

Specify first break point: Specify point 1. 

Specify second break point: Specify again point 1. 

Break vectors at point 

 Menu: Modify – Break vectors at point   

 Toolbar: Modify –  

 Command line: VCBREAKATPOINTCMD  

The Break vectors at point command breaks lines, arcs, circles, polylines, ellipses, splines and other vector objects 
into two parts at one point (without deleting part of the object).  

Command prompts:  

Select objects: Select object. 

Specify break point: Specify a point. 

Reverse 

 Menu: Modify –  Reverse 

 Command line: REVERSE 

This command is used to change the order of the vertexes of segments, polylines and splines. 

For example, a segment with 0,0 coordinates for the start point and 100,100 for the end point will have 100,100 
coordinates for the start point and 0, 0 for the end point after the direction is changed.  

Command options:  

Exit Finishes the command. 

Command prompts:  

Select object to flip or 

[Exit] 
Select an object.  

Select object to flip or 

[Exit] 
Select the next object or press ESC to finish the command. 

Join objects 

 Menu: Modify –  Join objects 

 Toolbar: Modify –  

 Command line: JOIN 

The Join objects command joins separate segments of objects into one object. The command can be applied to 
segments, arcs and open polylines. The command allows the creation of circles from arcs (Close option).  

Arcs are joined in the counterclockwise direction from the source arc. 

Joined objects are in one plane. 

Additional restrictions for joined objects types: 

Line segments Must lie on one infinite line.  

There can be gaps between segments. 

Polylines Lines, polylines and arcs can be joined to a polyline. 



Objects must lie in one plane. Parallel to the XY plane of the UCS. 

There must be gaps between objects. 

Arcs Objects must lie in one imaginary circle. 

There can be gaps between arcs. 

Elliptic arcs Objects must lie in one imaginary ellipse. 

There can be gaps between arcs. 

Command options:  

Close 

it 

Transforms an arc to a circle. 

 

Selection of first arc Selection of second arc Result 

   

Command prompts:  

Select source object: Specify the first arc. 

Select arcs to join to source or [Close it]: Specify the second arc. 

Select arcs to join to source or [Close it]: Press ENTER to finish the command. 

Editing a polyline  

 Menu: Modify – Object>  Polyline 

 Toolbar: Modify object –  

 Command line: PE, PEDIT 

Double clicking on a polyline starts the editing mode. 

Using the Polyline command you can edit polylines and also convert elementary objects, consisting of arcs and lines, 
into polylines. 

Command options: 



Multiple Selection of several objects mode. 

Close Closes (draws a segment from start to end vertex) a polyline. 

Open Opens a polyline (deletes a segment from start to end vertex). 

Edit vertex Switches to the editing of vertexes mode (edited vertex is marked with «Х» label). 

Next Goes to the next vertex. 

Previous Goes to the previous vertex. 

Break Breaks a polyline at the selected vertex. 

Insert Adds a vertex in the specified place. 

Move Changes the position of the selected vertex. 

Regen Regenerates a polyline. 

Straighten Changes a line segment to an arc segment. 

Tangent Specifies the direction of the tangent in the selected vertex for further polyline fitting.  

Width Specifies the first and second width of the segment, going after the selected vertex. 

Exit Closes the editing of vertexes mode. 

Join Joins segments, arcs and polylines into one object – polyline. 

End Closes selection of objects. 

Width Specifies a new width for all polylines.  

Fit Fits the polyline with arcs between polyline vertexes. 

Spline Transforms a polyline into a spline which is an approximation of the source polyline between the 
start and end vertexes and is very similar to the source polyline. 

Decurve Returns a polyline to its original condition, cancels the results of the Fit or Spline commands. 

Ltype gen Specifies a mode of the specified line type generation. If Off option is selected, generation of line 

type starts from dash and end dash in very vertex.  

Undo Cancels all actions to the original polyline. 

Command prompts:  

Select polyline or [Multiple]: Select Multiple. 

Select polyline or [Multiple]: Select objects. 

Enter an option [Close/Edit 

vertex/Join/Width/Fit/ Spline/Decurve/Ltype 

gen/Undo]: 

 

Select the required option. Press ENTER to 
finish the command. 

Editing a spline 

 Menu: Modify – Object >  Spline 

  Toolbar: Modify Object –  

 Command line: SPE, SPLINEDIT 

Double clicking on a spline starts the editing mode. 

This command allows changing of a spline’s shape by adding, deleting or replacing characteristic points, changing 
the direction of tangents at the start and end points of the spline. Using this command you can close or open a spline, 
change a tolerance value. A tolerance defines the maximum distance from the real spline to any of its characteristic 
points.  The smaller the value a tolerance has, the closer the spline is to the characteristic points. 

Command options: 



Fit data Switches to the editing of spline data mode, including tolerance values. 

Add Adds characteristic points to the spline. 

Close Closes an open spline with fitting at a join point. 

Open Opens a closed spline. 

Delete Deletes characteristic points from the spline and rebuilds the spline. 

Move Changes the position of the previous point. 

Next Selects the next point. 

Previous Selects the previous point. 

Select point Selects the control point. 

eXit Returns to the previous prompt in the command line. 

Purge Deletes the spline data from the document database. 

Tangents Edits the start and end points of the spline.  

System default Sets tangents at the spline ends by default. 

toLerance Specifies a new tolerance value . 

eXit Returns to the main prompt in the command line.  

Close Closes an open spline with fitting at a join point. 

Open Opens a closed spline. 

Move vertex Changes the position of control vertexes and deletion of characteristic points. 

Next Selects the next point. 

Previous Selects the previous point. 

Select point Selects the control point. 

eXit Returns to the previous prompt in the command line. 

Refine Changes the spline’s shape 

Add control 

point 
Adds a control point near the point, selected on spline, between two control points. 

Elevate order Increases the degree of the spline (increases the number of control points).  

Weight Changes the weight factors at the control points of the spline (the greater the weight factor 
is, the closer the spline is to the control point). 

Next Selects the next point. 

Previous Selects the previous point. 

Select point Selects the control point 

eXit Returns to the previous prompt in the command line. 

eXit Returns to the main prompt in the command line. 

rEverse Changes the spline direction to the opposite. 

Exit Closes the spline editing mode . 

Command prompts:  

Select spline: Select a spline. 

Enter an option [Fit data/Close/Move vertex/  



Refine/rEverse/Undo/eXit]: Select the required option. To finish editing, select 
Exit option. 

Commands to edit objects 

Erase 

 Menu: Modify –  Erase 

 Toolbar: Modify –  

 Toolbar: Main –  

 Command line: E, ERASE 

This command deletes objects from the document. 

The Erase command is also available in the context menu.  

Selected objects can be deleted by pressing the DEL button on the keyboard. 

Command prompts:  

Select objects: Select objects.  

Select objects: Continue selection of objects or press Enter to finish the command. 

Copy 

 Menu: Modify –  Copy  

 Toolbar: Modify –  

 Command line: CO, COPY, CP 

This command can copy selected objects once or several times. 

The Displacement option allows copying of objects by specifying a relative distance with coordinates. The 
coordinates define a displacement value for the objects  being copied. 

Command options:  

Displacement Specifies a relative distance and direction with coordinates. 

Mode Changes the copy mode. 

Single Single copy of objects. 

Multiple Multiple copies of objects. 

Exit Finishes the command in the multiple copy of objects mode. 

 

Command prompts:  

Select objects: Select objects. Press ENTER when 
the selection is finished. 

Specify base point or [Displacement/Mode] 

<Displacement>: 

Specify 1 base point. 

Specify second point or <use first point as 

displacement>: 

Specify 2 second point. 

Specify second point or [Exit] <Exit> : Specify 3 end point. Press ENTER to 
finish the command. 

Mirror 

 Menu: Modify –  Mirror 



 Toolbar: Modify –  

 Command line: MI, MIRROR 

This command is used to create mirror copies of objects along the specified axis. 

Using this command you can quickly create symmetrical objects, you just create one part of the object and the other 
part of the object is drawn by the command.  

Mirrored texts, attributes and their definitions have a mirror view. For a normal view of text, set 0 value (default value) 
for the MIRRTEXT system variable 

Command options:  

Yes Deletes source objects. 

No Source objects are not deleted. 

 

Selection of objects by 
frame 

Specifying the first point Specifying the second point Result 

  
 

 

Command prompts:  

Select objects: Select objects. Press ENTER when the selection is finished. 

Specify first point of mirror line: Specify the first point. 

Specify second point of mirror line: Specify the second point. 

Erase source objects? [Yes/No] <N>: Select the No option. 

Offset 

 Menu: Modify –  Offset  

 Toolbar: Modify –  

 Command line: O, OFFSET 

This command allows the creation of a new object similar to the selected one and is placed at the specified distance 
from it. 

Similarly, arcs and circles have diameters smaller or larger than the source objects, according to which side the offset 
was made. 

If the Multiple option is selected, all similar objects are created with the current offset. 

Command options:  

Erase Erases the source objects after creating similar ones. 

Yes Deletes the source objects. 

No Source objects are not deleted. 

Layer Defines the layer of the source objects. 

Source Creates similar objects on the source layer. 

Current Creates similar objects on the current layer. 

Multiple Switches on the mode for multiple creation of similar objects. 

Exit Finishes the command.  

 

Selection of object Offset Selection of object Offset Result 



     

Command prompts:  

Specify offset distance or [Erase/Layer]: Specify distance. 

Select objects to offset or [Exit]: Select an object. 

Specify point on side to offset or 

[Exit/Multiple] <Exit>: Specify a point. 

Select objects to offset or [Exit]: Select an object. 

Specify point on side to offset or 

[Exit/Multiple] <Exit>: Specify a point. 

Select objects to offset or [Exit]: Select the Exit option to finish the command. 

Array  

 Menu: Modify –  Array 

 Toolbar: Modify –  

 Command line: AR, ARRAY 

This command is used to create two-dimension arrays of the selected objects by placing their copies on the specified 
circle (polar array) or in the nodes of the specified rectangular grid (rectangular array).  

Array command opens the Array dialogue box.  

There is the  Select objects command in the top corner of the dialogue box; it temporarily closes the dialogue 

box whilst selecting the source objects.  There is a line showing the number of selected objects  - Objects selected 
below the button. 

There is a preview window below the line. 

Rectangular array 

 

Parameters: 



Rectangular array Switches on the rectangular array mode.  

Rows: Number of rows. 

Columns: Number of columns. 

Offset distance and direction 

Row offset: Distance between rows. 

Column offset: Distance between columns. 

Angle of array: Field to enter an angle of array. 

 
Button temporarily closes the dialogue box to specify the distance between rows and columns 
and also angle on the screen. 

Example of creating stairs using rectangular array: 

 Create one more stair; 

 Select created objects; 

 Specify number of rows - 1; 

 Specify number of columns - 7; 

 Specify distance between columns (specify point 1, after that point 2); 

 Specify angle (specify point 1, after that point 2); 

Source stair Selection of objects 
Distance between 

columns 
Angle Result 

 

 

 

 

 

 

 

  

Polar array 

 
The More button opens an additional section of the dialogue box to specify the base point of the X,Y axes. 



 

Parameters: 

Polar array Switches on the polar array mode. 

Center point: X: Y: Fields to enter the X, Y coordinates of the array  centre. 

 Button temporarily closes the dialogue box to specify  the centre of the array on the screen. 

Method and values 

Method: A drop-down list to select the method of array creation. 

Available options in the drop-down list: 

Total number of items & Angle to fill  

Total number of items & Angle between items 

Angle to fill & Angle between items 

Total number of 
items: 

Number of elements (with source object). 

Angle to fill: Angle of array fill. 

 Button temporarily closes the dialogue box to specify the fill angle on the screen. 

Angle between 
items: 

Angle between neighbouring array items. 

 
Button temporarily closes the dialogue box to specify the angle between neighbouring array 
items.  

Rotate items as 
copied 

Switches on/off the mode for rotating the elements in the array. 

More/Less This button opens/closes an additional part of the dialogue box. 

Offset distance and direction 

Set to object’s 
default 

Switches on/off the mode for specifying the base point. 

Base point: X: Y: Fields to enter the X,Y coordinates of the base point. 

 Button temporarily closes the dialogue box to specify the base point on the screen. 

Example of creating polar array: 

Source objects Selection of objects  Centre of array Result 

    

Move  

 Menu: Modify –  Move  



 Toolbar: Modify –  

 Hotkeys: CTRL+D  

 Command line: M, MOVE 

This command is used to move the selected objects to a specified distance and in a specified direction. 

The Displacement option allows moving of objects by specifying a relative distance with coordinates. Coordinates 
define a value for the displacement of objects. 

Command options:  

Displacement Specifies relative distance and direction using coordinates. 

 

Command prompts:  

Select objects: Select objects. Press ENTER when 
the selection is finished. 

Specify base point or [Displacement]: Specify a 1 base point. 

Specify second point or <use first point as 

displacement>: 

Specify a 2 second point. 

Rotate 

 Menu: Modify –  Rotate  

 Toolbar: Modify –  

 Hotkeys: CTRL+E  

 Command line: RO, ROTATE 

The command rotates the selected objects to a specified angle around the specified point. 

Command options:  

Copy Rotates a copy of the selected object. 

Reference Specifies the angle from the reference line. 

Points Specifies the angle from the reference line to the line specified by two points. 

 

Selection of objects Specifying a reference line by two points 
Specifying rotation 

angle 
Result 

 
   

  

Command prompts:  

Select objects Select objects. Press ENTER when the selection is finished. 

Specify base point: Specify a base point. 

Specify rotation angle or 

[Copy/Reference]: 
Select the Copy option. 

Specify rotation angle or 

[Copy/Reference]: 
Select the Reference option. 



Specify the reference angle: Specify a first point of reference. 

Specify second point: Specify a second point of reference. 

Specify the new angle or [Points]: Specify the angle. 

Scale  

 Menu: Modify –  Scale  

 Toolbar: Modify –  

 Command line: SC, SCALE 

This command is used to decrease or increase the size of the selected objects whilst retaining their proportions (the 
scale factors along the X and Y axes are  identical). If the scale factor is more than 1, the objects are increased in 
size; if it is less than 1,  they are decreased.  

Command options:  

Copy Scaling copy of the selected objects. 

Reference Scaling the selected objects towards the reference line whose length is a single scale factor 
and a new length for the reference line. 

Points Scaling the selected objects towards the reference line whose length is a single scale factor 
and a new length for the reference line, specified by two points. 

 

Selection of objects Specifying the base point Specifying the reference line 
 

 

 

 

 

             

Specifying a new length for the reference line Result 

                  

Command prompts:  

Select objects: Select objects. Press ENTER when the selection is finished. 

Specify base point: Specify the base point. 

Specify scale factor or 

[Copy/Reference]: 
Select the Reference option. 

Specify reference length: Specify the first point. 

Specify second point: Specify the second point. 

Specify the new length or 

[Points]: 
Select the Points option. 

Specify first point: Specify the first point. 

Specify second point: Specify the second point. 

Stretch 

 Menu: Modify –  Stretch  

 Toolbar: Modify –  

 Command line: S, STRETCH 



This command allows stretching or moving of objects. Objects, intersecting with a secant frame or polygon are 
stretched. Objects inside a frame or polygon are moved by the Stretch commands as they moved by the Move 
command.  

Lines, arcs and segments are stretched only by moving their end points inside the secant frame or polygon. The 
position of endpoints outside the secant frame or polygon remains the same.   

Other primitives are moved or not, according to whether or not their characteristic points are inside the secant frame 
(polygon).  

Characteristic points are  the centre of a circle, the insertion point of a block, the leftmost point of a base line for text 
and to define attributes (it does not depend on the aligning type used for creation).  

If the insertion point of a block is moved by the Stretch command, all its attributes are also moved.  

During the preliminary selection of objects, only objects selected with the ordinary or secant frame (polygon) are 
stretched with Stretch command. 

The Displacement option allows stretching or moving of objects by specifying a relative distance with coordinates. 

Coordinates define a value for the stretching or offset of objects.  

Command options:  

Displacement Specifies the relative distance and direction using coordinates. 

 

Selection of objects by 
secant frame 

Specifying base point Specifying a new point Result 

    

Command prompts:  

Select objects: Select objects. Press ENTER 
when the selection is finished. 

Specify base point or [Displacement] <Displacement>: Specify the base point. 

Specify second point or <use first point as displacement>: Specify the second point. 

Align  

 Menu: Modify –  Align 

 Command line: ALIGN 

This command moves and rotates an object to align it with another object; scaling is also possible. 

Command options:  

Yes Scales object by aligning points. 

No Does not scale object by aligning points 

 

Selection of objects Specifies first point for aligning objects 

    

Specifies second point for aligning objects 
Result 

With scaling Without scaling 



 
 

  

Command prompts:  

Select objects: Select objects for aligning. Press ENTER when objects are selected. 

Specify first source point: Specify the first point on the object to be aligned. 

Specify first destination 

point: 

Specify the first point on the destination object. 

Specify second source point: Specify the second point on the object to be aligned. 

Specify second destination 

point: 

Specify the second point on the destination object. 

Specify third source point: Press ENTER. 

Scale objects based on 

alignment points? <N> or 

[Yes/No]: Select the option. 

Distributing copies  

Divide 

 Menu: Draw  – Point >  Divide  

 Toolbar: Draw–  

 Command line: DIVIDE 

The Divide command distributes points or blocks at the same distance from each other along an object’s length or 

perimeter. Distribution along object points or blocks divides the object into segments of a specified length. 

Command options:  

Block Switches to block insertion mode. 

Yes Switches on the object to block aligning mode. 

No Switches off the object to block aligning mode. 

 

Block and objects to divide Dividing with block aligning Dividing without block aligning 

   

Command prompts:  

Select objects to divide: Select an object.  

Enter number of segments or [Block]: Select the Block option. 

Enter name of block to insert: Specify the block’s name and press ENTER. 

Align block with object? or [Yes/No]: Specify the option. 

Enter number of segments: Specify the number of segments and press ENTER. 

Chamfer 

 Menu: Modify –  Chamfer…  



 Toolbar: Modify –   

 Command line: CHA, CHAMFER 

This command is used to create chamfers at the points of intersection of objects, with automatic dimensioning ability. 
The command allows the creation of several chamfers  individually.  

After launching the command, the dialogue box for specifying the chamfer parameters opens: 

 

Parameters: 

 

This button switches on the mode for creating a chamfer with similar lengths. 

In this mode the Length 2 parameter is unavailable.  

 

 

This button switches on the mode for creating a chamfer with different lengths. 

 

 

This button switches on the mode for creating a chamfer by length and angle. 

In this mode there is a Corner parameter instead of the Length 2 parameter. 

 

Length 1 The first length of the chamfer. This field is used also to specify chamfers with similar lengths.  

Length 2 The second length of the chamfer. 

Angle Angle of the chamfer. 

 
This button temporarily closes the dialogue box to permit measuring the chamfer length and angle on 
the drawing. The Value picker dialogue box appears to perform measurements. 

 This button switches on the mode for cutting of full contour lines. 

 This button switches on the mode for cutting of partial contour lines before their intersection. 

 This button switches on the mode without lines cutting. 

 This button switches the automatic dimensioning mode on/off . 



 This button temporarily closes the dialogue box to permit copying of properties from created chamfers. 

Double clicking or right clicking in the fields to enter values will open the context menu with a list of the recently 
entered values: 

 
The context menu is available during the process of chamfer creation: 

 

Commands from the context menu: 

P-Properties The Chamfer dialogue box opens to change the chamfer parameters. 

N-New Finishes the creation of one group of chamfers and starts another. The command is applied when 
you need to create some chamfers with similar dimensions on one object and with the same 
dimensions on another object: 

 

F-Fillet Switches to the mode for creating fillets. The Fillet dialogue box opens to specify the parameters 

for the fillet. 

Fillet 

 Menu: Modify –  Fillet…  

 Toolbar: Modify –   

 Command line: F, FILLET 

This command is used to create fillets in the intersection points of objects, with automatic dimensioning ability. The 
command can create fillets  individually. 

The dialogue box opens after the command is launched: 



 

Parameters: 

Radius Radius of fillet. 

 
This button temporarily closes the dialogue box to allow measuring of the fillet radius on the drawing. The 
Value picker dialog appears to perform measurements. 

 This button switches on the lines cutting mode . 

 This button switches on the mode for cutting of lines before their intersection. 

 This button switches on the mode without lines cutting. 

 

 

This button switches on the additional dimensioning mode . 

 

 This button switches the automatic dimensioning mode on/off . 

 This button temporarily closes the dialogue box to allow copying of properties from created chamfers. 

Double clicking or right clicking in the fields to enter values will open the context menu with the list of the recently 
entered values: 

 
The context menu is available during the process of chamfer creation: 



 

Commands from the context menu: 

P-Properties The Fillet dialogue box opens to change the chamfer parameters. 

N-New Finishes the creation of one group of fillets and starts another. The command is applied when you 
need to create some fillets with one radius on one object and with the same radius on another 
object: 

 

C-Chamfer Switches to the mode for creating chamfers. The Chamfer dialogue box opens to specify the 

parameters of the fillet. 

Explode 

 Menu: Modify –  Explode  

 Toolbar: Modify –  

 Command line: EXPLODE, X 

The Explode command divides complex objects, such as polylines, dimensions, hatches and blocks into separate 

elements. For example, dividing a polyline causes its separation into lines and arcs; an associative dimension divides 
into a set of simple objects; a block is divided into a set of containing its objects; multiline text is divided into lines.  

The Explode command is applied only to one nesting level of a complex object, i.e. if it is required to explode a 
polyline belonging to a block, firstly you have to explode the block and after that  the polyline. 

Command prompts:  

Select objects: Select an object. 

Select objects: Select the next object and press ENTER to finish the command. 

Explode all objects 

 Menu: Modify –  Explode all objects 

 Toolbar: Modify –  

 Command line: EXPLODEALL 

The command explodes all nanoCAD objects (notes, tables etc.) into primitives.  

It is recommended not to apply the command,  unless necessary, because the exploded objects are not restored. 
After explosion of objects you cannot apply nanoCAD special functions and editing commands to them. 



Creating and editing complex objects 

Groups of objects 

 Menu: Modify –  Group…  

 Command line: GROUP 

To edit a set of objects they can be grouped in the document. You can select the whole group and its elements to 
edit. New objects can be added to a group and existing objects can be excluded from a group. Objects can belong to 
several groups at once, and a group can belong to another group. To restore the configuration of source groups 
grouped into one group, you have to ungroup nested groups.  

Groups can  be assigned names or use default names. An unnamed group (a group without its own name) has a 
default name - An, where n  is the number of created groups. 

A group name can contain up to 31 symbols and cannot contain spaces; it can contain letters, figures and special 
symbols (dollar sign ($), hyphen (-) and the break character (_)). 

Groups are saved with a document and can be used in the following working sessions.  

Main distinction between groups and blocks: 

 Objects in a group can be edited without ungrouping, but to edit objects in a block, the block must be exploded. 

 A group cannot be transferred to another document; it can be used only in the document where it was created.  

The Group command opens the Object Grouping dialogue box where there is a list with the names of existing 

groups in the document and descriptions for every group that is selectable: 

 

 

Parameters: 

Group Identification 

Group Name: Specify a group name. 

Description: Displays the description of the group (if it was specified during group creation). 



 
This button temporarily closes the dialogue box for selecting an object when you need to 
clarify its group. 

 
This button temporarily closes the dialogue box for highlighting a group’s objects on the 
screen. 

Include Unnamed Switches on/off the input of unnamed groups in the list in the Object Grouping dialogue box.  

Create Group 

 This button temporarily closes the dialogue box for selecting the objects of a group. 

Selectable Switches on/off the mode of whole group selection if one object is selected. 

Unnamed Switches on/off the mode for creating unnamed groups. 

Change Group 

 
This button temporarily closes the dialogue box to allow selecting objects to delete from the 
selected group. 

 
This button temporarily closes the dialogue box to allow selecting objects to add them to the 
selected group. 

 This button updates a change of name for a group. 

 
This button opens the Order Group dialogue box to change the order of objects in a group. 

 This button updates the changed description for the selected group. 

 
This button deletes the selected group. Objects of the group are not deleted from the 
document. 

 This button changes the selectable property of a group in the document. 

To create a group: 

 Enter the name for the created group and its description in the Group Name and Description fields of the Group 

Identification section. A name can contain letters, figures and special symbols, but must not contain spaces and. 
The Description field can be empty.  

 Select the  button to temporarily close the dialogue box to select the objects of a group. 

 Select the objects, press ENTER. 

 Select OK in the opened dialogue box. 

To identify a group:  

 To define the groups the object belongs to, select the . 

 After the dialogue box temporarily closes, specify an object on the screen. 

 The Group Member List dialogue box opens with all groups the selected object belongs to: 

 

 Select OK to get return to the previous dialogue box. 

 Select OK to close the dialogue box. 



The  button temporarily closes the dialogue box to allow highlighting of a group’s objects on the 
screen. The Object grouping dialogue box is displayed with the highlighted object: 

 

To delete objects from a group:  

 Select a group in the list. 

 Deselect the Selectable checkbox. 

 Select the  . 

 Select the objects to delete. 

 Select the End option (in the context menu or command line). 

 Select OK to close the dialogue box. 

Note 1: The description of the group is saved when all the objects are deleted from the group. To delete a group from 

a document, select the . 

Note 2: When a group is deleted from a document, objects of the group are not deleted.  

To add objects to a group:  

 Select group in the list. 

 Select the . 

 Select the objects to add. 

 Select the End option (in the context menu or command line). 

 Select OK to close the dialogue box. 

Note: When adding objects belonging to other groups to a group, the Selectable checkbox should be deselected. If it 
is selected, the groups that the objects belong to will be added to the group. 

To rename a group or change a description:  

 Select the group. 

 Make changes in the Group Name and Description fields of the Group Identification section. 

 Select the  or . 

The messages like  Group name has been updated or Group description has been updated are 

shown in the bottom left corner. 

 Select OK to close the dialogue box. 

To change the order of objects in the group:  

 Select the group. 

 Select the . 

 Specify the required parameters in the Order Group dialogue box: 



 

Parameters: 

Group Name List of existing groups. 

Description Shows the description of the selected group in the list (if it was specified when the group 
was created) 

Remove from position 
(0-2) 

Field to enter the current position (number) of the object in the group. 

Enter new position 
number for the object 
(0-3): 

Specifies the new position number of objects in a group. 

Number of objects (less 
than 4): 

Specifies the number of objects, whose positions are changed. 

 This button changes the positions of objects in the group. 

 
This button opens the Object Grouping dialogue box to display the order of objects in 

the group 

 This button changes the objects into their opposite order. 

Note 1: The order of object numbering is the order in which objects were selected  when they were added to the 
group. Numbering starts from 0. 

Note 2: You can change the positions of several objects at once.  

The  temporarily closes the Order Group dialogue box and opens the Object Grouping dialogue 
box: 



 

Parameters: 

 The button for the previous object selection. 

 The button for the next object selection. 

Object: 1 Shows the current position of the object in the group. 

Total: 4 Shows the number of objects in the group. 

Note: A selected object is highlighted on the screen.. 

Blocks 
A block is a collection of objects that can be associated together to form a single object. A block can be inserted in a 
drawing as many times as you need. 

Blocks are used to create elements of drawings which are used many times, to simplify the drawing process..   

Blocks can be used to create user libraries of frequently used parts and components.  

Relating all occurrences of a block to the same description of the block in the drawing database allows you to 
decrease the file size because every new insertion of the block causes the adding of the information about the 
insertion place, scale factors and rotation angle to the information available.  

 Reference to the block means the block definition or the insert block.  

When you create a block, its definition, which is stored in the blocks table of the document file, is created and is not 
displayed on the drawing. A block definition can contain other (nested) blocks. The only restriction on nested blocks 
is that you cannot insert blocks that reference themselves. 

During an insert block, the drawing component of the block is created. Any definition can have a set of components 
or not have any. When you change the block definition, all its components will change automatically. 

 

An existing block can be changed by redefining it. A new block is created with the name of the existing block. After 
the block description is changed, all occurrences of this block in the document are changed automatically. 

When a block is created, objects are placed in the block with their current properties; these values cannot be 
corrected in future. 

For example, if you create a block from red segments, after it is created you cannot influence the colour of these 
objects’, unless you have set these segments’ colour to a By Block value.  

By modifying the properties of a block insertion point, you can change the display of objects inside the block (those 
with By Block value).  

If the object coming into the block has a property with a By Layer value, that changes the layer properties; it is 
possible to change the object’s properties inside the block. 

Users can also set attributes for a block to be created. A block attribute is text included in the block whose value can 
be re-defined for each block intersection. For example, insert the following multiline text in the block displaying a 
workstation. Such fields are referred to as the block attributes and the text registered in such fields is called the 
attribute value. 

There are several ways to create and use blocks: 

 Group objects and save them as block in the current drawing (Draw menu – Block > Make); 

 Save a block in a separate file to use it in other drawings by specifying in the command line WBLOCK; 

 Insert any other drawing as incidental to a drawing with blocks (Insert menu – DWG reference…; 

 Create a file with a set of frequently used blocks to use it as a library. 



Creation of a block 

 Menu: Draw – Block >  Make…  

 Toolbar: Draw  –  Create Block… 

 Command line: ACADBLOCKDIALOG, B, BLOCK, BMOD, NEWBL 

The Block Definition dialogue box allows the specifying of the parameters to create a new block and redefine a 
definition for existing block: 

 

 

Parameters: 

Name: Type a name for the created block. 

To redefine the existing block, choose its name from the drop-down list. 

Base point 

Specify On Screen At the block insertion in the drawing, this point will be located at the  centre of the cursor 
after the dialogue box is closed. 

 Pick Point 
At the block insertion in the drawing, this point will be located at the  centre of the cursor 
after the dialogue box is closed temporarily. 

X: Y: Z: Specify the point coordinates for the block insertion. 

Objects 

Specify On Screen Select the objects to be entered into the block after the dialogue box is closed. 

 Select Objects 
Select the objects to be entered into the block after the dialogue box is closed temporarily. 

Retain Retains the objects selected for the block in the drawing after creation of the block 
definition. 

Convert to block Creates the block entry at the location of the objects selected for the block after creation of 
the block definition. 

Delete Deletes the objects selected for the block from the drawing after creation of the block 
definition. 

Selected objects  The information on the quantity of objects selected for the block. 

Settings 



Scale uniformly Prevents the block entries from using a different scale. 

Allow exploding Defines whether the block entries can break into their components using the Explode 

command. 

Block units: Specify the insertion units for the block entry. 

Description: Allows the hidden attribute of text description of the block to be specified.  

Note: The objects to be added to the block can be selected in advance, before opening the Block Definition dialogue 

box window. 

Block attributes 
A block’s attribute is used to link text information or any other data, called an attribute value, with the block. 

It is possible to enter an attribute’s value, which is saved with the block, when you insert a block with variable 
attributes. You can assign a different value to an attribute when you insert the same block. 

Information, stored in drawing attributes, can be exported in electronic tables or databases for further processing and 
generation of different documents; for example, specifications or bill for materials. You can link several attributes with 
different names within one block.  

Attributes for a block should be created before block definition.  

To create an attribute 

  Menu: Draw – Block >  Define Attributes… 

 Toolbar: Draw  –  Define Attributes … 

 Command line: ATT, ATTDEF 

The Attribute Definition dialogue box is used to specify an attribute’s parameters: 

 

 

Parameters: 

Mode 

Invisible The attribute value of the inserted block is not displayed on the screen and not printed. 



Constant Sets the fixed attribute value for all block definitions. 

Verify Checks the accuracy of the attribute value during a block insertion. 

Present Whether to attribute a default value at a block insertion. 

Lock Position Locks the position at a block insertion. 

Attribute 

Tag: Sets an attribute name. 

Prompt: The text containing the current attribute is displayed at the block intersection.. If left empty, 
the prompt will be the attribute tag. 

Default: Value which is applied to the attribute by default 

Insertion point 

Specify on screen Specify the insertion point on the drawing. 

X: Y: Z: Coordinates of the insertion point. 

Text Settings 

Justification: Choice of  alignment 

Text style: Sets the text style. 

Text height: Sets the text height. 

Rotation: Sets the text rotation. 

 
The dialogue box temporarily closes and you can specify height or rotation on the screen. 

 

After an attribute is created, you can add it to a set of objects during the creation of the block. You should select not 
only geometric objects but also attributes  in answer to the command prompt for selection of objects during creation 
of a block. The order of selection of attributes defines the order of the prompts to enter the values of the attributes 
during block insertion.  

You can link an attribute with a block when redefining a block. 

Example of “Table_title” attribute with “Warning!” value: 

Before an attribute insertion in the block: After an attribute insertion in the block:  

 

  

 

Attributes of inserted blocks can be edited using the Attributes block manager (Modify menu – Object or  Modify 
Object toolbar) and in the Inspector dialogue box. 



The Attributes block manager opens the Edit of attributes dialogue box where you can change the values of the 

block attributes: 

 

Block Insertion  

 Menu: Insert –   Block…  

 Toolbar: Draw –  Insert Block… 

 Command line: I, INSBL, INSERT 

This command inserts previously defined blocks in the drawing. 

If the rotation angle of the block is specified, the centre of rotation is placed at the insertion point. If the rotation angle 
of the block is specified on the screen (by point), the slope angle of an imaginary line starting from a specified point to 
the insertion point of the block is set as the rotation angle. 

After inserting it in the drawing, a block is processed as a graphic primitive. To  be able to work with separate objects 
of a block, it can be exploded during insertion by selecting the Explode checkbox in the Insert Block dialogue box, 
or after insertion by using the Explode command from the Modify menu. 

To specify the parameters of an inserted block, the command opens the dialogue box: 

 

Parameters: 

Name: Choose the name of the block definition from the drop-down menu. If the list is empty, the 
current document does not contain any block definitions. 



Insertion point 

Specify on screen If this checkbox is on, the appropriate parameter is requested from the user after closing the 
dialogue box window.  

X: Y: Z: Coordinates of an insertion point. 

Scale 

Specify on screen If this checkbox is on, the appropriate parameter is requested from the user after closing the 
dialogue box window.  

X: Y: Z: Scale factors for the X, Y, Z axes. 

Uniform Scale The specified scale for the X axis will be applied to the Y and Z axes automatically. 

Rotation 

Specify on screen If this checkbox is on, the rotation angle is requested from the user after closing the dialogue 
box window. 

Angle: Rotation angle for an inserted block. 

Block Unit 

Unit: Insertion units, which have been set at the creation of the block definition. 

Factor: The scale factor calculated as a ratio of the block units to the drawing units. 

Explode Allows insertion of the block split into separate objects. 

Note: If you set a negative scale value along any  axis, when the block is inserted, the block will be mirrored towards 
this axis. 

Managing blocks in a current drawing 

 Menu: Format –  Blocks…  

 Command line: BLOCKSCMD 

The Blocks dialogue box contains information about all blocks in the document and about their insertion numbers:  

 

Columns: 

Name List of blocks in the document. 

Refs Information about the number of block insertions in the current document. 

Description Information from the Description field of the Block Definition dialogue box. 

To rename a block: 

 Click twice on the block’s name. 



 Enter a new name from the keyboard. 

To delete the description of a block: 

 Select the block from the list. 

 Select the  button or select the Delete command from the context menu. 

 Select the Yes button.  

 Select Close to close the dialogue box. 

Note 1: The Delete command (or Del button) deletes only the block insertion in the document. To delete the block 
description, use the Block Definition dialog.  

Note 2: Some block descriptions are system. They cannot be deleted. 

Block editor  

 Menu: Tools –  Edit block insertion…  

 Command line: REFEDIT 

You can edit block descriptions without closing the current drawing by editing block insertions.  

Exploding block insertion  
When a block’s insertions are exploded, a block is divided into its separate objects. 

To explode a block, select the Explode command or select the   button on the Modify toolbar. If it was prohibited 

to explode the block when the description was created, such block insertions cannot be exploded.  

Saving a block in a separate file  

 Command line: WBLOCK, ACADWBLOCKDIALOG, W 

The command allows saving in a separate file:  

 A whole drawing with all changes; 

 A block in the current document; 

 Separate fragments of the drawing. 

The Write Block dialogue box appears after the WBLOCK command is launched: 

 

Parameters: 



Source 

Block:  Switches on the mode to select a block in the document, from a list, in order to save it. 

Entire document Switches on the mode for saving the whole document in a separate file. 

Objects Switches on the mode for saving selected objects in the current document in a 
separate file. 

Base point 

  Pick point 
This button temporarily closes the dialogue box to allow a base point to be specified 
on the screen. 

X: Y: Z: Coordinates of the base point. 

Objects 

  
Select 
objects 

This button temporarily closes the dialogue box to allow objects on the screen to be 
selected. 

Retain Switches on the mode to keep the selected objects in the drawing after saving them in 
a separate file.  

Convert to block Switches on the mode for creation of a block insertion instead of selected objects after 
they were saved in a separate file.  

 Delete Switches on the mode for deleting the selected objects after they were saved in a 
separate file.  

Objects 
selected: 18 

Information about the number of objects selected for saving. 

Destination 

File name and 
path: The  button opens the Save Document File dialogue box to specify the path, 

format and name for the file. 

Insert units Drop-down list for selecting the measurement units of the saved file. 

Insert External Reference 

 Menu: Insert –   *.dwg Reference… 

 Toolbar: Draw –   

 Command line: XA, XATTACH 

External references allow you to add information from other drawings to the current document. It is possible to insert 
several external references into one document. Conversely, the same document can be used as an external 
reference in several other documents. External references can contain inserted external references. When you add 
an external reference, all external references inserted in it will also be displayed in the current drawing. 

External references can only link external documents to the current document. The objects placed in the drawing file 
with external references are displayed in the current drawing with other objects in this drawing, but they are not 
added into the drawing. The external reference is a kind of label that indicates the path to an external drawing. When 
you add the external reference, its objects are not copied into the current drawing or loaded from the external 
reference file every time you open basic drawing or restart the external reference. Anу changes made to the external 
reference will be also displayed when you open the basic document or restart an external reference. 

When you insert an external reference into the drawing, the file size of the current drawing is increased slightly. 

Since the external references are always kept in separate files, then the exchange of drawings should convey not 
only the basic drawings, but all drawings which are referred to. 

You can specify different types of external reference: attachment into the drawing and overlay on the drawing. When 
you insert an external reference using an attachment type, then all external references inserted into the drawing are 
added to it. If you choose an overlay type when you insert an external reference, then external references inserted 
into it are ignored. Overlay external references are used when the information provided by an external reference in 
the current drawing is not needed for later use of this drawing as an external reference. 

There are three types of folder path information to save with an attached reference: 



 Full (absolute) path is a fully specified folders hierarchy that locates the file reference. This is the most specific 

but least flexible option. 

 Relative path is a partially specified folders hierarchy that is defined relative to the current drawing (the folder in 

which it is stored). If you choose this type, it is necessary to save the current drawing. For the enclosed reference 

the relative path specifies a reference location, which can be the current open document. This is the most flexible 

option, and enables you to move your current drive to a different drive that uses the same folder structure. If the 

file that is being referenced is located on a different local hard drive or on a network server, the relative path 

option is not available. 

 No path – not specify a path to an external reference. Specifying the No path option is useful when moving a set 

of drawings to a different folder hierarchy or to an unknown folder hierarchy.   

To insert an external reference into the drawing, specify the path and file name in the opened External Reference 

dialogue box: 

 
Select the necessary external reference and click Open. The External Reference dialogue box will open. 



 

Options: 

Name: The list of the names of the external references inserted into the drawing. 

 
Opens the Open dialogue box to choose files for the insertion of new references. 

 

Found in: Displays the file path where the external reference is to be found. 

Saved path: Displays the saved path of access to the external reference. 

Reference Type 

Attachment When you attach a drawing file as an external reference, you link that referenced drawing to the 
current drawing.  

Overlay An overlaid external reference is not included when the drawing is itself attached or overlaid as an 
external reference to another drawing. 

Path Type Choose the saved path type to the external reference: 

Full path 

Relative path 

No path 

Insertion Point  

Specify On-
screen 

Select the box to set the X,Y,Z coordinates values in the command line or specify the position on 
the screen. The «X» «Y» «Z» fields of this section are inaccessible. 

 

X: Y: Z: Set the X, Y, Z coordinate values in the corresponding fields of the current document. 

 

Scale 

Specify On-
screen 

Select the box to set the scale values in the command line or specify the position on the screen. The 
«X» «Y» «Z» fields of this section are inaccessible. 

X: Y: Z: Set the scale values in the corresponding fields of the current document. 

 

Uniform Set the scale factors on the Y and Z axes to the same scale factor as the X axis. 



Scale   

Rotation 

Specify On-
screen 

Select the box to set the rotation angle value in the command line or specify its position on the 
screen. The Angle field of this section is inaccessible. 

 

Angle: Set the angle value on which it is necessary to turn the reference entry in the current document. 

Block unit 

Unit: Displays the specified parameter value of the insertion units for the inserted block. 

Factor: Displays the scale factor, which is calculated based on the block insertion units parameter value and 
document units. 

Edit references 

 Menu: Tools – External reference >  Edit reference 

 Command line: REFEDIT 

The use of external references allows you to quickly combine multiple drawings in a single document. To make work 
with external references more convenient, you can edit the references directly in the current drawing to which they 
are added. 

To edit a referenced drawing from within the current drawing, you use the working set to identify objects that belong 
to the external reference or block insertion rather than the current drawing. The working set includes only the objects 
belonging to the reference selected for editing. 

You can add or remove objects from the working set. If you create a new object while editing a reference, it is almost 
always added to the working set automatically. Editing changes in the working set can be stored in the source file of 
the external reference or block insertion. 

Start the Edit reference command. In the command line you can see: 

Select reference or block insertion or [All insertions]: 

Select the external reference on the drawing and in the Select insertion dialogue box that opens, choose the objects 
to edit: 

 
If you select the All insertions option in the command line, the Select insertion dialogue box opens immediately 

and in the Element Name section all references and blocks inserted into the drawing will be displayed: 



 

Options: 

Zoom to block Switches on/off the mode to display the selected reference on the screen. 

Use uncial names for 
layers, styles and block 

Controls whether layers and other named objects extracted from the reference are 
uniquely altered. If selected, named objects in external references are altered (names 
are prefixed with $#$), similar to the way they are altered when you bind external 
references. If cleared, the names of layers and other named objects remain the same 
as in the reference drawing. Named objects that are not altered to make them unique 
assume the properties of those in the current host drawing that share the same name.  

 

Lock objects Locks all objects not in the working set. This prevents you from accidentally selecting 
and editing objects in the host drawing while in a reference editing state. The 
behaviour of locked objects is similar to objects on a locked layer. 

 

Select the objects for editing and click OK. The refedit toolbar will appear. 

 
Use the refedit toolbar to add or remove objects from a working set and also save and discard external reference 

editing. 

REFEDIT, separated by a colon, is added to the document name in the tab . It means that work with the document 
occurs in the external reference editing mode. 

 

Add objects to the working set  

 Menu: Tools – External reference >  Add objects to working set 

 Toolbar: refedit –   

 Command line: REFSET 

Use this command to transfer the objects from the current drawing to the working set. 



Remove objects from the working set 

 Menu: Tools – External reference >  Remove objects from working set 

 Toolbar: refedit –   

 Command line: REFSET 

Use this command to remove selected objects from the working set. 

Save external reference changes  

 Menu: Tools – External reference >   Save and close 

 Toolbar: refedit –   

 Command line: REFCLOSES 

Use this command to save external reference changes and close the refedit toolbar. The external reference editing 
mode will be completed. The REFEDIT term, separated by a colon, that was added to the document name in the tab 

will disappear. 

Discard external reference changes 

 Menu: Tools – External reference >   Discard changes  

 Toolbar: refedit –   

 Command line: REFCLOSED 

Use this command to discard external reference changes and close the refedit toolbar. The external reference 
editing mode will be completed. The REFEDIT term, separated by a colon, that was added to the document name in 
the tab will disappear. 

Insert image 

 Menu: Insert –  Image from file… 

 Toolbar: Draw –  

 Command line: ROPEN 

You can insert images into the drawing. The list of supported raster formats is displayed in the Raster file formats 
section of the Options dialogue box (the Tools menu – Options): 

 
Raster images can be referenced and placed in drawing files but, like external references, they are not actually part 
of the drawing file. The image is linked to the drawing file through a path name. Linked image paths can be changed 
or removed at any time.  

Once you've attached an image, you can reattach it multiple times, treating it as if it were a block. Each insertion has 
its own clip boundary and its own settings for brightness, contrast, fade, and transparency. 

To insert a raster image, specify the necessary options in the opened Insert Raster Image dialogue box. 



 

Options: 

Name: Includes the list of names of the inserted images.  

 Opens the Insert Raster Image dialogue box.  

Path: Displays the path where the raster image file must be located. 

Insert Point 

Specify On-
screen 

Select the box to set the X,Y,Z coordinates values in the command line or specify the position on 
the screen. The «X» «Y» «Z» fields of this section are inaccessible. 

X: Y: Z: Enter the X, Y, Z coordinate values for the raster image insertion in the corresponding fields. 

Scale 

Specify On-
screen 

Select the box to set the scale value of the raster image in the command line or specify the position 
on the screen. The «X» «Y» «Z» fields of this section are inaccessible. 

W:  Set the scale factor width.  

H: Set the scale factor height. 

Uniform 
Scale 

Specifies the scale factor for the Width or Height values. A value specified for Width is also reflected 
in the Height value. 

Rotation  

Specify On-
screen 

Specifies the rotation angle for the inserted image, using the pointing device. 

Angle: Sets the rotation angle for the inserted image. 

Insert image relative to 

UCS Sets the insert image mode relative to the User Coordinate System (UCS).  

View Sets the insert image mode relative to the World Coordinate System (WCS). 



Image Settings 

 Menu: Modify – Object >  Image… 

 Toolbar: Modify Object –  

 Command line: MODIFYRASTER 

You can adjust the brightness, contrast and fade for the display of the raster image without affecting the original 
raster image file. The image adjustment is intended for improvement of the display of raster images (adjust contrast 
to make poor-quality images easier to read) or special effects. Bitonal images cannot be adjusted for brightness, 
contrast or fade. 

To adjust raster image options, use the Modify Raster Image dialogue box: 

 

Options: 

Raster Image: List of the raster images inserted in the drawing. 

Adjustment 

Brightness: Controls the brightness of the image. 

Contrast: Controls the contrast of the image. 

Fade: Controls the fading effect of the image. 

Visibility 

Show Image          Sets the display of the image on the screen. If the box is not selected, only the frame of the raster image is 
displayed. 

Show Clipped         Displays the image area in the show border that has been set. 

Transparency Sets the transparency mode of the raster images. When the transparency mode is set to on, it is possible to 
show the objects of the raster image through transparent pixels. For example, in bitonal images, background 
pixels are treated as transparent. 

You can set the transparency of the raster image in the Inspector dialogue box (General section). 

 Resets the values for brightness, contrast and fade to the default settings. 

Methods for setting the slider:  

 Place the cursor over the slider. When the slider is highlighted, press the left mouse button and keeping it held 

down, move the cursor left to decrease or right to increase the setting value. Choose the required position for the 

slider and release the mouse button; the value will be displayed in the box to the right of the scale. 

 Place the cursor at the point on scale to which the slider should be moved. Left click to set the slider to the 

selected point. 



 Enter the required value settings in the box to the right of the scale. 

 In the box to the right of the scale, click the up arrow to increase or down arrow to decrease the value settings by 

one. 

It is possible to set a new show boundary for the inserted raster image (the New command from the Modify menu – 
Clip). 

The show boundary of the raster image can be transparent. 

To change the transparency of the raster image boundary: 

 Select the raster image. 

 Set the transparency level in the Transparency field of the General section of the Inspector window. 

External references control 

 Menu: Insert – External References…  

 Command line: EXTERNALREFERENCES, IMAGES 

The command opens the External References dialogue box. It displays all external references contained in the 
document and manages these references: 

 

The dialogue box 
displays information about the references to the inserted drawings as well as for the raster images.  

The dialogue box contains the tool buttons and two sections: External References and Details. Both panes are 
working in the double data display mode . 

The External References pane can display information about references in a list structure (the Show List 

button) or in a tree structure (the Show tree button). The list view is set by default in the window. 

The Details pane displays the properties of the references selected in the upper section in the list view (the Show 

properties button) or displays the content of the selected reference in a preview window (the Show preview 

 button). 

The options of the External References pane in the list view: 



Columns 

Name Displays the name of the external reference file. 

Status Displays the status of the external reference file: 

Loaded – the referenced file is attached to the currently drawing. 

Unloaded – the referenced file is marked to be unloaded from the drawing. 

Not Found– the referenced file no longer exists in the valid search path. 

Unresolved – the referenced file cannot be read. 

Orphaned – the referenced file is attached to another file that has an Unresolved status. 

Size Displays the size of the attached referenced file. 

Type *.dwg files display the file type of the referenced file: 

Attachments 

Overlays 

Raster images display their file format: 

TIFF 

BMP 

JPG 

JPEG 

PNG 

Date The date when the referenced file was created or last saved. 

Saved Path Displays the path that is saved with the drawing when the referenced file is attached. 

Buttons 

  
Unload 
XRef Unloads the selected file references from the drawing. 

  
Reload 
XRef Reloads the selected file references to the drawing. 

  
Detach 
XRef Detaches the selected file references. 

  

 

Save XRef 

 

Changes the selected raster image references. It is possible to change the reference file name, 
file type and file format.  

  Show list Displays the references information in the list view. 

  Show tree Displays the references information in the tree view. 

When the External References pane is set to the list view, it is possible to select several references: 

 when the SHIFT key is pressed, then all references located between the first and last click will be selected; 

 when the CTRL key is pressed, you can select any references from the list by clicking.  

When the External References pane is set to the tree view, a tree structure of all external references along with their 
levels of nesting within the drawing will be displayed.  

 
It is possible to select only one file reference in the tree view of the External References pane. 

The options of the Details pane in the list view: 

Columns 

Name Displays the name of the external reference file. 



Status Displays the status of the external reference file: 

Loaded – the referenced file is attached to the current drawing. 

Unloaded – the referenced file is marked to be unloaded from the drawing. 

Not Found– the referenced file no longer exists in the valid search path. 

Size Displays the size of the attached referenced file. 

The size of the attached referenced file doesn’t display when the reference has the status: 

Unloaded 

Not Found 

Type *.dwg files display the file type of the referenced file: 

Attachment 

Overlay 

Raster images display their file format: 

TIFF 

BMP 

JPG 

JPEG 

PNG 

Date The date when the referenced file was created or last saved. 

The date doesn’t display when referenced file has the status: 

Unloaded 

Not Found 

Saved Path Displays the path of the referenced file. 

The saved path does not necessarily indicate the present file location. 

Found at Displays the path where the external reference file is located. 

This place is the actual file location. 

The full path and saved path may be different. 

Buttons 

  
Show 
properties Displays the properties of the selected referenced file in the list view. 

  Show preview Displays contents of the selected referenced file in the preview window. 

The External references dialogue box displays not only information about inserted references, but also allows you to 

perform operations with drawing files which are referenced.  

These operations are: 

 Load/unload of the external reference in the current drawing. 

 Reload of the external reference from the current drawing (without reloading the current drawing). 

 Delete the entry of the external reference with all data from the current drawing. If you only delete the reference 
from the drawing it will not delete the layers of the external reference. To permanently delete an external 
reference, use the Detach command in the External references dialogue box. 

 Changes the selected raster image references. It is possible to change the referenced file name, file type and file 
format. 

Change of the external reference to the raster image 
To change reference to the image: 

 In the External References dialogue box, select the reference to the image in the list  

 Click the Save  button. 

 In the opened Save Image File dialogue box, specify the file name and file type: 



 

 Click the Options button. 

 In the TIFF Options dialogue box, set the necessary parameters: 

 

 Click OK. 

 Click Save. 

Image settings 

 Menu: Insert – External References…  

 Command line: EXTERNALREFERENCES, IMAGES 

nanoCAD allows you to convert the inserted images into other supported raster file formats. The list of supported 
raster file formats is shown in the Options dialogue box (the Tools menu – the Options command). 

For the TIFF format, you can also change settings such as colour mode, compression, organisation, byte order; for 



JPG and JPEG formats – Image Quality. 

To save an image to another format or to change the format parameters: 

 In the External References dialogue box select raster references and click Save. 

 In the opened Save Image File dialogue box, type the new file name, select the file type from the drop-down list 
and click the Options button.  

 Depending on the selected file type, the TIFF Options dialogue box or the JPEG Options dialogue box will be 
open. 

TIFF Options 
The settings of this dialogue box also apply to other types of TIFF-formats, including multiple-page TIFF and TIFF 
with geodata. 

If part of a multiple TIFF-file includes images of different types, such as colour and bitonal, then you can adjust 
separately for each of these types. 

There is a separate tab for each of the colour modes. For example, to adjust the saving options for a 256-color image 
in TIFF, it is necessary to use the 256 Indexed tab. 

 

Options: 

Compression: Drop-down list to select the raster degree of compression. 

Depending on the selected colour mode, the following parameters in the list are available: 

No compression Raster is saved without compression. 

In this case, the file will be of a large size. At the same time the file can be 
read by any program that supports working with TIFF 

CCITT modified 
Huffman RLE 

The compression type, which combines Huffman and RLE algorithms. 

It is used to compress the bitonal rasters. 

CCITT Group 3 
fax encoding 

The compression type, which uses the Huffman algorithm with a fixed table 
for compressing bitonal rasers. 

The following options are available for this compression type: 

2-D Encoding – The most effective data compression. 

Fill To Byte Boundary - Controls the method of defining the line start. 

When this option is on, a new line always starts with the bits number of a 
multiple byte. 

CCITT Group 4 
fax encoding 

The compression type that is optimal for the bitonal rasters. 

It is supported by most raster editors and ensures the best compression of 
bitonal data. 

Macintosh RLE 
(Packbits)  

The compression type that is optimal for colour images. It is supported by 
most raster editors. 

At the Striped or Tiled internal organisation, the use of this compression 

type in some cases can give an increase of file size compared to the saved 



file without compression. 

ZIP (Deflate 
compression)  

The compression type that uses an algorithm similar to that used in the ZIP 
archiver. 

Can be used with any raster types. 

Versions of the AutoCAD 2005 and earlier don’t support reading TIFF-files  
with ZIP-compression. 

Versions of the Spotlight 6.0, RasterID 3.0 and earlier also cannot 

read files of this compression type. In some cases, attempting to open files 
of this compression type can lead to fatal errors. 

Use the slider to control the degree of compression: 

 

Set the maximum degree of compression to reduce the file size. But this 
leads to an increase in the time taken for reading/saving the raster image.  

Lempel-Ziv & 
Welch  

The compression type that uses a universal compression algorithm without 
data loss. 

This algorithm has a high work speed when compressing and when 
decompressing. The inconvenience is the low degree of compression in 
comparison with a scheme of two stage encoding. 

This compression type is used also in GIF and PDF formats. 

JPEG                 
DCT 
compression  

The compression type that uses a JPEG algorithm. 

The same algorithm is used in the similarly-named JPEG format. 

It is designed to compress colour rasters.  

It allows the highest degree of compression to be achieved. 

Also, as described above for the ZIP-compression, JPEG-compression is 
not supported by all raster editors. 

JPEG-compression, unlike any other compressions which are used in 
TIFF-format, is performed with some data loss. This compression type is 
very useful to create a reduced size file, for example, for Internet 
transmission. But it is not recommended to use it to store important 
information. 

Indeed, whenever you save a TIFF-file to JPEG-compression, 
recompression is performed, in which the quality of raster deteriorates.  

Use the slider to control the degree of compression: 

 
Increasing the degree of compression reduces the file size, but this leads 
to a reduction of its quality. At the maximum degree of compression you 
can get raster that may be deformed beyond recognition. 

 

Organization: A drop-down list to select the type of internal organization of the TIFF-file. 

The following options are available: 

Row – All data within the file are written in one block. This organisation type is also called 

blocked. TIFF-files of this organisation have the highest compatibility with other programs 
designed for viewing and editing of rasters. 

Striped – All data within the file are written in the form of individual portions of lines. In this way, in 

some cases, the downloading and viewing of images are accelerated. But in some cases, a 
combination of the row and striped organisation and one of the compression types, for example, 
Macintosh RLE (Packbits), leads to an increase of the file size instead of the expected reduction. 

Tiled – All data within the file are written in the form of fragment, so-called tiles. This organisation 

type is not supported by all raster editors. The use of the tile organisation can speed up viewing of 
rasters. 



Byte Order: A drop-down list to select the byte order in the word, which is different for PC and Macintosh. 

Two options are available:  

Intel (little-endian) - Byte order in which the junior (least significant) byte is written first. 

Motorola (big-endian) - Byte order in which the senior (most significant) byte is written first. 

Save 
Thumbnail  

Switching on/off the mode to save a file with a reduced copy of the image (thumbnail). 

Thumbnail is used to quickly view the file content in the file open dialogue box.  

It should be remembered that when you switch on the Save Thumbnail mode, the TIFF-file will be 
saved as multipage and it cannot be read by all raster editors. 

JPG and JPEG Options 

You can change the degree of compression for JPG and JPEG file formats. 

Use the slider to control the degree of compression: 

 

Increasing the degree of compression reduces the file size, but this leads to a reduction in its quality. At the maximum 
degree of compression you can get a raster that may be deformed beyond recognition. 

Show boundary 
Shows a set of raster images, blocks or external references in the enclosed area. (see «Set show boundary for a 
viewport» section («THE COMPONENT LAYOUT AND PLOT DRAWING» - «Viewports» -  «Edit Layout 
Viewports»)). 

The show boundary defines the visibility of objects in the current document. The original objects are not changed. 

Setting of the clip boundary is achieved using the clipping contour. 

Clipped blocks or external references, raster images and viewports can be edited as well as not clipped ones. 

Setting of the show boundary for the block or external reference 

 Menu: Modify – Clip > XRef  

 Command line: XCLIP 

The command sets the clipping contour of the show boundary to display the section of the inserted block or external 
reference. 

The command doesn’t change the objects of the block or external reference (the definition of the block or external 
reference remains unchanged). Creation of the clipping contour affects only the display block or an external reference 
in the current document. 

 If a block or external reference has been inserted more than once, it is possible to specify a different clipping contour 
for each entry, but each entry can have only one contour. 

Clipping of the block or external reference is carried out by a polygonal contour: rectangle, polygon or closed polyline. 

The XCLIPFRAME system variable is designed to set the visibility of the boundary of the clipping contour. If the 
system variable is set to a value of 1, the boundary of the clipping contour will be displayed on the screen. You can 
select it and print it out. If the system variable is set to a value of 0, the visibility of the boundary will be turned off (set 
by default).  

Display of the boundary of  the clipping contour is turned 
on 

(value of the system variable XCLIPFRAME =1) 

Display of the boundary of  the clipping contour is turned 
off 

(value of the system variable XCLIPFRAME =0) 

ms-its:ACAD_ACR.chm::/XCLIPFRAME.htm
ms-its:ACAD_ACR.chm::/XCLIPFRAME.htm
ms-its:ACAD_ACR.chm::/XCLIPFRAME.htm


  

You can turn off the clipping of the block or external reference to display the full entry and then turn it on again to 
display only the clipped area. 

A clipped section of the block or external reference can be  copied, moved and rotated in the same way as an entry 
of the block or external reference that is not clipped. The clipping contour is copied, moved or rotated with the entry. 

The clipping options also extend to attached references: when the main reference is clipped, all attached references 
will be clipped too.  

The clipping contour can be redefined. Set the new clipping contour to remove the old contour. 

After removing the clipping contour, the block or external reference is displayed on the screen in full. 

Options:  

On Mode displays a clipped section of the block or external reference. 

Off Mode displays the full entry of the block or external reference. 

Clip_depth Set near and far clipping planes for the external reference or block. 

Objects beyond the limit of the contour set by planes of the space will not be displayed on 
the screen. 

Distance Creating a clipping plane, passing at a prescribed distance parallel to the clipping 
contour. 

Remove Delete near and far clipping planes. 

Delete Delete the clipping contour for the selected entry of the block or external reference. 

This option deletes the clipping contour and clipping plane. 

Generate_Polyline To automatically  create a polyline whose vertices match  the vertices of the clipping 
contour. 

This option is used to change the current clipping contour: the created polyline is edited 
by the PEDIT command (the Modify menu – Object > Polyline). Then the edited polyline 

is used to change the existing clipping contour so that it is based on the new contour. 

New Create a new clipping contour. 

Select_polyline Set the limits contour by the selected closed polyline. 

The polyline should be created previously and consist of straight-line segments. 

Polygonal Set the polygonal contour of the show boundary by sequenced specifying of the 
polygonal vertices. 

Undo Sequenced cancelling of the specified points of the polygonal vertices. 

Specified first point cannot be cancelled. 

Rectangular Set the rectangular contour of the show boundary by sequenced specifying of the 
opposite rectangular vertices. 

 

External reference to setting of the show boundary External reference after the setting of the show boundary 



  

The command prompts when you specify a rectangular boundary: 

Select block or X-references: Select the block or reference and press 
ENTER. 

Enter clipping options 

[ON/OFF/Clip_depth/Delete/generate_Polyline/New] 

<New>: N 

[Select_polyline /Polygonal/Recrangular] 

<Rectangular>: Choose  Rectangular.  

Specify first corner: Specify the first corner.  

Specify opposite corner: Specify the opposite corner. 

The command prompts when you setting the polygonal boundary: 

Select block or X-references: Select the block or reference and press 
ENTER. 

Enter clipping options 

[ON/OFF/Clip_depth/Delete/generate_Polyline/New] 

<New>: N 

[Select_polyline /Polygonal/Recrangular] 

<Rectangular>: Choose Polygonal. 

Specify first point: Specify the first point. 

Specify next point or[Undo]: Specify the second point. 

… … 

Specify next point or[Undo]: Specify the end point and press ENTER. 

The command prompts when you specify a boundary by polyline: 

Select block or X-references: Select the block or reference and press 
ENTER.  

Enter clipping options 

[ON/OFF/Clip_depth/Delete/generate_Polyline/New] 

<New>: N 

[Select_polyline /Polygonal/Recrangular] 

<Rectangular>: Choose Select_polyline. 

Select_polyline: Select polyline. 

To turn on/off clipping of the block or external reference: 

 In the Modify menu click Clip and then On or Off commands. 

 In reply to the prompt in the command line Select block or X-reference: Select the entry and press 

ENTER. 

To change the clipping contour of the block or external reference: 

 In the Modify menu click Clip and then the New command. 

 In reply to the prompt in the command line Select block or X-reference: Select the entry and press 

ENTER. 

 In reply to the prompt in the command line Delete old boundary(s)? [Yes/No] <Yes>: Select Yes or 

press ENTER 

 In reply to the prompt in the command line [Select_polyline/Polygonal/Rectangular] 

<Rectangular>: Select the required option and set the new clipping contour.  



Note: It is possible to create a new clipping contour if the old contour is deleted.  

To delete the clipping contour:  

 In the Modify menu click Clip and then Delete command. 

 In reply to the prompt in the command line Select block or X-reference: Select entry and press 

ENTER. 

Setting of the show boundary for a raster image 

 Menu: Modify – Clip > New  

 Command line: NEWCLIP 

The command allows you to  insert a clip of the raster image into the drawing, to set the display on the screen and 
print only the required part of the raster image. 

Setting of the show boundary of the raster image affects its display in the current document, but does not change the 
source image. 

Clipping of the raster image is done using a polygonal outline (rectangular, polygonal or closed polyline), whose 
vertices are inside the image boundary. 

 It is possible to specify a different clipping contour for each entry of the same raster image, but each entry can have 
only one contour. 

The clipping contour can be turned off to display the original image and then back on to show the clipping image. 

The clipping contours can be redefined. When you specify a new clipping contour, the old contour should be deleted. 

After deleting the clipping contour, the raster image is displayed on the screen in its original boundaries. 

Options:  

Select_polyline Set the limits contour using the selected closed polyline. 

The polyline should be created previously and consist of straight-line segments. 

Polygonal Set the polygonal contour of the show boundary by sequenced specifying of the polygonal 
vertices. 

Undo Sequenced cancelling of the specified points of the polygonal vertices. 

Specified first point cannot be cancelled. 

Rectangular Set the rectangular contour of the show boundary by sequenced specifying of the opposite 
rectangular vertices. 

 

Setting the rectangular contour of the show boundary of 
the raster image 

Displaying of the raster image after setting the show 
boundary 

 

The command prompts when setting the rectangular boundary: 

Select block or X-references: Select raster and press ENTER.  

[Select_polyline /Polygonal/Recrangular] 

<Rectangular>: Press ENTER. 

Specify first corner: Specify the first corner. 

Specify opposite corner: Specify the opposite corner. 



The command prompts when setting the polygonal boundary: 

Select block or X-references: Select raster and press ENTER.  

[Select_polyline /Polygonal/Recrangular] 

<Rectangular>: Choose Polygonal. 

Specify first point: Specify the first point. 

Specify next point or[Undo]: Specify the second point. 

… … 

Specify next point or[Undo]: Specify the end point and press ENTER. 

The command prompts when specifying a boundary by a polyline: 

Select block or X-references: Select the raster and press ENTER.  

[Select_polyline /Polygonal/Recrangular] 

<Rectangular>: Choose Select_polyline. 

Select_polyline: Select the polyline. 

To turn on/off the clipping contour: 

 In the Modify menu, click Clip and then the On or Off commands. 

 In reply to the prompt in the command line Select block or X-reference: Select the raster image and 

press ENTER. 

To change the clipping contour: 

 In the Modify menu, click Clip and then the New command. 

 In reply to the prompt in the command line Select block or X-reference: Select the raster image and 

press ENTER. 

 In reply to the prompt in the command line Delete old boundary(s)? [Yes/No] <Yes>: Select Yes or 

press ENTER 

 In reply to the prompt in the command line [Select_polyline/Polygonal/Rectangular] 

<Rectangular>: Select the required option and set the new clipping contour.  

Note: It is possible to create a new clipping contour if the old contour is deleted.  

To delete the clipping contour:  

 In the Modify menu, click Clip and then the Delete command. 

 In reply to the prompt in the command line Select block or X-reference: Select the raster image and 

press ENTER. 

 



Execution of Drawings commands 

The Filling and Hatch commands 

 Menu: Draw –  Hatch 

 Toolbar: Draw –  

 Command line: BHATCH, H, HATCH 

Hatching in nanoCAD means filling of the selected area with the predefined pattern. 

The Hatch pattern is a predefined pattern used to represent different materials such as steel, concrete, glass and so 
on.  A soid fill can also be used as a hatch pattern. 

The hatch can be associative or annotative. 

An associative hatch is updated when you change the boundary. 

An annotative hath does not depend upon the boundary. 

You can use several methods to specify the boundaries of a hatch: 

 specify a point in an area that is enclosed by objects, 

 or select objects that enclose an area. 

The Hatch dialogue box appears to select the hatch pattern and specify options: 

 

Options: 



Type and pattern 

Type: Drop-down list to select the type of hatch pattern: 

The following types are available: 

Predefined 

User defined  

Custom 

Pattern: Drop-down list to select the available predefined patterns. 

The Pattern option is available only if you set the Type to Predefined. 

 This button opens the Hatch pattern dialogue box. 

Swatch: Displays a preview of the selected pattern. 

Click the swatch to display the Hatch pattern dialogue box. 

Custom pattern: Drop-down list to display the available custom patterns. 

 This button opens the Hatch pattern dialogue box. 

Angle and scale 

Angle: Drop-down list to specify an angle for the hatch pattern relative to the X axis of the current 
UCS.  

Values can be input from the keyboard. 

Scale: Drop-down list to expand or contract a predefined or custom pattern. Values can be input 
from the keyboard.  

This option is only available if you set the Type to Predefined or Custom. 

Double Turns on/off the mode to draw a second hatch positioned at 90 degrees to the original hatch. 

This option is only available if you set the Type to User Defined. 

Hatch origin  Setting the start point to create the hatch. 

Some hatches, such as brick patterns, need to be aligned with a point on the hatch boundary.  

By default, all hatch origins correspond to the current UCS origin. 

Use current origin Turns on the mode of origin setting stored in the HPORIGINMODE system variable.  

The origin is set to 0,0 by default. 

Specified origin            Specifies a new hatch origin. 

 

Click to set new 
origin 

Specifies the new hatch origin point on the screen using the cursor. 

Default to 
boundary extents 

Turns on/off the mode for calculation of a new origin based on the rectangular extents of the 
boundary for the hatch. 

From the drop-down list the following options are available: 

Bottom left 

Bottom right  

Top right  

Top left  

Center 

The icon displays the current position of the origin point: 

 

Store as default 
origin 

Turns on/off the mode for saving the value of the new hatch origin in the HPORIGIN system 
variable. 

Boundaries 

  
Add:          Pick 
points 

Determines a boundary from the existing objects that form an enclosed area around 
the specified point. The dialogue box closes temporarily and you are prompted to 



pick a point. 

  
Add:          Select 
objects 

Determines a boundary from selected objects that form an enclosed area. The 
dialogue box closes temporarily and you are prompted to select objects. 

  
Remove 
boundaries        

Removes from the boundary definition any of the objects that were added previously. 

This option is unavailable if you have not specified points or not selected objects. 

  
Recreate boundary Creates a polyline or region around the selected hatch and optionally associates the 

hatch object with it. 

This option is available when you edit the hatch. 

  

 

View selection 
Temporarily closes the Hatch dialogue box and displays the currently defined 
boundaries with the current hatch settings.  

This option is unavailable if you have not specified points or not selected objects. 

Options 

Associative Turns the associative hatch mode on/off . 

Create separate hatches Turns on/off the mode for changing a single hatch object that has several separate 
boundaries into individual hatch objects. 

 

Draw order: Drop-down list to assign the draw order to a hatch or fill.  

From the drop-down list the following options are available: 

Do not assign 

Send to back 

Bring to front 

Send behind boundary 

Bring in front of boundary 

  
Inherit Properties  Temporarily closes the Hatch dialogue box to specify boundaries using the hatch 

properties of a selected hatch object.  

 
Temporarily closes the Hatch dialogue box and displays the currently defined 
boundaries with the current hatch settings.  

Press ESC to return to the dialogue box. 

,  
Expands the Hatch dialogue box to display more options. 

More Options section of the Hatch dialogue box: 



 

More Options section of the Hatch dialogue box: 

Islands 

Island detection Turns on/off the mode to detect internal closed boundaries (islands). 

Island display 
style 

Select the island display style 

 
Normal 

Hatches inward from the outer boundary. 

If the hatch encounters an internal island, it turns off hatching until it encounters another 
island within the island.  

 
Outer 

Hatches inward from the outer boundary. Hatch turns hatching off if it encounters an internal 
island. This option hatches only the outermost level of the structure and leaves the internal 
structure blank. 

 

Ignores all internal objects and hatches through them. 



Ignore 

Boundary retention 

Retain boundaries Creates boundary objects from the temporary hatch boundaries and adds them to the 
drawing. 

Object type: Controls the type of the new boundary object. 

The following types are available: 

Region 

Polyline 

Boundary set Defines the set of objects  analysed when defining a boundary from a specified point. The 
selected boundary set has no effect when you use Select Objects to define a boundary. 

From the drop-down list the following object sets are available: 

Current viewport - Defines the boundary set from everything within the current viewport.  

Existing set - Defines the boundary set from the objects that you selected with New.  

  New Temporarily closes the Hatch dialogue box to select the objects that define the boundary set. 

Gap tolerance 

Tolerance Sets the maximum size of gaps that can be ignored when objects are used as a hatch 
boundary.  

Enter a value, in drawing units, from 0 to 5000 to set the maximum size of gaps that can be 
ignored when the objects serve as a hatch boundary. 

Any gaps equal to or smaller than the value you specify are ignored and the boundary is 
treated as closed. 

 

Inherit options When you use Inherit Properties to create a hatch, these settings control the location of the 
hatch origin. 

Use current origin Uses the current hatch origin setting. 

Using source 
hatch origin 

Uses the hatch origin of the source hatch. 

To create hatch: 

 In the Hatch dialogue box select the required hatch pattern from the drop-down Pattern list or in the Hatch 

pattern dialogue box opened after you click  icon. The graphic structure of the selected pattern will be 

displayed in the Swatch field. 

 Set the required hatch options in the dialogue box. 

 Click Add: Pick points  icon and specify points inside the areas that need to be hatched. Or click Add: 

Select objects  icon and select objects that form an enclosed area. The selected boundaries for the hatch 

are highlighted by a blue solid line when you pick a point inside the area and a white dotted line when you select 
objects. If the results of highlighting are not satisfactory for any reason, press ESC or click Cancel to cancel the 

context menu for the selected boundaries and return to the Hatch dialogue box to reset the selection. The 
Preview and OK buttons in the opened dialogue box will be blocked.  

 If the highlighted contour is satisfactory, press ENTER or click the Enter command in the context menu of the 
Hatch dialogue box. 

 To preview the hatch result, click . To finish the command without previewing, click OK. 

When you preview the hatch result: 

 If the preview of the hatch is  satisfactory, click Accept in the command line or click Enter or Accept in the 
context menu to finish the command. Pressing ENTER also finishes the command. 

 If the preview is not  satisfactory, select Reject in the command line or click Cancel or Reject in the context 
menu to return to the dialogue box and change the hatch options,. Pressing ESC also returns to the dialogue 

box. 



To create the hatch using the inherited properties of a selected hatch:  

 Click the Inherit properties  icon. The Hatch dialogue box closes temporarily, to select the prototype 

hatch. 

 Select the hatch object whose properties you want the hatch to inherit. The Preview and OK buttons in the 
opened dialogue box will be blocked.  

 After selection, you can right-click in the drawing area and use the options on the context menu to switch 

between the Pick Internal Point  and Select Objects  options to create boundaries 

 The order of the rest of the actions corresponds to the order of actions performed when you create a hatch. 

Modify Hatched Areas 

 Menu: Modify – Object >  Hatch… 

 Toolbar: Modify Object –  

 Command line: HATCHEDIT 

As with any other object, a hatch can be deleted,  copied, moved, rotated, etc. 

If a hatch is selected, you can change its scale and angle. 

You can edit the hatch properties in the Hatch dialogue box that is used to create the hatch. 

The Edit Hatches command allows you to recreate removed hatch boundaries. When you use the Edit Hatch 
command, the Recreate boundary option will be available in the Hatch dialogue box. 

To recreate a boundary: 

 Start the Hatch  command from the Modify – Object  

 In the Hatch dialogue box, click the Recreate boundary  icon. 

 In the command line or context menu, select the Region or Polyline option to specify the object type to recreate 

the boundary. 

Select Yes or No in the command line Reassociate hatch with new boundary?[Yes/No] <N>:. 

 In the Hatch dialogue box click OK.  

Shape 

 Menu: Draw –  Shape… 

 Command line: SHAPE 

Shapes represent the objects described in a special format and are saved in text files with SHP extensions. 

Shapes can be part of the description of complex line types (for more information, see the Line Types section 
(«Objects Properties »)). 

SHX-fonts are also described and stored in the SHP-files. Each symbol of this font is a special type of  figure. 

Shapes are objects that you use like blocks. User-defined shapes are helpful when you need to insert a simple part 
many times and when speed is important. Blocks are more versatile and easier to use and apply than shapes. 
However, shapes are more efficient to store and draw.  
The nanoCAD delivery includes two files (GOST 2.303-68.shx and ltypeshp.shx), containing forms descriptions. After 
installation, data files are located in a folder: 
c:\Documents and Settings\All Users\Application Data\Nanosoft\nanoCAD\SHX.  
The GOST 2.303-68.shx file contains the shapes used to describe complex lines types in the GOST 2.303-68.lin file. 
nanoCAD supports shapes created for AutoCAD. 
You can create the definition files for user-defined shapes with a text editor or word processor that is then saved in 
the ASCII format. To use the compiled file in nanoCAD, just place it in the folder: 
c:\Documents and Settings\All Users\Application Data\Nanosoft\nanoCAD\SHX. 
The Shapes command allows you to insert shapes from (*.SHX) files into the document. Selection of the file 
containing the shapes is carried out in the Choose Form dialogue box. 



 

To insert a shape: 

 In the Shapes section, choose the file. The slides with graphic images of the available shapes in the file are 

displayed in the box located in the top right part of the dialog. 

 Select the shape to insert and left click on the shape slide or select the shape name from the drop-down Shape 
list. 

 Click ОК. 

After closing the dialogue box, perform the appropriate actions on prompts from the command line: 

Specify insertion 

point: 

Specify the point. 

Specify shape rotation 

<0>: 

Type the angle of rotation. 

Specify shape scale 

<100.0000>: 

Type the scale factor. 

Note: You can set the parameter values of the shape using the cursor on the screen, in which case there are dynamic 
changes in the appearance of the inserted shape, depending on the cursor  movement. 

FillShapes  

 Menu: Draw –  FillShapes… 

 Command line: FILLSHAPES 

FillShapes can be used as an alternative to the Hatch command; for example, to  represent solid woodland or a 
water-logged area in topographical drawings. Unlike Hatch, the FillShapes command allows you to set the distance 

between rows and columns of shapes and also the angle of rotation of the shape in the filling (do not confuse with 
angle of rotation of the filling). 

FillShape is not associative; that is, when you modify the boundary of the filled area (for example, using the grips or 
the Stretch command),  the fill is not automatically updated. 

After running the command, the Choose Shape dialogue box opens to choose the shape which is required to fill the 
enclosed area: 



 

Note: When you choose a shape to fill the area, the same dialogue box as when choosing a shape to insert into the 
document is used. To choose a shape as a fill, use the same order as when you choose a shape to insert into the 
document (for more details, see «Shape» («Design Drawings commands»). 

Options: 

Yes Create a block from all the shapes that make up the fill. The block can later be broken into separate shapes 
by the Explode command. 

No Create the fill from shapes as separate elements. 

Choose the shape for the fill and close the Choose Shape dialogue box. Perform the appropriate actions at the 

prompts from the command line: 

Click point inside contour: Specify a point. 

Specify shape rotation <0>: Type the value for the rotation angle of the shape. 

Specify shape scale <100.0000>: Type the scale factor. 

Specify shape horizontal offset <16.0000>: Type the distance between the columns of shapes. 

Specify shape vertical offset <16.0000>: Type the distance between the rows of shapes. 

Specify shape grid angle <0>: Type the shape fill angle. 

Combine shapes to block? <Yes> or [Yes/No/]: Select the necessary options and press ENTER to 
end the command. 

Note: You can set the parameter values of the fill using the cursor on the screen, in which case there are dynamic 
changes in the appearance of the fill, depending on the cursor  movement. 

Boundary 

 Menu: Draw –  Boundary… 

 Toolbar: Draw –  

 Command line: BO, BOUNDARY 

This command creates a region bounded by a closed polyline (boundary). A boundary can be created from lines, 
polylines, circles, arcs, ellipses, elliptic arcs, and splines. A boundary can be created from a single closed object or 
from several intersecting or adjoining end points of the objects bounded by the closed region. 

You can create a square or create a hatch for areas bounded by the boundary. 

After starting the command, the Boundary Creation dialogue box opens: 



 

To create a region or boundary: 

 From the Object type list select the Polyline or Region. 

 To search for internal closed boundaries (islands), select the Islands detection  checkbox. 

 Click the Pick Points  icon. 

 Specify a point on the drawing for each internal closed boundary from which you want create a region or a 
polyline. 

 Click ОК. 

To limit the number of objects included in boundary determination, you can create a new set of boundaries: 

  

 In the Boundary Set section, click the New  icon. 

 Select the objects on the drawing that define the boundary. 

When you select the Current viewport option from the list, the current boundaries set is cancelled, and a new 
boundaries set is created of all objects within the boundaries of the current viewport. 

Solid 

 Menu: Draw –  Solid 

 Command line: SOLID 



This command creates filled polygons. 

The first two points define one edge of the polygon.  

Pressing Cancel or Enter at the fourth font prompt creates a filled triangle. Specifying a fifth point creates a 

quadrilateral area. 

The last two points form the first edge of the next filled area. The prompts Specify third point: Specify 

fourth point or [Exit]: are repeated. Specifying successive third and fourth points creates further 

connected triangles and four-sided polygons in a single solid object. 

The order of specifying the vertices when you create a quadrilateral area affects the shape:  

  

Options: 

Exit Ends the command. 

The following prompts are displayed:  

Specify first point: Specify point 1. 

Specify second point: Specify point 2. 

Specify third point: Specify point 3. 

Specify fourth point or 

[Exit]: 
Specify point 4 or press ENTER to create a triangle or cancel the command. 

Specify third point: Specify the next point. 

Specify fourth point or 

[Exit]: 
Specify the next point or select Exit to end the command. 

Wipeout 

 Menu: Draw –  Wipeout 

 Toolbar: Draw –  

 Command line: WIPEOUT 

This command creates a polygonal area that masks underlying objects with the current background colour.  

The wipeout area is bounded by a frame that you can turn on for editing and turn off for plotting. You can convert a 
closed polyline consisting of line segments into a masking object. 

You can create the masking objects in the paper space to hide the objects in the model space. 

Options: 

Undo Undo the last specified point. 

This option allows you to undo all the specified points except the start point. 

Close Closes the boundary and ends the command. 

Polyline Create a mask boundary from an existing closed polyline. 

Frames Select the visibility of the boundaries. 

ON Display the boundaries. 

OFF Hide the boundaries. 

The following prompts are displayed:  

Specify start point or [Frames/Polyline]: Specify the point. 

Specify next point <Start tangent>: Specify the next point. 

Specify next point <Start tangent> or [Undo]: Specify the next point. 

Specify next point <Start tangent> or 

[Undo/Close]: 
Specify all subsequent points defining the 
boundary inside which is necessary to hide the 
objects. 



Specify next point <Start tangent> or 

[Undo/Close]: 
Press ENTER or select the Close option to 

end the command. 

When you create the boundary from closed polyline, the following prompts are displayed:  

Specify start point or [Frames/Polyline]: Select the Polyline option. 

Select closed polyline: Select the polyline. 

When you create the boundary in the frames mode, the following prompts are displayed:  

Specify start point or [Frames/Polyline]: Select the Frames option. 

Enter mode <ON> or [ON/OFF]: Select the required option. 

Note: Selecting the boundary visibility mode  affects all mask objects on the drawing. 

Revision Cloud 

 Menu: Draw –  Revision Cloud 

 Toolbar: Draw –  

 Command line: REVCLOUD 

Revision clouds are polylines that consist of sequential arcs. The maximum arc length cannot be set to more than 
three times the minimum arc length. 

Revision Clouds are used to drawing explanatory labels and markings on the drawings. 

When you start the command, the current parameters of the revision cloud are displayed in the command line: 

Minimum arc length: 15000.000000 Maximum arc length: 15000.000000 Style: Normal 

Options: 

Arc_length Specifies the minimum and maximum length of the arcs in a revision cloud. 

Object Specifies a closed object to be converted to a revision cloud or to reverse the direction of the 
arcs in the revision cloud. 

Style Specifies the style of the revision cloud. 

Normal Normal style. 

Calligraphy Calligraphy style. 

 

The following prompts are displayed:  

Specify first point [Arc length 

/Object/Style]<Object>: 
Specify the first point. 

Guide crosshairs along cloud path...: Move the cursor to the start point of required contour. 
When the cursor draws near to the start point, 
automatic closing of the cloud contour will happen and 
the command will be finished. 

When you convert a closed object to a revision cloud and change the direction of the arcs in the revision cloud to the 
opposite, the following prompts are displayed: 

Specify first point [Arc length 

/Object/Style]<Object>: 
Select the Object option. 

Select object: Select the object. 

Reverse direction [Yes/No]<NO>: Select the required option. 

Normal Style Calligraphy Revision cloud  

   

  



Work with Text 
The text you add to your drawings conveys a variety of information. It may be a complex specification, title block 
information, a label, or even part of the drawing. 

In nanoCAD you can create and edit single-line text and multiline text. 

For short entries that do not require multiple fonts or lines, create single-line text. Single-line text is most convenient 
for titles and labels. 

For long, complex entries, such as technical requirements or technical specifications, create multiline text. 

To input text, the vector fonts with an shx extension are used. These fonts are installed when you install nanoCAD. In 
addition, it is possible to use the TrueType fonts which are installed in the operating system and have a TTF 
extension. 

The nanoCAD tools for text creation allow you to select the typeface, set and edit the text height, weight and 
alignment modes. 

Text 

 Menu: Draw – Text >  Single LineText 

 Toolbar: Draw –  

 Command line: TEXT 

The command allows you to create one or more lines of text. Each text line is an independent object. 

To create multiple lines of text, after each line is input of press ENTER to move the cursor to the next line. You can 

also start a new line, by specifying it with the cursor on the screen. 

To input «degree», «plus/minus», «diameter», you can use the special symbols: %%d, %%p and %%c.  

Press ESC to cancel the command and remove the typed text. 

To finish text input, press the key combination CTRL+ENTER. 

By default, when you input text, the text style that is set as current in the Text Style dialogue box is used. 

If necessary, you can change the text style in the command line immediately after the start of the command. 

Options:  

Style Type the name of the text style in the command line. 

? The display of all available text styles in the command line. 

The following prompts are displayed:  

Input origin of text or [Style]: Select the Style option. 

Type the text style or ?: Type the name of the text style or ? symbol to show the names 
of all available text styles in the command line. 

Input origin of text or [Style]: Input the origin of the text on the drawing. 

Specify text height <2.5000>: Type in the command line or set by cursor on the screen the text 
height. 

Specify rotation of text <0>: Type in the command line or set by cursor on the screen the 
rotation of the text. 

Type the text. Finish input with 

<Ctrl>+<Enter> or cancel it with 

<Esc>...: 

Type the text. Press CTRL+ENTER to finish input and end the 
command. 

To create rotated text: 

 Input the origin of the text. 

 Specify the text height. 

 Specify the rotation of the text: 



 

 After specifying the rotation, the text line remains horizontal for convenience during input. The objects on the 
drawing will be rotated by the specified angle, but in the opposite direction: 

 

 Type the text:  

 

 Finish input with Ctrl+Enter. The image on the screen returns to its normal view: 

 

Multiline Text  

 Menu: Draw – Text >  Multiline Text…  

 Toolbar: Draw –  

 Command line: MT, MTEXT, T 

Multiline text consists of any number of text lines or paragraphs that fit within a width you specify. It can extend 
vertically to an indefinite length. Multiline text is a single object. 

There are more editing options for multiline text than there are for single-line text. For example, you can apply 
underlining, fonts, colour, and text height changes to individual characters, words or phrases within a paragraph 



Draw a rectangular frame by double clicking a point to place multiline text there. Specify the top left corner first and 
then the bottom right corner. 

In the Text format dialog that opens, set the parameters of the multiline text: 

 

Options:  

 Drop-down list to select the text style. 

 

Drop-down list to select the font file that defines the style of the 
characters. 

 
Input field for the characters’ height. 

 

Text formatting modes 

 Bold 
Turns bold formatting on and off for new or selected text. This option is 
available only for characters using TrueType fonts. 

 Italic 
Turns italic formatting on and off for new or selected text. This option is 
available only for characters using TrueType fonts. 

 Underlined Turns underlining on or off for new or selected text. 

 Overlined Turns overlining on or off for new or selected text. 

Text position modes  

 Align left  Sets the alignment of the text to the left. 

 Align center Sets the alignment of the text to the  centre. 

 Align right  Sets the alignment of the text to the right. 

 Justified Sets the text mode to justified. 

 Distributed Sets the text mode to distributed. 

Change the case of selected text 

 Uppercase 
Changes the selected text to uppercase (replace the lowercase 
characters with uppercase). 

 Lowercase 
Changes the selected text to lowercase (replace the uppercase 
characters with lowercase). 

Additional options  

 

Determines the forward or backward slant of the text.  

A positive angle slants text to the right. A negative angle slants text to the left 

 

Widens or narrows the selected characters.  

The 1.0 setting represents the normal width of the letter in this font.  

Set to more than 1.0 to increase the width, and set to less than 1.0 to 
decrease the width. 



 Drop-down list to select the colour for the text. 

 Undo Undoes actions in the text editor.  

 Redo Redoes actions in the text editor. 

 CTRL+ENTER Click button to close the window. 

To create multiline text: 

 Set the text area by specifying the top left corner first and then the bottom right corner. 

 Set the required options in the Text format dialogue box. 

 Click the cursor inside the text area on the drawing. 

 Type the text from the keyboard. 

To move to a new line, press ENTER. 

To insert «degree», «plus/minus», «diameter» symbols, use the Insert symbol command from the context menu: 

 

Note: Text can be overlookd if the font size in the Text format dialogue box is set too small compared to the scale of 
the drawing. 

 Set the position of the selected text using the text input window elements: 

 

 To complete typing the multiline text, press the key combination CTRL+ENTER or click ОК in the Text format 

dialogue box. You can also click outside the text input area on the drawing  to complete the typing of the multiline 
text,. 

Note: Press ESC to cancel the text input and finish the command. 

Background Mask 

You can use the background mask for multiline text. The background mask allows you to place text on the non-
transparent background.  

To create a background mask: 

 Select the multiline text. 

 Select the mask colour from the drop-down Background Mask list (the Text section) of the Inspector window:  



 

The mask is created for the entire text area. When you resize the text area using grips, the size of mask also 
changes. 

 
Select No to cancel the background mask. Select Background color to assign the background colour to the mask. 

The Background Offset option of the Inspector window sets the fields for the text mask. 

The factor value is based on the text height: 

- A factor of 1.0 exactly fits the multiline text object.  

- A factor of 1.5 (set by default) extends the background by 0.5 times the text height 

It is possible to set the background for several text objects at one time. 

Editing Text  
Text objects created in nanoCAD, are selected with grips and they can be edited like other objects: rotated, removed, 
copied etc. 

The properties of text objects can be changed in the Inspector window. 

Note: It is only possible to change single-line text properties in the Inspector window. 

Justification of the text objects 

 Menu: Modify – Object > Text >  Justifytext  

 Toolbar: Modify Object –  

 Command line: JUSTIFYTEXT 

Start the command and select the text object on the screen. Select the justification method in the command line or 
from the context menu. 

For single line text, the JUSTIFYTEXT command changes the type of justification, without moving the text (the 

number and location of the grips will be changed). 

For multiline text, the JUSTIFYTEXT command changes the type of text justification relative to the text boundaries, 

without moving the text (the number and location of the grips for the text area and the location of the boundaries of 
the text area relative to the text will be changed). 

To change the type of justification with a simultaneous change of the text object (for single-line text) and text area (for 
multiline of text) use the Inspector window. 

To do this you should first select the text object and then specify the required type of justification in the Inspector 



window: 

 

 

Start the command and select the text object on the drawing. Specify the type of justification in the command line or 
the context menu. 

Options:  



Left 

 

- Left-justifies the text at the baseline. 

Align 

 

- Inscribes text between two points. 

The width of each character is calculated 
automatically so that the text exactly fits into the 
specified area. 

The character height is not changed. 

Fit 

 

- Inscribes text between two points. 

The height and width of each character is 
calculated automatically so that the text exactly 
fits into the specified area. 

Center 

  

- Aligns text from the horizontal  centre of the 
baseline, which you specify with a point. 

Middle 

 

- Aligns text at the horizontal  centre of the 
baseline and the vertical  centre of the height 
you specify. 

Right 

 

- Right-justifies the text at the baseline. 

TL 

   

Left-justifies text at a point specified for the top of 
the text.  

TC 

   

 Centres text at a point specified for the top of 
the text. 

TR 

   

Right-justifies text at a point specified for the top 
of the text. 

ML 

   

Left-justifies text at a point specified for the 
middle of the text. 

MC 

   

 Centres the text both horizontally and vertically 
at the middle of the text. 

MR 

  

Right-justifies text at a point specified for the 
middle of the text. 

BL 

 
 

Left-justifies text at a point specified for the 
baseline. 

BC 

  
 

 Centres text at a point specified for the baseline. 

BR 

   

Right-justifies text at a point specified for the 
baseline. 

Editing the content of the text objects 

Editing single-line text 

 Menu: Modify – Object > Text >  Edit…  



 Toolbar: Modify Object –  

 Command line: DDEDIT, ED 

Editing the content of single-line text is carried out on the screen. The content of the selected single-line text is 
selected and highlighted automatically to completely edit the text. If necessary, you can insert or delete single 
characters or fragments within the line. For more convenient editing, use the context menu: 

 
Press CTRL+ENTER or click on the drawing out of the single-line text to confirm changes and finish the editing. 

To finish the editing without saving changes, press ESC. 

Note: Press ENTER to split the single-line text into two lines, each of which is transformed into a separate text object 

after the command end. 

Text lines can be edited by double clicking. In this case, the Text settings dialogue box opens where you can edit 
not only text content, but also the options: 

 

Options: 

Text Field for display and editing of the text line content. 

  
Insert 
special 
symbol 

This icon opens an additional menu to insert symbols. 

Text Style Drop-down list to select the text style. 

Color Drop-down list to select the colour of the text line. 

Height Drop-down list to select the height of the characters. 

Keyboard input is also possible. 

Width factor Sets the character spacing.  

Entering a value less than 1.0 condenses the text.  

Entering a value greater than 1.0 expands it. 

Oblique  Sets the oblique angle of the text. 



 The fields display/specify the compatibility of the width factor and oblique of the edited text 
symbols by the value set in the text style. 

For text in which the width factor and/or oblique of the symbols correspond to the specified text 
style, the check boxes are selected in these fields: 

. 

If the width factor and/or oblique of the symbols does not correspond to the specified text style, 
the check boxes are not selected: 

. 

The current values of the editable text are displayed in the input fields for the width factor and 
oblique. 

To set the width factor and oblique for the editable text to the values which correspond to 
those set in the text style, it is necessary to select the check boxes. Values are changed 
automatically: 

. 

The Insert special symbol  icon opens an additional menu that allows you to select and insert the special 

symbols into the current text line: 

 

The buttons , ,  of this menu, in turn, also open: 

Menus of some mathematical and 
other symbols 

Uppercase Greek letters menu Lowercase Greek letters menu 

 

  

Note: Special characters are displayed correctly only in texts based on vector fonts. When you insert characters 
based on a TrueType font into the text,  question marks instead of the special characters appear on the screen.  

To insert symbols: 

 Place the cursor in the required position in the text line. 

 Click the Insert special symbol  icon. 

 Select the required symbol. 

 When you click on the symbol, the additional menu will be closed and the symbol will be inserted automatically at 
the current position of the cursor in text line. 

Editing multiline text 

 Menu: Modify – Object > Text >  Edit…  

 Toolbar: Modify Object –   

 Command line: DDEDIT, ED 



Start the command and select the multiline text. The Text format dialogue box opens. You can also activate the 

editing mode, by double clicking on the multiline text.  

To edit the content and options of multiline text: 

 Select the text fragment in the text box and replace it with new text or type additional text. When text is selected, 
the following options are available in the context menu: Select All, Cut, Copy, Paste, Undo, Redo, Insert 
symbol.  

 Change the options for the selected text by using the tools of the Text format dialogue box. 

 To end multiline text editing, press CTRL+ENTER or click ОК in the Text format dialogue box. You can also by 
click out of the text input area on the drawing to complete text the typing. 

Note: Press ESC to cancel the text input and finish the command.  

Creating a text style 

 Menu: Format –  Text Style… 

  Toolbar: Styles –  

 Command line: ST, STYLE 

The text style is a convenient tool that creates text objects using different fonts, font size, obliquing angle, orientation, 
and other text characteristics. 

You can create and use several text styles in one drawing. Each text object in the drawing is created using the 
current text style. If you want to create text using a different text style, you can make another text style current. 

Except for the default Standard text style, you must create any text style that you want to use. 

You can modify an existing text style in the Text Style dialogue box by changing the settings. 

A text style name can be up to 255 characters long. It can contain letters, numbers, and the special characters dollar 
sign ($), hyphen (-), and underscore (_). 

By default, the text styles are automatically named Style1, Style2, Style3, etc. 

Created text styles are saved with the drawing file.  

You can remove unused text styles from your drawing by deleting them from the Text Style dialogue box or with the 
Purge command (the File menu – Drawing Utilities).  

Note 1: The Standard text style cannot be removed. 

Note 2: Changing the Upside Down and Backwards options has no effect on multiline text objects 

The Text Style dialogue box allows you to set the current text style, create new text styles, change the parameters of 
the existing text styles (imported as a *.dwg or *.dwt  files): 

 

Options: 

  
Add new 
style Creates a new text style. 

  Delete style Deletes unused text styles. 

 Set current  
Sets the selected style  as current. 



Name Name of text style. 

Font name  Drop-down list to select the font file that set the character’s style. 

Extra Drop-down list to select the character’s style. 

The list is empty for shx-fonts. 

For TTF-fonts the following types are available: 

Italic 

Normal 

Bold 

Bold Italic  

Height Input field for the height of the characters: 

Width factor Sets the character spacing.  

Entering a value less than 1.0 condenses the text.  

Entering a value greater than 1.0 expands it. 

Oblique angle Sets the oblique angle of the text. 

 Upside down Turn on/off the mode to display the characters upside down. 

 Backwards Turn on/off the mode to display the characters backwards 

 

 

Vertical 
Turn on/off the mode to display the characters aligned vertically. Vertical is only available if 
the selected font supports dual orientation. 

Note: The vector fonts (*.shx) are marked with S in the Font name list, TrueType-fonts with T. 

To create a text style: 

 Select the text style, which the new text style should be based on (the Add new style  icon is available). 

 Click the Add new style  icon. The new style with Style1 name will be created. 

 To rename the created style, double click on the text style name, type the new name and press ENTER.  

 From the drop-down list select the font file. 

 Specify the required font options (height, extra, oblique angle, etc.). 

 To set the created text style as the current one, double click in the left field next to the text style. The flag  in 

this box indicates that the style is set as the current one. 

 Click Close to close the dialogue box. 

Some commands are also available in the context menu by right clicking in the field of the text styles list: 

 

To delete a text style: 

 Select the text style you want to delete (the Delete style  icon is available). 



 Click the Delete style  icon or select Delete Style from the context menu (the selected style must not be the 

current one). 

 Click Close to close the dialogue box. 

Find and Replace Text 

 Menu: Edit –  Search and Replace…  

 Command line: FIND 

The Search and Replace command is used to find text in the document: 

You can also start the command from the context menu: 

 
Start the command to open the Find and Replace dialogue box: 

 

Options: 

Find what: In the Find what field, type the text to be searched for. 



Replace with: In the Replace with field, type the text that is required to replace the found lines  

Look In  Set the Look in parameter.  

The following options are available: 

In whole document 

In current space 

In current selection 

 Click the icon  to open the Quick selection dialogue box. 

Find options 

 or  This icon maximises/minimises the options list. 

Match case If this is checked, the search is made to match the case of the letters. 

Match whole word If this is checked, the search is made for whole words; that is letter combinations separated by 
stops or spaces. 

Search in found      This option is accessible after the line search has been made. It restricts the search range. 

Use extended 
options 

This option is accessible when searching in the objects base. Click the icon  and in the 
window that appears, choose the expanded search spaces 

Use regular 
expressions 

Switch to the search mode with additional choices of conditions.  

Click the icon  and in the window that appears, choose the required expression. 

 
For guidance on the elements of the list, there is a help with more detailed explanations. 

The expression is selected with a left-click. It is possible to use some regular expressions. 

Multiline text Switch on/off the multiline text search mode. 

When the mode is on, the Find what and the Replace with fields take the form:  

 



 

Starts the search procedure. 
The search result will be shown in the table. 

 

 Replaces all found fragments with the new value. 

 Starts the process of consecutive replacement of the found fragments. 

 Passes the next found fragment in the list without replacing it with the new value. 

 Clear All Click this icon to clear the list of found text fragments. 

 Stop Click this icon to stop the find and replace process. 

 
Group results by 
objects 

Click this icon to group results by objects. 

 

 

Show object  
Click this icon to show the selected text fragment in the table on the drawing or in the 
database of objects. 

 Edit object 
Click this icon to open the Text settings dialogue box to edit the found text fragment on 

the drawing. 

Note: Left-click on the headings of the table columns of the search results to sort the found text fragments: 

  

To find and edit the text fragment on the drawing: 

 Click the Search and Replace command in the context menu. 

 Type the text, for example, maximum, into the Find what field. 

 Click the button . 

 Select the required line in the table of search results. 



 

 Double click on the required line, or click the Show object  icon, or select the Show object command from 

context menu: 

 

 As a result, there is auto-panning of the found fragment that contains the selected text on the drawing: 

 

 Click the Edit object  icon or select the Edit object command from the context menu to open the Text 

settings dialogue box: 

 



 Type the required changes and click OK. 

Dimensioning 
Dimensions display the geometrical attributes of the objects on the drawing, as well as the distances and angles 
between them. 

The dimensions are part and parcel of any drawing. 

In general, dimensions can consist of the following items: 

 The dimension line indicates the direction and extent of a dimension. For angular dimensions, the dimension line 
is an arc. 

 The extension line is drawn from the measured object to the dimension line. 

  

 Arrows are displayed at the ends of the dimension line. You can use different types of arrows, including tick 
marks and points. 

 The dimension text displays the numerical value of the measured object. The text can also include prefixes and 
suffixes, for example, symbols of the radius, diameter, degree, etc., as well as tolerances. 

 The leader is the line joining together the dimension text and the dimension line to which it belongs. Leaders can 
be created automatically (when the corresponding options are set), when the text size does not fit between the 
extension lines or when you manually drag the dimension text (with grips) to another place. 

The four basic types of dimensioning are: 

 Linear dimensions display the distance between the specified points. This type includes the following 
dimensions: 

 horizontal, 

 vertical, 

 aligned, 

 ordinate, 

 group dimension, 

 base dimension and 

 dimensions chain. 

 Radial dimensions indicate the radii and diameters of arcs and circles. These include: 

 diameter, 

 radius,  

 big radius. 

 Angular dimensions are used to indicate the angles between two segments or three points. 

 Arc dimension displays the length of an arc or an arc segment of a polyline. 

Dimensions can be associative, non-associative or exploded. Associative dimensions adjust to changes in the 
geometric objects that they measure. 

 Associative dimensions. Automatically adjust their locations, orientations and measurement values when the 
geometric objects associated with them are modified.  

 Non-associative dimensions. Selected and modified with the geometry they measure. Non-associative 
dimensions do not change when the geometric objects they measure are modified. 

 Exploded dimensions. Contain a collection of separate objects: lines, arrows, arcs and text, rather than a single 
dimension object. Exploded dimensions do not change when the geometric objects they measure are modified. 

It is not recommended to disable the associative dimensioning mode which is used  by default or to explode the 
associative dimensions without a strong reason. 

In nanoCAD, the dimensioning commands are available from the Dimensions menu and from the Utilities toolbar: 

 
If necessary, you can use the Dimensions toolbar: 

 

Some features of nanoCAD’s dimensioning 

Set the Scale for Dimensions 
You can specify the size of dimensions in your drawing. Set the scale value using the Scale icon in the status line. 

Dimension scale affects the size of the dimension geometry relative to the objects in the drawing. At dimensioning, all 



size elements (height of the dimension text, size of the arrows etc.) are automatically scaled corresponding to the 
current dimension scale. 

The dimension scale is useful to dimension fragments drawn in the model space at the 1:1 scale. Their scale will 
change at arrangement on the worksheet.  

For example, two views are drawn in the model space at the 1:1 scale . The first view will be placed on the layout at 
1:1, the second view (based on its actual size) at 1:10. For dimensioning in the model space, you must specify the 
dimension scale as 1:1 for the first view and 1:10 for the second view. All elements of dimensioning of the first view 
will have values determined by the dimension style (for example, the height of the dimension text – 2.5 mm, the 
length of the arrows – 2.5 mm, etc.). The value of the second view dimensions will be automatically increased by 10 
times (the height of the dimension text in the model space will be 25 mm, the length of the arrow – 25 mm), so that 
the dimensions are displayed correctly (the height of the dimension text – 2.5 mm, the length of the arrows – 2.5 mm, 
etc.) when this view is inserted on the layout. 

When you change the dimension scale, the dimensions are not recalculated automatically. 

To change any size of dimension scale, it is necessary to select it and select the required scale in the Measurement 
scale menu. 

To set drawn dimensions to the current dimension scale, it is necessary to select the Set to selection command in 
Measurement scale menu and select the required dimensions on the drawing. 

 

For more information on using scale, see «Symbol scale and measurement scale» («TUNING NANOCAD»). 

Dimensioning with a single command 

 Menu: Dimensions –  Auto  

 Toolbar: Utilities –  

 Command line: D, DIMLINEAR, DLI 

1.  You can set all dimensions in nanoCAD using a single command – Auto (the Dimensions menu) or 
Dimensions (on the Utilities and the Dimensions toolbars). 

It is recommended to turn on the snap mode to maximise the facilities for dimensioning with a single command; set 
the required type of snap as a permanent snap. Switch on the To turn the object snap “Nearest” on automatically 
during an insert of objects option in the nanoCAD – Options dialogue box on the Main tab of the Edit section (the 
Tools menu –  Settings parameters). 

2.  Start the Auto command and select any dimensions from the context menu by right clicking: 

, 

or by selecting the appropriate option in the command line: 

Insert dimension [Auto /aLigned /Horizontal /Vertical /Radial /Diametral /BigRadius 

/arC/U-angUlar/Ordinate /CHain/Base/Properties /Grouped]: 



3.  You can also set dimensions on the drawing directly after starting the Auto command. 

When you move the cursor over any graphic entity (segment, segment of polyline, arc or circle) it will be highlighted 
automatically: 

 
When the graphic entities are highlighted, nanoCAD displays the secondary symbols near the cursor that serve as 
prompts for the user.  The secondary symbols indicate what dimension will be drawn if you left click on the graphic 
entity: 

 Aligned dimension. 

 Horizontal dimension. 

 Vertical dimension. 

 Diameter dimension. 

 Radius dimension. 

 Angle dimension. 

 Base dimension. 

This method is used for dimensioning relating to a graphic primitive. 

4.  To quickly draw the dimensions that relate to a graphic primitive, you can turn off the object snap mode. 

5.  When you move cursor along the highlighted primitive, the corresponding snap markers are displayed at its 
characteristic points. You can use it to specify the initial points of the extension lines:  

 
This method is used for dimensioning the elements of a drawing consisting of several graphic primitives. 

6.  nanoCAD allows you to place the dimensions at given distances from each other, not only in base 
dimensions, but also at linear dimensioning. The distance by which the new dimension should be spaced from the 
existing one, is specified by a base-line spacing option in the Modify dimension style dialogue box on the Lines tab. 

To do this, it is necessary to specify the position of the dimension line and slowly move the cursor from the existing 
dimension line. When you draw near a specified distance, the new dimension line will be “attracted” to the required 

position. The colour of the secondary character displayed near the cursor changes from red ( ,  or ) to blue 

( ,  or ): 

Dimension line is not at the specified distance Dimension line is at the specified distance 

  

7.  At dimensioning, you can set the extension line oblique by holding the CTRL key and moving the cursor in 

the desired direction. 

8.  To change the position of the dimension text, hold the SHIFT key and move the cursor to the first or second 
extension line (by default, the dimension text is located in the centre of the dimension line). 

9.  During dimensioning, you can use the Edit dimension  dialogue box to specify the required properties and 
options for the executable dimension. To do this, it is necessary to select the Properties option in the command line 
or context menu. The dimensioning command is not interrupted.  

10.  To finish dimensioning, press ESC or select Cancel from the context menu. 

11.  You can dimension chamfers and fillets during their creation. Turn on the Measure chamfer or Measure fillet 
mode in the Chamfer or Fillet dialogue box.  

Linear dimensions 

Horizontal, vertical and aligned dimensioning 
In the following examples, horizontal, vertical and aligned dimensions are created by using the Auto command. 

 Menu: Dimensions –  Auto  



 Toolbar: Utilities –   

 Command line: D, DIMLINEAR, DLI 

To dimension you can use also the Horizontal, Vertical and Aligned dimension commands. 

 Menu: Dimensions –  Horizontal 

 Toolbar: Utilities –  

 Command line: DIMHOR 

 

 Menu: Dimensions –  Vertical 

 Toolbar: Utilities –  

 Command line: DIMVER 

 

 Menu: Dimensions –  Aligned dimension 

 Toolbar: Utilities –  

 Command line: DAL, DIMALIGNED 

 

To  specify the horizontal dimension of the line: 

 Start the Auto command. 

 Place the cursor over the line to 
show its dynamic highlighting 

and display the character . 

Left click to confirm the 
dimensioning:  

 Move the cursor down to 

change the character to : 

 Left click to set the position of 
the dimension line: 

   

To  specify the vertical dimension of the line: 

 Place the cursor over the line to 
show its dynamic highlighting 

and display the character . 

Left click to confirm the 
dimensioning: 

 Move the cursor to the right to 

change the character to : 

 Left click to set the position of 
the dimension line: 

   

To  specify the aligned dimension of the line: 

 Place the cursor over the line to 
show its dynamic highlighting 

and display the character . 

Left click to confirm the 
dimensioning: 

 Move the cursor to the left to 

change the character to : 

 Left click to set the position of 
the dimension line: 



   

For dimensioning the arc length using characteristic points: 

 Start the Auto command. 

 Place the cursor over the arc to 
show its dynamic highlighting: 

 Move the cursor near to the 
endpoint of the arc. When the 
snap marker appears, left click 
to choose the endpoint of the 
first extension line of the 
dimension: 

 Move the cursor to the other 
endpoint of the arc and left click 
to choose the endpoint of the 
second extension line of the 
dimension: 

   

 Move the cursor to the middle of 
the arc to display the character 

: 

 Move the cursor down and to 
the left to change the character 

to : 

 Left click to set the position of 
the dimension line: 

   

For dimensioning between two parallel line segments: 

 Start the Auto command. 

 Select the lower line 
segment by 
highlighting it and left 
click: 

 Select the top line 
segment by 
highlighting it and left 
click when the 
horizontal character 
appears: 

 Move the cursor up 
and to the left to 
change the character 

to : 

 Left click to set the 
position of the 
dimension line: 

    

To draw the dimension from a point to a line segment: 

 Start the Auto command. 

 Select the lower line 
segment by 
highlighting it and left 
click:: 

 Select the endpoint of 
the second line 
segment using the 
snap: 

 Move the cursor up 
and to the left: 

 Left click to set the 
position of the 
dimension line: 

 
   

Ordinate dimensioning 

 Menu: Dimensions –  Ordinate 



 Toolbar: Utilities –  

 Command line: DIMORDINATE 

To  specify the chain of linear ordinate dimensions: 

 Start the Auto command. 

 Select the Ordinate option in the command line or context menu. 

 Specify the first point of the first dimension:  Specify the second point of first dimension: 

  

 Specify the dimension line location:  Select the Base option in the command line or context 

menu and specify the endpoint of the second ordinate 
dimension: 

    

 Specify all the endpoints of the other ordinate dimensions:  Press ENTER to finish the command: 

  

To specify the chain of angular ordinate dimensions: 

 Start the Auto command. 

 Select the angUlar option in the command line or context menu. 

 Specify the first point of the 
angular dimension (vertex of 
angle): 

 Specify the second point of the 
angular dimension: 

 Specify the third point of the 
angular dimension: 

   

 Select the Ordinate option in 

the context menu and specify 
the dimension line location: 

 Select the CHain option in the 

command line or context menu 
and specify the endpoint of the 
second dimension: 

 Specify the endpoint of the third 
dimension: 

   



 Specify the endpoint of the last dimension:  Press ENTER to finish the command: 

  

Group dimensioning 

 Menu: Dimensions –  Group dimension 

 Toolbar: Utilities –  

 Command line: QDIM 

The Group dimension command is particularly useful for creating a series of vertical or horizontal dimensions. 

To specify the group dimensions: 

 Start the Auto command. 

 Select the Grouped option in the command line or context menu. 

 Select the objects you want to dimension:  Press ENTER to end the selection of objects: 

  

Depending on the direction of the cursor movement (vertical or horizontal), the chain of vertical or horizontal 
dimensions will be dynamically displayed. 

 Move the cursor to change the character from red to 

blue : 

 Left click to specify the location of the dimension 
lines: 

  

When dimensioning the objects that have a small length , the crossed arrows are 
automatically replaced by notches or points: 

  

The setting for replacement of intersecting arrows is performed in the nanoCAD – Options dialogue box (The Tools 

menu - Settings Parameters): 



 

Base dimensioning 

 Menu: Dimensions –  Base dimension 

 Toolbar: Utilities –  

 Command line: DBA, DIMBASELINE 

Base dimensions are a sequence of dimensions measured from a reference point. 

A base dimension creates a linear, angular or ordinate dimension from the baseline of the previous or selected 
dimension. 

To draw the base dimensions: 

 Start the Auto command. 

 Select the Base option in the command line or context menu. 

 Select the extension line of the 
previous dimension as a base: 

 Specify the endpoint of the first 
dimension: 

 Specify the endpoints for all the 
other dimensions and press 
ENTER to finish the command: 

   

The default spacing between the baseline dimensions can be set from the Modify dimension Style, Lines  tab, 
Baseline Spacing. 



Chain dimensioning 

 Menu: Dimensions –  Dimensions chain 

 Toolbar: Utilities –  

 Command line: DCO, DIMCONTINUE 

The dimensions chain creates a dimension that starts from an extension line of a previously created dimension. 

The dimensions chain can be a linear, angular or ordinate. 

To draw the dimensions chain, the object must have least one linear, angular or ordinate dimension. 

To draw the dimensions chain: 

 Start the Auto command. 

 Select the CHain option in the command line or context menu. 

 Select the previously created 
dimension as the base: 

 Specify the endpoint of the first 
dimension: 

 Specify the endpoints for all the 
other dimensions and press 
ENTER to finish the command: 

   

Radial dimensions 

Diametrical dimensioning 

 Menu: Dimensions –  Diameter dimension 

 Toolbar: Utilities –  

 Command line: DIMDIAMETER 

For dimensioning the diameter of a circle: 

 Start the Auto command. 

 Place the cursor over the circle 
to show its dynamic highlighting 

and display the character . 
Left click to confirm the 
dimensioning: 

 Choose the location of the 
dimension: 

 Left click to fix the chosen 
location of the dimension: 

 

   

For dimensioning the diameter of a circle using characteristic points: 

 Turn on the Quadrant snap. 

 Start the Auto command. 

 Place the cursor over the circle 
to show its dynamic highlighting 

and display the character . 
Left click to confirm the 
dimensioning: 

 Move the cursor to the first 
characteristic point of the circle 
and left click to specify the 
endpoint of the first extension 
line of the dimension: 

 Move the cursor to the second 
characteristic point of the circle 
and left click to specify the 
endpoint of the second extension 
line of the dimension: 

 

 

 

  



 Move the cursor up to display 

the character . 

 Move the cursor up to change 
the character from red to blue: 

 Left click to set the location of the 
dimension line: 

   

Radial dimensioning 

 Menu: Dimensions –  Radius dimension 

 Toolbar: Utilities –  

 Command line: DIMRADIUS, DRA 

To draw the radius of a circle: 

 Start the Auto command. 

 Select the Radial option in the command line or context menu. 

 Place the cursor over the circle 
to show its dynamic highlighting. 
Left click to confirm the 
dimensioning: 

 Choose the location of the 
dimension: 

 Left click to fix the chosen 
location of the dimension: 

   

To draw the arc radius: 

 Start the Auto command. 

 Place the cursor over the arc to 
show its dynamic highlighting 

and display the character . 
Left click to confirm the 
dimensioning: 

 Choose the location of the 
dimension: 

 Left click to fix the chosen 
location of the dimension: 

   

Options for dimensioning the arc radius: 

   

Big radius dimensioning 

 Menu: Dimensions –  Big radius 

 Toolbar: Utilities –  



 Command line: DIMJOGGED, DJO 

The big radius command creates jogged dimensions for circles and arcs. 

To draw the big radius: 

 Start the Auto command. 

 Select the BigRadius option in the command line or context menu. 

 Place the cursor over the arc to 
show its dynamic highlighting. 
Left click to confirm the 
dimensioning: 

 Choose the location of the 
dimension: 

 Left click to fix the chosen 
location of the dimension: 

   

Angular dimensions 

 Menu: Dimensions –  Angle dimension 

 Toolbar: Utilities –  

 Command line: DAN, DIMANGULAR 

To draw the angle between two segments: 

 Start the Auto command. 

 Place the cursor over one of the segments to show 
its dynamic highlighting and display the character 

. Left click to confirm the dimensioning: 

 Place the cursor over the second segment to show 
its dynamic highlighting and display the character 

. Left click to confirm the dimensioning: 

 
 

 Choose the location of the dimension:  Left click to set the location of the dimension line: 

  

For dimensioning the angluar dimension using characteristic points: 

 Start the Auto command. 

 Select the anGular option in the command line or context menu. 

 Specify the first point of the 
angular dimension (vertex of 
angle): 

 Specify the second point of the 
angular dimension: 

 Specify the third point of the 
angular dimension: 

   

 Specify the location of the dimension line:  Press ENTER to finish the command: 



   

Arc length 

 Menu: Dimensions –  Arc  

 Toolbar: Utilities –  

 Command line: DAR, DIMARC 

This command creates an arc length dimension. Arc length dimensions measure the distance along an arc or polyline 
arc segment.  

To  differentiate between the arc dimensions and the linear or angular dimensions, the arc symbol is displayed above 
the dimension text by default. 

For dimensioning the arc length dimension: 

 Start the Auto command. 

 Select the arC option in the command line or context menu. 

 Place the cursor over the arc to 
show its dynamic highlighting. 
Left click to confirm the 
dimensioning: 

 Choose the location of the 
dimension: 

 Left click to fix the chosen 
location of the dimension: 

     

Dimensions editing  
You can edit the existing dimensions using the Inspector window or the Edit dimension dialogue box. 

The content of the Inspector window depends on the type of dimension selected. 

The form of the Edit dimension dialogue box is different for different dimension styles. For the Standard and SPDS 
dimension styles, the Edit dimension dialogue box will have a more simplified form than for the ESKD dimension 

style. 

ESKD dimension style Standard and SPDS dimension styles 

  

The options and input fields, coupled with the fit settings and buttons for the Technical conditions, Fit table, Square 
brackets, Round brackets, Pointed brackets are not included in the Edit dimensions dialogue box for the 
Standard and SPDS dimension styles. 

Below is a description of the Edit dimension dialogue box for the ESKD dimension style: 

You can open the Edit dimension dialogue box in different ways: 

 Double click on the dimension. 

 Place the cursor over the dimension and press the right mouse button. 

 Select the dimension, press the right mouse button and select the Edit command from the context menu. 



 
The structure of the input fields for the dimension text: 

 

 Options: 

Dimension type In this section the dimension type (for example, Linear dimension, Diametral dimension, Angular 
dimension etc.) and values of the dimension text are displayed. 

 

Prefix The prefix consists of the text input field and the Symbol button. 

If the dimension does not have a special symbol that is set as the default prefix, the button is 

displayed without an image: . Click the icon to open the panel to select a symbol: 

  

If a special symbol from the panel is set by default, it appears on the button: 

 

A prefix specified in the Edit dimension dialogue box has precedence over a prefix set by 
default. 

Example of dimension text with a prefix consisting of the text and special symbol: 

 

Nominal value Field to display and edit the nominal value of the dimension text. 

Suffix This field displays the suffix of the dimension text set by default, such as the chamfer angle 



designation: 

 
In the same field, you can set the value of a custom symmetrical fit of the dimension: 

 

Fit designation The fields display the specified fit values of the dimension. 

Depending on the way the fits are written (the Fit view button), the values in the fields can be 

displayed in different ways: 

  
 

 
 

 

Note The input field for a note for the dimension is used to create the hyperlink to the item that 
contains the technical conditions that define the general requirements for several dimensions. For 
example, in this field you can type the star symbol (*) to denote the reference dimension (having 
the corresponding item in the technical conditions). 

The second line 
of the 
dimension text 

An example displaying the dimension text consisting of two lines: 

 

Buttons 

 
These buttons are used to change the arrow type. 

Click to open the panel and select the required arrow type: 

 

   
These buttons are used to turn on/off the modes for placing text in the Square, Round or Pointed 
brackets. 

 
This button is used to turn on/off the mode for placing the text on the leader. 

Example: 

Mode is on Mode is off  



  
 

 This button is used to turn on/off the mode for placing the text in a rectangle. 

 
Use this button to choose the method of writing the fit. 

Click to open the following panel: 

 

 Opens the Technical conditions dialogue box. 

 Opens the Fits dialogue box. 

 

Opens the Calculator. 

 
This button opens the Text settings dialogue box to change the style, height and colour of the dimension 

text. 

 
The Match Properties button temporarily closes the Edit dimension dialogue box to select the dimension 

whose properties should be copied to the editable dimension. 

Please note that context menus, which include the following commands, are available in the input fields of the 
dimension text : 

 

These commands are used to collect inputted information and insert it into 
the input fields if necessary.  

 

The functions of the first three commands of this section are as their names 
suggest. 

The Pick from drawing command temporarily closes the Edit dimension 

dialogue box and opens the Value picker dialogue box to get different 
objects properties from the drawing. You can then insert them into the Edit 
dimension dialogue box. 

The Symbols command allows you insert various symbols into the input 
fields, including characters from the Windows table. 

Should this say 
Much Properties 
or More 
Properties? 
 
 
 
 
 



 

 

The commands from this section allow you to perform operations using the 
clipboard. 

 

Sets the precision of the nominal dimension. 

To set the dimension fit:  

 Click the button . 

 In the panel that appears, select the method of writing  the tolerances:  

 

 Click the button . 

 In the opened Fits dialogue box, select the required values: 



 

Break and Restore dimensions 
If necessary, you can use breaks to improve the readability of the graphical information and exclude errors in the 
dimensions on the drawing. The Break dimension command, unlike the Explode command from the Modify menu, 
does not break the completeness of the dimension  and does not result in a loss of associativity. 

 Essentially, the Break dimension command does not remove the dimension part, but places a mask  on it. 

To break the dimension (or rather, to place the mask), it is necessary to select two points on the dimension or 
extension line that define the location and length of the mask.  

When you edit the dimension or an object that intersects dimension, the dimension mask (break) will not be updated 
automatically. So after moving the dimension or editing an object that intersects dimension, you should first restore 
the dimension and then add a dimension mask (break) again.  

Dimension Break 

 Menu: Dimensions –  Break dimension 

  Toolbar: Utilities –  

 Command line: DIMBREAK 

Creates a break in the dimension. When you create a break, turn on the Nearest snap (or switch on the To turn the 
object snap “Nearest” on automatically during an insert of objects option in the nanoCAD – Options dialogue 
box on the Main tab of the Edit section (the Tools menu –  Settings parameters). 

Options:  

Unbreak Removes the breaks in the selected dimension. 

 

    

The following prompts are displayed:  

Select dimension to break: Select the dimension. 

Select first point [Unbreak]: Select the first point. 

Select second point [Unbreak]: Select the second point. 

When you select a dimension, the Break line command will be available from context menu. 



Dimension Restore  

 Menu: Dimensions –  Restore dimension  

  Toolbar: Utilities –  

 Command line: DIMUNBREAK 

Removes the dimension breaks created by the Break dimension command. 

The following prompts are displayed:  

Select dimensions to unbreak: Select the dimensions and press ENTER. 

When you select dimension, the Unbreak lines command will be available from context menu. 

Explode dimensions 
In some cases, it is necessary to explode a dimension into separate parts – lines, arrows, arcs and dimension text. 
To perform this operation, use the Explode command from the Modify menu. 

It is strongly recommended not to explode the dimensions unless there is a specific need. 

Dimension styles 

 Menu: Format –  Dimensions styles…  

 Menu: Dimensions –  Dimensions styles… 

 Toolbar: Styles –  

 Command line: DIMSTYLE 

A dimension style is a named collection of dimension settings that control the appearance of dimensions, such as 
arrowhead style, text location and lateral tolerances. 

nanoCAD is supplied with two dimension styles: ESKD and SPDS, corresponding to the requirements of the Unified 
Design Documentation System and Construction Design and Estimate Documentation. 

When the program  is installed, the user is prompted to choose which style will be used by default: 

 
If necessary, you can change the default style in the Main tab of the nanoCAD – Options dialogue box (the Tools 
menu – the Settings Parameters command). 

Controlling of the dimension styles is carried out in the Dimension Style Manager dialogue box: 



 

Options: 

Current style: Displays the name of the current dimension style . 

Styles: Displays a list of the dimension styles in the drawing 

Preview of: Shows a graphic representation of the style selected in the Styles list. 

  Sets the style selected under Styles as the current one. 

 Displays the Creating style dialogue box where you can define a new dimension style. 

 Changes the options for the style selected in the list. 

 Changes the options for the current dimension style. 

 Compares the properties of two dimension styles. 

 Deletes the selected dimension style. 

To set the current dimension style: 

 Select the required style from the Styles list. 

 Click the button . 

To create a new dimension style: 

 In the Styles list, select the style from which you want to create a new one. 

 Click the button . 

 In the Creating style dialogue box, type a name for the new style: 



 

Options: 

New style 
name: Specifies the new dimension style name. 

Start with:  Sets the style to use as a basis for the new one. 

Use for: Creates a dimension substyle that applies only to specific dimension types. 

The following substyles are available: 

All dimensions 

Linear dimensions 

Angular dimensions 

Diametral dimensions 

Radial dimensions 

Ordinate dimensions 

Leader dimensions 

 Click ОК.  

 In the Modify dimension style dialogue box that appears, set the required options for the new dimension style. 

To modify a dimension style: 

 In the Styles list, select the required style. 

 Click the button . 

 In the Modify dimension style dialogue box that appears, set the new options for the dimension style to be 
modified. 

To change the options for the current dimension style: 

 In the Styles list, select the current dimension style (if you select any other style, the Override button 

 will not be available). 

 Click the button . 

 In the Modify dimension style dialogue box that appears, override the options for the current dimension style. 

To compare two dimension styles: 

 In the Styles list, select the first dimension style which you want to compare. 

 Click the button . 

 In the Compare Dimension Styles dialogue box, from the With list select the second dimension style for 
comparing: 



 

Options: 

Compare: Drop-down list to select the first dimension style for comparing. 

With:  Drop-down list to select the second dimension style for comparing. 

Found differences: 

Description List of the properties of the compared dimension styles. 

Variable List of the dimension variables that define the compared properties. 

 Use this button to copy the comparison results to the clipboard. 

The Compare Dimension Styles dialogue box can be used to view a list of all the properties of any dimension style. 
To do this, select the same dimension style in the Compare and With lists: 



 

To delete a dimension style: 

 In the Styles list, select the style that you want to delete. 

 Click the button . 

Modify a dimension style 
The properties of new dimensions are set and options for existing dimension styles are modified in the Modify 
dimension style dialogue box.  

The name of the dimension style being modified is displayed in the dialogue box title: 

 
The Modify dimension style dialogue box contains the following tabs: 

 Lines 

 Symbols and arrows 

 Text 

 Fit 

 Primary units 

 Alternate units 

 Tolerance 

The window in the upper right corner of each tab displays a graphical preview of the properties of the dimension style 
being modified. 



The Lines tab 
Sets the properties of dimension lines and extension lines. 

 

Options: 

Dimension lines  

Color: Displays and sets the colour for the dimension line. 

Linetype: Sets the linetype of the dimension line. 

Lineweight: Sets the lineweight of the dimension line. 

Extend beyond 
ticks: 

Specifies the distance to extend the dimension line past the extension line when you use ticks 
and no marks for arrowheads. 

Extend beyond ticks: 2 Extend beyond ticks: 0 

   
 

Baseline 
spacing: 

Sets the spacing between the dimension lines of a baseline dimension. 

                    

Suppress:        
Dim line 1, Dim 
line 2 

Suppresses the display of dimension lines. 

Dim Line 1 suppresses the first dimension 
line 

Dim Line 2 suppresses the second 
dimension line 

  
 



Extension lines 

Color: Sets the colour for the extension lines. 

Linetype ext 
line 1: Sets the linetype of the first extension line. 

Linetype ext 
line 2: Sets the linetype of the second extension line. 

Lineweight: Sets the lineweight of the extension line. 

Suppress:        
Ext line 1, Ext 
line 2 

Suppresses the display of extension lines. 

Ext Line 1 suppresses the first extension 
line 

Ext Line 2 suppresses the second 
extension line 

  
 

Extend beyond 
dim lines: 

Specifies the distance to extend the extension lines above the dimension line.  

Extend beyond dimension line: 1.25 Extend beyond dimension line: 0 

  
 

Offset from 
origin: 

Sets the distance to offset the extension lines from the points on the drawing (object) that define 
the dimension. 

Offset from object: 0.625 Offset from object: 0 

  
 

Fixed Length 
Extension 
Lines: 

Enables fixed length extension lines. 

Length: Sets the total length of the extension lines. 

 

The Symbols and arrows tab 
Sets the format and placement for arrowheads,  centre marks, arc length symbols and jogged radius dimensions. 



 

Options: 

Arrowheads 

First: Sets the arrowhead for the first dimension line.  

When you change the first arrowhead type, the second arrowhead automatically changes to 
match it. 

Second: Sets the arrowhead for the second dimension line. 

When you change the second arrowhead type, the first arrowhead does not automatically 
change to match it. 

Leader: Sets the arrowhead for the leader line. 

Arrow size: Displays and sets the size of arrowheads. 

Center marks  

None Creates no  centre mark or  centreline.  

Mark Creates a  centre mark. 

Line Creates a  centreline. 

Size: Displays and sets the size of the  centre mark or  centreline. 

Arc length symbol  

Preceding 
Dimension Text 

Places arc length symbols before the dimension text. 

Above 
Dimension Text 

Places arc length symbols above the dimension text. 



None Suppresses the display of arc length symbols. 

Radius dimension jog 

Jog angle: Determines the angle of the transverse segment of the dimension line in a jogged radius 
dimension. 

The Text tab 
Sets the format, placement, and alignment of dimension text: 

 

Options: 

Text appearance  

Text style: Lists the available text styles. 

 Displays the Text styles dialogue box where you can create or modify text styles. 

Text color: Sets the colour for the dimension text. 

Fill color: Sets the colour for the text background in dimensions. 

Text height: Sets the height of the current dimension text style. 

If a fixed text height is set in the Text Style (that is, the text style height is greater than 0), that 
height overrides the text height set here. 

Fraction height 
scale: 

Sets the scale of fractions relative to the dimension text. 

This option is available only when Fractional is selected as the Unit Format on the Primary 

Units tab. The value entered here is multiplied by the text height to determine the height of 
dimension fractions relative to dimension text. 

Draw frame When selected, draws a frame around the dimension text. 



around text 

Text placement  

Vertical: Controls the vertical placement of the dimension text in relation to the dimension line: 

 

Centered –  Centres the dimension text between the two parts of the 

dimension line. 

 

Above - Places the dimension text above the dimension line. The 

distance from the dimension line to the baseline of the lowest line of 
text is the current text gap. 

 

Outside - Places the dimension text on the side of the dimension line 

farthest away from the first defining point. 

 

JIS - Places the dimension text to conform to a Japanese Industrial 

Standards (JIS) representation. 

 

Horizontal: Controls the horizontal placement of the dimension text along the dimension line in relation to 
the extension lines: 

 

Centered –  Centres the dimension text along the dimension line 

between the extension lines. 

 

At Ext Line 1 - Left-justifies the text with the first extension line along 

the dimension line. The distance between the extension line and the 
text is twice the arrowhead size plus the text gap value. 

 

At Ext Line 2 - Right-justifies the text with the second extension line 

along the dimension line. The distance between the extension line and 
the text is twice the arrowhead size plus the text gap value. 

 

Over Ext Line 1 - Positions the text over or along the first extension 

line. 

 

Over Ext Line 2 - Positions the text over or along the second 

extension line. 

 

Offset from dim 
line: 

Sets the current text gap, which is the distance around the dimension text when the dimension 
line is broken to accommodate the dimension text. 

This value is also used as the minimum length required for dimension line segments. 

Text is positioned inside the extension lines only if the resulting segments are at least as long as 
the text gap. Text above or below the dimension line is placed inside only if the arrowheads, 
dimension text and a margin leave enough room for the text gap. 

Offset from dim line: 0.625 Offset from dim line: 0 

  
 

Text alignment  

Horizontal Places text in a horizontal position. 

                          

Aligned with 
dimension line               

Aligns text with the dimension line. 

ISO standard Aligns text with the dimension line when text is inside the extension lines, but aligns it 



horizontally when text is outside the extension lines. 

  
 

The Fit tab 
Controls the placement of the dimension text, arrowheads, leader lines and the dimension line: 

 

Options: 

Fit options 

 

Controls the placement of text and arrowheads based on the space available between 
the extension lines. 

Either text or arrows 
(best fit) 

Moves either the text or the arrowheads outside the extension lines based on the best 
fit. 

Arrows Moves the arrowheads outside the extension lines first, then the text. 

Text Moves the text outside the extension lines first, then the arrowheads. 

 

Both text and arrows When not enough space is available for text and arrowheads, both are moved outside 
the extension lines. 

 

Always keep text Always places the text between the extension lines. 



between ext lines 

Suppress arrows if they 
don’t fit inside 
extension lines 

Suppresses arrowheads if not enough space is available inside the extension lines. 

Text placement  

 

Sets the placement of the dimension text when it is moved from the default position; that 
is, the position defined by the dimension style. 

Beside the dimension 
line 

If selected, moves the dimension line whenever the dimension text is moved. 

 

Over dimension line, 
with leader 

If selected, dimension lines are not moved when text is moved. If text is moved away 
from the dimension line, a leader line is created connecting the text to the dimension 
line. 

The leader line is omitted when text is too close to the dimension line. 

 

Over dimension line, 
without leader 

If selected, dimension lines are not moved when text is moved.  

 

Scale dimension features 

Use overall scale of: Sets a scale for all dimension style settings that specify size, distance or spacing, 
including text and arrowhead sizes. 

Scale dimensions to 
layout 

Determines a scale factor based on the scaling between the current model space 
viewport and the paper space. 

Fine tuning 

Place text manually Places the text at the position you specify at the Dimension Line Location 

prompt. 

Ignores any horizontal justification settings. 

Draw dim line between 
ext lines 

Draws dimension lines between the measured points, even when the arrowheads are 
placed outside the measured points. 

The Primary units tab 
Sets the format and precision of the primary dimension units and sets prefixes and suffixes for the dimension text: 



 

Options: 

Linear dimensions 

Unit format: Sets the current units format for all dimension types except Angular. 

Precision: Displays and sets the number of decimal places in the dimension text. 

Fraction 
format: 

Sets the format for fractions. 

Options are available if you have set the Fractional or Architectural values in the Unit format 
option. 

Decimal 
separator: 

Sets the separator for decimal formats. 

Options are available if you have set the Decimal value in the Unit format option. 

Round off: Sets rounding rules for dimension measurements for all dimension types except Angular. 

For example:  

1. If you enter a value of 0.25, all distances are rounded to the nearest 0.25 unit.  

2. If you enter a value of 1.0, all dimension distances are rounded to the nearest integer. 

The number of digits displayed after the decimal point depends on the Precision setting. 

Prefix: Includes a prefix in the dimension text.  

You can enter text or use control codes to display special symbols. For example, entering the 
control code %%c displays the diameter symbol.  

When you enter a prefix, it overrides any default prefixes such as those used in diameter and 
radius dimensioning. 

 

Suffix: Includes a suffix in the dimension text.  

You can enter text or use control codes to display special symbols.  



When you enter a suffix, it overrides any default suffixes. 

 

Measurement scale  

Scale factor: Defines the linear scale options. 

Scale factor set by default – 1.  

For example, if you enter 2, the dimension for a 1-millimetre line is displayed as two  millimetres.  

The value does not apply to angular dimensions and is not applied to rounding values or to plus or 
minus tolerance values.  

Apply to 
layout 
dimension 
only 

Applies the measurement scale factor only to dimensions created in layout viewports.  

Except when using non-associative dimensions, this setting should remain unchecked. 

Zero suppression  

Leading Suppresses leading zeros in all decimal dimensions.  

For example, 0.3000 becomes .3000. 

Trailing Suppresses trailing zeros in all decimal dimensions.  

For example, 30.0000 becomes 30. 

0 feet Suppresses the feet portion of a feet-and-inches dimension when the distance is less than one 
foot.  

For example, 0'-6 1/2" becomes 6 1/2". 

Options are available if you have set the Engineering or Architectural values in the Unit format 
option. 

0 inches Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral 
number of feet.  

For example, 1'-0" becomes 1'. 

Options are available if you have set the Engineering or Architectural values in the Unit format 
option. 

Angular dimensions 

Unit format: Sets the angular units format. 

Precision: Sets the number of decimal places for angular dimensions. 

Zero suppression 

Leading Suppresses leading zeros in angular decimal dimensions.  

For example, 0.3000 becomes .3000. 

Trailing Suppresses trailing zeros in angular decimal dimensions.  

For example, 30.0000 becomes 30. 

The Alternate units tab 
Specifies the display of alternative units in dimension measurements and sets their format and precision: 



  

Options: 

Display alternate  Adds alternative measurement units to the dimension text. 

Alternate units 

Unit format: Sets the unit format for alternative units. 

Precision: Sets the number of decimal places for alternative units. 

Multiplier for all 
units: 

Specifies the multiplier used as the conversion factor between primary and alternative units.  

For example, to convert inches to  millimetres, enter 25.4.  

The value has no effect on angular dimensions and it is not applied to the rounding value or the 
plus or minus tolerance values. 

Round distance 
to: 

Sets rounding rules for alternative units for all dimension types except Angular.  

For example: 

1. If you enter a value of 0.25, all alternate measurements are rounded to the nearest 0.25 unit.  

2. If you enter a value of 1.0, all dimension measurements are rounded to the nearest integer.  

The number of digits displayed after the decimal point depends on the Precision setting. 

Prefix: Includes a prefix in the alternative dimension text.  

You can enter text or use control codes to display special symbols. For example, entering the 
control code %%c displays the diameter symbol. 

When you enter a prefix, it overrides any default prefixes such as those used in diameter and 
radius dimensioning. 

 

Suffix: Includes a suffix in the alternative  dimension text.  

You can enter text or use control codes to display special symbols. 



When you enter a suffix, it overrides any default suffixes. 

 

Zero suppression  

Leading Suppresses leading zeros in all decimal dimensions.  

For example, 0.3000 becomes .3000. 

Trailing Suppresses trailing zeros in all decimal dimensions.  

For example, 30.0000 becomes 30. 

0 feet Suppresses the feet portion of a feet-and-inches dimension when the distance is less than 1 
foot.  

For example, 0'-6 1/2" becomes 6 1/2". 

Options are available if you have set the Engineering or Architectural values in the Unit 
format option. 

0 inches Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral 
number of feet.  

For example, 1'-0" becomes 1'. 

Options are available if you have set the Engineering or Architectural values in the Unit 
format option. 

Placement 

After primary 
value Places the alternative units after the primary units in the dimension text. 

Below primary 
value Places the alternative units below the primary units in the dimension text. 

The Tolerances tab  
Controls the display and format of the dimension text tolerances: 



 

Options: 

Tolerance format  

Method: Sets the method for calculating the tolerance: 

 

None - Does not add a tolerance. 

 

 

Symmetrical – Adds a plus/minus expression of tolerance in which a single 

value of variation is applied to the dimension measurement.  

A plus-or-minus sign appears after the dimension.  

Enter the tolerance value in Upper Value. 

 

Deviation – Adds a plus/minus tolerance expression.  

A plus sign (+) precedes the tolerance value entered in Upper Value, and a 
minus sign (-) precedes the tolerance value entered in Lower Value. 

Note 1: If you input a minus sign (-) before an upper maximum deviation value, 
the value will be displayed with a minus sign (-) on the drawing. 

Note 2: If you input a minus sign (-) before the a lower maximum deviation 
value, the value will be displayed with a plus sign (+) on the drawing. 

 

Limits– Creates a limit dimension.  

A maximum and a minimum value are displayed, one over the other.  

The maximum value is the dimension value plus the value entered in Upper 
Value. The minimum value is the dimension value minus the value entered in 
Lower Value. 

 

Basic – Creates a basic dimension, which displays a box around the full extent 

of the dimension. 

 



Precision: Sets the number of decimal places. 

Upper value: Sets the maximum or upper tolerance value.  

When you select Symmetrical in Method, this value is used for the tolerance. 

Lower value: Sets the minimum or lower tolerance value. 

Scaling for 
height: 

Sets the current height for the tolerance text.  

The ratio of the tolerance height to the main dimension text height is calculated. 

Vertical 
position: 

Controls the text justification for symmetrical and deviation tolerances: 

 

Bottom Aligns the tolerance text with the bottom of the main dimension text. 

 

Middle - Aligns the tolerance text with the middle of the main dimension text. 

 

Top Aligns the tolerance text with the top of the main dimension text. 

 

 

Zero suppression  

Leading Suppresses leading zeros in all decimal dimensions.  

For example, 0.3000 becomes .3000. 

Trailing Suppresses trailing zeros in all decimal dimensions.  

For example, 30.0000 becomes 30. 

0 feet Suppresses the feet portion of a feet-and-inches dimension when the distance is less than 1 foot.  

For example, 0'-6 1/2" becomes 6 1/2". 

Options are available if you have set the Engineering or Architectural values in the Unit format 
option. 

0 inches Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral 
number of feet.  

For example, 1'-0" becomes 1'. 

Options are available if you have set the Engineering or Architectural values in the Unit format 
option. 

Alternate units tolerance 

Precision: Displays and sets the number of decimal places. 

Zero suppression 

Leading Suppresses leading zeros in all decimal dimensions.  

For example, 0.3000 becomes .3000. 

Trailing Suppresses trailing zeros in all decimal dimensions.  

For example, 30.0000 becomes 30. 

0 feet Suppresses the feet portion of a feet-and-inches dimension when the distance is less than 1 foot.  

For example, 0'-6 1/2" becomes 6 1/2". 

Options are available if you have set the Engineering or Architectural values in the Unit format 
option. 

0 inches Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral 
number of feet.  

For example, 1'-0" becomes 1'. 

Options are available if you have set the Engineering or Architectural values in the Unit format 
option. 



Notes 

Leader note  

 Menu: Draw – Notes >  Leader notes …  

 Toolbar: Utilities –  

 Command line: NOTE 

This command opens the Leader note dialogue box to set the leader note options: 

 

Options:  

Use the icons to add/remove text input fields and to add a border: 

 Add string.  

 Remove string. 

 Simple note. 

 Multiline note. 

Use the icons to select the style of the extension line: 

 None. 

 Arrow. 

 Point. 

 Open arrow. 

 Half-arrow. 

 Oblique. 

Use the icons to select the text alignment method: 

 By left edge. 

 By centre. 

 By right edge. 

Other icons and options: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 



 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

 
The Add extension line icon is used to insert additional extension lines. The icon is enabled when you edit a 
leader inserted into the drawing. 

Right-click in the text field and choose the required menu item: 

  
The History item contains a list of recently input text lines. 

The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a universal note: 

 Type the required text into the text fields. 

 Select the required leader options. 

 Click ОК. 

 Specify a point on the object to which the leader arrow will be directed.  

 The following arrow type switching options are available in the command line and context menu: 

None– creates the extension line without an arrow, 

Arrow– creates the extension line with an arrow, 

Point– creates the extension line with a point. 

 Select an option and specify the leader position on the drawing. 

Position note 

 Menu: Draw – Notes >  Position notes…  

 Toolbar: Utilities –  

 Command line: MLD, MLEADER 

This command opens the Position note dialogue box to set the note options: 



 
Option: 

Use the icons to select the style of the extension line: 

 None. 

 Arrow. 

 Point. 

 Open arrow. 

 Half-arrow. 

 Oblique. 

Use the icons to select the text alignment method: 

 By left edge. 

 By centre. 

 By right edge. 

Other icons and options: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 

 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

 
The Add extension line icon is used to insert additional extension lines. The icon is enabled when you edit 

a leader inserted into the drawing. 

Inclination step 
of extension line 

Drop-down list to select inclination. 

In the list the following inclinations are available: 

Custom - the extension line is placed arbitrarily (by default); 

15 - the extension line is placed in step multiples of 15°; 

30 - the extension line is placed in step multiples of 30°; 

45 - the extension line is placed in step multiples of 45°; 

90 - the extension line is placed in step multiples of 90°. 

Right-click in the text field and choose the required menu item: 



  
The History item contains a list of recently input text lines. 

The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a position note: 

 Type the required text into the text fields. 

 Select the required note options. 

 Click ОК. 

 Specify a point on the object to which the leader arrow will be directed.  

 Specify the shelf position on the drawing. 

Comb leader note 

 Menu: Draw – Leaders >  Comb leader notes…  

 Toolbar: Utilities –  

 Command line: NOTEC 

This command opens the Comb leader note dialogue box to set the comb leader note options: 

 

Options:  

Use the icons to select the style of the extension line: 



 None. 

 Arrow. 

 Point. 

 Open arrow. 

 Half-arrow. 

 Oblique. 

Use the icons to select the text alignment method: 

 By left edge. 

 By centre. 

 By right edge. 

Other icons and options: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 

 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

 
The Add extension line icon is used to insert additional extension lines. The icon is available when you edit 

a leader inserted into the drawing. 

 
The Select line icon is used to switch the comb orientation parallel to the specified line on the drawing. The 

icon is available when you edit the comb leader note inserted into the drawing. 

Inclination step of 
extension lines 

Drop-down list to select inclination. 

In the list the following inclinations are available: 

Custom - the extension line is placed arbitrarily (by default); 

15 - the extension line is placed in step multiples of 15°; 

30 - the extension line is placed in step multiples of 30°; 

45 - the extension line is placed in step multiples of 45°; 

90 - the extension line is placed in step multiples of 90°. 

Comb orientation of 
extension lines 

Drop-down list to select the comb orientation of the extension line. 

The following options are available in the list: 

Custom 

Horizontal 

Vertical 

Right-click in the text field and choose the required menu item: 



  
The History item contains a list of recently input text lines. 

The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a comb leader note: 

 Type the required text into the text fields. 

 Select the required leader options. 

 Click ОК. 

 Specify the leader’s position and press ENTER to end. 

 Specify the leader’s position and angle. In the command line the following prompts are displayed:  

 [Horizontal /Vertical /Parallel]. The Parallel option allows you to choose the direction of a 

comb leader note parallel to any line on the drawing. 

 Specify the shelf position on the drawing. 

Node secant note 

 Menu: Draw – Notes >  Node secant notes…  

 Toolbar: Utilities –  

 Command line: NOTES 

This command opens the Node secant note dialogue box to set the note options: 

 

Options:  

Use the icons to select the text alignment method: 



 By left edge. 

 By centre. 

 By right edge. 

Use the icon to select the secant type: 

 Single-stroked line. 

 Double-stroked line. 

Other icons: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 

 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

 
The Select line icon is used to override the first and second lines of breaking construction. The icon is 
available when you edit the node secant note inserted into the drawing. 

 

Right-click in the text field and choose the required menu item: 

  
The History item contains a list of recently input text lines. 

The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a node secant note: 

 Type the required text into the text fields. 

 Select the required note options. 

 Click ОК. 

 Specify the first line of breaking construction, perpendicular to which the secant line will be located. 



 Specify the second line of breaking construction. 

 Specify the shelf position on the drawing. 

Note for multilayered constructions 

 Menu: Draw – Notes >  Notes for multilayered constructions… 

 Toolbar: Utilities –   

 Command line: QLEADER 

This command opens the Note for multilayer constructions dialogue box to set the note options: 

 

Options:  

Use the icons to add/remove text input fields and to add borders: 

 Add string.  

 Remove string. 

 Line on first string. 

Use the icons to select the style of the extension line: 

 None. 

 Arrow. 

 Point. 

 Open arrow. 

 Half-arrow. 

 Oblique. 

 Right angle. 

Use the icons to select the text alignment method: 

 By left edge. 

 By centre. 

 By right edge. 



Other icons: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 

 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

 
The Select line icon is used to override the insertion point of the extension line. The icon is available when 

you edit the note for multilayer constructions inserted into the drawing. 

Right-click in the text field and choose the required menu item: 

  
The History item contains a list of recently input text lines. 

The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a note for multilayer constructions: 

 Type the required text into the text fields. 

 Select the required note options. 

 Click ОК. 

 Specify a point on the object to which the leader arrow will be directed. 

 Specify the shelf position on the drawing. 

Node note  

 Menu: Draw – Notes >  Node notes…  

 Toolbar: Utilities –  

 Command line: NLD, NLEADER 

This command opens the Node note dialogue box to set the note options: 



 

Options:  

Use the icons to select the text alignment method: 

 By left edge. 

 By centre. 

 By right edge. 

Other icons and options: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 

 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

Inclination step of 
extension lines 

Drop-down list to select the inclination. 

In the list the following inclinations are available: 

Custom - the extension line is placed arbitrarily (by default); 

15 - the extension line is placed in step multiples of 15°; 

30 - the extension line is placed in step multiples of 30°; 

45 - the extension line is placed in step multiples of 45°; 

90 - the extension line is placed in step multiples of 90°. 

Right-click in the text field and choose the required menu item: 

  
The History item contains a list of recently input text lines. 



The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a node note: 

 Type the required text into the text fields. 

 Select the required note options. 

 Click ОК. 

 Specify the oval/circle  centre. 

 Specify the oval/circle size. 

 Specify the shelf position and/or the leader pitch angle. 

Mark of linear designs 

 Menu: Draw – Notes >  Marks of linear designs… 

 Toolbar: Utilities –  

 Command line: LINM 

This command opens the Mark of linear designs dialogue box to set the note options: 

 

Options:  

Use the icons to select the text alignment method: 

 By left edge. 

 By centre. 

 By right edge. 

Other icons: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 

 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

 
The Select line icon is used to override the insertion place of the extension line. The icon is available when 

you edit the marks of linear constructions inserted into the drawing. 

 
The Auto repeat icon allows you to mark several linear constructions without a repeated command call. For 
each new leader, the Linear constructions marking dialogue box will open to set new options for the 
leader, for example, new text. 



 
The Multiple insert icon allows you to mark several linear constructions without a repeated command call. 

All leaders are drawn with same options and with the same text. 

Right-click in the text field and choose the required menu item: 

  
The History item contains a list of recently input text lines. 

The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a note: 

 Type the required text into the text fields. 

 Select the required note options. 

 Click ОК. 

 Select line of construction, on which the mark will be located. 

 Specify the text position. 

Chain note 

 Menu: Draw – Notes >  Chain notes…  

 Toolbar: Utilities –  

 Command line: NOTEH 

The command opens the Chain note dialogue box to set the note options: 



 

Options:  

Use the icons to select the style of the extension line: 

 None. 

 Arrow. 

 Point. 

 Open arrow. 

 Half-arrow. 

 Oblique. 

Use the icons to select the text alignment method: 

 By left edge. 

 By centre. 

 By right edge. 

Other icons: 

 

The Insert special symbol icon opens the panel with the table of special symbols, to select and insert them 

at the current cursor position in the text input field. 

 The Notepad icon opens the Notepad dialogue box. 

 

The Match properties icon temporarily closes the dialogue box to specify the inserted leader whose 

properties should be copied and applied to the newly-created leader. 

 
The Add extension line icon is used to insert additional extension lines. The icon is available when you edit 

a chain note inserted into the drawing. 

Right-click in the text field and choose the required menu item: 



  
The History item contains a list of recently input text lines. 

The Recent item is a list specified by the user. 

The Pick from drawing item opens the Value picker toolbar which allows you to copy values from the objects on the 

drawing: 

 

To create a chain note: 

 Type the required text into the text fields. 

 Select the required note options. 

 Click ОК. 

 Specify the first leader node. 

 Specify the next leader nodes. 

 Specify the last node and press ENTER. 

 Specify the shelf position. 

If the first leader node is placed on the line, the extension line will be perpendicular to this line. 

Editing the leaders 
You can edit the leaders by double clicking. When editing the leaders, the same dialogue box as when creating these 
leaders will be opened, but some additional icons that are blocked when creating leaders will be available (for 
example, the Add extension line, Select line and others). 

It is very easy to edit leaders with grips (for more information, see “Advanced grips” («EXECUTION OF DRAWINGS 
COMMAND» - «Notes»)). 

You can also detach, append and edit extension lines with the appropriate commands from the Draw menu – the 
Notes item or from the Utilities toolbar. 

Detach leader  

 Menu: Draw – Notes >  Detach leader 

 Toolbar: Utilities –  

 Command line: PLD 

To detach a leader, it is necessary to select it in the drawing. The leader will be detached immediately after its 
selection. 



Append leader  

 Menu: Draw – Notes >  Append leader 

 Toolbar: Utilities –  

 Command line: PL 

To append leader: 

 Specify a point on the object. 

 If necessary, specify the number of intermediate points forming a break of leader. 

 Specify a point on the required leader inserted in the drawing, to finish the command. 

Edit leader 

 Menu: Draw – Notes >  Edit leader 

 Toolbar: Utilities –  

 Command line: PLR 

To edit leader:  

 Select a leader in the drawing. 

 Specify a point on the required leader to fix a new position for the leader. 

Advanced grips for design elements 
Advanced grips are assigned for editing objects on the screen without using the Edit window. 

The advanced grips are different in shape (round, triangular, rhombic, etc.) and, in some cases, in colour from the 
ordinary grips.  

When the advanced grips operating mode is on, selection of design elements is made first and then they are edited 
with the mouse. 

You can turn the advanced grips operating mode on/off in the Edit item in the Main tab of the nanoCAD – Options 
dialogue box (the Tools menu – the Settings Parameters command): 

 
 

Universal note  



  
 

 
Use this grip to select the arrow type. 

Click on the grip to open the menu for arrow type selection: 

 

 Use this grip to add a leader. 

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to rotate a shelf. 

 Use this grip to mirror a shelf. 

 

Position note  

  

 
Use this grip to select the arrow type. 

Click on the grip to open the menu for arrow type selection: 

 

 Use this grip to add a leader. 

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to rotate a shelf. 

 Use this grip to mirror a shelf. 

 



Comb leader note 

  

 
Use this grip to select the arrow type. 

Click on the grip to open the menu for arrow type selection: 

 

 Use this grip to add a leader. 

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to rotate a comb line. 

 Use this grip to rotate a shelf (located next to the grip). 

 Use this grip to mirror a shelf. 

 

Node secant note 

  

 
Use this grip to select the stroke type. 

Click on the grip to open the menu for stroke type selection: 

 

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to rotate a shelf. 

 Use this grip to mirror a shelf. 

 Use this grip to move a shelf. 

 

Note for multilayer constructions 



 
 

 
Use this grip to select the arrow type. 

Click on the grip to open the menu for arrow type selection: 

 

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to rotate shelves. 

 Use this grip to change the position of shelves. 

 

Nodal note 

  

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to rotate a shelf. 

 Use this grip to mirror a shelf. 

 

Linear constructions marking  

  

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to change the shelf position. 

 Use this grip to change the text position. 



 

Chain note  

  

 
Use this grip to select the arrow type. 

Click on the grip to open the menu for arrow type selection: 

 

 Use this grip to add a leader. 

 
Use this grip to align text. 

There are 3 alignment types: by left edge, by  centre and by right edge. 

 Use this grip to rotate a shelf. 

 Use this grip to mirror a shelf. 

 

Table 

 
  

 
Use these grips to edit the linear dimensions of columns. 

 
Use these grips to edit the linear dimensions of rows. 

Tables 

 Editing Tables on the Drawing 
 The Interface 
 Basic Tools 
 Editing the Size of Rows and Columns 
 Import, Export from MS Excel 
 Page Division 
 Cell properties 
 Snap to cell 
 Expression builder interface 
 Function in expression builder 
 Report creation 

 Menu: Draw – Tables >  Tables… 

 Toolbar: Draw –  

 Command line: TABLE, TB 
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The command opens the Create table dialogue box: 

 

 To create a non-standard table, click the Custom table item. Use the numeric entry fields to set the 

parameters for the custom table. The number of rows or columns and cell sizes can be altered later when the 
table is first edited. 

 

 To insert a standard table, click the Load from base item. A standard table can be inserted from the 
nanoCAD library. 



 

Choose the desired table type in the dialogue box. All basic standard tables are present in the nanoCAD 
library. 

 To insert a table from a file, click the Load from file item. 

 

Click the Browse button and select the table file 
Supported formats: 

 tbl - tables format; 
 dat - data file or text file; 
 mdb - Microsoft Access database; 
 xls - Microsoft Office Excel table; 
 xlsx - Microsoft Office Excel 2007 table; 
 csv - table, cells are divided by commas; 
 txt - standard text file; 
 xml - XML document. 



When loading the table from xlsx or xls files, it is necessary to select the list in the Excel document. 

 

It is important! The list choice can be carried out after loading the table from a file. 

 

In the table properties, the Source file line displays the path to the initial table file. 

In the Source query line, enter the required list from the document. Then in the Table edit dialogue box click 

the Update table from external source  icon. 

When loading the table from an mdb file, the list of base queries is displayed in the drop-down list. 

 

To import tables from files, it is possible to drag a file from the browser to the Table edit 
dialogue box. 

When dragging a file from the browser into the table field, the imported table is added to the 
existing table. 



When dragging a file from the browser into the dialogue box field, the imported table replaces 
the existing table 

 To generate an object base report, click the Object based report item. 

 

To choose the required objects, click the Select button. 



Setting of 
search conditions is carried out in the Quick Selection dialogue box. 

Which attributes of the chosen objects the report is based on are also set in this dialogue box. 

 

The attributes to be included in the report are switched by tags in the list or switches. 

 
 All - all attributes are selected 
 None - the choice is removed from all attributes 
 Invert - selection of attributes is inverted 

The report with a template of a view is created in the table: 

=Iff(Exist(Object."AttributeName");Object."AttributeName";"") 

This expression checks the existence of the given attribute line with the AttributeName name and uses its 
value in the cell. Otherwise, it leaves a cell empty. 



 

The number of columns in the table is defined by the number of chosen attributes. 

 To import a table from Excel, select the Import from Excel item. The document should be opened to make 
this item active. 

 

 Choose the location of the base point. 

 

 Choose the row numbering method. 

 

 If the Grow Down to Up box is checked, the rows will be numbered in reverse order. Check the 

 box to start the Format dialogue box when you insert a table. 

 Click the OK button and pick the insertion point in the drawing. 

Note: If the objects group was previously selected on the drawing and the Tables  command is activated, then 

you will be offered the option to create an object-based report. 
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Editing Tables on the Drawing  

The on-screen table editor is opened by left-clicking the table frame while holding down the CTRL key. Content can 
be entered into cell by placing the cursor above the cell and left-clicking. The active cell is then highlighted in green. 
The text entered in a cell is automatically condensed to fit the cell width. 

The Table Edit toolbar is shown when a table is being edited on-screen. 

 

 Group cells. Use this button to merge adjacent cells. 

  After clicking this icon, the cell located under the cursor is made active and shown in green. Hold down the left 
mouse button and select the cells you wish to merge. Left-click again to confirm selection - the selected cells will be 
merged together. 

 

 

 

 Ungroup cells. Use this button to restore previously merged cells into single cells.  

  
After clicking the icon, move the cursor to a cell which was created by merging multiple cells. It is made active and 
highlighted in green. Left-click inside the cell. The cell breaks up into its original smaller cells 

 Split cells. This button divides a cell into smaller cells. 

  After clicking the icon, place the cursor over a cell and left-click inside the cell. The application prompts for two points 
within the cell - pick these two points by left-clicking each. The Regroup dialogue box will appear. 

 

Enter the desired division values. Multiple cells within a single row or column can be split simultaneously. 

 Pencil. Use this button to split a cell into multiple cells by drawing additional cell borders. 



  Move the cursor over a cell and left-click inside the cell. Click the icon. Draw the division line by picking points on the 
existing cell borders (use nanoCAD object snap). The cell or cells will be split into new cells of arbitrary size. Each 
new cell is independent.  

 

 
 

 Add row adds a row to the bottom of the table. 

 Add column adds a column to the end of the table. 

 Insert row adds a row to the table at the cursor position. 

 Insert column adds a column to the table at the cursor position. 

 Delete row deletes the row containing the active cell. 

 Delete column deletes the column containing the active cell. 

 Row properties use to alter the height of the row containing the active cell. A dialogue box appears in which the 
row height, in millimetres, can be specified. 

 Column properties use to alter the width of the column containing the active cell. A dialogue box appears in 
which the column width, in millimetres, can be specified. 

 

 

 Cell properties opens the Cell Properties dialogue box. Use this to set the properties of the selected cell. 

 Cells properties use this to set the properties of multiple cells. Select the desired cells and set the parameters 
in the corresponding dialogue box. 

 Sum. 

 Selective sum. 

Use these buttons to automatically add up the values from the selected cells and display the sum in a blank cell at 
the end of the selection. When using these functions, do not enter any sum expressions in the Cell Properties 

dialogue box. 

 Notepad opens the Default – Notepad dialogue box. 



 Calculator opens the Calculator dialogue box. 

  This button allows a special symbol to be inserted from the menu. 

 Exit exits the on-screen table editor. 

The Interface 

The Table edit dialogue box: 

 

The dialogue box contains: 

 standard pull-down menus 

; 

 tool palettes buttons; 
 rulers with sliders allowing column width or row height to be quickly adjusted; 
 the cell grid with name headers. 

 

Each table section has a header: 

 First page header; 
 Header; 
 Last page header; 
 Report header; 
 Report template; 
 Report; 
 Report sum; 
 First page footer; 
 Footer; 
 Last page footer. 

Click the left mouse button on a row or column name to select it. 

 



 

To select the table, click the rectangle at the intersection of the lines and columns names. 

 

Names (addresses) of table cells are fully equivalent to those used in MS Excel: columns are marked alphabetically 
(A, B, C, D, ... , Z; AA, BB etc.) while rows are marked with ordinal numbers. 

Filling of adjacent cells with data. 

To accelerate the data input in the table, it is possible to use the function of automatic data filling. The table editor can 
automatically continue a line of numbers, number combinations and text with a set pattern.  By selecting several cells 
and dragging the filling marker, it is possible to quickly fill in the data lines with the different types. 

 

Filling cells with sequences of numbers or combinations of numbers and text with a set pattern. 

1. Select the first of the filled cells. 

 
2. Enter the initial value for the values line. 

 
3. Enter a value in the following cell to set the filling pattern. 

 

For example, if it is required to set the sequence 1, 2, 3, 4, 5..., enter in the first two cells values of 1 and 2. If 
the sequence 2, 4, 6, 8… is  required, enter 2 and 4. If the sequence 2, 2, 2, 2… is  required, the second cell 
can be left empty.  

The sequence filling proceeds as shown in the table below. 

Initial value Line extension  

1, 2, 3... 4, 5, 6... 

First period Second period  Third period... 

Article 1 Article 2 Article 3... 

 

4. Select the cell or cells containing the initial values. 

 

5. Drag the filling marker over the range with which it is necessary to fill. 

 



The cells will be filled with the set sequence of numbers. 

 

To fill in an increasing order, drag the marker down or to the right. To fill in a decreasing order, drag the 
marker up or to the left. 

Use the autofilling to continue lists containing the values from collections (main menu/rows/user sorting). 

Cell Colours  

 

 - cell containing an expression;; 

 

 - not edited cell, for example, in report; 

 

 - cell with a mistake in an expression; 

 

 - cell containing data of report section; 

Basic Tools 

 Open table allows a data set from a previously created *.dat file to be imported, or a standard table template 
from the nanoCAD library to be imported. Clicking the black triangle shows additional buttons which are used to 
select the data source. 

 

 

 Insert a table from the library. 

 Insert a table from an external file *.tbl, *.dat, *.mdb, *.txt, *.csv, *.xml, *.xls, *.xlsx. If an Excel file is 
chosen, only the first list will be inserted. 

 Save to file exports the cell data to a special *.dat file format or saves it in the nanoCAD library. Clicking the 
black triangle shows additional buttons used to select the desired destination. 

  

 Save table in nanoCAD library. 

 Export table to an external file *.dat, *.txt, *.csv, *.xml, *.xls. 

 Export to Excel exports the table data to MS Excel. Clicking this button creates a new Excel worksheet 
containing all the table data with identical formatting. 

 Import from Excel imports calculated data from an open MS Excel worksheet. 
 

The standard windows clipboard tools: 

  
 Cut 

 Copy 

 
Paste 

 Undo last change.  



 Redo last change. 

Formatted cell navigation tools: 

  
 Move row down  

 Move row up  

 Move column left  

 Move column 
right  

 Page division. This tool is intended for dividing a table into multiple fragments without losing its integrity. Use 

this function to split a large table in order to place it on a smaller sheet of paper, while still being able to edit it as a 
whole 

Tools used for sorting cells by contents: 

  

  Sort ascend 

 Sort descend 

 Create summary function summarises the contents of the chosen cells. 

  

Select the cell in which it is required to calculate the sum and click the button . Select the cells which are to be 
summarised and press Enter. 

 Open calculator opens the Calculator window. 

 Open Notepad opens the Notepad window. 

 Insert material. 

Use this tool to insert formatted rows of material into the table. Click the icon to open the Material dialogue box 

 

 Special Symbols button allows a special symbol to be inserted from the menu. 



 Recalculate Table is used to manually update the calculated cell data after editing reference cell values or 
altering expressions. 

 Automatic calculation operates a mode of automatic recalculation of the values of the table cells. By default, 
the automatic calculation mode is included 

 Update reports. Click this button to update the report.  

 Automatic report update operates a mode of automatic recalculation of the report. By default, the automatic 
report update mode is included. 

 Group selection merges multiple cells into a single cell. 

 Ungroup selected cells restores the original cells from merged cells. 

 Change count of rows and columns. Use to change the count of rows and (or) columns in the chosen cells 
range. 

  
Select one or several cells and click the Change count of rows and columns button. In the Regroup dialogue box 
that appears, enter the required values for breakdown. 

 

 Split table cells with pencil tool use to insert new cells by manually drawing new grid lines. 

  

 

Specify the start and end point of a line which will divide each cell that is crossed by it into two. Right-click on a cell 
border to delete this border. 

 Text alignment use to control the text alignment in the selected cells. Clicking the black triangle brings up 
additional buttons. 

  

 



 Borders use to display or hide the borders of the selected cells. Clicking the black triangle brings up 
additional buttons used to toggle border visibility. 

  

 

 No border lines. 

 Display all lines around the selected 
cells. 

 Display all borders - inner and outer. 

The remaining tool icons are self-explanatory. 

The Border Colour pull-down menu: 

 

The Border Lineweight pull-down menu: 

 

To set the border parameters, it is necessary to select the colour or lineweight again and then to choose the border 

(use the Borders  command) to which it is necessary to apply the set parameters.  

Cell Properties. The parameters of the table cells are set in the Cell properties dialogue box.  

To edit the properties of a single cell using the all-function editor, select the desired cell and open Cell properties 
from the context menu. The effect of this command is the same as in the on-screen table editor. 

To edit multiple cells in the all-function editor, select the desired cells and open Cell properties from the context 
menu or use the Ctrl+Enter key combination. The effect of this command is the same as in the on-screen table editor. 

  

 



Editing the Size of Rows and Columns  

To adjust the height of a row or the width of a column, use the sliders located on the rulers (horizontal and vertical). 
Move the slider by clicking it and holding down the left mouse button whilst dragging it. While adjusting the height or 
width, their values are highlighted in colour for easy monitoring. 

 

Row height and column width may also be set in the property dialogue box that can be opened by right-clicking the 
header of a row or column.  

1. In this dialogue box, enter the desired width/height in millimetres. 



 

2. In the Properties of column dialogue box, the Hidden checkbox is available. Using it, you can hide the 
display of the selected column on the drawing. It can be displayed in the editor mode. 

 

It is also possible to hide a column using the column context menu. 

 

The Substitute zeros command (in numerical cells with a zero value, the cells should have a numerical 
format) replaces the cells’ contents with the set text. 

Note! The format of the cell text value is established in the cell properties on the Content tab.  

Close the dialogue box by clicking OK. 

Import, Export from MS Excel 

The Import table from Excel  button imports calculated data from an open MS Excel worksheet. 

 In the open Excel list, select the cell data from which it is required to import to the nanoCAD table. 

 Click the Import table from Excel  button in the Table Edit dialogue box. 
 The data will be transferred into the table. 



The Export table to Excel  button exports the table data to MS Excel. Clicking this button creates a new Excel 

worksheet containing all the table data with identical formatting. 

Note! The following data are not exported to Excel from the nanoCAD tables: 

 nanoCAD blocks 
 Formatted text  
 Expression mismatched Excel format 

Page Division 

 Page division divides a table into multiple fragments without losing its integrity. Use this function to split a large 
table in order to place it on a smaller sheet of paper, while still being able to edit it as a whole. 

 Invoking this command brings up the Page division dialogue box. 

 

 Check the Single page box to disable page division.  

 

 Choose the division method:  
1. Custom. The table can be divided into any parts.  

 

The page break before a row is set by the Start new page command from the context menu.  



 

 

Close the dialogue box. In the Table edit window the break will be marked by a border, using which it 
is possible to change a row height. 

 



On the drawing, the table with the break will look as follows: 

 

The parts of the divided table can be moved independently of each other within the drawing. Double 
click on any part to open the table editor. 
 

2. By row count enter the desired number of rows in the fragment. Headers do not count. 

 

3. By maximal page height enter the total height of the fragment, in millimetres, using the current 
scale. 



 

Convert table 

 Menu: Draw – Tables >  Convert table… 

 Toolbar: Tables –  

 Command line: CONVERTTABLE 

This command is used to convert AutoCAD tables into nanoCAD tables. Further editing of AutoCAD tables can be 
carried out using  nanoCAD tools. 

To convert a table, launch the Convert table  command and select the table. 

The actual sizes of the initial graphics are multiplied by the drawing scale. If the table will have row heights with a 
zero value, it is necessary to change the drawing scale according to the size of the initial graphics. 

When you convert nanoCAD 3.0 tables to an AutoCAD table, all dynamical links will be destroyed.  

Cell properties 

You can set the properties of table cells in the Cell Properties dialogue box. 

To edit the properties of a cell, select it in the Table edit dialogue box and select the Properties command from the 

right-button menu or use the Ctrl+Enter key combination or double click on the cell. The action of this command is 
similar to Cell Properties on the Table edit toolbar. 

To edit several table cells, select the required cells and select the Properties command from the right-button menu. 
The effect of this command is similar to Cells Properties on the Table edit toolbar. 



  

 

 

There are six tabs: 

 In the Content tab you can specify the data format and formula to calculate a value. 



 

You can specify the data format and enter the value for the cell. Select the Read only checkbox to prevent 
cell editing. The cell is highlighted. 
 
 

 
- - Opens the Expression builder. 

 



 
 
 

 
- Insert block into the cell. 

Select a block in the current drawing. You can select another file using the Open menu. 

 

After a block is selected, it is displayed in the cell properties dialogue box and in the table cell. 



 

To detach a block, select Remove block in the Selection of block dialogue box. 



 

 In the Font tab you can specify the text font, symbol colour, line weight, indent, text angle and text scaling. 

 

The Vertical checkbox changes the text direction to vertical. 



If the Oblique and Horizontal scaling fields are empty, their values are taken from the text style. If the 
Horizontal indent field is empty, its value is taken from the table settings. 

 In the Fit tab you can specify the Cell width and height and fitting parameters. 

 

If text width is more than cell width: 

 

If text height is more than cell height: 



 

Occupy extra rows does not change the row’s number in the table; the required row is made higher by the 
required number of times and lined. 

 In the Borders tab you can specify the type, weight and colour of the lines of the selected cell. You can 
control the display of cell borders. To switch border display on/off, select one of the buttons. 

 

 

or click near the cell border in the preview area. To align text in the cell, click the symbol  in the cell. 



 

To specify the colour of the border, click the symbol  and select a colour from the list. 

 

To specify the line weight of the border, select the Line weight field and select the weight from the list. 

 

The colour and weight of cells and their fill colour can be specified in the tab. 

 

To apply a new colour and weight, click the border or use the buttons. 

 

 Comment tab. Field to enter a comment. 



 

A cell with a comment is displayed with a green label in the editor and when moving the cursor over it the 
comment is shown. 

 

 In the Presets tab you can specify the style for a cell. 



 

To create a style, click on an empty space on the Presets tab and from the context menu select Create. 

 

To work with style templates, open the context menu of a style. 

 

  

 

Snap to cell 

In every cell formula you can use other object properties. If automatic table recalculation is switched on, the object 
formula is automatically recalculated when the object is changed.  You can attach one or several objects to every 
cell. Objects have names: Object1, Object2, Object3, … There is continuous numbering in the table. If an object is 
not used in any formulas, it is detached from the table during the following recalculations and the object references 
are renumbered. 

To snap object properties to a specified cell, use Expression from the right-button menu or press the key 
combination Shift+F2. 

This picture needs to be 
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Expression builder dialogue box opens.  

 

Click the Attach object button.  

Select the object whose properties you want to snap to the cell. In the properties list you will see the selected object’s 
properties. Double-click it and the property will be added to the cell field. Click OK 



 

After the object is attached to the cell, the cell colour is changed (it means that there is a formula in the cell) and the 
calculated result will be displayed: 

Expression builder interface 
With expression builder you can specify parameters, arithmetic expressions and references to object properties for 
the selected cell. 

You can open expression builder for a table cell and for the Attach object dialogue box. Press Shift+F2 to open the 
dialogue box. 

 

In the top part of the dialogue box there is a field to enter any arithmetic expressions and use any constants and 
object properties. 

During input, in the list of functions and constants, all items containing input are displayed. If the input is incorrect, a 
message about the error or a tooltip will be displayed. 



 

Click in the preview and the expression in the input field will be selected. 

 

Press the  button and the entered expression will be saved on the template formula bar. 



 

Expressions from the formula template bar are marked with a star in the list of functions and constraints. 

Formula templates 

These allow expressions to be saved in templates for further use.  

To save an expression, type it in the field and select the  button. The expression’s button will be displayed in the 
templates list.   

There is a tooltip when you move the cursor over the item. 

 

To insert a template, select the button of the saved template.  
To delete a template, press the Alt button and drag the template button outside the Expression builder dialogue 
box. 

 

If there are “$” symbols in the template, after insertion they are changed to the selected text. For example, we create 
the Iff(Exist($);$;””) template then type the text Object.Name, select it and insert the Iff template and the symbols are 
changed to the text -  Iff(Exist(Object.Name;Object.Name;””). 



Snap to objects  

 
-  attaches object. 

Functions in the expression builder 

Mathematical operations: 

+ 
Addition 

- Subtraction 

* 
Multiplication 

/ Division 
^ Raising to the power 
sqrt() Square-root generation 

  

Logical operations: 

== equals 
> more 
< less 
! nor 
| or 
!= not equals 
>= not less 
<= not more 
|| or 
&& and 

Functions: 

Mathematical: 

Cos, Sin, Tg - trigonometric function; argument is specified in degrees. 

Acos, Asin, Atg - arc trigonometric functions, the result received in degrees. 

Abs - modulus. 

Int – rounding of number. 

Summ - returns the sum of the variables’ values if the cells are grouped. 

When entering a function, pay attention to brackets. 

For example: 

Summ(Row) - returns the sum of the numbers of grouped rows. 

Summ(Detal.L) - returns the sum of the parameter L values of the “Detail” object in grouped rows 

Data conversion: 

Str - data conversion to string type. 

Num - data conversion to numeric type. 

Frm - numerical value conversion to string type according to the parameters of the table column. 

For example: 

Frm(0.001230) returns 0.0012 string if zero suppression mode and 0,0000 accuracy are set for the column containing 
the cell. 



Selection and comparing: 

FmtText - addition of formatted strings. 

FmtSub - creation of lower index. 

FmtSuper - creation of upper index. 

FmtDigit - number conversion to typesetting form. 

FmtRaw - not formatted text. 

DmtDiv - creation of fraction. 

If/Iff - function of logical decision. Format: 

if(Logical_Condition; If_True; If_False, 

Where: 

Logical_Condition – logical condition with logical operations for comparing; 

If_True – returned value, if logical condition is held 

If_False - returning value, if logical condition is not held 

For example: 

if(object == Marker; Marker.Position; "Not determined"). If the object type attached to the column cell has a Marker 
value, the function returns its Position value.  If the object has another type, the Not determined value is returned. 

Exist - Checks the existence of a constant: =IF(EXIST(Object.Name);Object.Name;0) 

Min/Max - returns the minimum/maximum value listed in the brackets 

For example: 

Min(maximum_value; minimum_value) – returns minimum_value; 

Max(maximum_value; minimum_value) - returns maximum_value. 

Count - returns the number of objects (for grouped rows of a table). 

For example: 

Count() - returns number of objects attached to the cells of the grouped rows. 

Avg - calculates arithmetical average of arguments. It can use any number of arguments of any ranges. Null 
arguments are not used. 

Off - returns a cell value, specified by a relative index. The index format is: 

Off(row; column) 

For example: 

Off(-1;2) - returns the cell value located one row above and two columns to the right of the current cell 

Cell returns the cell value specified by an absolute index. 

Merge (Cells,Expression) - merges the Cells in a range. If the Expression is not equal to zero, it returns the 
Expression value. 

For example: 

=merge(A5:C5; "Name") – merges cells from А5 to С5 and in the results cell, the “Name” text is displayed. 

SetHeight() – specifies the column height. Height value is specified in brackets. 

Val() - calculated argument. 



For example: 

=val("A"+"1") - calculates "A1", and uses it as an expression (value in A1 cell). If argument is not a row, it is returned. 
=val(10+2) – is the same as =10+2. 

=val("summ(A"+Str(off(0;-1))+":D"+Str(off(0;-1))+")") - sum of cells from A to D of row, whose number is in the cell to 
the left of the current one. In general, you can do without val. It is needed when you have to enter a cell address in 
user form to take the value from it further. Create the Addr variable, attach it to the input field in the form and enter in 
the table: =val(Addr). Function allows recurrence: =val(val("A"+"1")) - takes its value from the cell whose address is in 
cell A1. Number of enclosures is limited to 64. 

Geometry(Object) - works as Attach object . The height of the attached object is fitted to the cell height. The object 
is taken from the report and attached to the cell. 

SUMM(Section(-1)) - Sum of the current column’s cells in the section, following after the current section. 

COUNT(Section(A3)) - Number of rows in the section containing cell A3. 

Reserved variables: 

Pi - pi character. 

Row - returns the row number for every cell (rows are numbered from 1, the header row is not numbered). 

Col - returns the column number for every cell (column “A” is number 1). 

Object - returns the object type, attached to row cells. 

Object1, Object2, … - objects attached to the cell. 

Title - table name. 

RowCount - general number of rows. 

ColCount - general number of columns. 

Report creation  
Reports are used to arrange information about objects in the drawing. 

To create a report, select Insert Report section from the Section menu in the table editor. 

 
A report consists of two sections: Report template and Report. 

The report template defines how the content is displayed in the report and can contain one or several lines. A copy of 
the template rows is created for every object. Formulas are calculated according to the properties of the selected 
objects. 



 
The report template contains the variables of the selected objects; the values of the template variables are displayed 
in the report. 

Using the Select source objects  tool you can select inserted objects according to the required conditions. 

 



In the Grouping and merging  dialogue box you can specify the settings for grouping and merging table cells.  
 
Report template menu: 

 Object filter opens Quick selection;  

 Merging and grouping allows grouping and merging cells by properties;  

 Freeze report switches off Automatic update;  

 Report header adds a report header row to the beginning of the report;  

 Report footer adds a report summary row to the end of the report;  

 

Context menu of the Report summary cells: 

 

The action applied to the column fragment in one section. 

Vertical grouping  

A report template can contain several lines. Cells with identical values can be merged. From the right-button menu 
select Insert row or Add row. 



  

 

When adding a row, it is added after the selected row, but when inserting a row, it is added before selected row. 

 

Setting variables for rows. Select A4 and A5 cells and from the right-button menu select Group. 



 

The selected cells will be grouped. The table will be displayed as follows: 

 

There are cells in the report highlighted with special colours. 

 

If you edit such cells, changes are applied to the object to which they belong. 



 

Create a table and report template. 

Add the parameters: =Object.Name and =Object.L. 

 

Enter a new length, for example 120. 

 

The bolt’s length is changed. 

Grouping and 
merging cells 

Group and merge  button. Report template. 

In the Grouping and merging dialogue box you can specify settings for grouping and merging table cells. Grouping 
and merging are only applied to cells in the report template. 



 

Study the example for how to merge cells. 

  



    

Merging 

1. In the Grouping and merging dialogue box select Append rule and select Merge. 

 

2. Select the column name for the cells you want to merge. Selection is made by double clicking on the column 
name or by dragging it into the Select field. 

 

Note! To select another column, you should drag it into the column list and then select it. You can select 
several columns then place them in the required order. 

The columns are processed according to the rules of the grouping template. 



3. If you want to sort, select and don’t sort and select sort type. 

 

4. Click OK to check the result in the table editor. Cells having identical values in the D column will be merged. 

 



 

Rows, which have identical values in B and identical values in C columns, are merged. The order of specifying 
columns is unimportant. 

 

 

Rows, which have identical values in B are merged, then cells in C and E are merged. The order of specifying 
columns is unimportant. 



 

 

Rows, which have identical values in C, are merged, then cells in E and B are merged. The order of specifying 
columns is unimportant. 

 



Grouping 

1. In the Grouping and merging dialogue box select Append rule and select Group. 

 

2. Select the column name of the cells you want to group. Selection is made by double clicking on the column 
name or by dragging it into the Select field. 

 

3. If you want to sort, select and don’t sort and select a sort type. 
4. Click OK to check the result in the table editor. Cells having identical values in the C column will be grouped. 



 

Insert material 

Insert material  button. 

Use this tool to insert formatted row of material in the table. Click the icon to open the Material dialogue box. 

 

Measure 

 Menu: Tools – Inquiry >  Measure… 

 Toolbar: Main –  

 Command line: MEASURE 

Take from drawing allows the taking of properties from a drawing or from standard details. The Value picker toolbar 
appears 

 
Measured value displayed in the same Value picker dialogue box. 

 



 
The imaging precision of measurements and calculations for the commands of the Value picker dialogue box 
corresponds to the value set for the current dimension style (the Precision options from the Primary units tab of the 
Modify dimension style dialogue box). 

Options: 

 
Measure 
distance 

Measures the distance between specified points, radius or diameter.  You can switch the 
method of measurement from the context menu or the command line.  

 
Measure 
angle 

Measures the angle. You can switch the method of measurement from the context menu or 
the command line. 

 
Measure 
perimeter 

Measures the perimeter of the closed area or the length of the closed polyline or circle. 

To measure: 

- click inside the enclosed area (the measured contour is highlighted), 

- click on the closed polyline or circle. 

 
Measure 
area  

Measures the area of the closed contour.  

To measure: 

- click inside the enclosed area (the measured area is indicated by hatching), 

- click on the closed polyline or circle. 

 
Complex 
area 

Measures some areas of the closed contours. 

To measure: 

- click inside each enclosed area (the measured areas are indicated by hatching), 

- click on all the closed polylines or circles. 

Press ENTER to finish selection of the closed areas (of polylines and circles). The calculated 
value of the complex area is displayed in the dialogue box. 

 
Take from 
property 

The command takes the values of any parameter from the selected nanoCAD objects on the 
drawing (dimension, leader, table, etc.). 

The parameters values of the selected object are displayed in the list in the new window: 

 

 
Take from 
text 

Takes the values of the selected single line or multiline text: 



 
To select text, place the cursor over it. The selection is highlighted by a frame. 

 Calculate Opens the Calculator. 

 
Take from 
notes 

Opens the Notepad. 

 

Note: If the Value picker dialogue box was called up at the runtime of another command (for example, from the 
Position note dialogue box of the Pick from drawing command from the context menu), the measured value is 
passed to this dialogue box. 

Calculator 

 Button:  Calculator  

The calculate button is available in the Value picker dialogue box, the Edit dimension dialogue box and the Table edit 
toolbar. 

You can perform simple and more complex mathematical calculations in the table cells using the calculator functions.  

 
 

It is possible to connect the calculator to the Notepad  tool. 

To access the Notepad button, click the button : 



 
The drop down list displays the tables from the Notepad. This tool is useful when you frequently perform  standard 
calculations. 

The Insert button is used to insert the result of the calculation from the calculator into the edited table cell or input 
field. 

You can use the arrow buttons from the bottom left corner to select table cells. The name of the current cell is also 
displayed: 

 
You can use the Expression command from the View menu to calculate formulas: 

 
Use the left field to enter the formula to be calculated. The result will be displayed in the right field. 

The Precision option sets the rounding level of the calculation result. 

Notepad  

 Button:  Notepad  

The Notepad button is available in the Value picker dialogue box and in the Table edit toolbar. 

Notepad is used to enter temporarily used text (acronyms, symbols etc.). It is a universal tool for text input.  

Notepad allows the saving of a set of expressions and their positional structure in a file; entering and placing of text 
expressions and small tables; searching and editing of previously created notes. 

There is a content tree in the left part of Notepad. The user can select partitions, pages and tables there. There are 
control buttons in the top part:  



 

Buttons:  

 

Load from file Opens the Notepad file saved on the disk. 

 
Save Saves changes in the Notepad file. 

These buttons control the structure of the Notepad: 

 
Add partition  

 
Add page  

 
Add table  

 

Delete tree item 
 

 

Edit page Switches on page and table editing mode. This button is available if a page or table is 
selected in the tree.  

When editing a page, the tree becomes unavailable and the edit toolbar buttons show 
in the right part of the dialogue box: 

 



or the table:  

 
 

Page editing tools: 

 Clear Clears the current page. 

 Load from file Allows importing of text from an MS Word RTF-file. 

 

 

Save to file 
 

Allows writing of the page content into an RTF-file for 
using in MS Word. 

 

Add technical 
condition 

 

 

Delete technical 
condition 

 

 Move down  
 

 Move up 
 

 

 

Superscript   

 

Turn on\off the input mode for uppercase index. 

 

 

Subscript   
 

Turn on\off the input mode for bottom index. 

 

 

Insert special 
symbol  

 

Opens the panel to select and insert special symbols. 

 

 

 

Insert fraction  

 

Opens the Insert fraction dialogue box to set the 
numerator and denominator of the fraction: 

 

The switch  controls the display of the fraction 
line.  

 

 

Insert tolerance  

 

Opens the Fit dialogue box.  

 Insert material  Opens the Material dialogue box.  

 Calculator Opens the Calculator dialogue box. 



 

Table editing tools: 

 Insert row  
 

 Delete row  
 

 Insert column  
 

 Delete column 
 

 

Rename column        Opens the Column properties dialogue box, in 

which you can set the width and name of the 
selected column: 

 
 

 

Select/Transfer 
selected text  

Transfers the selected text into the edited table cell.  

If page or table is selected in the tree, its content is displayed in the right part of the 
dialogue box.  

Select the text and select the  button. 

Note: When you use the Notepad for the first time, it is recommended to save the new notepad in a separate file 
using the Save button. 

 The dialogue box has a special search tool to search the text line. Right click on any partition or page of the partition 
and select the Find command from the context menu. The found links are placed in the Find result section. 

To speed up the search procedure, you can view recently used expressions in the History section: 

 
You can create an unlimited number of sections and subsections, pages and tables in the Notepad:  



 
You can move the partitions, pages and tables in the structural tree by using drag and drop. 

To rename the partitions, pages and tables, use the Rename command from the context menu. 

When you want to close the dialogue box, it offers to save the changes in the Notepad: 

 

Features of the design elements 

In place edit 

 Button:  In place edit 

 Command line: IPEDIT 

This command allows you to edit all nanoCAD’s objects, containing text, directly in the drawing. 

To quick-start the command, press and hold down the CTRL key  and left click on the object. 

After running the command, the cursor appears in the text line of the edited object: 

 

Parameters redefinition 

 Button:  Parameters redefinition  

 Command line: PR 

This command is used to define the variations in the settings of the nanoCAD design objects in the current drawing. 
The redefinition is controlled by the parameters set in the settings of the design elements (the Tools menu – the 
Settings Parameters command). 

The command allows you the check the redefinition status of one, several or all objects in the drawing. 

The Parameters redefinition command opens the nanoCAD - Redefine object parameters dialogue box: 



 

The objects are grouped by type in the dialogue box. The objects’ parameters are grouped by name. 
To set parameters or remove redefinitions, use the Object filter list: 

 The 
total number of found objects in the drawing is displayed in the brackets for each object type. 

When an object type is selected, its properties will be displayed in the parameters table and its graphical view will be 
displayed in the right box of the dialogue box. 



 

The redefined parameters are highlighted in blue. If, for the selected objects group, only some parameters have 
redefinitions, then the redefinition highlighting will be diagonal. 

 

To remove the redefinition, it is necessary to click the icon . 

 

To remove the redefinition from all objects, it is necessary to click the Clear redefinition from all parameters icon in 

the left bottom part of the dialogue box: 

 
It is possible to enter the new value for the selected parameter from the keyboard or select from the drop-down list: 

 
If the new value aligns with a value specified by default in the nanoCAD – Options dialogue box (the Tools menu – 

the Settings Parameters command), the blue highlighting will not be displayed. 

To change the parameters of one or several design elements, it is necessary to: 

 Select the objects on the drawing. 

 Select the Parameters redefinition command from the context menu.  



 In the opened dialogue box set new values for the settings. The changes apply only to the selected objects. 

The Parameters redefinition  command is useful to check documents for compliance of design elements with 

corporate company standards. 

To check the redefinition status of all objects on the drawing: 

 Start the Parameters redefinition command.  

 Press Enter to select all nanoCAD design elements. They will be highlighted on the drawing. 

 Click the Clear redefinition from all parameters  icon to clear redefinition from all parameters. As a result,  

you obtain a document designed according to the settings set by your company (consisting in part of nanoCAD 
elements). 

Regenerate 

 Button:  Regenerate  

 Command line: REGENOBJ 

This command is used to: 

 regenerate the nanoCAD objects, 

 regenerate overlapping of the nanoCAD objects, 

 regenerate the tables,  

 update automatically calculated attribute values. 



Create 3D objects 

Surfaces 
nanoCAD allow you to create a polygon or polyface mesh by specifying vertices. The mesh density controls the 
number of facets in legacy polygonal and polyface meshes. Density is defined in terms of a matrix of M and N 
vertices, like a grid consisting of columns and rows. M and N specify the column and row position, respectively, of 
any given vertex. 

Mesh objects do not have the mass and volume properties of 3D solids. 

In the Draw menu – Meshes item, the commands for the 3D meshes creation in the form of elementary surfaces are 
presented – box, wedge, cone, sphere, torus, pyramid, dish, dome. 

You can control whether the mesh is displayed as a wireframe, hidden, or conceptual image by changing the visual 
style. 

Box 

 Menu: Draw – Meshes > Box  

 Command line: 3D 

The command creates a 3D box.  

Options: 

Cube Switch to create a cubic box with edges of equal length. 

Reference Specify the rotation angle of the box, measured from the reference angle. 

Points Specify the rotation angle, measured from the reference angle to the segment, defined by two points. 

 

Command prompts:  

Specify corner point of 

box: 

Specify point 1. 

Specify length of box: Specify point 2. 

Specify width of box or 

[Cube]: 
Specify point 3 or select the Cube option. 

Specify height of box: Specify point 4. 

Specify rotation angle 

of box about the Z axis 

or [Reference]: 

 

Specify the rotation angle or select the Reference option. 

The rotation angle is set relative to the first corner specified (point 1) and is 
measured from the X-axis on the XY plane. 

When you select the Reference option, the following prompts are displayed: 

Укажите опорный угол 

<0>: 

Specify a point or enter the angle value. 

Укажите новый угол или 

[Точки]: Specify a point or enter the angle value or select the Points option. 

Note: The Reference and Points options are useful to define the box orientation relative to an existing object. 

Wedge 

 Menu: Draw – Meshes> Wedge  

 Command line: 3D 
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The command creates a right-angled wedge-shaped polygon. 

 

Command prompts: 

Specify corner 

point of wedge: 

Specify point 1. 

Specify length of 

wedge: 

Specify point 2. 

Specify width of 

wedge: 

Specify point 3. 

Specify height of 

wedge: 

Specify point 4. 

Specify rotation 

angle of wedge 

about the Z axis or  

[Reference]: 

 

Specify a point or enter an angle value. The rotation angle is set relative to the first 
corner specified (point 1) and is measured from the X-axis on the XY plane. 

Cone 

 Menu: Draw – Meshes> Cone  

 Command line: 3D 

The command creates a cone-shaped polygon mesh. 

Option: 

Diameter Switch to specify the diameter. 

 

Command prompts: 

Specify center point for base of cone: Specify the  centre point for the base of the cone (point 1). 

Specify radius for base of cone or 

[Diameter]: 
Specify the radius for the base of the cone (point 2) or 
select the Diameter option. 

Specify radius for top of cone or 

[Diameter]<0>: 
Specify the radius for the top of the cone (point 3) or select 
the Diameter option. A value of 0 (set by default) 

produces a cone. A value greater than 0 produces a 
truncated cone. 

Specify height of cone: Specify the height of the cone (point 4). 

Enter number of segments for surface of 

cone <16>: 

Enter the number of segments. 

Sphere 

 Menu: Draw – Meshes> Sphere  

 Command line: 3D 

The command creates a spherical polygon mesh. 



Option: 

Diameter Switch to specify the diameter. 

 

Command prompts: 

Specify center point of sphere: Specify the  centre point of the sphere (point 1). 

Specify radius of sphere or[Diameter]: Specify the radius of the sphere (point 2) or select the 
Diameter option. 

Enter number of longitudinal segments for 

surface of sphere <16>: 

Enter the number of longitudinal segments for the surface 
of the sphere. 

Enter number of latitudinal segments for 

surface of sphere <16>: 

Enter the number of latitudinal segments for the surface of 
the sphere. 

Torus 

 Menu: Draw – Meshes> Torus  

 Command line: 3D 

The command creates a toroidal polygon mesh.  

Option: 

Diameter Switch to specify the diameter. 

 

Command prompts: 

Specify center point of torus: Specify the  centre point of the torus (point 1). 

Specify radius of tours or 

[Diameter]: 
Specify the radius of the torus (point 2) or select the Diameter 

option. 

Specify radius of tube or 

[Diameter]: 
Specify the radius of the tube (point 3) or select the Diameter 

option. 

Enter number of segments around 

torus circumference <16>: 

Enter the number of segments around the torus circumference. 

Enter number of segments around 

tube circumference <16>: 

Enter the number of segments around the tube circumference. 

Pyramid 

 Menu: Draw – Meshes> Pyramid  

 Command line: 3D 

The command creates a pyramid or a tetrahedron. 

Options: 

Tetrahedron Switch to create the tetrahedron. 

Ridge Switch to create a pyramid with a top with a ridge form. 

Top Switch to create a truncated pyramid. 



 

When you create a pyramid, the following prompts are displayed: 

Specify first corner point for base of 

pyramid: 

Specify point 1. 

Specify second corner point for base of 

pyramid: 

Specify point 2. 

Specify third corner point for base of 

pyramid: 

Specify point 3. 

Specify fourth corner point for base of 

pyramid or [Tetrahedron]: 
Specify point 4. 

Specify apex point of pyramid or [Ridge/Top]: Specify point 5. 

 

When you create a truncated pyramid, the following prompts are displayed: 

Specify first corner point for base of 

pyramid: 

Specify point 1. 

Specify second corner point for base of 

pyramid: 

Specify point 2. 

Specify third corner point for base of 

pyramid: 

Specify point 3. 

Specify fourth corner point for base of 

pyramid or [Tetrahedron]: 
Specify point 4. 

Specify apex point of pyramid or [Ridge/Top]: Select the Top option. 

Specify first corner point for top of pyramid: Specify point 5. 

Specify second corner point for top of 

pyramid: 

Specify point 6. 

Specify third corner point for top of pyramid: Specify point 7. 

Specify fourth corner point for top of 

pyramid: 

Specify point 8. 

Note: To create the top of a pyramid, it is necessary to set the points in the same order as for the base. 

 

When you create a truncated tetrahedron, the following prompts are displayed: 

Specify first corner point for base of 

pyramid: 

Specify point 1. 

Specify second corner point for base of Specify point 2. 



pyramid: 

Specify third corner point for base of 

pyramid: 

Specify point 3. 

Specify fourth corner point for base of 

pyramid or [Tetrahedron]: 
Select the Tetrahedron option. 

Specify apex point of tetrahedron or [Top]: Select the Top option. 

Specify first corner point for top of 

tetrahedron: 

Specify point 4. 

Specify second corner point for top of 

tetrahedron: 

Specify point 5. 

Specify third corner point for top of 

tetrahedron: 

Specify point 6. 

Note: To create the top of a tetrahedron it is necessary to set the points in the same order as for the base 

 

When you create a pyramid with the top with the ridge form, the following prompts are displayed: 

Specify first corner point for base of 

pyramid: 

Specify point 1. 

Specify second corner point for base of 

pyramid: 

Specify point 2. 

Specify third corner point for base of 

pyramid: 

Specify point 3. 

Specify fourth corner point for base of 

pyramid or [Tetrahedron]: 
Specify point 4. 

Specify apex point of pyramid or [Ridge/Top]: Select the Ridge option. 

Specify first ridge end point of pyramid: Specify point 5. 

Specify second ridge end point of pyramid: Specify point 6. 

Dish 

 Menu: Draw – Meshes> Dish  

 Command line: 3D 

The command creates the lower half of a spherical polygon mesh. 

Option: 

Diameter Switch to specify the diameter. 

 

Command prompts: 

Specify center point of dish: Specify the  centre point of the dish (point 1). 

Specify radius of dish or [Diameter]: Specify the radius of the dish (point 2) or select 
the Diameter option. 

Enter number of longitudinal segments for surface 

of dish <16>: 

Enter the number of longitudinal segments for 
the surface of the dish. 

Enter number of latitudinal segments for surface Enter the number of latitudinal segments for the 



of dish <8>: surface of the dish. 

Dome 

 Menu: Draw – Meshes > Dome  

 Command line: 3D 

The command creates the upper half of a spherical polygon mesh. 

Option: 

Diameter Switch to specify the diameter. 

 

Command prompts:  

Specify center point of dome: Specify the  centre point of the dome (point 
1). 

Specify radius of dome or [Diameter]: Specify the radius of the dome (point 2) or 
select the Diameter option. 

Enter number of longitudinal segments for surface 

of dome <16>: 

Enter the number of longitudinal segments 
for the surface of the dome. 

Enter number of latitudinal segments for surface 

of dome <8>: 

Enter the number of latitudinal segments for 
the surface of the dome. 

Mesh 

 Menu: Draw – Meshes> Mesh  

 Command line: 3D 

The command creates a planar mesh. 

 

Command prompts:   

Specify first corner point 

of mesh: 

Specify point 1. 

Specify second corner point 

of mesh: 

Specify point 2. 

Specify third corner point 

of mesh: 

Specify point 3. 

Specify fourth corner point 

of mesh: 

Specify point 4. 

Enter mesh size in the M 

direction: 

Enter a value between 2 and 256. 

Enter mesh size in the n 

direction: 

Enter a value between 2 and 256. 

Note 1: The M and N directions are similar to the X and Y axes of an XY plane. 

Note 2: M and N sizes determine the number of lines drawn in each direction along the mesh. 



3D Mesh 

 Menu: Draw – Meshes> 3D Mesh 

This command creates polygon meshes. 

As you create the mesh, you specify the size of the mesh in the M and N directions. 

A pair of m and n (row number and column number) defines the position of each vertex of the mesh. Specifying of the 
vertices starts with the vertex (0, 0). The value of n changes first. 

The vertices can be located at any distance from each other. 

You can close the meshes with PEDIT.  

The following example shows the points corresponding to the vertices for a 3D Mesh with N=4 and M=5 sizes. 

 

Command prompts: 

Enter size of mesh in M 

direction: 

Enter a value between 2 and 256. 

Enter size of mesh in N 

direction: 

Enter a value between 2 and 256. 

Specify location for vertex 

(0, 0): 

Specify the location for the first vertex. 

Specify location for vertex 

(0, 1): 

Specify the location for the second vertex. 

… … 

Specify location for vertex 

(m, n): 

Specify the location for the last vertex. 

Note 1: The M and N directions are similar to the X and Y axes of an XY plane. 

Note 2: M and N sizes determine the number of lines drawn in each direction along the mesh.  

Setting of the orthographic and isometric views 
To quickly set the view, select the View – Views and select the required standard orthographic and isometric views. 

Orthographic views 
Set Top 

 Menu: View – Views >  Set Top  

 Command line: VIEW1 

Set the top view . 

Set Bottom 

 Menu: View – Views >  Set bottom 

 Command line: VIEW2 

Set the bottom view . 

Set Left 

 Menu: View – Views >  Set Left  

 Command line: VIEW4 

Set the left view. 

Set right 

 Menu: View – Views >  Set Right  



 Command line: VIEW5 

Set the right view. 

Set Front 

 Menu: View – Views >  Set Front  

 Command line: VIEW3 

Set the front view . 

Set back 

 Menu: View – Views >  Set Back  

 Command line: VIEW6 

Set the back view. 

Isometric views 
SW Isometric  

 Menu: View – Views >  SW Isometric  

 Command line: SWISO 

Set the southwest isometric view. 

SE Isometric  

 Menu: View – Views >  SE Isometric 

 Command line: SEISO 

Set the southeast isometric view. 

NE Isometric  

 Menu: View – Views >  NE Isometric  

 Command line: NEISO 

Set the northeast isometric view. 

NW Isometric  

 Menu: View – Views >  NW Isometric  

 Command line: NWISO 

Set the northwest isometric view. 

Visual style 
nanoCAD allows you to choose the methods (styles) to display the three-dimensional objects in the current viewport. 

The basic methods of object display: 

 

Wireframe displays the objects using lines and curves to represent the boundaries. The 

objects are visible. 

 

Hidden displays the objects using the 3D wireframe representation, but hides the lines 

representing the back faces.  



 

Shade assigns a monochrome colour to the visible surface of the object and also makes the 

background invisible. Each object is shaded by the current colour. In the shaded visual 

styles, the faces are lit by one distant light that is located behind the left shoulder of the 

user. The object view depends on the selected shading method. 

The command control styles are represented in the View menu – Visual Style. 

2D Wireframe 

 Menu: View – Visual style > 2D Wireframe  

 Command line: VSCURRENT0 

The objects are representedas transparent . The command displays the objects using lines and curves to represent 
the boundaries. Raster and OLE objects, linetypes, and lineweights are visible. 

3D Wireframe 

 Menu: View – Visual style > 3D Wireframe 

 Command line: VSCURRENT1 

The objects are represented  as transparent. The command displays the objects using lines and curves to represent 
the boundaries. Raster objects are invisible, linetypes, and lineweights are ignored. 

3D Hidden 

 Menu: View – Visual style > 3D Hidden  

 Command line: VSCURRENT2 

The command displays the objects using the 3D wireframe representation and hides the lines representing the back 
faces. 

Flat Shaded 

 Menu: View – Visual style > Flat Shaded 

 Command line: VSCURRENT3 

Fills the surface with the colour which is determined by the colour of the object or layer.  At the same time, a shadow 
is superimposed on the surface as if there is a light source in the same position as the observer.Curved surfaces 
have a multifaceted view. 

Gouraud Shaded 

 Menu: View – Visual style > Gouraud Shaded 

 Command line: VSCURRENT4 

The Gouraud method is used. The surface and colour transitions are displayed as smooth. If the object is not 
assigned a material, it will be shaded in the colour of an object or layer. 

Flat Shaded with Edges 

 Menu: View – Visual style > FlatShaded with Edges 

 Command line: VSCURRENT5 

The object will have simple filling of the faces and selected edges 

Gouraud Shaded with Edges 

 Menu: View – Visual style > GouraudShaded with Edges 

 Command line: VSCURRENT6 

 In this case Gouraud shading is applied to objects, but the edges of their surfaces are visible. 

 



The component layout and plot drawing 

Model space and paper space 
There are two distinct working environments, or “spaces,” in which you can create objects in a drawing. In nanoCAD 
they are represented by the Model and layout tabs. 

Typically, a model composed of geometric objects is created in a three-dimensional space called model space. A final 
layout with specific views and annotations of this model is created in a two-dimensional space called paper space. 

These spaces are accessible on two or more tabs near the bottom of the drawing area: the Model tab and one or 
more layout tabs. 

Layout tabs access an area called paper space. In paper space, you place your title block, create layout viewports to 
display views, dimension your drawing, and add notes. 

You can create a single layout viewport that fits the entire layout or create multiple layout viewports in the layout. 
Once you create the viewports, you can change their size, their properties, and also scale and move them as 
needed. 

Layouts 

It is possible to create multiple layouts in a drawing; each layout can contain different plot settings and paper sizes. 
The layout tabs are located in the bottom part of the document window, next to the Model tab. To switch between the 
Model tab and layouts, click the necessary tab: 

 
 

To quick switch between the Model space and layouts, use the  button located at the end of tabs line. This button 

also allows you to switch between the named views available in the document. Left click to open a context menu that 
displays all the tabs and named views available in the document: 

 
The top part of the menu displays the named views, the bottom part displays the Model and layouts tabs. The current 

space is marked with . To switch between tabs or named views, it is necessary to click on the corresponding 

name in the menu. When you switch to a named view, there is auto-panning of the view on the screen.  

You can rename, delete and add layout tabs unlike the Model tab. 



Another important difference between Model space and paper space is that you create non-overlapping viewports in 
the Model space, i.e. snap-together at the boundaries. In Model space you can print only the current viewport. 
Viewports in the paper space are floating. They can be moved to any part of the layout. Their boundaries can be 
close to each other and overlapped or be located at some distance from each other. You can print all the viewports 
located on the layout at the same time. 

To work with a layout, use the command from the Insert menu – Layout item, or from the Layout toolbar, or from 
the context menu that opens by right clicking the Model tab or a Layout tab. 

To create a new layout, use the Add Layout command. To delete a layout, use the Delete Layout command. To 
rename a layout, use the Rename Layout command. 

The format of displayed layout is set in the Page Setup dialogue box. 

Note: The print area of the layout for the current format settings and printer is displayed by a dashed line. 

You can change the layout colour in the Options dialogue box using the Color settings item – Layout Paper. 

When you prepare a layout, you typically go through the following process: 

 Create a model of your subject on the Model tab. 

 Click a Layout tab and specify layout page settings, such as plotting device, paper size, plot area, plot scale and 
drawing orientation. 

 Insert a title block into the layout. 

 Create a new layer to be used for the layout viewports. 

 Create the layout viewports and position them on the layout. 

 Set the orientation, scale and layer visibility of the view in each layout viewport. 

 Add dimensions and annotate in the layout as  necessary. 

 Turn off the layer containing the layout viewports. 

 Execute the plot setting of the layout. 

 Plot the layout. 

Work with Layouts 

To create a new layout 

 Menu: Insert – Layout >  New Layout  

 Command line: ADDLAYOUT 

At the command prompt -  Input layout name <Layout3>, enter the name of the new layout and press ENTER. 

The layout name should be unique up to 255 characters. 

Note: No more than 31 characters of the layout name are displayed on the layout tab. 

To create a layout from a template  

 Menu: Insert – Layout > Layout from template… 

 Command line: LAYOUTFROMTEMPLATE 

The command creates a new layout in the document. 

The command allows you to create one or several layouts from an existing template file (*.dwt) or drawing file 
(*.dwg). 

Start the command to open the Open Document file dialogue box: 



 

To select a template in the Open Document file dialogue box: 

 Select the *.dwt format from the Files of type list; 

 select the folder where the template file or drawing file is stored; 

 select the file; 

 click Open; 

 select one or several layouts in the Insert Layout(s) dialogue box (use SHIFT and CTRL keys):  

 
 

 click ОК. 

If the name of the inserted layout is the same as the name of a layout in the paper space, then the new layout will 
have a name consisting of the name of the existing layout, to which the name of the inserted layout is joined with an 
underscore character. For example, when you insert a layout called A4 into a document already having a layout with 
same name, a layout called A4_A4 will be created. When you next insert the layout called A4, it will be created with 
the name A4_A4_A4 and so on.  



 Save a layout as a template 

 Menu: Insert – Layout > Save layout as… 

 Command line: LAYOUTTOTEMPLATE 

This command saves the created layout as a template with a *.dwt or *.dwg extension.  

The command prompts, by default, to save the last active layout: Enter layout to save <A1>:. 

Press ENTER to confirm. Enter the name in the command line and press ENTER to save a different layout. 

The command opens the Save Document File dialogue box: 

 

To save a template in the Save Document File dialogue box: 

 

 to save the file, specify the path from the drop-down Save in list; 

 enter a name into the File name field; 

 select the Drawing Template (*.dwt) format from the drop-down Save as type list; 

 Click Save. 

Delete layout  

 Menu: Insert – Layout >  Delete Layout 

 Command line: DELETECURLAYOUT 

This command prompts, by default, to delete the last active layout: Enter layout to delete <A1>:. 

Press ENTER to confirm. Enter the name in the command line and press ENTER, to delete a different layout.  

You can delete a layout by right clicking on the layout tab and selecting the Delete Layout command from the 
context menu. 

Rename layout  

 Menu: Insert – Layout > Rename Layout  

 Command line: RENAMECURLAYOUT 

This command prompts, by default, to rename the last active layout. 

Press ENTER to confirm. Enter the name in the command line and press ENTER, to rename a different layout.  



You can rename a layout by right clicking on the layout tab and selecting the Rename Layout command from the 

context menu. 

Viewports 
nanoCAD allows you to create layout viewports from the model space. You can create multiple layout viewports in the 
layout. Once you create the viewports, you can change their size, their properties and also scale and move them as 
needed. 

It is important to create layout viewports on their own layer. When you are ready to plot, you can turn off the layer and 
plot the layout without plotting the boundaries of the layout viewports. 

Create Layout Viewports 

Create a rectangular viewport 

 Menu: View – Viewports >  Rectangular 

 Command line: ADDRECTANGLEVIEWPORT 

nanoCAD allows use of this command on the current layout tab in which the viewport should be located, as well as 
directly from the model space. 

Create a rectangular viewport from the model space 

When you create a viewport from the model space, specify, with a frame, the drawing area (in the model space) that 
should be displayed in the viewport. 

Command prompts:  

Specify viewport first corner: Specify the first corner of the rectangular viewport in the 
model space 

Specify viewport second corner: Specify the opposite corner of the rectangular viewport in the 
model space 

Enter layout to make current <A4>: Enter the layout on which you want place the viewport. 

By default, you will be offered the layout that was current 
(active) before the command start. 

Input or choose view scale 

<Paper><1.000000>: Input the viewport scale. 

Specify Viewport Center Point: Specify the viewport  centre point. 

Create a rectangular viewport from a layout 

Options: 

Extent Display all objects from the model space in the viewport. 

Active<0.000831> Display the current view of the model space in the viewport. 

Paper<1.000000> Set the viewport scale corresponding to the layout scale. 

 

Command prompts:  

Specify viewport first corner: Specify the first corner of the rectangular viewport in 
the layout tab. 

Specify viewport second corner: Specify the opposite corner of the rectangular 
viewport in the layout tab. 

Input or choose view scale <Paper> or 

[Extents/Active<0.000831>/Paper<1.000000>]: 
Input the viewport scale or select the required 
option. 

Create a polygonal viewport 

 Menu: View – Viewports >  Polygonal 

 Command line: ADDPOLYGONVIEWPORT 

nanoCAD allows use of this command on the current layout tab in which the viewport should be located, as well as 
directly from the model space. 

Create a polygonal viewport from the model space 

When you create a viewport from the model space, specify the vertex points of the polygonal area of the drawing (in 
the model space) that should be displayed in the viewport. 



Option: 

Undo Consistently undo the specified points of the polygonal area.  

The start point cannot be undone.  

 

Command prompts:  

Specify start point: Specify the start point of the polygonal vertex. 

Specify next point or [Undo]: Specify the second point of the polygonal vertex. 

… … 

Specify next point or [Undo]: Specify the end point of the polygonal vertex and press 
ENTER. 

Enter layout to make current <A4>: Enter the layout on which you want to place the viewport. 

By default, you will be offered the layout that was current 
(active) before the command start. 

Input or choose view scale 

<Paper><1.000000>: Input the viewport scale. 

Specify Viewport Center Point: Specify the viewport  centre point. 

Create a polygonal viewport from a layout 

Options: 

Undo Consistently undo the specified points of the polygonal area.  

The start point cannot be undone.  

Extent Display all objects from the model space in the viewport. 

Active<0.000831> Display the current view of the model space in the viewport. 

Paper<1.000000> Set the viewport scale corresponding to the layout scale. 

 

Command prompts:  

Specify start point: Specify the start point of the polygonal vertex. 

Specify next point or [Undo]: Specify the second point of the polygonal vertex. 

… … 

Specify next point or [Undo]: Specify the end point of the polygonal vertex and 
press ENTER. 

Input or choose view scale <Paper> or 

[Extents/Active<0.000831>/Paper<1.000000>]: 
Input the viewport scale or select the required 
option. 

Create a viewport by object  

 Menu: View – Viewports >  by Object 

 Command line: DDOBJECTVIEWPORT 

This command allows you to convert a closed polyline, circle or ellipse into a viewport. 

nanoCAD allows use of this command on the current layout tab in which the viewport should be located, as well as 
directly from the model space.  

Create a viewport by object from the model space 

Options: 

Extent Display all objects from the model space in the viewport. 

Active<0.000831> Display the current view of the model space in the viewport. 

Paper<1.000000> Set the viewport scale corresponding to the layout scale. 

 

Command prompts:  

Enter layout to make current <A4>: Enter the layout on which you want to place the 
viewport. 

By default, you will be offered the layout that was 



current (active) before the command start. 

Select closed object to create viewport: Select the closed object. 

Input or choose view scale <Paper> or 

[Extents/Active<0.000831>/Paper<1.000000>]: 
Input the viewport scale or select the required 
option. 

Create a viewport by object from a layout 

Options: 

Extent Display all objects from the model space in the viewport. 

Active<0.000831> Display the current view of the model space in the viewport. 

Paper<1.000000> Set the viewport scale corresponding to the layout scale. 

 

Command prompts:  

Select closed object to create viewport: Select the closed object. 

Input or choose view scale <Paper> or 

[Extents/Active<0.000831>/Paper<1.000000>]: 
Input the viewport scale or select the required 
option. 

Edit Layout Viewports  
You can redefine the boundary of a layout viewport by using the grips. You can either use the multi-feature modes for 
grips editing of viewports which are used as the boundary of the closed polylines and splines (for more information, 
see «Editing viewports of paper space» («EDITING OBJECTS»-«Ways to edit objects»-«Editing objects using 
multifunctional grips»)). The type and location of grips depend on the type of viewport or the object from which it is 
converted: 

 

 
The following editing commands can be used with the selected viewport: Copy, Move, Scale, etc. 

You can copy and move the viewports to the clipboard and paste them from the clipboard. 

The clipboard options can be modified in the Inspector window:  

 
To turn on/off the content display of the viewport, use the Yes or No options from the drop-down list of the On option 
(or use the ON/OFF command from the View menu – Viewports item).  

 



The objects on the turned off viewport are invisible. You cannot set as default the turned off viewport. A large number 
of active (with turned on visibility of content) viewports requires considerable time for regeneration. Turn off the 
visibility of some unused viewports to improve the regeneration of document. You can move and resize the 
deactivated viewports. The deactivated viewports are not printed. 

The Display locked option allows you to block or unblock a viewport (Yes and No options are available in the drop-
down list). A similar function is performed by the Lock/Unlock command from the View menu – Viewports item. 

Locking a viewport used to previously set the scale of a viewport remains unchanged (viewport zoom does not affect 
the viewport scale). 

The Standard Scale and Scale option allows you to set or change the scale of the displayed view in a viewport. For 

example, if a drawing fragment is created in 1:1 scale and you want  to specify 1:4 scale for it, it is necessary enter 
0.25 value in the right column of the Scale option or select 1:4 from the drop-down list of the Standard Scale option.   

 

The view scale of a viewport is not changed when you edit the boundaries of the viewport; for example, when you 
modify a boundary by grips. If you set the scale in the layout viewport before you access the model space, you can 
lock the scale to prevent changes. When the scale is locked, you cannot use zoom while you work in model space 

You can clip the boundaries of the viewports (the Modify menu – Clip – Viewport).  

The viewport allows you to edit the objects of the model space from the layout. If you are in paper space, double-click 
within a layout viewport. You are now in model space. The selected layout viewport becomes the current viewport, 
and you can pan the view and change the layer properties. If you are in model space in a layout viewport, double-

click outside the viewport. To switch quickly from a viewport in layout, use the  button in the status bar. Located 

next, the  button performs switching from the layout back into the viewport. 

Set show boundary for a viewport 

 Menu: Modify – Clip > Viewport  

This command allows you to change the border of the created layout viewport. 

Use the command to clip the border of the viewport and objects displayed on the viewport. The show boundary only 
defines the objects’ visibility option in the viewport, the objects do not change on the drawing. 

Options:  

Polygonal Set the polygonal contour of the show boundary by specifying all the polygon vertices.  

Undo Undo the specified points of the polygon vertices. 

The start point cannot be undone. 

Object Set the boundary contour by specifying the closed object.  

The object should already be created. 

You can use circles, ellipses, closed polylines and closed splines as objects,. 

 

Viewport before setting the display boundary Viewport display after setting a polygonal display 
boundary 



  

Command prompts when you set polygonal boundary: 

Select viewport to apply action: Select the viewport. 

Specify clipping option <Polygonal> или 

[Polygonal/Object/Delete]: Select the Polygonal option. 

Specify start point: Specify the start point.  

Specify next point or [Undo]: Specify the second point.   

… … 

Specify next point or [Undo]: Specify the end point and press ENTER. 

Command prompts when you set boundary by object: 

Select viewport to apply action: Select the viewport. 

Specify clipping option <Polygonal> или 

[Polygonal/Object/Delete]: Select the Object option. 

Select closed object to create viewport:  Select the closed object.  

Document plot 
To print document: 

 In the Layers dialogue box (the Format menu – Layers…), carry out the following for the layers that should be 
printed: 

 turn on the visibility ( ), 

 turn on the availability to print ( ). 

 If necessary, set the display order of the objects, using the Display Order commands from the Tools menu.  

 Set the printer settings for each layout: 

 right-click on the Model tab or corresponding tab in the Layout, 

 in the opened context menu select the Page Setup… command: 

, 

 create a new, edit existing or import the parameters set of a page previously created in another document, 

 when you create a new or edit an existing parameters set of a page, specify the required parameters in the Page 
Setup Manager dialogue box.Click the Apply to layout button to apply the parameters set to the current layout 
and close the dialogue box. 

 Print out the task (the File menu - the Plot or Batch plot command).  

Page Setup Manager  

 Menu: File –  Page Setup…  



 Toolbar: Main –  

 Command line: PAGESETUP 

When you are preparing a document for printing, it is necessary to save the settings of the plot options in the named 
page setups. Use the named page setups to reduce the document preparation time for the plot by applying previously 
made plot settings to new documents layouts. 

You can create named page setups, modify existing ones or import page setups from other drawings. The page 
setups are assigned to each page of the document and stored in a document file. 

Start the command and the Page Setup Manager dialogue box will be opened. The name of the current layout is 
displayed in brackets in the dialogue box title bar: 

 

Options: 

Existing page setups 

In the left part of the section, the list of page setups that are available to apply to the current layout is displayed. 

Layouts that have a named page setup applied to them are enclosed in asterisks (for example, *Model*, *Layout1*). 

 
Displays the page setup that is applied to the current layout. Layouts that have a named page 
setup applied to them are enclosed in asterisks, with the named page setup in parentheses; for 
example, *Model(Setup)*, *Layout(Setup)*, etc. 

 

Note: When the current layout is selected, the Apply to layout button is not available.  

 
Opens the New Plot Set dialogue box, in which you can select a set created earlier as a 
template and enter a name for the new page setup. 

 
Opens the Page Setup dialogue box, in which you can edit the settings for the selected page 

setup. 

 
Opens the Open Document File dialogue box (a standard file selection dialogue box), in 

which you can select a file from which to import one or more page setups. 

 Deletes the selected setup from the existing page setups list. 

Plot parameters  Displays information about the selected page setup. 

Device name: Displays the name of the plot device. 

Plotter: Displays the type of plot device. 



Output: Displays the physical location of the output device. 

Paper format: Displays the name, paper size and orientation specified in the currently selected page setup. 
The paper size and orientation are displayed in square brackets [ ]. 

Note: The name of the paper format can include the paper size that is displayed in round 
brackets ( ). 

Note: The page setups created for the layouts are not applied to the model space. Conversely, the page setups 
created for the model space are not applied to the layouts. 

To create the page setup: 

 Click the  button. 

 In the opened New Plot Set dialogue box in the Based on plot set section, select an already created setup as 

the template. 

 

 In the Name field, enter the name of the new setup. 

 Note: By default, the created page setup will be named SetupN, where N is the number of the created setup. It is 
recommended to assign a user name to the new setup which will display the name and orientation, plotter name, 
etc. For example, A4 (portrait) PDFCreator or А1 (landscape) CanonLargeFormat W7250. 

 Click ОК. 

 Specify the necessary parameters in the Page setup dialogue box and click ОК. 

The newly created setup is displayed in the Existing page setup list of the Page Setup Manager dialogue box. 

To edit the page setup: 

 Select the setup to edit from the Existing page setup list. 

 Click the  button. 

 Edit the required parameters in the opened Page Setup dialogue box. 

 Click ОК. 

To import the page setup: 

 Click the  button. 

 In the opened standard file selection dialogue box, select the file or folder in which it is located. 

Note: You can import page setups from the drawing format (DWG), drawing template (DWT) or drawing 
interchange format (DXF) 

 Select one or more page setups in the Import page setup dialogue box (use the SCHIFT and CTRL keys). 



 

 Click ОК. 

Page Setup 
The Page Setup dialogue box is displayed when you create a new or edit an existing page setup (the New and 
Create button): 

 

Options: 

Printer/plotter 

Name: Drop-down list displays the available plotting devices. 

 
Displays the dialogue box, where you can view or modify the current plotter 
configuration. 

The dialogue box view and configuration settings are determined by the driver 



of the current plotting device. 

Paper size and orientation 

 Drop-down list to select the paper size for the current plotting device 

Portrait Sets the portrait paper orientation. 

Landscape Sets the landscape paper orientation. 

Plot upside down  Turns round the print area. 

Plot area 

 
Specifies the area of the drawing to be plotted. 

From the drop-down list the following options are available: 

Display Plots the view in the current viewport in the Model tab or in 
the current paper space view in a Layout tab. 

Extents Plots the portion of the current space of the drawing that 
contains objects. All geometry in the current space is 
plotted. 

Limits When plotting from the Model tab, plots the entire drawing 
area that is defined by the grid limits. 

Layout When plotting a layout, plots everything within the printable 
area of the specified paper size. 

View Plots a view that was previously saved with the View 
command. You can select a named view from the list: 

 

Note: If there are no saved views in the drawing, this option 
is unavailable. 

Window Plots any portion of the drawing that you specify.  

When you select this option, the Page Setup dialogue box 

will be temporary closed and in the command line the 
prompt appears: Specify First Corner or 

[Select]: you can specify the two corners of the area to 

be plotted. The paper size and orientation in this case are 
defined by the parameters specified in the Paper size and 
orientation section. 

Click the Window button to use the pointing device to 
specify the two corners of the area to be plotted, or enter 
coordinate values. The Select option allows you to 

specify the plot area by selecting one side of the frame that 
limits the paper size.  

When you specify the first plot area, additional options are 
displayed in the dialogue box: 

 

 
New window 
print area  

Cancels all plot areas by 
setting a new area. 

 
Add window 
print area 

Adds the plot area to those 
already specified. 

 
Delete last 
print area 

Removes the specified plot 
areas in the reverse order of 
their assignment. 

  



 

Shows an accurate representation of the effective plot area relative to the 
paper size and printable area.  

The tooltips display the paper size and printable area: 

Dashed line – defines the plot area for the specified paper size (numbers 
indicate the length and width of the plot area). 

The blue hatch bounded by the dashed contour – defines the location 
of the specified plot area on the paper. 

Red line – is a warning that the specified plot area exceeds the plot 

boundaries. 

Plot offset 

Х: Specifies the plot origin in the X direction relative to the setting of the Plot 
Offset option. 

Y: Specifies the plot origin in the Y direction relative to the setting of the Plot 
Offset option. 

Multipage Turn on/off the multipage plot mode. This option is available when the Fit to 
paper option is off. 

Center the plot Turn on/off the mode for automatic offset detection in the X and Y directions 
so that the drawing is placed in the  centre of the paper. 

Plot scale  

Fit to paper Scales the plot to fit within the selected paper size. 

Frame width: This option considers the weight of the frame line defining the drawing 
boundaries and coinciding with the plot area boundaries. When you set a 
parameter value equal to the weight of the frame lines, the frame prints 
without reducing its thickness. 

For example, if the parameter value is equal to zero, the frame created by 
lines of 1 mm, will be printed at 0.5 mm thick. Set the parameter to a 1 mm 
value to print the frame at 1 mm thick.  

Note: The Frame width option is available when the Fit to paper mode is on. 

Scale: Defines the exact scale for the plot. You can create a custom scale by 
entering the number of inches (or  millimetres) equal to the number of 
drawing units. 

Plot style table (pen assignments)  

 Drop-down list to select the current plot style. 

 
Opens the Plot Style Table Editor dialogue box to edit the plot styles for the 

currently assigned plot style table or create new. 

Shaded viewport options 

Shade plot: Specifies how shaded and rendered viewports are plotted.  

The following options are available:  

As displayed - plots objects the way they are displayed on the screen. 

Wireframe - plots objects in wireframe, regardless of the way they are 
displayed on the screen. 

Hidden - plots objects with hidden lines removed, regardless of the way 
the objects are displayed on the screen. 

Rendered - plots objects as rendered, regardless of the way they are 

displayed on the screen. 

Quality: Specifies the resolution at which shaded and rendered viewports are plotted.  

The following options are available:  

Draft –sets rendered and shaded model space views to be plotted as 

wireframe. 

Preview - sets rendered and shaded model space views to be plotted at 
one quarter of the current device resolution, to a maximum of 150 dpi. 

Normal - sets rendered and shaded model space views to be plotted at 



one half of the current device resolution, to a maximum of 300 dpi. 

Presentation - sets rendered and shaded model space views to be 
plotted at the current device resolution, to a maximum of 600 dpi. 

Maximum - Sets rendered and shaded model space views to be plotted 

at the current device resolution with no maximum.  

Custom - sets rendered and shaded model space views to be plotted at 

the resolution setting that you specify in the DPI box, up to the current 
device resolution. 

DPI: Specifies the resolution of the current plotting device.  

This option is available if you select Custom in the Quality box. 

Plot options  The options that allows you to switch between ready-configured plot styles 
(the *.ctb or *.stb files) and customised properties for the objects in the 
current document. 

Plot object lineweights  Specifies whether lineweights assigned to objects and layers are plotted.  

Plot with plot styles Specifies whether plot styles applied to objects and layers are plotted.  

When you select this option, Plot Object Lineweights is automatically 
selected also. 

Plot paperspace last Plots model space geometry first.  

Hide paperspace objects         Specifies whether the Hide operation applies to objects in the paper space 

viewport.  

This option is available only from a layout tab.  

The effect of this setting is reflected in the plot preview, but not in the layout. 

Scale lineweights Scales lineweights in proportion to the plot scale. Lineweights normally 
specify the linewidth of plotted objects and are plotted with the linewidth size, 
regardless of the plot scale. 

 
Displays the drawing as it will appear when plotted on paper by executing the 
Preview command.  

 
Displays the page setup that is applied to the current layout.  

The named page setup applied to the layout is displayed in the title of the 
Plot dialogue box when you print this page. 

 

Set the custom paper formats 
If necessary, it is possible to set a paper format that is not in the drop-down list of the Paper size and orientation list in 
the Plot and Page Setup dialogue boxes. You can set new paper formats in addition to those available in nanoCAD 
in the Papers section of the Options dialogue box (the Tools menu – Options). 

To set a new paper format: 

 Select paper formats in the Papers section of the Options dialogue box. 

 Click the Add button. 

 In the opened Add paper format dialogue box specify the name, units, paper size and plot area size for the new 
paper format. 



 

Note 1: The plot area sizes are set according to the plotting device used because these are determined by the 
manufacturer of the plotting device.  

Note 2: When you set the paper size, the minimum and maximum sizes for the plotting device used should be 
considered. They are also determined by the manufacturer of the plotting device. 

 Click OK to close the window. 

 Click OK to close the Options dialogue box. 

The specified paper format will be displayed in the Paper size and orientation list in the Plot and Page Setup 
dialogue boxes after you select a specific plotting device.  

Note 3: If the paper format for which the sizes given are more or less acceptable for a specific plotting device, then 
the paper size and orientation list for this device are not displayed. 

Plot Style Editor 

 Menu: File –  Plot Style Manager… 

 Toolbar: Main –   

 Command line: PLOTSTYLEMANAGER 

A plot style controls how an object or layer is plotted by determining the plotted properties such as lineweight, colour, 
and fill style. Plot style tables collect groups of plot styles. The same drawing can be printed in different ways, for 
example, in colour or monochrome, by assigning various plot styles to it.  

The Plot Style Manager dialogue box is also used to change plot style settings for both named and colour-
dependent plot style tables. 

Colour-dependent plot style tables are stored in the Plot Styles folder and have a *.ctb extension. By using colour-

dependent plot styles to control how objects are plotted, you ensure that all objects that share the same colour are 
plotted the same way. 

All named plot style tables have an *.stb extension. You can only create, delete and apply plot styles in a named plot 

style table. You can define as many or as few plot styles as you need in a drawing. 

Colour-dependent (*.ctb extension) and named (*.stb extension) plot style tables are stored in the Plot Styles folder 
by default: 

c:\Documents and Settings\User_name\Application Data\Nanosoft\nanoCAD 3.0\PlotStyles. 

You can add, delete, rename and copy plot styles in a named plot style table using the Plot Style Manager dialog: 



 
Click OK to open the Plot Style Table Editor dialogue box: 

 
The General tab contains a description of the plot style table and general information about the file. 

The Form View tab lists all of the plot styles in the plot style table and their settings. 

The   button opens the Edit Lineweights dialogue box: 



 

The plot style editor can be opened by the  button from the Page Setup dialogue box. 

Plot Preview  

 Menu: File –  Plot Preview… 

 Toolbar: Main –  

 Key combination: CTRL+F2  

 Command line: PREVIEW 

You can preview the drawing from the Plot Preview dialogue box: 

 

Note: A preview is not available for a layout that does not have an assigned plotter. 



Options:  

 Zoom all  Display the whole plot area in the preview window. 

 Zoom 1:1 Display the plot area at a scale of 1:1. 

 Zoom in  Zoom in to the image. 

 Zoom out Zoom out from the image. 

 Print Sends the drawing to the plotter. 

 Close Closes the Plot Preview dialogue box. 

Additional options are displayed in the dialogue box for a multipage plot: 

 First page Display the first page of a plot set in the preview. 

 Previous page  Display the previous page of a plot set in the preview. 

 Next page Display the next page of a plot set in the preview. 

 Last page Display the last page of a plot set in the preview. 

 

Display the number of the page you are viewing in the window, and the total number of 
pages of the plot set. 

You can zoom and pan an image in the preview window by clicking inside the window:  

 To zoom an image, rotate the mouse wheel. 

 To pan an image, move the mouse with the left or right button pressed and also the mouse wheel. 

You can open the Plot Preview dialogue box from the Page Setup, Plot and Publish dialogue boxes. 

When printing files that have rich graphics, a large number of viewports, etc., the message “Not enough memory to 
create preview” can appear in the preview window. In this case it is necessary to change the Print preview mode 
settings in the System setting item of the Options dialogue box.  

By default, the Metafile parameter is set: 

 

Plot 

 Menu: File –  Plot… 

 Toolbar: Main –  

 Key combination: CTRL+P  

 Command line: DWFOUT, PLOT 

This command opens the Plot dialogue box that differs from the Page Setup dialogue box only in the Page setup 
section and it has a Plot button instead of OK. 



 

Options:  

Page setup 

Name: Displays a list of available page setups in the drawing. 

After the first drawing plot, the <Previous plot> option is available in the list. It stores the settings of the 
last plot. 

 

 
Displays the New Plot Set dialogue box, in which you can save the current settings in the Plot 

dialogue box to a named page setup. 

Description of other options see in the Page Setup section («THE COMPONENT LAYOUT AND PLOT DRAWINGS» 
- «Document plot» - «Page Setup Manager»). 

When you set the plot area, the following parameters are displayed on the screen: 

 

 size and orientation of the selected plot paper format as a frame which is 
displayed by a solid blue line, 

 real plot area for the specified printer and selected paper format as a frame 
which is displayed by a dashed blue line, 

 specified plot area of the drawing as a frame which is displayed by a dashed 
red line. 

You can change the colour of the frame specified by default in the Color settings 
section of the Options dialogue box (the Tools menu – Options): 

 

To set several plot areas: 

 In the Plot area section, select the Window option from the drop-down menu. 

 Specify the first and second corners of the first plot area on the screen. 



 In the Plot dialogue box click the Add window print area button and specify the second plot area. 

 Repeat the process of specifying plot areas for other plot areas. 

 To cancel the last plot area specified in error, click the Delete last print area  button. When you click this 

button again, the previous plot area will be deleted and so on. 

Note 1: When you click the Delete last print area  button, the Plot dialogue box is not closed. 

Note 2: Click the New window print area button to cancel all specified plot areas and specify a new plot area. 

To set a multipage plot: 

 Select a printer. 

 Specify the paper size and orientation. 

 Turn off the Fit to paper option. 

 Specify the plot scale. 

 Turn on the Multipage option. 

 Specify the plot area. 

 If necessary, set the plot offset or turn on the Center the plot option. 

The multipage plot is useful to print large formats (A0, A1, etc.) on printers that do not support a plot of these formats. 

Example: Plot of the A1 (landscape) format on A4 papers 

The Plot settings: 

 
Display the A1 layout to A4 papers in the model space: 



 

Batch Plot 

 Menu: File –  Batch Plot… 

 Toolbar: Main –  

 Command line: PUBLISH 

This command allows you to create and send to print a drawing set by publishing the sheet set to a single, multi-
sheet file. You can create a paper drawing set by publishing the sheet set to the plotter named in each sheet's page 
setup. You can customise a collection of drawings for a specific user and you can add and remove sheets from the 
list. The Multi-sheet job option allows you to place one or more files in the list, for example, when you create PDF-
files using a virtual printer. The order of the sheets in the file corresponds to the order of the sheets in list. 

After starting the command, the Publish dialogue box opens: 

 

Options: 

Publish lists Drop-down list containing the named publish lists available to plot. 

The two lists are displayed by default: 

Last  - last layouts lists sent to plot. 



Current – list of all layouts available in the opened documents. 

Number of 
copies: 

Specifies the number of copies to publish. 

Multi-sheet job Turn on/off the mode to plot sheets in the file, for example, when you print on a virtual printer. 

The sheets plot is carried out in order, as specified in the dialogue box. 

If you assign the same plotter for all sheets, they will be placed in one file. 

If you assign different plotters for different sheets, the plot will be carried in separates files for 
each plotter. If you change the plotter, a new file will be created. 

Columns 

State Column displays the plot status: 

 
Print sheet. 

 

 Don’t print sheet. 

 
The plot is forbidden (in the case of incorrect plot settings, for example, do not 
specify a plotter). 

Double-click to switch the status from Plot to Not plot. 

File Displays the file name. 

Layout Displays the name of the layout tab in paper space. Displays the Model for the model space.  

Page setup Displays the named page setup for the sheet. 

If the sheet does not have an assigned page setup, it displays None. 

Plotter Indicates that the output devices given for each drawing sheet in the page setup will be used. 

If you don’t assign an output device to a sheet, the None value will be displayed. 

Paper Displays the paper size and orientation. 

Buttons 

 Deletes all layouts from the list to create a new publish list. 

 

Кнопка сохранения списка листов.  

Saves publish list. 

Click this button to open the Save publish list as dialogue box: 

 
The List name is displayed by default. 

But you can set the user name list. 

Click OK and the named list will be saved in the folder: 

С:\Documents and Settings\Users\User name \Application 
Data\Nanosoft\nanoCAD\PlotConfigs\ 

The named lists are saved in the files with *.plst extension.  

 

Saves the publish lists with a new name. 

Click this button to open the Save publish list as dialogue box. The List name is displayed by 
default. 

If a new name of publish list is same as already existing, after you click OK the following 

dialogue window appears: 



 

 

Adds a new page to plot. 

It is possible to select page only from the opened documents. 

Click this button to open the Add page to plot dialogue box: 

  
From the drop-down lists of the Add page to plot dialogue box you can select: 

- document containing page to add to plot (Document:); 

- Layout from selected document (Layout:); 

- A named set of parameters list, if it exists in the document (Page setup:) 

 Moves the selected drawing sheets up one position in the list. 

 Moves the selected drawing sheets down one position in the list. 

 Deletes the selected drawing sheets from the list of sheets. 

 
Opens the Plot preview dialogue box. 

The preview of plot results is available for the selected sheet in the list. When you print from 
the preview mode, only the viewable sheet will be printed. 

 
Opens the Page Setup dialogue box to specify the plot options. 

Double-click on any column of the selected sheet, except the State column, to open the Page 
Setup dialogue box. 

 
Starts the publishing operation. The sheets, with the state allowing printed output, will be 
printed. 

 Closes the dialogue box. 

To create named publish lists to plot: 

 Open one or more documents, the layouts of which it is necessary to plot. 

 Start the   Batch Plot command. 

 When you open the Publish dialogue box, the list of the layouts, available in the opened documents, is formed 
automatically. The following order of the layouts is set by default: 



- the first in the list is a document from which you run the Batch Plot command. This is followed by the 

documents in order of their tabs in the graphic editor window (from left to right); 

- the Model tab is first displayed in the document. Next there are tabs of Layout1, Layout2, A4, A3, etc. 

 To edit list: 

- to remove unnecessary to plot layouts, select them and click Remove from list button or press DEL; 

- to move the layouts, use the  Move up and the  Move down buttons. 

 To set plot settings for each page, click the button (double click on any selected layout column, 

except the State column, also opens the Page Setup dialogue box). 

Use the previously created named sets of page setup, to reduce the time of parameters settings. 

 Click the  Save publish list button. 

 Enter a name of the list in the Save publish list as dialogue box. 

 Click OK to save list. 

 Click  button, to close the Publish dialogue box. 

Note: When you save a plot setting for each page, the name and location of the file are stored in the list. To select a 
named list of layouts to plot, double click on any column of selected layout, except for the Status column (or click the 

 button). File will be loaded automatically, provided that the path has not changed. 

To edit the publish list to plot: 

 Open the document. 

 Start the  Batch Plot command. 

 In the Publish dialogue box select necessary list from the drop-down Publish lists list. 

 Edit list. 

 Click the  Save publish list button. 

 Click  button, to close the Publish dialogue box. 

To rename the publish list to plot: 

 Open the document. 

 Start the  Batch Plot command. 

 In the Publish dialogue box select necessary list from the drop-down Publish lists list. 

 Edit list. 

 Click the  Save publish list as button. 

 Enter a new name of list. 

 Click OK to save renamed list. 

 Click  button, to close the Publish dialogue box. 

Features of the batch plot from the model space 

 Start the  Page setup command. 

 In the opened Page Setup Manager dialogue box click the  button. 

 In the New Plot Set dialogue box enter name of set, for example, A4 Landscape. 

 Click OK. 

 In the opened Page Setup dialogue box select printer, paper size – A4 and orientation – Landscape, set scale 
and other plot parameters. 

 Specify by Window first print area of A4 format, then second and all other area of A4 format (the  Add 

window print area button). To delete the wrong set of the last area, use the  Delete last print area button. 

The  button allows you to see preview plot result of the selected areas. Preview can be used at 
any stage of set print areas. 

 Set the last print area of A4 format and to complete command, click OK in the Page Setup dialogue box. 

Note: When you create a named set of the pages setup for the batch plot from the model space, it is necessary to 
include in the set all areas of the appropriate format that need to be printed. 



 Click the  button to create the following parameters set of lists in a similar way (for example, A3 
Portrait) 

 Repeat these steps to create other sets of parameters (for example, to create a set of A2 Portrait, A1 Landscape, 
etc.). 

 Specify the last parameters set and click the Close button in the Page Setup Manager dialogue box. 

When you create all named sets of setup pages in model space, you can start the batch plot. 

To run the batch plot of the created named sets of setup pages:  

 Start the  Batch Plot command. 

 In the Publish dialogue box, lick the  New publish list button to clear the current list. 

 Click the Add page to plot button. 

 In the opened Add page to plot dialogue box: 

- in the drop-down Document list select document (if you plot multiple documents at once), 

- in the drop-down Layout list, select Model (displayed by default when you plot from model space), 

- in the drop-down Page setup list, select the A4 Landscape parameters set. 

 Click OK to add selected named set into the layouts to plot list. 

 Click the Add page to plot button, to add next set (for example, A3 Portrait), etc. 

 To start plot, click the  button. 
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